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Preface

This guide describes the configuration and method development tasks in the Thermo 
TraceFinder™ 4.1 application for a user with LabDirector or Supervisor permissions.

 To suggest changes to the documentation or to the Help

Complete a brief survey about this document by clicking the button below.
Thank you in advance for your help.

Accessing Documentation
The TraceFinder application includes complete documentation. For system requirements, 
refer to the Release Notes on the software DVD.

 To view the TraceFinder manuals

From the Microsoft™ Windows™ taskbar, choose Start > All Programs > Thermo 
TraceFinder > Manuals.

–or–

From the application, choose Help > Manuals.

Contents

• Accessing Documentation

• License Activation

• Special Notices

• Contacting Us

http://www.surveymonkey.com/s/PQM6P62
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 To view user documentation from the Thermo Fisher Scientific website

1. Go to thermofisher.com.

2. Click the Services & Support tab.

3. On the right, click Manuals & Protocols.

4. In the Refine Your Search box, search by the product name.

5. From the results list, click the title to open the document in your web browser, save it, or 
print it. 

To return to the document list, click the browser Back button.

 To view TraceFinder Help 

Open the TraceFinder application and choose Help > TraceFinder Help. 

• To find a particular topic, use the Contents, Index, or Search panes.

• To create your own bookmarks, use the Favorites pane.

https://www.thermofisher.com
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License Activation 
When you first start the TraceFinder application, a dialog box displays the number of days 
remaining in your 120-day free evaluation license. If your evaluation license has expired, the 
License Activation wizard opens. 

Two types of licenses are available:

• 120-Day Evaluation Version (free of charge)

• Full Version Single License 

The evaluation version is full-featured and automatically expires 120 days after activation. 
Any attempt to set back the system date automatically terminates this version. You can 
purchase and then activate the full version of the application at any time, during or after the 
free evaluation, without reinstalling the software. 

Each activation key is valid only for a single license. Any additional installation generates a 
different license and requires a different activation key.

For software download and licensing questions, contact support at 
ThermoMSLicensing@thermo.com.

Note  You can open the License Activation wizard at any time during your evaluation 
period by choosing Help > About TraceFinder and Licensing from the TraceFinder menu 
and then clicking Activate. If you already have a permanent license, a message tells you 
that your product is fully licensed.

mailto:ThermoMSLicensing@thermo.com
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Use the License Activation wizard to activate or deactivate the license for the application. To 
activate the license, you must have an activation code from Thermo Fisher Scientific. You 
must deactivate the license before you transfer it to another computer.

 To start the license activation or deactivation process

1. Open the application.

2. Choose Help > About TraceFinder and Licensing to display the License Activation 
wizard.

3. Click Activate (Deactivate) to start the activation or deactivation process, as applicable.

The License Activation wizard opens.

4. Follow the instructions in the License Activation wizard.

For additional instructions, click Help in the wizard.

IMPORTANT  The 120-day evaluation license includes both basic TraceFinder 4.1 features 
and the unknown screening features. When you purchase a permanent license, you have 
the option to purchase the unknown screening features. Your permanent license might not 
include the unknown screening features.
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Special Notices
Make sure you follow the special notices presented in this guide. Special notices appear in 
boxes; those concerning safety or possible system damage also have corresponding caution 
symbols.

Contacting Us
There are several ways to contact Thermo Fisher Scientific for the information you need. You 
can use your smartphone to scan a QR code, which opens your email application or browser. 

IMPORTANT  Highlights information necessary to prevent damage to software, loss of 
data, or invalid test results; or might contain information that is critical for optimal 
performance of the system.

Note  Highlights information of general interest.

Tip  Highlights helpful information that can make a task easier.

Contact us Customer Service and Sales Technical Support

(U.S.) 1 (800) 532-4752 (U.S.) 1 (800) 532-4752

(U.S.) 1 (561) 688-8731 (U.S.) 1 (561) 688-8736

us.customer-support.analyze
@thermofisher.com 

us.techsupport.analyze
@thermofisher.com 

mailto:us.customer-support.analyze@thermofisher.com
mailto:us.customer-support.analyze@thermofisher.com
mailto:us.techsupport.analyze@thermofisher.com
mailto:us.techsupport.analyze@thermofisher.com
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 To find global contact information or customize your request

1. Go to thermofisher.com. 

2. Click Contact Us and then select the type of support you need.

3. At the prompt, type the product name. 

4. Use the phone number or complete the online form. 

 To find product support, knowledge bases, and resources

Go to thermofisher.com/us/en/home/technical-resources.

 To find product information

Go to thermofisher.com/us/en/home/brands/thermo-scientific. 

Note  To provide feedback for this document: 

• Send an email message to Technical Publications (techpubs-lcms@thermofisher.com).

• Complete a survey at surveymonkey.com/s/PQM6P62. 

Contact us Customer Service and Sales Technical Support

https://www.thermofisher.com
https://www.thermofisher.com/us/en/home/technical-resources.html
https://www.thermofisher.com/us/en/home/brands/thermo-scientific.html
mailto:techpubs-lcms@thermofisher.com
http://www.surveymonkey.com/s/PQM6P62
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Using the Configuration Console

Use the features of the Configuration console to do any of the following:

• Activate features, such as multiplexing, intelligent sequencing, qualitative browsers, 
screening libraries, and compound database creation for small molecules and peptides.

• Select the reports that are available to users, the detector types, and the algorithms used 
for peak detection. 

• Customize adduct definitions, additional sample grid columns, and flags.

When user security is activated, you must have Configuration permissions to access the 
features in the Configuration console. 

If you are a member of the local administrator’s group and are launching the TraceFinder 
application for the first time, by default, you have LabDirector permissions. For information 
about groups and permissions, refer to the TraceFinder Administrator Console User Guide.

Contents

• Specifying Application Defaults

• Specifying Default Peak Detection Parameters

• Specifying Adducts

• Activating Optional Features

• Creating Custom Columns

• Creating Custom Flags

• Specifying the Reports
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 To access the Configuration console 

Click the Application Configuration icon, , in the upper right corner of any 
window.

The TraceFinder Configuration console opens.

Table 1. Navigation pane functions in the Configuration console 

Function Description

Defaults Use the Defaults view to specify the default laboratory and 
instrument names, the displayed mass precision, and the intensity 
scale to use for reporting. See Specifying Application Defaults.

Peak Detection 
Defaults 

Use the Peak Detection Defaults view to specify a peak detection 
algorithm and its options and to determine the area under a curve. 
See Specifying Default Peak Detection Parameters.

Adducts Use the Adducts view to specify the adducts that will be available for 
use in method development. See Specifying Adducts.

Optional 
Features

Use the Optional Features view to enable features, such as quick 
acquisition, multiplexing, intelligent sequencing, and screening 
libraries. See Activating Optional Features.

Custom 
Columns

Use the Custom Columns view to add six additional columns to the 
samples list in batches. See Creating Custom Columns.

Flag 
Customization

Use the Flag Customization view to customize error flags and 
conditions to indicate compound errors in Data Review for 
quantitation batches. See Creating Custom Flags.

Reports Use the Reports view to configure which reports are available to 
users. See Specifying the Reports.
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Specifying Application Defaults
Use the Application – Defaults view of the Configuration console to specify the default 
laboratory and instrument names, the displayed mass precision, and the chromatogram 
intensity scale to use for reporting. When user security is activated, you must have 
Configuration – Defaults permission to access these features.

Follow these procedures:

• To open the Defaults view

• To specify a default laboratory name and instrument name

• To specify default mass precision and the intensity scale

 To open the Defaults view

In the navigation pane for the Configuration console, click Defaults.

The Application – Defaults view opens.

 To specify a default laboratory name and instrument name

1. Type the name of your laboratory in the Lab Name box.

When you create a method, the application uses this default laboratory name for the 
Laboratory Name value on the Processing page of the Method View. The application uses 
this laboratory name in the report headings. 

The application does not apply this default laboratory name to previously created 
methods. By default, the laboratory name is Default Laboratory.

2. Type the name of your instrument in the Instrument Name box.

When you create a batch, the application uses this default instrument name for the 
Instrument Name value. The application uses this instrument name in the report 
headings.

3. To save your changes, click Apply.

The application does not apply this default instrument name to previously created 
batches. By default, the instrument name is Thermo Scientific Instrument.
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 To specify default mass precision and the intensity scale

1. In the Display Mass Precision box, set the decimal value for the mass precision to an 
integer from 2 to 6, inclusive.

The default number of digits to display is 2. The application uses this mass precision 
value to display mass values in the following locations: 

• Reports:
– Blank Report
– Confirmation Report (data spectra, library spectra, quantitation ion display, and 

qualitative ion display)
– All High Density reports (m/z values)
– Ion Ratio Failure Report (quantitation ion and qualitative ion)
– Manual Integration Report (m/z value)
– Quantitation Report (QIon)

• All peaks on the Detection pages in the Method Development mode
• The spectrum display in Data Review in the Analysis mode
• The spectrum display in the Method Forge dialog box

2. Select either the Relative or Absolute option for the Chromatogram Intensity Scale.

This sets the default display type for both quantitation and qualitative chromatograms 
displayed in data review and reports. 

3. To save your changes, click Apply.

IMPORTANT  When you create a method using a raw data file, the application reads 
the filter precision value from the raw data file to create scan filters; however, the 
application uses the Display Mass Precision value when showing masses that are not 
embedded within filter strings and masses that are displayed on spectral plots.
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Specifying Default Peak Detection Parameters
When user security is activated, you must have Configuration – Peak Detection Defaults 
permission to access default peak detection parameters for the Genesis, ICIS, or Avalon 
detection algorithms.

Use the Peak Detection Defaults view to specify a peak detection algorithm and its options 
and to determine the area under a curve. These parameters are available for quantitation 
methods only.

The following topics include procedures for specifying common peak detection parameters 
and the parameters used for each of the following detection algorithms:

• Genesis Detection Method

• ICIS Detection Method

• Avalon Detection Method

 To open the Peak Detection Defaults view

In the navigation pane for the Configuration console, click Peak Detection Defaults.

The Application – Peak Detection Defaults view opens. 

• For parameter information that is common to all detection algorithms, see Common 
Peak Detection Parameters.

• For parameter information specific to the Genesis detection algorithm, see Genesis 
Detection Method.

• For parameter information specific to the ICIS detection algorithm, see ICIS 
Detection Method.

• For parameter information specific to the Avalon detection algorithm, see Avalon 
Detection Method.

 To specify common detection parameters

1. In the Detector Type list, select a detector type.

For detailed descriptions of the available detector types, see Common Peak Detection 
Parameters.

2. In the Mass Tolerance area, do the following:

a. Select the unit of measure that you want to use (MMU or PPM). 

b. In the Value box, specify the number of millimass units or parts per million to use as 
the upper limit.

The application applies this mass tolerance to the extracted chromatograms. The default 
is 500 MMU.

Note  For the Q Exactive™ mass spectrometer, set the Mass Tolerance to 5 PPM.
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3. In the Retention Time area, do the following:

a. In the Window box, specify the width of the window (in seconds) to indicate how far 
around the expected retention time the system will look for a peak apex. 

b. In the View Width box, specify the viewable size (in minutes) of the ion 
chromatogram display. 

4. In the Ion Ratio Parameters area, do the following:

a. In the Window Type list, select Absolute or Relative as the calculation approach for 
determining the acceptable ion ratio range. 

b. In the Window box, select the acceptable ion ratio range. 

c. In the Ion Coelution box, select the maximum difference in retention time between a 
confirming ion peak and the quantification ion peak.

5. In the Peak Detection Parameters area, select one of the detection algorithms: Genesis, 
ICIS, or Avalon.

6. Specify the parameters for the selected detection algorithm.

For detailed parameter descriptions, see one of the following:

• Genesis Detection Method

• ICIS Detection Method

• Avalon Detection Method
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Common Peak Detection Parameters

All of the detection algorithms use these parameters: Detector Type, Mass Tolerance, 
Retention Time, and Ion Ratio. When you create a new method from a compound database, 
the application inherits the peak detection parameters from the database.

Figure 1. Common peak detection areas
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Table 2. Common peak detection parameters  (Sheet 1 of 2)

Parameter Description

Detector Type MS: Mass spectrometer that ionizes sample molecules and then 
separates the ions according to their mass-to-charge ratio (m/z).

PDA: Photodiode array detector providing a linear array of discrete 
photodiodes on an integrated circuit chip. It is placed at the image 
plane of a spectrometer so that a range of wavelengths can be 
simultaneously detected.

Analog: Supplemental detectors (for example, FID, ECD). When 
you select this detector, any reports that display a QIon value show 
the value as Analog and any reports that display spectra show the 
spectra as Not Available.

A/D card: If your detector is not under data system control, you can 
capture the analog signal and convert it to digital using an interface 
box (for example, SS420X) for storage in the raw data file.

UV: A UV spectrophotometer (for variable-wavelength detection) or 
photometer (for single-wavelength detection) equipped with a 
low-volume flow cell. This detector detects analytes that readily 
absorb light at a selected wavelength.

Mass Tolerance

Units • (Default) MMU (millimass units) 
MMU is a static calculation to the extracted mass.

• PPM (parts per million) 
PPM is a variable calculation dependent on the actual mass. The 
smaller the mass, the narrower the tolerance range. The larger the 
mass, the wider the tolerance range.

Value Upper limit of MMU or PPM.

Valid range: 0.1 through 50 000
Default: 500

Retention Time

Window (sec) Width of the window (in seconds) to indicate how far around the 
expected retention time the system will look for a peak apex. 

View Width (min) Viewable size (in minutes) of the ion chromatogram display. 
Changing the view width does not affect the process of peak 
detection; the application uses it only for graphical display. 



 1 Using the Configuration Console
Specifying Default Peak Detection Parameters

Thermo Scientific TraceFinder Lab Director User Guide 9

Ion Ratio Parameters

Window Type Specifies the absolute or relative calculation approach for determining 
the acceptable ion ratio range. 

Window (+/-%) Specifies the acceptable ion ratio range.

Ion Coelution (min) Specifies the maximum difference in retention time between a 
confirming ion peak and the quantification ion peak.

Detection 
Algorithm

Specifies the default peak detection algorithm.

Valid values: Genesis, ICIS, Avalon

Peak Detection 
Strategy (Analyte)

Specifies the peak detection method used for analyte compounds.

Highest Peak: Uses the highest peak in the chromatogram for 
component identification. 

Nearest RT: Uses the peak with the nearest retention time in the 
chromatogram for component identification.

Peak Detection 
Strategy (ISTD)

Specifies the peak detection method used for internal standard 
compounds.

Highest Peak: Uses the highest peak in the chromatogram for 
component identification. 

Nearest RT: Uses the peak with the nearest retention time in the 
chromatogram for component identification.

Peak Threshold 
Type

Specifies whether the application identifies peaks by height or area.

Smoothing Determines the degree of data smoothing to be performed on the 
active component peak prior to peak detection and integration. The 
ICIS peak detection algorithm uses this value.

Valid values: Any odd integer from 1 through 15 points
Default: 1 

Extraction Window 
(min)

Specifies a window that limits how much of the entire trace the 
application processes. When cleared, the application processes the 
entire trace, which slows processing.

Default: 3.00

Table 2. Common peak detection parameters  (Sheet 2 of 2)

Parameter Description
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Genesis Detection Method

The application provides the Genesis peak detection algorithm for backward compatibility 
with Xcalibur™ 1.0 studies. 

Figure 2. Genesis peak detection

Table 3. Genesis peak detection parameters  (Sheet 1 of 3)

Parameter Description

Detection Algorithm Specifies the Genesis peak detection algorithm.

S/N Threshold Specifies the current signal-to-noise threshold for peak integration. 
Peaks with signal-to-noise values less than this value are not 
integrated. Peaks with signal-to-noise values greater than this value 
are integrated. 

Valid range: 0.0 through 999.0
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Enable Valley 
Detection

Uses the valley detection approximation method to detect 
unresolved peaks. This method drops a vertical line from the apex 
of the valley between unresolved peaks to the baseline. The 
intersection of the vertical line and the baseline defines the end of 
the first peak and the beginning of the second peak. 

Expected Width (sec) Specifies the expected peak width parameter (in seconds). This 
parameter controls the minimum width that a peak is expected to 
have if valley detection is enabled. 

With valley detection enabled, any valley points nearer than the 
expected width/2 to the top of the peak are ignored. If a valley 
point is found outside the expected peak width, the application 
terminates the peak at that point. The application always 
terminates a peak when the signal reaches the baseline, 
independent of the value set for the expected peak width. 

Valid range: 0.0 through 999.0

Constrain Peak Width Constrains the peak width of a component during peak 
integration of a chromatogram. You can then set values that 
control when peak integration is turned on and off by specifying a 
threshold and a tailing factor. Selecting the Constrain Peak Width 
check box activates the Peak Height (%) and Tailing Factor 
options.

Peak Height (%) A signal must be above the baseline percentage of the total peak 
height (100%) before integration is turned on or off. This text box 
is active only when you select the Constrain Peak Width check 
box. 

Valid range: 0.0 through 100.0%

Tailing Factor Specifies the tailing factor that controls how the application 
integrates the tail of a peak. This factor is the maximum ratio of 
the trailing edge to the leading side of a constrained peak. This 
text box is active only when you select the Constrain the Peak 
Width check box. 

Valid range: 0.5 through 9.0

Table 3. Genesis peak detection parameters  (Sheet 2 of 3)

Parameter Description
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Peak S/N Cutoff Sets the peak edge to values below this signal-to-noise ratio. 

This test assumes it has found an edge of a peak when the baseline 
adjusted height of the edge is less than the ratio of the baseline 
adjusted apex height and the peak S/N cutoff ratio. 

When the S/N at the apex is 500 and the peak S/N cutoff value is 
200, the application defines the right and left edges of the peak 
when the S/N reaches a value less than 200. 

Valid range: 50.0 through 10000.0

Valley Rise (%) Specifies that the peak trace can rise above the baseline by this 
percentage after passing through a minimum (before or after the 
peak). This criteria is useful for integrating peaks with long tails.

This method drops a vertical line from the apex of the valley 
between unresolved peaks to the baseline. The intersection of the 
vertical line and the baseline defines the end of the first peak and 
the beginning of the second peak. 

When the trace exceeds rise percentage, the application applies 
valley detection peak integration criteria. This test is applied to 
both the left and right edges of the peak. 

Valid range: 0.1 through 500.0

Valley S/N Specifies a value to evaluate the valley bottom. Using this 
parameter ensures that the surrounding measurements are higher. 

Valid range: 1.0 through 100.0
Default: 2.0

# Background Scans Specifies the number of background scans performed by the 
application.

Report Noise As Determines if the noise used in calculating S/N values is calculated 
using an RMS calculation or peak-to-peak resolution threshold. 
Options are RMS or Peak To Peak.

Table 3. Genesis peak detection parameters  (Sheet 3 of 3)

Parameter Description
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ICIS Detection Method 

The ICIS peak detection algorithm is designed for MS data and has superior peak detection 
efficiency at low MS signal levels. 

Figure 3. ICIS peak detection 

Table 4. ICIS peak detection parameters  (Sheet 1 of 3)

Parameter Description

Detection Algorithm Specifies the ICIS peak detection algorithm.

Area Noise Factor Specifies the noise level multiplier used to determine the peak edge 
after the location of the possible peak. The ICIS peak detection 
algorithm uses this value. 

Valid range: 1 through 500
Default: 5
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Peak Noise Factor Specifies the noise level multiplier used to determine the potential 
peak signal threshold. The ICIS peak detection algorithm uses this 
value.

Valid range: 1 through 1000
Default: 10

Baseline Window Specifies that the application looks for a local minima over this 
number of scans. The ICIS peak detection algorithm uses this 
value.

Valid range: 1 through 500
Default: 40

Constrain Peak Width Constrains the peak width of a component during peak 
integration of a chromatogram. You can then set values that 
control when peak integration is turned on and off by specifying a 
peak height threshold and a tailing factor. Selecting the Constrain 
Peak Width check box activates the Peak Height (%) and Tailing 
Factor options.

Peak Height (%) Specifies that the signal must be above the baseline percentage of 
the total peak height (100%) before integration is turned on or 
off. This text box is active only when you select the Constrain Peak 
Width check box. 

Valid range: 0.0 through 100.0%

Tailing Factor Specifies the tailing factor that controls how the application 
integrates the tail of a peak. This factor is the maximum ratio of 
the trailing edge to the leading side of a constrained peak. This 
text box is active only when you select the Constrain the Peak 
Width check box. 

Valid range: 0.5 through 9.0

Min Peak Height (S/N) Specifies the minimum peak height measured as a signal-to-noise 
ratio.

Valid range: 0.00 through 999.00
Default: 3.0

Table 4. ICIS peak detection parameters  (Sheet 2 of 3)

Parameter Description
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Noise Method Specifies the noise method as INCOS or Repetitive.

INCOS: Uses a single pass algorithm to determine the noise level. 
The ICIS peak detection algorithm uses this value. 

Repetitive: Uses a multiple pass algorithm to determine the noise 
level. The ICIS peak detection algorithm uses this value. In 
general, this algorithm is more accurate in analyzing the noise than 
the INCOS Noise algorithm, but the analysis takes longer. 

Min Peak Width Specifies the minimum number of scans required in a peak. The 
ICIS peak detection algorithm uses this value.

Valid range: 0 through 100 scans
Default: 3

Multiplet Resolution Specifies the minimum separation in scans between the apexes of 
two potential peaks. This is a criteria to determine if two peaks are 
resolved. The ICIS peak detection algorithm uses this value.

Valid range: 1 through 500 scans
Default: 10 

Area Tail Extension Specifies the number of scans past the peak endpoint to use in 
averaging the intensity. The ICIS peak detection algorithm uses 
this value.

Valid range: 0 through 100 scans
Default: 5

Area Scan Window Specifies the number of allowable scans on each side of the peak 
apex. A zero value defines all scans (peak-start to peak-end) to be 
included in the area integration. 

Valid range: 0 through 100 scans
Default: 0 

RMS Specifies that the application calculates noise as RMS. By default, 
the application uses Peak To Peak for the noise calculation. RMS is 
automatically selected if you manually determine the noise region.

Table 4. ICIS peak detection parameters  (Sheet 3 of 3)

Parameter Description
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Avalon Detection Method 

The Avalon peak detection algorithm is designed for UV data. The Avalon peak detection 
algorithm also supports negative peaks. You can edit the Event values from the Avalon Event 
List.

Figure 4. Avalon peak detection 

Table 5. Avalon peak detection parameters 

Parameter Description

Detection Algorithm Specifies the Avalon peak detection algorithm.

Time/Event/Value Displays the events specified in the Avalon Event List dialog box. 
Initially displays only the default events that cannot be edited or 
deleted.

Autocalc Initial Events Automatically calculates the events in the Event list.

Edit Opens the Avalon Event List dialog box where you can edit the 
Time/Event/Value parameters.
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Avalon Event List

The event list includes both user-defined and noneditable default events. The application 
displays the default events when you choose Avalon sensitivity. You cannot delete these events 
or change their time or values. For a detailed list of events and value ranges, see Event types.

Figure 5. Avalon Event List dialog box

Table 6. Avalon Event List dialog box parameters 

Parameter Description

Time (Min) Specifies the start time of the event.

Event Specifies the type of event. For a detailed list of events and value 
ranges, see Event types.

Value Specifies the value of the event.

Add Adds a new event to the list with the current Time/Event/Value 
parameters.

Delete Removes the selected Time/Event/Value parameter from the event 
list.

Change Applies the current parameter values.

Cancel Closes the dialog box without making any changes. Any additions, 
deletions, or changes revert to their original state.

Apply Closes the dialog box.



1 Using the Configuration Console
Specifying Default Peak Detection Parameters

18 TraceFinder Lab Director User Guide Thermo Scientific

Figure 6. Event types

Table 7. Event type descriptions  (Sheet 1 of 2)

Event type Description

Start Threshold Specifies the threshold at the start of a peak. The Start Threshold is 
directly related to the RMS noise in the chromatogram.

Valid range: 0 through 999 999 999

End Threshold Specifies the threshold at the end of a peak. The End Threshold is 
directly related to the RMS noise in the chromatogram.

Valid range: 0 through 999 999 999

Area Threshold Controls the area cutoff. Any peaks with a final area less than the area 
threshold will not be detected. This control is in units of area for the 
data. 

Valid range: 0 through 999 999 999

P-P Threshold Specifies the peak-to-peak resolution threshold controls how much 
peak overlap must be present before two or more adjacent peaks 
create a peak cluster. Peak clusters have a baseline drop instead of 
valley-to-valley baselines. Specified as a percent of peak height 
overlap.

Valid range: 0.1 through 99.99

Negative Peaks Permits detection of a negative going peak. Automatically resets after 
finding a negative peak.

Valid values: On or Off
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Bunch Factor Specifies the number of points grouped together during peak 
detection. This event controls the bunching of chromatographic 
points during integration and does not affect the final area 
calculation of the peak. A high bunch factor groups peaks into 
clusters.

Valid range: 0 through 999

Tension Controls how closely the baseline should follow the overall shape of 
the chromatogram. A lower tension traces the baseline to more 
closely follow changes in the chromatogram. A high baseline tension 
follows the baseline less closely, over longer time intervals. 

Valid range: 0 through 999.99 minutes

Tangent Skim Specifies that you can tangent skim any peak clusters. By default, it 
chooses the tallest peak in a cluster as the parent. You can also 
identify which peak in the cluster is the parent. Tangent skim peaks 
are detected on either side (or both sides) of the parent peak. Tangent 
skim automatically resets at the end of the peak cluster.

Valid range: 0 through 1

Shoulders On Allows peak shoulders to be detected (peaks which are separated by 
an inflection rather than a valley) Sets a threshold for the derivative.

Shoulders Off Disables peak shoulder detection.

Valid range: 0 through 50

Force Cluster On Forces the following peaks to be treated as a cluster (single peak).

Force Cluster Off Ends the forced clustering of peaks.

Disable Cluster On Prevents any peaks from being clustered.

Disable Cluster Off Permits clusters to occur again.

Table 7. Event type descriptions  (Sheet 2 of 2)

Event type Description
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Specifying Adducts
An adduct ion is formed from a precursor ion and contains all of the constituent atoms of that 
ion and additional atoms or molecules. Adduct ions are often formed in the mass 
spectrometer ion source. Adducts can be either positive or negative.

Use the Application – Adducts view to specify the adducts that will be available for you to use 
in method development. When user security is activated, you must have Configuration – 
Adducts permission to access these features.

Follow these procedures:

• To open the Adducts view

• To add an adduct

• To remove an adduct

 To open the Adducts view

In the navigation pane for the Configuration console, click Adducts.

The Application – Adducts view opens, displaying the default positive and negative 
adducts.
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 To add an adduct

1. In the Positive Adducts or Negative Adducts pane, click the Add New Adduct icon, .

The application adds a new, editable row at the bottom of the Adducts list.

2. Type the formula for the new adduct ion.

The formula syntax is alphanumeric and case sensitive. It can include parentheses and 
brackets.

The formula specifies the difference between the neutral molecule and the charged ion 
that you expect to see in the results.

For example, a sodium adduct has [M+Na]+ as the expected charged ion (where M is the 
neutral molecule), so you would type “Na” for the formula. A water adduct has 
[M+H+H2O]+ as the expected charged ion, so you would type “H3O” for the formula.

The application displays a type and neutral mass for the adduct formula you entered.

3. Select the default name (New Adduct) and type a name for the adduct.

You cannot change the type or neutral mass, but the application will correctly calculate 
these values later.

IMPORTANT  When you create an adduct formula, you can type both uppercase and 
lowercase letters; however, the application interprets all uppercase input as 
single-letter elements and all lowercase input as two-letter elements. 

For example, it interprets the string “inau” as In Au and “COSI” as C O S I.
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4. Press ENTER.

The application adds the adduct to the adducts list and calculates the correct type (Gain 
or Loss) and the neutral mass.

These adducts are available for you to select in the Compound Database view of the 
Method Development mode when you specify parameter values for compounds. 

 To remove an adduct

1. In the Positive Adducts or Negative Adducts pane, select the adduct that you want to 
remove.

2. Press DELETE and confirm that you want to delete the selected adduct.

You can delete only adducts that you added to the adducts list. You cannot delete default 
adducts defined by the TraceFinder installation.
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Activating Optional Features 
When user security is activated, you must have Configuration – Optional Features permission 
to access these features.

Use the Application – Optional Features view to activate the following features:

• Quick Acquisition

• Delay Calibration

• User Peak Detection Settings

• Autosampler Tray Configuration

• Qualitative Results

• Acquisition Submission Options

• Qualitative Explorer

• Screening Libraries

• Multiplexing

• Intelligent Sequencing

• Processing Options

• Cdb Options
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 To open the Optional Features page

In the navigation pane for the Configuration console, click Optional Features.

The Application – Optional Features page opens. 

Quick Acquisition

The quick acquisition option activates the Quick Acquisition feature in the Acquisition, 
Analysis, or Method Development mode.

 To activate quick acquisition

1. Select the Quick Acquisition Allowed check box.

2. To immediately apply this feature change, click Apply.

For a description of the Quick Acquisition features, see Appendix A, “Using Quick 
Acquisition” in the TraceFinder User Guide.

Note  The Quick Acquisition feature is not available when you activate Multiplexing. 
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Delay Calibration 

You can determine when the application calculates the calibration curve, using the Delay 
Calibration option. Delaying the recalibration until the application processes the last 
calibration sample in a batch is faster but less responsive than recalibration after each 
calibration sample.

 To delay calculation of a calibration curve

1. Select the Delay Calibration check box.

2. To immediately apply this feature change, click Apply.

User Peak Detection Settings

Use the User Peak Detection Settings Allowed option to modify the method integration 
settings for specific compounds in Data Review. 

 To enable the modify peak detection settings

1. Select the User Peak Detection Settings Allowed check box.

2. To immediately apply this feature change, click Apply.

Autosampler Tray Configuration

By default, the TraceFinder application lets the autosampler automatically determine the tray 
configuration. When you are using a Waters™ ACQUITY™ system, you must make this 
feature unavailable and explicitly specify the tray configuration when you create a batch.

 To disallow automatic tray configuration

1. Select the Allow Auto Sampler to Automatically Determine … check box.

2. To immediately apply this feature change, click Apply.

Qualitative Results

When you select the Enable Qualitative Results Display and Processing option, the 
application displays the following qualitative processing features for quantitation methods and 
batches:

• Method Template Editor

To specify qualitative settings in a method template, see To specify qualitative peak 
processing.
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• Master method 

To specify qualitative settings on the Processing page for a method, see To specify 
qualitative peak processing parameters.

• Batch View 

To enable qualitative processing for a batch in Data Review, refer to Chapter 4, “Using 
the Analysis Mode for Quantitation Batches” in the TraceFinder User Guide.

• Data Review

For descriptions of the Qualitative View features in Data Review, refer to Chapter 4, 
“Using the Analysis Mode for Quantitation Batches” in the TraceFinder User Guide. 

• Acquisition wizard 

To enable qualitative processing for a batch in the acquisition wizard, refer to Chapter 3, 
“Using the Acquisition Mode” in the TraceFinder User Guide. 

For GC configurations, the qualitative processing option is enabled by default.

For LC configurations, the qualitative processing option is not enabled by default.
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Acquisition Submission Options 

To control acquisitions, you can activate either submission option: full-sequence or 
single-sample. When you submit batches from the Acquisition mode or Quick Acquisition 
batches from any mode, they run in first-in-last-out order. The last batch submitted is the first 
batch to run, unless you submit a batch as a priority batch in Acquisition mode.

• When you use Full Sequence Submission, priority batches always run immediately after 
the currently acquiring batch is completed.

• When you use Single Sample Submission, priority batches always run immediately after 
the currently acquiring sample is completed.

 To specify acquisition submission features

1. Select either the Full Sequence Submission or the Single Sample Submission option:

• Full Sequence Submission: Supports look-ahead features of the autosampler. When 
the instrument method specifies the look-ahead feature, the application functions like 
a multiplex driver and feeds the autosampler the next vial position.

When you submit a batch, the autosampler begins preparing for all sample injections 
when the pre-run condition begins. All samples in the batch must be completed 
before other batches (even higher priority batches) can begin.

• Single Sample Submission: Supports intelligent-sequencing features. When you 
submit a batch, the autosampler begins preparing for one sample injection at a time. 
Higher priority batches can interrupt the sample sequence in the currently acquiring 
batch.

2. To save your changes, click Apply.

You must restart the application to apply this feature change.

Note  The Full Sequence Submission feature is not available when you activate 
Intelligent Sequencing. 

Note  The Single Sample Submission feature is not available when you activate 
Multiplexing.
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Qualitative Explorer

You can use either the FreeStyle™ application or Qual Browser to display chromatograms and 
spectra, detect chromatogram peaks, search libraries, simulate spectra, subtract background 
spectra, apply filters, add text and graphics, create and save layouts, and view instrument 
parameters as they changed during the acquisition. 

 To specify a qualitative explorer 

Select either the Thermo FreeStyle or the Thermo Xcalibur Qual Browser option.

Screening Libraries

Use the specified screening libraries for both quantitation methods and target screening 
methods. For more information about how you can use screening libraries in a quantitation 
method, see Screening Libraries in a Quantitation Method. For more information about how 
you can use screening libraries in a target screening method, see Screening Libraries in a 
Target Screening Method. 

When you specify the Library Search Type on the Processing page for a target screening 
method, choose the mzVault™ search type, the NIST™ search type, or the NIST High 
Resolution search type. See Editing the Acquisition Page.

• When you choose mzVault as the library search type for a quantitation or target screening 
method, the application uses the mzVault library file (.db) specified in the Configuration 
console. You can search only one spectral library when you process a sample.

• When you choose NIST or NIST High Resolution as the library search type for the 
method, the application uses the NIST libraries specified in the Configuration console. 
You can choose to search multiple NIST libraries when you process a sample.

 To specify an mzVault screening library

Click Browse and locate the library that you want to use for screening.

Note  You can access the explorer by choosing Tools > Launch Qual Explorer in the 
main TraceFinder menu bar. Refer to Chapter 2, “Getting Started” in the TraceFinder 
User Guide.

Note  You can use only one search type when you process a sample. When you select 
NIST or NIST High Resolution as the library search type in your method, the 
application does not use the screening library that you specify here.
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 To specify a NIST screening library

1. Click Select.

The Select NIST Libraries dialog box opens, listing the libraries you installed for the 
application.

2. Select the check box for each NIST library that you want to use for screening and click 
OK.

3. To immediately apply this feature change, click Apply.

The application searches the specified screening library to identify or confirm a sample 
compound, matches the fragment ion spectrum in the library to the compound’s ion 
spectrum, and returns the highest score (best match).

The application performs either a forward library search or a reverse library search. A forward 
search compares the mass spectrum of an unknown compound to a mass spectral library 
entry, whereas a reverse search compares a library entry to an unknown compound.

Screening Libraries in a Quantitation Method

In a quantitation method, you can enable library matching and set a score threshold to 
minimize poor matches. See mzVault. To match a compound, the resulting score from a 
library search must be higher than the specified threshold value.

Screening Libraries in a Target Screening Method

In a target screening method, you can specify the library search to either identify or confirm 
library matches and set a score threshold to minimize poor matches. See Editing the 
Processing Page.

• Identify or Confirm: The application identifies or confirms the sample compound by 
searching the specified search library and returning the highest score (as a percentage 
value) for the fragment ion spectrum in that library that matches the compound’s ion 
spectrum. 

Note  You can use only one search type when you process a sample. When you select 
mzVault as the library search type in your method, the application does not use the 
NIST libraries that you specify here.
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• Score Threshold: To identify or confirm the presence of a compound, the resulting score 
from a library search must be higher than the specified threshold value. 

Screening Libraries in an Unknown Screening Method

Unknown screening methods do not use screening libraries.

Multiplexing
The application uses multiplexing features in the Acquisition mode when you specify 
channels for a sample in a batch. Refer to Chapter 3, “Using the Acquisition Mode” in the 
TraceFinder User Guide.

 To specify multiplexing features

1. Select the Multiplexing check box.

2. Select the check box for each channel that you want to use for acquisition.

3. To immediately apply this feature change, click Apply.

Intelligent Sequencing
Use Intelligent Sequencing for single-sample submission. When you submit a batch, the 
autosampler begins preparing for one sample injection at a time. Higher priority batches can 
interrupt the sample sequence in the currently acquiring batch.

 To activate the intelligent sequencing feature

1. Select the Intelligent Sequencing check box.

The Acquisition Submission Options default to Single Sample Submission. The Full 
Sequence Submission option is not available when you select the Intelligent Sequencing 
option.

2. To immediately apply this feature change, click Apply.

IMPORTANT  To use a library search for identification or confirmation, the application 
requires meeting these conditions:

• The raw data file must contain higher energy collision-induced dissociation (HCD), 
source collision-induced dissociation (CID), or all ions fragmentation (AIF) ion 
spectra.

• The spectra must exist at a time point within the compound’s elution time range.

Note   Multiplexing is not available when you activate Intelligent Sequencing.

Note  When you activate multiplexing, the Quick Acquisition and Single Sample 
Submission optional features are not available.

Note   Intelligent Sequencing is not available when you activate Multiplexing.
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Processing Options 
Use these options to enable auto-batch processing or to allow unknown screening.

 To allow auto-reprocessing

1. Select the Auto Reprocess check box.

• When you select this option, the Auto Reprocess option is selected by default in the 
banner of all application views.

• When you clear this option, the Auto Reprocess option is cleared by default in the 
banner of all application views.

2. To immediately apply this feature change, click Apply. 

 To allow unknown screening 

1. Select the Allow Unknown Screening check box.

• When this option is selected, Unknown Screening features are displayed in the 
application.

• When this option is cleared, Unknown Screening features are not displayed in the 
application.

2. To immediately apply this feature change, click Apply.

Cdb Options

Use these options to enable small molecule compound databases or peptide compound 
databases.

 To allow users to create peptide compound databases 

1. Select the Allow Peptide Compound Database Creation check box.

• Selecting this option enables the New Peptide Compound Database command in the 
File menu of the Compound Database view in the Method Development mode. 

• Clearing this option makes the New Peptide Compound Database command not 
available in the File menu of the Compound Database view in the Method 
Development mode; however, in the Compound Database menu, you can still access 
the Peptide Prediction Tool.

2. To immediately apply this feature change, click Apply.

Note   When you use auto-reprocessing, it can slow batch processing.
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 To allow users to create small molecule compound databases 

1. Select the Allow Small Molecule Compound Database Creation check box.

• Selecting this option enables the New Small Molecule Compound Database 
command in the File menu of the Compound Database view in the Method 
Development mode. 

• Clearing this option makes the New Small Molecule Compound Database command 
not available in the File menu of the Compound Database view in the Method 
Development mode. 

2. To immediately apply this feature change, click Apply.
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Creating Custom Columns
Use the Custom Columns page to add six additional columns to the samples list in batches. 
The application treats these custom columns the same as other columns when you export data 
to a Microsoft Excel™ spreadsheet or to a CSV file. 

When user security is activated, you must have Configuration – Custom Columns permission 
to access these features.

You can use the Modify Columns dialog box to display and change the order of these columns 
in the sample list (see the Column Display topic in the appropriate Analysis chapter for your 
quantitation, target screening, or unknown screening batch).

You can use the Field Chooser to display and change the order of these columns in the Data 
Review Samples pane (see the Samples Pane topic in the appropriate Analysis chapter for your 
quantitation, target screening, or unknown screening batch).

You can use the information in these columns (for example) for temperature control when 
you use Aria™ MX for multiplexing or for injector and multiple column module ports when 
you use the TurboFlow™ method with the Prelude™ or TLX data systems. 

Follow these procedures:

• To open the Custom Columns page

• To add custom columns to new batches

• To create new batches without custom columns

• To control the display of custom columns

 To open the Custom Columns page

Click Custom Columns in the navigation pane. 

The Application – Custom Columns page opens.
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 To add custom columns to new batches 

1. Select the Enable Custom Columns check box.

The application adds six additional columns to the samples list in all new batches that you 
create. 

The Enable Custom Columns check box controls both the creation of custom columns 
on new batches and the display of custom columns in the Modify Columns dialog box in 
the Batch View and the Field Chooser in the Data Review Samples pane.

2. For each custom column, select the default column name and type your custom name, as 
in this example:

3. Click Apply.

The application adds the six custom columns to all new batches that you create.

 To create new batches without custom columns

Clear the Enable Custom Columns check box and click Apply.

When you create new batches, they will not include custom columns, and the application 
hides the display of the custom columns for any previous batches that you created with 
custom columns enabled.

 To control the display of custom columns

Do one of the following:

• To make custom columns available for all batches, select the Enable Custom 
Columns check box and click Apply.

• To make custom columns not available for batches, clear the Enable Custom 
Columns check box and click Apply.

Note  Only new batches include these custom columns. The application does not add 
custom columns to previously created batches.

Note  If you return to this page and change the custom column names, the 
application uses the new names only for future batches. 
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Creating Custom Flags
Use the Flag Customization view to customize error flags and conditions that indicate 
compound errors in Data Review for quantitation batches. You can edit the priority assigned 
to an error condition (flag rule) and the shape and color of the icon used to indicate the error. 
You can also delete an error condition or create a new one. When user security is activated, 
you must have Configuration – Custom Flags permission to access these features.

 To open the Flag Customization view 

Click Flag Customization in the navigation pane. 

The Application – Flag Customization view opens.
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Follow these procedures:

• To edit priority groups

• To create a new priority group

• To edit flag rules

• To create a new flag rule

• To remove all customization

In the Priority Groups area, you can edit the priority, shape, or color of a flag. You can also 
delete a flag or create a new one. You cannot change the name of a flag.

 To edit priority groups 

1. Do any of the following:

• Select the default Priority value and type a new value.

A priority of 1 is the highest priority. The higher the Priority number, the lower the 
priority. 

• Double-click the Shape value and select a new shape from the list.

• Open the Color list and select a new color from the color palette.

2. When you have completed all your changes, click Apply to save your changes. 
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 To create a new priority group

1. In the Priority box, type a value.

You can enter positive or negative numbers. The lower the number, the higher the 
priority.

2. In the Name box, type a name for the new priority group.

3. Select a flag shape from the Shape list: Circle, Square, or Flag.

4. Open the Color list and select a color from the color palette.

5. (Optional) Click Advanced and select a color based on RGB, HSL, or CMYK color 
palettes. See Advanced Dialog Box.

6. Click Create.

The application adds the new flag to the Priority Groups list, as in this example:
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 To edit flag rules

1. Do any of the following:

• In the Description column, select the current text and type a new description.

• Double-click the PriorityGroup value and select a new group from the list.

• Click Delete.

The application immediately removes the flag rule. To restore the deleted rule, click 
Undo.

2. When you have completed all your changes, click Apply to save your changes. 

 To create a new flag rule 

1. In the Name box, type a name for the new rule.

Keep the name short and make it intuitive.

2. In the Description box, type a description for the new flag rule.

This description can be anything that you want and use as many characters as you want.

3. From the Flags list, select an error condition.

4. From the PriorityGroup list, select a priority group.

This list includes both the default priority groups and any priority groups that you 
created. See To create a new priority group.

5. Click Create.

The application adds your new flag rule to the end of the Flag Rules list.

 To remove all customization

Click Reset to Factory Defaults.

The application removes all new priority groups, new flag rules, and any edits to the 
groups or rules.

Note  You can edit the description and priority group for a flag rule, and you can 
delete a rule. You cannot edit the name or flag type for a rule. 
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Advanced Dialog Box

Use the features in the Advanced dialog box to select custom colors for your flags, using RGB, 
HSL, or CMYK color standards.

Figure 7. Advanced RGB colors

With the Red/Green/Blue (RGB) color palette, you can select a color with a specific RGB 
value, as displayed on a computer monitor.

Figure 8. Advanced HSL colors

With the Hue/Saturation/Lightness (HSL) color palette, you can select a color with a specific 
HSL value, as is commonly used in computer graphics.



1 Using the Configuration Console
Creating Custom Flags

40 TraceFinder Lab Director User Guide Thermo Scientific

Figure 9. Advanced CMYK colors

With the Cyan/Magenta/Yellow/Key (CMYK) color palette, you can select a color with a 
specific CMYK value, as you might specify in a color printer. The key (K) color used on 
printers is always black.
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Specifying the Reports 
When user security is activated, you must have Configuration – Reports permission to 
configure a list of reports that users can access when they generate reports from the Method 
Development, Analysis, or Acquisition modes.

 To open the Application – Reporting view

In the Configuration console navigation pane, click Reports.

The Application – Reporting view opens. 

The application displays the Excel template files in the following folder:

…\TraceFinderData\4.0\Templates\ReportTemplates

Each template has an XLS file and a metadata file to support report generation. 

 To specify which reports are available

Select the check box for each report that you want to make available.

• To return the report selections to their original state (when you first opened this 
view), click Undo.

• To save your changes, click Apply.

Your report settings are immediately available in the application.

IMPORTANT   TraceFinder 4.1 uses the same data as TraceFinder 4.0. By default, the application 
stores the report templates for the 4.1 release in the TraceFinderData\4.0\Templates folder.
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The application can generate any of the following reports. 

Figure 10. Reports
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2

Using Compound Databases in the Method 
Development Mode

The Compound Database view is available for quantitation, target screening, and unknown 
screening methods. The TraceFinder application supports both small molecule and peptide 
databases.

When user security is activated, you must have Method Development permission to manage 
compound definitions for the current database in the Compound Database view. You can 
export compounds to a CSV file or mass list, or you can import compounds from an XML, a 
CSV, or a CDB file. 

 To access the compound database

1. Click Method Development in the navigation pane.

The Method Development navigation pane opens. 

2. Click Compound Database.

The current database opens. 

Contents

• Working with a Compound Database View for Small Molecules

• Working with a Compound Database View for Peptides

• Linking Internal Standards

• Using the Peptide Predictor Wizard

• Using the Peptide Modifications Editor

• Importing and Exporting
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Working with a Compound Database View for Small Molecules
The Compound Database view displays the small molecule data in the compound database. 
From this page, you can import small molecule compounds into the database, export 
compounds to a CSV file or mass list, add or remove compounds, and add or remove target 
peaks, confirming peaks, or fragments. You can also create new compound databases or save 
the current database to a new name.

Figure 11. Compound Database view for small molecules

The Compound Database view includes the following features:

• Tree View Pane

• Peak View Pane

• Compound Details Pane
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Tree View Pane

The tree view for small molecule databases displays all compounds in the compound database, 
their target peaks, confirming peaks, and fragments.

Follow these procedures:

• To display only specific compounds

• To expand the names of all compounds in the database

• To collapse and reopen the names of all compounds in the database

• To read the tree view syntax

• To display the peak parameters and compound details for a compound
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 To display only specific compounds

In the Compound Name box, type the name of the compound that you want to locate in 
the list. The Tree View list displays only compound names that contain the text you 
typed. This search feature is not case-sensitive.

In the following examples, as you type the letter a, the application displays all compounds 
that contain “a”. As you continue to type tr, the application displays only compounds that 
contain the letters “atr”.

 To expand the names of all compounds in the database

In the Tree View pane, click Expand All.

The application expands the target peaks, confirming peaks, and fragments for all 
compounds in the tree view.

 To collapse and reopen the names of all compounds in the database

1. In the Tree View pane, click Collapse All.

The application collapses the target peaks and associated peaks for all compounds in the 
compound list and displays only the highest level or “All Results”.

Note   When you click Expand All after typing text in the Compound Name box, the 
application expands only the compounds that contain the entered text.

Note   When the Compound Name box contains text, the application displays only 
the compounds that contain the entered text.
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2. To display the names of all collapsed compounds in the compound list, expand All 
Results.

 To read the tree view syntax

The Tree View pane displays compound names and the m/z for the target peaks. It also 
displays any confirming peaks or fragments and their m/z.

Identifiers for the peak types are as follows:
• T: Target peak
• C: Confirming peak
• F: Fragment
• P: Protein

 To display the peak parameters and compound details for a compound

In the Tree View pane, click the compound name.

The Peak View Pane displays the peak parameters for the selected compound and the 
associated confirming peaks and fragments. 

The Compound Details Pane displays parameters that are applied to all target peaks, 
confirming peaks, and fragments in the selected compound.

Note   When the Compound Name box contains text, the application displays only 
the compounds that contain the entered text.

Click here.

Compound name
Target peak

Confirming peak

Compound name
Target peak

Fragment 
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Peak View Pane 

Use the Peak View Pane to display parameters for the compound you selected in the Tree 
View pane (or all compounds when you select All Results).

Follow these procedures:

• To hide or display columns in the Peak View pane

• To add a new compound

• To remove a compound

• To edit values in the compound database grid

• To specify a column as fixed



 2 Using Compound Databases in the Method Development Mode
Working with a Compound Database View for Small Molecules

Thermo Scientific TraceFinder Lab Director User Guide 49

 To hide or display columns in the Peak View pane

1. Click the Field Chooser icon, , in the upper left corner of the pane.

The Field Chooser displays all available columns of data for the Peak View pane.

2. Select the check box for each column that you want to display, or clear the check box for 
each column that you want to hide.

The application displays or hides the columns in the Peak View pane.

3. When you are finished modifying the column display, click  to close the Field 
Chooser. 

 To add a new compound

1. Scroll to the bottom of the Peak View pane.

There is always one blank row in the grid.
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2. In the blank row, type or paste values into the columns.

3. Press ENTER to add another blank row to the grid.

 To remove a compound

1. Click anywhere in a row to select the compound.

2. Right-click and choose the Delete Row.

3. At the prompt to confirm that you want to delete the compound, click Yes.

The application removes the compound from the database grid.

 To edit values in the compound database grid

Do either of the following:

• Select the current column value and type a new value.

–or–

• Select single cells or entire columns whose values you want to copy, using a 
copy-and-paste operation.

You can use this method to replicate entire columns. Click the column header to 
select the entire column, and then use CTRL+C and CTRL+V to replicate the 
column values.

When you change the charge state, adduct, or polarity for a compound, the application 
recalculates the precursor and product masses.

 To specify a column as fixed 

In the column header, click the Pin icon, .

The application moves the column to the left side of the grid.

When you use the scroll bar at the bottom of the Peak View pane, the pinned columns on 
the left remain fixed while the other columns scroll right and left. 

Note  Some columns have dropdown lists from which you can select values.

Note  Do not use CTRL+X to delete a compound. CTRL+X deletes only the 
parameter values in selected cells.

Note  Do not use CTRL+X to delete a compound. CTRL+X deletes only the 
parameter values in selected cells.
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Peak View Pane 

Use the Peak View pane to display parameters for the compound.

Figure 12. Peak View pane

 

Table 8. Peak View pane parameters  (Sheet 1 of 3)

Column Description

Compound Name Alphanumeric name assigned to the compound.

Peak Label User-specified label displayed in Analysis plots.

Peak Workflow Specifies the compound as TargetPeak, Confirming, or Fragment.

Associated Target Peak Specifies the target peak associated with a confirming peak or 
fragment.

Chemical Formula Specifies the chemical formula that the application uses to 
calculate the m/z or precursor m/z. You cannot edit the chemical 
formula from the Peak View pane. To edit this value, use the 
Compound Details Pane. 

MS Order Specifies that the confirming peaks come from the same scan 
(ms1) or are fragments from an adjacent scan (ms2). 

Precursor m/z The mass-to-charge ratio (m/z) of a target peak. The location of 
the center of a target precursor ion peak in mass-to-charge ratio 
units. 

In confirming peaks, the precursor mass is the same as the target 
peak precursor mass.

Product m/z The mass-to-charge ratio of the quantitation ion. The location of 
the center of a target quan ion peak in mass-to-charge ratio (m/z) 
units. 

m/z Mass-to-charge ratio found in the spectra for the peak. Assumes 
that the charge is 1.
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Adduct The adducts specified in the configuration file. To add or remove 
adducts from the default lists, see Specifying Adducts. 

Adducts affect the calculated amount of the extracted mass by 
adding to or subtracting from the neutral mass.

Because adducts are polarity sensitive, select the Polarity parameter 
before selecting the Adduct value.

Default positive values: None, Hydrogen, Ammonium, Sodium, 
Potassium
Default negative values: None, Hydrogen-Loss, Acetate, Formate
Default: None

Polarity Positive or Negative

Charge State The charge state of the ion (the z value in m/z). For example, a 
charge state of 2 with a negative polarity means that the 
compound has 2 more electrons than protons.

Valid range: 1 through 10
Default: 1

Height Threshold Controls the peak height cutoff. Any peaks with a height less than 
the height threshold will not be detected. 

Area Threshold Controls the area cutoff. Any peaks with a final area less than the 
area threshold will not be detected. This control is in units of area 
for the data. 

Valid range: 0 through 1 000 000 000

Collision Energy The energy used when ions collide with the collision gas.

Default: Read from the scan filter
Valid range: –250.00 through +250.00

Retention Time Specifies the time after injection when the compound elutes. 

RT Window Specifies the maximum viewable window around the identified 
chromatographic peak.

Lens Valid range: –400 through +400

Energy Ramp Valid range: 0 through 200

Target Ratio Specifies the theoretical ratio of the confirming ion’s response to 
the quantification ion’s response as a percentage.

Valid range: 1 through 100

Table 8. Peak View pane parameters  (Sheet 2 of 3)

Column Description
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Compound Details Pane 

The view displays additional, editable parameters for the selected compound.

Figure 13. Compound Details pane

 

Integration Strategy Specifies the order in which integration and summary are 
performed.

• Individual: Performs integration and then sums the XIC.
• Summed: Sums the XIC and then integrates.

Group User-defined alphanumeric names of groups to which the 
compound belongs.

To create groups, see Editing the Groups Page.

Table 8. Peak View pane parameters  (Sheet 3 of 3)

Column Description

Table 9. Compound Details pane parameters  (Sheet 1 of 2)

Parameter Description

Compound Name Specifies the alphanumeric name assigned to the compound.

Ionization Specifies the alphanumeric identifier. 

Valid values: None, ESI, APCI, EI, CI, or APPI
Default: None

Chemical Formula Chemical formula for the compound. Used to calculate the 
neutral mass for the compound.

CAS No The Chemical Abstract Service (CAS) number that the application 
matched with the compound. 
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Compound Type Specifies the compound type as Analyte or Internal Standard.

Modification Specifies any modification to the compound.

Compound Groups User-specified groups to which the selected compound belongs.

Response Threshold Specifies the threshold used to integrate only peaks with a response 
greater than this value. A minimum response that must be met to 
allow peak confirmation. Used only for target screening methods 
and XIC experiments.

Valid range: 1000 or greater
Default: 5000

Neutral Mass Specifies the mass calculated from the chemical formula. The sum 
of all AMU elements in the compound. This parameter is 
informational only; it is not used for peak detection.

Category User-specified alphanumeric identifier, such as Class 1, Class 2, 
Opiates, and so forth.

Internal Standard Specifies the internal standard (ISTD) for the selected compound. 
The list displays all compounds with the compound type of 
Internal Standard. 

Table 9. Compound Details pane parameters  (Sheet 2 of 2)

Parameter Description
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Working with a Compound Database View for Peptides
The Compound Database view displays the peptide data in the compound database. From 
this page, you can import peptides into the database, export peptides to a CSV file or mass 
list, add or remove peptides, and add or remove target peaks, confirming peaks, or fragments. 
You can also create new compound databases or save the current database to a new name.

Figure 14. Compound Database view for peptides

The Compound Database view includes the following features:

• Tree View Pane

• Peak View Pane

• Compound Details Pane
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Tree View Pane

The tree view for peptide databases displays all proteins, compounds, and associated target 
peaks.

Follow these procedures:

• To display only specific proteins

• To display only proteins that include specific compounds

• To expand the names of all compounds and proteins in the database

• To collapse and reopen the names of all compounds in the database

• To read the tree view syntax

• To display the peak parameters for a protein

• To display the compound details for a compound in a protein
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 To display only specific proteins 

In the Protein Name box, type the name of the protein that you want to locate in the list. 
The Tree View list displays only protein names that contain the text you typed.

In the following examples, as you type the letters sp|o, the application displays all proteins 
that contain “sp|o”. As you continue to type 4, the application displays only proteins that 
contain “sp|o4”.

 To display only proteins that include specific compounds

In the Compound Name box, type the name of the compound that you want to locate in 
the list. The Tree View list displays only the proteins that include compound names that 
contain the text you typed. This search feature is not case-sensitive.

In the following examples, as you type the letter g, the application displays all proteins 
that include compounds that contain “g”. As you continue to type another letter g, the 
application displays only proteins that include compounds that contain the letters “gg”.

Note   When the Protein Name box contains text, the application displays only the 
proteins that contain the entered text.

When both the Protein Name box and Compound Name box contain text, the tree 
view displays only items that meet both criteria.
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 To expand the names of all compounds and proteins in the database

In the Tree View pane, click Expand All.

The application expands the proteins, compounds, and associated target peaks in the tree 
view.

 To collapse and reopen the names of all compounds in the database

1. In the Tree View pane, click Collapse All.

The application collapses the proteins, compounds, and associated target peaks for all 
proteins in the tree view and displays only the highest level or “All Results”.

2. To display the names of all collapsed proteins in the tree view, expand All Results.

Note   When Compound Name box contains text, the application displays only the 
compounds that contain the entered text.

When both the Protein Name box and Compound Name box contain text, the tree 
view displays only items that meet both criteria.

Note   When the Protein Name box or Compound Name box contains text, the 
application displays only the proteins or compounds that contain the entered text.

When both the Protein Name box and Compound Name box contain text, the tree 
view displays only items that meet both criteria.

Click here.
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 To read the tree view syntax

The Tree View pane displays compound names and the m/z for target peaks. It also 
displays any confirming peaks or fragments and their m/z.

Identifiers for the peak types are as follows:
• T: Target peak
• C: Confirming peak
• F: Fragment
• P: Protein

 To display the peak parameters for a protein

In the Tree View pane, click the protein name.

The Peak View Pane displays the peak parameters for the selected protein, all included 
compounds, associated target peaks, and confirming peaks.

 To display the compound details for a compound in a protein

In the Tree View pane, click the compound name.

The Compound Details Pane displays parameters that are applied to associated target 
peaks and confirming peaks in the selected protein/compound combination.

Peak View Pane 

Use the Peak View Pane to display parameters for the protein you selected in the Tree View 
pane (or all proteins when you select All Results). 

Follow these procedures:

• To hide or display columns in the Peak View pane

• To add a new compound

• To remove a compound

Note   When there is text in the Protein Name box or Compound Name box, the 
application displays only the proteins or compounds that contain the entered text.

When both the Protein Name box and Compound Name box contain text, the tree 
view displays only items that meet both criteria.

Protein name

Compound name
Associated 
target peak

Confirming peak
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• To edit values in the compound database grid

• To specify a column as fixed

 To hide or display columns in the Peak View pane

1. Click the Field Chooser icon, , in the upper left corner of the pane.

The Field Chooser displays all available columns of data for the Peak View pane.
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2. Select the check box for each column that you want to display, or clear the check box for 
each column that you want to hide.

The application displays or hides the columns in the Peak View pane.

3. When you are finished modifying the column display, click  to close the Field 
Chooser. 

 To add a protein

1. Scroll to the bottom of the Peak View pane.

There is always one blank row in the grid.

2. In the blank row, type or paste values into the columns.

3. Press ENTER to add another blank row to the grid.

 To remove a protein

1. Click the row number to select the protein.

2. Press DELETE.

3. At the prompt to confirm that you want to delete the protein, click Yes.

The application removes the protein from the database grid.

 To edit values in the compound database grid

Do either of the following:

• Select the current column value and type a new value.

–or–

• Select single cells or entire columns whose values you want to copy, using a 
copy-and-paste operation.

You can use this method to replicate entire columns. Click the column header to 
select the entire column, and then use CTRL+C and CTRL+V to replicate the 
column values.

When you change the charge state, adduct, or polarity for a compound, the application 
recalculates the precursor and product masses. 

Note  Some columns have dropdown lists from which you can select values.

Note  Do not use CTRL+X to delete a protein. CTRL+X deletes only the parameter 
values in the selected cells.

Note   You cannot edit the values in the following columns: Chemical Formula, 
Peptide Sequence, Precursor m/z, Product m/z.
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 To specify a column as fixed 

In the column header, click the Pin icon, .

The application moves the column to the left side of the grid.

When you use the scroll bar at the bottom of the Peak View pane, the pinned columns on 
the left remain fixed while the other columns scroll right and left. 

Peak View Pane

Use the features in the Peak View pane to display parameters for the protein you selected in 
the Tree View pane (or all proteins when you select All Results).

Figure 15. Peak View pane

 

Table 10. Peak View pane parameters  (Sheet 1 of 3)

Column Description

Protein Name Alphanumeric name assigned to the protein. 

Compound Name Alphanumeric name assigned to the compound. 
Default: the peptide sequence

Peak Label User-specified label displayed in Analysis plots.

Peak Workflow Specifies the compound as TargetPeak, Confirming, or Fragment.

Associated Target Peak Specifies the target peak associated with a confirming peak or 
fragment.

Peptide Sequence Specifies the peptide sequence that the application uses to 
calculate the m/z or precursor m/z. You cannot edit the peptide 
sequence from the Peak View pane. To edit this value, use the 
Compound Details Pane.

Available only for peptide databases.

Chemical Formula Specifies the chemical formula that the application uses to 
calculate the product m/z or precursor m/z. You cannot edit the 
chemical formula from the Peak View pane. To edit this value, use 
the Compound Details Pane.
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MS Order Specifies that the confirming peaks come from the same scan 
(ms1) or are fragments from an adjacent scan (ms2). 

Precursor m/z The mass-to-charge ratio (m/z) of a target peak. The location of 
the center of a target precursor ion peak in mass-to-charge ratio 
units. 

In confirming peaks, the precursor mass is the same as the target 
peak precursor mass.

Product m/z The mass-to-charge ratio of the quantitation ion. The location of 
the center of a target quan ion peak in mass-to-charge ratio (m/z) 
units. 

m/z Mass-to-charge ratio found in the spectra for the peak. Assumes 
that the charge is 1.

Adduct The adducts specified in the configuration file. To add or remove 
adducts from the default lists, see Specifying Adducts. 

Adducts affect the calculated amount of the extracted mass by 
adding to or subtracting from the neutral mass.

Because adducts are polarity sensitive, select the Polarity parameter 
before selecting the Adduct value.

Default positive values: None, Hydrogen, Ammonium, Sodium, 
Potassium
Default negative values: None, Hydrogen-Loss, Acetate, Formate
Default: None

Modification The application reads modifications from imported peptide files 
or from the Peptide Predictor wizard. 

Available only for peptide databases.

Polarity Positive or Negative

Charge State The charge state of the ion (the z value in m/z). For example, a 
charge state of 2 with a negative polarity means that the 
compound has 2 more electrons than protons.

Valid range: 1 through 10
Default: 1

Height Threshold Controls the peak height cutoff. Any peaks with a height less than 
the height threshold will not be detected. 

Table 10. Peak View pane parameters  (Sheet 2 of 3)

Column Description
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Area Threshold Controls the area cutoff. Any peaks with a final area less than the 
area threshold will not be detected. This control is in units of area 
for the data. 

Valid range: 0 through 1 000 000 000

Collision Energy The energy used when ions collide with the collision gas.

Default: Read from the scan filter
Valid range: –250.00 through +250.00

Retention Time Specifies the time after injection when the compound elutes. 

RT Window Specifies the maximum viewable window around the identified 
chromatographic peak.

Lens Valid range: –400 through +400

Energy Ramp Valid range: 0 through 200

Target Ratio Specifies the theoretical ratio of the confirming ion’s response to 
the quantification ion’s response as a percentage.

Valid range: 1 through 100

Integration Strategy Specifies the order in which integration and summary are 
performed.

• Individual: Performs integration and then sums the XIC.
• Summed: Sums the XIC and then integrates.

Ion Type Specified as b or y with a numerical designation.

Available only for peptide databases.

Group Alphanumeric names of groups to which the compound belongs.

Table 10. Peak View pane parameters  (Sheet 3 of 3)

Column Description
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Compound Details Pane 

The view displays additional, editable parameters for the selected compound.

Figure 16. Compound Details pane

 

Table 11. Compound Details pane parameters  (Sheet 1 of 2)

Parameter Description

Protein Name Displays the alphanumeric name assigned to the selected protein.

Compound Name Displays the alphanumeric name assigned to the selected 
compound in the protein.

Ionization Specifies the ionization process. 

Valid values: None, ESI, APCI, EI, CI, or APPI
Default: None

Peptide Sequence Specifies the order in which amino acid residues, connected by 
peptide bonds, lie in the chain in peptides and proteins. The 
sequence uses accepted Amino acid designations.

CAS No Specifies the Chemical Abstract Service (CAS) number that the 
application matched with the selected compound.

Compound Type Specifies the compound type as Analyte or Internal Standard.

Modification Specifies any modification to the compound.

Compound Groups Specifies comma-separated groups to which the selected 
compound belongs. Master methods created from this compound 
database display the compound groups on the Groups page in the 
Method View. See Editing the Groups Page.
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Linking Internal Standards 
In both small molecule and peptide compound databases, the TraceFinder application can 
link compounds to their internal standards when the compound name for the internal 
standard is the same as the target compound name appended with text and enclosed in 
brackets. For example, the application can link the internal standard CompoundX[ISTD] to 
the target compound CompoundX. 

Response Threshold Specifies the threshold used to integrate only peaks with a response 
greater than this value. A minimum response that must be met to 
allow peak confirmation. Used only for target screening methods 
and XIC experiments.

Valid range: 1000 or greater
Default: 5000

Neutral Mass Specifies the mass calculated from the peptide sequence. The sum 
of all AMU elements in the compound. This parameter is 
informational only; it is not used for peak detection.

Category User-specified alphanumeric identifier, such as Class 1, Class 2, 
Opiates, and so forth.

Internal Standard Specifies the internal standard (ISTD) for the selected compound. 
The list displays all compounds with the compound type of 
Internal Standard. 

Table 12. Amino acid designations 

Amino acid Designation Amino acid Designation

Alanine A Leucine L
Arginine R Lysine K
Asparagine N Methionine M
Aspartate D Phenylalanine F
Cysteine C Proline P
Histidine H Serine S
Isoleucine I Threonine T
Glutamine Q Tryptophan W
Glutamate E Tyrosine Y
Glycine G Valine V

Note  You can specify amino acid designations in either uppercase or lowercase letters.

Table 11. Compound Details pane parameters  (Sheet 2 of 2)

Parameter Description
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 To specify a compound as an internal standard

1. In the Tree View pane, select the compound that you want to specify as an internal 
standard.

2. In the Peak View pane, select the compound name and append [*** ] to the name, for 
example: Atrazine[ISTD].

Th application can automatically link this compound as the internal standard for the 
Atrazine compound.

 To link internal standards to target compounds

Choose Compound Database > Autolink Internal Standard and Target Compound 
from the main menu.

The application does the following:

a. For each compound with a name that ends in [*** ], sets the Compound Type to 
Internal Standard.

b. For any CompoundX for which there is a CompoundX[***], sets CompoundX[***] as 
the internal standard for CompoundX.

c. When there are multiple matching internal standard compounds, the application sets 
the first saved CompoundX[***] as the internal standard for the target compound.

If the multiple internal standards were saved at the same time, the application 
displays a message that the target compound could not be linked to an internal 
standard because there are multiple internal standards.

For example, for the target compound NGFILDGFPR, the application finds the 
internal standard compounds NGFILDGFPR[HeavyK] and 
NGFILDGFPR[LightR]. Because both [*** ] appends were added to the compound 
database at the same time, the application displays the error message.

Note  You can also append [*** ] to the compound names in a CSV file or mass list before 
you import the compounds into the compound database.

IMPORTANT  Make sure you have designated internal standard compounds by 
appending [*** ] to their names.

Note  The application does not overwrite a manually saved Compound Type of 
Analyte even when the compound name has [*** ] appended to its name.

Note  If the application does not find a target compound, CompoundX, to match 
a CompoundX[***], the application performs no further action.
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Using the Peptide Predictor Wizard 
For protein data, use the Peptide Predictor wizard to predict the theoretical peptide fragments, 
modify any of the amino acids in the peptide, create a mass list of the peptides (unmodified, 
native peptides and modified peptides), and then either create a compound database with 
these masses or add these masses to an existing compound database.

For peptide data, use the Peptide Predictor wizard to modify any of the amino acids in the 
peptide, create a mass list from the peptides, and then either create a compound database with 
these masses or add these masses to an existing compound database.

You cannot specify both proteins and peptides in the Peptide Predictor wizard at the same 
time. However, you can use the Peptide Predictor wizard in two separate sessions to add 
proteins and peptides to the same compound database.

Figure 17. Peptide Predictor workflow

 To open the Peptide Predictor wizard

1. Choose Compound Database > Peptide Prediction Tool > Peptide Prediction Tool 
from the TraceFinder main menu.

The Peptide Predictor wizard opens. 

2. Begin your mass list with either protein data or peptide data.

See To begin a protein mass list.

– or –

See To begin a peptide mass list.

Global Modifications

Transitions

Digestion

Proteins Peptides

Output

Local Modifications
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 To begin a protein mass list

1. Set the Content Type to Protein.

2. Do one of the following:

• Click Browse, locate a FASTA file, and click Open.

The application displays the protein sequence in the FASTA file, overwriting any 
previous content in the pane.

• Manually type in the protein sequences in FASTA file format.

Follow these FASTA rules for specifying proteins:

– Use the approved amino acid alphabet. See Amino Acids.

– Begin the sequence with a single-line description. Use a greater-than (>) sign in 
the first column to distinguish the description from the sequence data. Or, follow 
the > with a sequence identifier and then the description. Use no space between 
the > and the first letter of the identifier. For example:

>horsegi|418678|pir||MYHOZ myoglobin - common zebra [MASS=16950]

– Follow the description with lines of sequence data. For example:
GLSDGEWQQVLNVWGKVEADIAGHGQEVLIRLFTGHPETLEKFDKFKHLKTEAEMKASEDLKK
HGTVVLTALGGILKKKG

HHEAELKPLAQSHATKHKIPIKYLEFISDAIIHVLHSKHPGNFGADAQGAMTKALELFRNDIA
AKYKELGFQG

– Keep all lines of text shorter than 80 characters. 

– Do not use any blank lines in the sequence.

– The sequence ends when another line starting with > appears, indicating the start 
of another sequence. 

Note  The maximum number of allowed proteins is 10. If you import a list with 
more than 10 proteins, the application imports only the first 10 protein 
sequences.

Note  You can manually edit the imported proteins.

IMPORTANT  The maximum number of allowed proteins is 10. If you create a 
list with more than 10 proteins and click Next, the application displays an error 
message.
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Figure 18. Example of an imported FASTA file showing human allergens

The applications displays the digestion parameters for proteins. See Digestion Page.

3. Select an enzyme.

For a complete list of available enzymes, see Digestion Enzyme.

4. Specify the maximum number of internal cleavage sites within a peptide fragment that an 
enzyme can miss during the digestion process. 

The default is 0, meaning that the application considers the enzyme to have efficiently 
cleaved at all the possible cleavage sites in a protein with 100 percent specificity.

The enzymatic digestion process does not always result in all the available cleavage sites in 
a protein being cleaved; therefore, it is important to specify the number of missed 
cleavage sites that can be present in a peptide fragment where the enzyme could have 
cleaved but did not. 

5. Specify the number of starting amino acids in each sequence that the application ignores, 
for example: 

6. Select to use either the monoisotopic mass or the average mass to calculate the mass of the 
ions.

7. Follow the instructions To specify transitions.
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Digestion Page

Use the digestion page to specify the digestion parameters for proteins.

Figure 19. Digestion page for proteins

Table 13. Digestion page parameters

Parameter Description

 Digestion Enzyme Specifies one of the following enzymes to digest the 
protein.

• No Enzyme
• Trypsin (KR)
• Trypsin (KRLNH)
• Trypsin (K)
• Trypsin (R)
• Chymotrypsin
• Chymotrypsin (FWY)
• Clostripain
• Cyanogen Bromide
• IodosoBenzoate
• Proline Endopept
• Staph Protease
• GluC Bicarb
• AspN
• GluC
• CNBR
• ArgC
• Elastase
• Formic Acid
• LysC
• LysN
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 To begin a peptide mass list

1. Set the Content Type to Peptide.

2. Manually type in the peptide sequences or paste the sequences from the Clipboard.

Follow these rules for specifying peptides:

• Use the approved amino acid alphabet. See Amino Acids.

• Use a contiguous sequence of characters to define a single peptide. 

• Use any characters not in the alphabet as separators between multiple peptides. For 
example, the application parses the peptide sequence ARNDCE/YVWTCEQ into 
two peptides: ARNDCE and YVWTCEQ.

Figure 20. Example of a peptide file 

Number of Missed Cleavage 
Sites Allowed

Specifies the maximum number of missed cleavage sites 
that the application can allow per peptide fragment.

Valid range: 0 through 10
Default: 0

Number of Starting Amino 
Acids to be Ignored

Specifies the number of amino acids at the beginning of 
each protein sequence that the application ignores.

Valid range: 0 through 100
Default: 25

Mass to Use Specifies the method used to calculate the mass.

(Default) Use Monoisotopic Mass: The mass of the 
isotopic peak that is composed of the most abundant 
isotopes of those elements present in the molecular 
formula.

Use Average Mass: The weighted average of the isotopic 
masses weighted by the respective isotopic abundances.

Table 13. Digestion page parameters

Parameter Description
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3. Select to use either the monoisotopic mass or the average mass to calculate the mass of the 
ions. See Mass Page.

4. Follow the instructions To specify transitions.

Mass Page

Use the mass page to specify the method used to calculate the mass of the ions.

Figure 21. Mass page for peptides

 To specify transitions

1. Click Next.

The Transitions Page opens where you can specify the output transition options that you 
want to use. Use the parameters on the transitions page to specify the mass range of the 
precursor and product ions to be processed. 

For proteins, the mass list on the transitions page shows the predicted list of peptides 
generated by the enzymatic cleavage process. See Example prediction of proteins that are 
broken at the cleavage sites. 

Table 14. Mass page parameter for peptides

Parameter Description

Mass to Use Specifies the method used to calculate the mass.

(Default) Use Monoisotopic Mass: The mass of the isotopic peak that is 
composed of the most abundant isotopes of those elements present in the 
molecular formula.

Use Average Mass: The weighted average of the isotopic masses weighted by 
the respective isotopic abundances.
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For peptides, the mass list on the transitions page identifies all peptide sequences as 
user-created. See Example of user-created peptides.

Figure 22. Example prediction of proteins that are broken at the cleavage sites

Figure 23. Example of user-created peptides

2. In the Minimum m/z Allowed in the Instrument box, enter a value for the minimum 
mass that your instrument can measure.

3. In the Maximum m/z Allowed in the Instrument box, enter a value for the maximum 
mass that your instrument can measure.

4. Choose a target mode: All Transitions Within a Range (MS2 order) or Precursor Ion 
Options (MS1 order).

• When you select All Transitions Within a Range, do the following: 

i. Specify the From and To values for the ion type range.

For valid values, see All Transitions Within a Range.

If none of the selected transitions are possible, the application does not create 
transitions.

ii. Specify the values to use for the precursor charge and the product charge 
prediction.
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iii. Click Add.

The application creates transitions from the specified transition range, precursor 
charge, and product charge.

When you click Next, the application applies these transitions to all peptides.

Figure 24. Example of all transitions on the modifications page

• When you select Precursor Ion Options, do the following:

i. Specify the minimum and maximum charge states to be used for the prediction.

ii. Specify the number of isotopes that you want returned from the prediction.

When you click Next, application applies these precursor ion parameters to all 
peptides. 

IMPORTANT  You must add at least one transition before you can perform 
modifications on the amino acids.

IMPORTANT  You must specify a valid range before you can perform 
modifications on the amino acids.
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Figure 25. Example of precursor ion options on the modifications page

5. Follow the instructions To specify local modifications or To specify global modifications.

Transitions Page

Use the transitions page to specify the output transition options that you want to use.

Figure 26. Transitions page 
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Table 15. Transitions page parameters  (Sheet 1 of 2)

Parameter Description

Minimum m/z Allowed in 
the Instrument

Specifies the minimum mass that your application can 
measure.

Default: 400

Maximum m/z Allowed in 
the Instrument

Specifies the maximum mass that your instrument can 
measure.

Default: 1500

Target Mode

All Transitions Within a Range

From Valid values: 
• y1
• y2
• y3
• y4
• b1
• b2
• b3
• b4
• (mz higher than parent_mz)
• (mz higher than parent_mz) –1
• (mz higher than parent_mz) –2 
• (mz higher than parent_mz) +1
• (mz higher than parent_mz) +2 

Default: y3

To Valid values: 
• last ion
• last ion – 1
• last ion – 2
• last ion – 3
• 3 ions from the start limit
• 4 ions from the start limit
• 5 ions from the start limit

Default: last ion – 2

Precursor Charge Valid range: 0 through 10
Default: 2

Product Charge Valid range: 0 through 10
Default: 1
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 To specify local modifications

1. Click Next.

The Modifications Page opens where you can specify point modifications for each amino 
acid or terminal.

2. In the left pane, select a peptide sequence.

The right pane displays all amino acids in the sequence.

Each amino acid has an amino and a carboxylic group. By convention, the peptides are 
written from the n-Terminal to the c-Terminal. The n-Terminal refers to the free amine 
group of the first amino acid. The peptide terminates with a free carboxylic group of the 
last amino acid, which is the c-Terminal.

3. In the right pane, click each amino acid that you want to modify.

A dropdown list displays all available modifications for each selected amino acid. 

4. Select the modifications that you want to apply to each amino acid in the selected 
peptide.

5. Click Apply or click Create Copy and Apply.

Apply: Applies the selected modifications to the respective amino acid in the selected 
peptide.

Create Copy and Apply: Saves a copy of the original, unmodified file and then applies 
the selected modifications to the respective amino acid in the selected peptide.

Add / Remove Adds a transition based on the current parameter setting, or 
removes the selected transition definition.

Precursor Ion Options

Charge Range Specifies the beginning and ending values for the charge range.

Valid range: 0 through 100
Default: 2 through 3

Number of Isotopes
(starting from the most 
abundant)

Valid range: 0 through 10
Default: 0 

Note  The defaults for the n-Terminal and the c-Terminal are H and OH, 
respectively. When you use the defaults, the application does not display the terminals 
in the mass list. If you modify the amino acid assigned to a terminal, the application 
displays the modified value in the mass list.

Table 15. Transitions page parameters  (Sheet 2 of 2)

Parameter Description
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The application applies the modifications to each amino acid in the selected peptide.

6. Repeat steps 2 through 5 for each peptide sequence that you want to modify.

7. Do one of the following:

• To make global modifications, follow the instructions To specify global 
modifications, beginning with step 2.

–or–

• To save your mass list, follow the instructions To save the mass list. 

 To specify global modifications

1. Click Next.

The Modifications Page opens where you can specify global modifications for each amino 
acid or terminal. 

When you modify an amino acid in a top-level protein sequence, the application applies 
each modification to each instance of the amino acid in the mass list. 

2. In the left pane, select a peptide sequence.

The right pane displays all amino acids in the sequence.

Each amino acid has an amino and a carboxylic group. By convention, the peptides are 
written from the n-Terminal to the c-Terminal. The n-Terminal refers to the free amine 
group of the first amino acid. The peptide terminates with a free carboxylic group of the 
last amino acid, which is the c-Terminal.

3. In the right pane, click each amino acid that you want to modify.

A dropdown list displays all available modifications for each amino acid. 

4. Select the modifications that you want to apply to all instances of each amino acid.

5. Click Apply or click Create Copy and Apply.

Apply: Applies the current modifications to all instances of the amino acids.

Create Copy and Apply: Saves a copy of the unmodified file and then applies the current 
modifications to all instances of the amino acids.

Note  Local modifications overwrite any previous global modifications.

Note  Global modifications do not overwrite previous local modifications.

Note  The defaults for the n-Terminal and the c-Terminal are H and OH, 
respectively. When you use the defaults, the application does not display the terminals 
in the mass list. If you modify the amino acid assigned to a terminal, the application 
displays the modified value in the mass list.
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The application applies the modifications to all instances of the amino acids in the 
sequence file.

The following examples show global modifications to a single amino acid when the target 
mode is All Transitions Within a Range or Precursor Ion Options.

Figure 27. Example of All Transitions Within a Range

Note  Global modifications do not overwrite any previous local modifications.

Select a top-level protein sequence.

Select a modification for any of the 
listed amino acids and click Apply.

The application updates all 
instances of the modified amino 
acid.
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Figure 28. Example of Precursor Ion Options

Select a top-level protein sequence.

Select a modification for any of the 
listed amino acids and click Apply.

The application updates all 
instances of the modified amino 
acid.
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Modifications Page

Use the modifications page to specify point modifications or global modifications for each 
amino acid or terminal.

Figure 29. Modifications page

Table 16. Modifications page parameters 

Parameter Description

Amino acids

Single-letter codes for amino acids (lowercase characters are also allowed):
A alanine L leucine
R arginine K lysine
N asparagine M methionine
D aspartic acid F phenylalanine
C cysteine P proline
E glutamic acid S serine
Q glutamine T threonine
G glycine W tryptophan
H histidine Y tyrosine
I isoleucine V valine
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 To save the mass list

1. Click Next.

The Output Page opens where you can specify the output database and import options 
that you want to use.

2. To create a new compound database for the compounds, do the following:

a. In the Output CDB Selection area, click Create.

The New Compound Database dialog box opens.

b. In the New Compound Database dialog box, type a name for the new compound 
database and click OK.

3. To add these compounds to an existing compound database, do the following:

a. In the Output CDB Selection area, click Browse.

The Open Compound Database dialog box opens.

b. In the Open Compound Database dialog box, select a compound database and click 
Open.

4. In the Import Options area, specify one of the following:

• To identify all found peaks as target peaks, select the All option.

• To identify only the first found peak as a target peak and identify all other peaks as 
confirming ions or fragments, select the One option and then select either the 
Confirming Ion or Fragment option.

5. Click Finish.

The application add the identified peptides to the specified compound database, closes 
the Peptide Predictor wizard, and opens the compound database in the Compound 
Database view in the TraceFinder application. 
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Output Page

Use the output page to specify the output database and import options.

Figure 30. Output page

Using the Peptide Modifications Editor
Use the Peptide Modifications Editor to define the modifications that are available in the 
Peptide Predictor wizard.

Follow these procedures:

• To open the Peptide Modifications Editor

• To edit the available default modifications

• To create custom modifications

Table 17. Output page parameters 

Parameter Description

Output CDB Selection

Create Opens the New Compound Database dialog box where you can create a 
new compound database.

Browse Opens the Open Compound Database dialog box where you can select a 
compound database to which you can add the peptide mass list. 

Import Options

Number of 
Target Peaks

Specifies the number of found peaks to identify as target peaks.

Set Others To Specifies that other found peaks are identified as confirming ions or 
fragments.



 2 Using Compound Databases in the Method Development Mode
Using the Peptide Modifications Editor

Thermo Scientific TraceFinder Lab Director User Guide 85

 To open the Peptide Modifications Editor 

Choose Compound Database > Peptide Prediction Tool > Edit Peptide Modifications 
from the TraceFinder main menu.

The Peptide Modifications Editor window opens.

 To edit the available default modifications

1. Click the Default Modifications tab.

The Default Modifications Page displays the names and mass values for the application’s 
default amino acid modifications. You cannot edit the values for a default modification; 
however, you can make a modification unavailable (not visible) in the Peptide Predictor 
wizard.

By default, all modifications are visible in the Peptide Predictor wizard.

2. For each modification that you do not want displayed on the modifications page of the 
Peptide Predictor wizard, select the modification and clear the Is Visible check box.

When you select a modification, the application displays a check mark for each of the 
amino acids that this modification affects.

3. When you have finished setting the visibility for the modifications, click Save Visibility.

The application saves the visibility settings, and the Peptide Predictor wizard displays only 
the modifications that have the Is Visible option checked.

4. When you have finished your changes to the default and custom modifications, click 
Cancel.

The application discards any changes that you made after the last time you clicked Save 
Visibility on the Default Modifications page or after you clicked Save Custom 
Modifications on the Custom Modifications page and then closes the wizard.

Modified amino acidSelected modification
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Default Modifications Page

Use the Default Modifications page to select which modifications are visible in the Peptide 
Predictor wizard.

Figure 31. Default Modifications page

Table 18. Default Modifications page parameters 

Parameter Description

Modification List

Full Name Name of the modification.

Name User-specified name for the modification.

Delta Mass (Mono) Specifies the modification to the monoisotopic mass of the ion when it is calculated using the 
exact mass of the most abundant isotope of each element. The modification can be a positive or 
negative change.

Delta Mass (Avg) Specifies the modification to the mass of the ion when it is calculated using the average atomic 
weight of each element. The modification can be a positive or negative change.

Is Visible When selected, displays the modification on the modifications page of the Peptide Predictor 
wizard.

Amino Acids List
Specifies the amino acids associated with the selected modification. These values are not 
editable. For a list of amino acid abbreviations, see Amino Acids.

Function Buttons

Save Visibility Saves the visibility settings. The Peptide Predictor wizard displays only the modifications that 
have the Is Visible option checked and were saved.

Cancel Discards any changes that you made after the last time you clicked Save Visibility and then 
closes the wizard.
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 To create custom modifications

1. Click the Custom Modifications tab.

The Custom Modifications Page displays the names and mass values for the user-created 
amino acid modifications.

2. Click Add.

The application adds a new row where you can define a custom modification.

3. In the Full Name column, type a name for the modification.

4. In the Delta Mass (Mono) column, type the adjustment to the mass to use when you 
calculate the mass using the monoisotopic method.

The value can be a positive or negative number.

5. In the Delta Mass (Avg) column, type the adjustment to the mass to use when you 
calculate the mass using the average mass method.

The value can be a positive or negative number.

6. To display the modification on the modifications page of the Peptide Predictor wizard, 
select the Is Visible check box.

By default, the Is Visible check box is not selected and the custom modification is not 
visible in the Peptide Predictor wizard.

7. Select the check box for each of the amino acids for which this modification is available.

8. Repeat steps 2 through 7 for each custom modification that you want to define.

9. Click Save Custom Modifications.

10. When you have finished your changes to the default and custom modifications, click 
Cancel.

The application discards any changes that you made after the last time you clicked Save 
Visibility on the Default Modifications page or after you clicked Save Custom 
Modifications on the Custom Modifications page and then closes the wizard.
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Custom Modifications Page

Use the Custom Modifications page to define custom modifications.

Figure 32. Custom Modifications page

Table 19. Custom Modifications page parameters 

Parameter Description

Modification List

Full Name Name of the modification.

Delta Mass (Mono) Specifies the modification to the monoisotopic mass of the ion when it 
is calculated using the exact mass of the most abundant isotope of each 
element. The modification can be a positive or negative change.

Delta Mass (Avg) Specifies the modification to the mass of the ion when it is calculated 
using the average atomic weight of each element. The modification 
can be a positive or negative change.

Is Visible When selected, displays the modification on the modifications page of 
the Peptide Predictor wizard.

Amino Acids List
Specifies the amino acids associated with the selected modification. 
For a list of amino acid abbreviations, see Amino Acids.

Function Buttons

Add Adds a new, empty row to the custom modifications list.

Remove Deletes the selected modification.

Save Custom 
Modifications

Saves the custom modifications. The Peptide Predictor wizard displays 
only the modifications that have the Is Visible option checked and 
were saved.

Cancel Discards any changes that you made after the last time you clicked 
Save Custom Modifications and then closes the wizard.
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Importing and Exporting
To import and export compound data, see the following topic and procedures:

• To import compounds from ToxID, ExactFinder, or legacy TraceFinder

• To import compounds from Skyline, PepFinder™, or PinPoint

• To edit a mapping template

• To export all compounds to a CSV file

• To export selected compounds to a mass list

• Data Columns with Default Values

 To import compounds from ToxID, ExactFinder, or legacy TraceFinder

1. Choose Compound Database > Import Compounds from the main menu.

The Select File to Import into the Current Compound Database dialog box opens.

You can import compounds from the following file types:

• ToxID™ Exactive™ CSV

• ToxID MS2 CSV

• TraceFinder CSV

• TraceFinder Mass List XML

• TraceFinder 4.0 Legacy CDB

• ExactFinder™ 2.0 CDB

• .include-masses

Note  If you have unsaved changes in your current compound database, a message 
prompts you to save the changes. Click Yes and continue with the import procedure.
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2. Locate the CDB, CSV, or XML compound database file that you want to import and 
click Open.

The Import Compounds to CDB dialog box opens.

3. To select a different compound database, click Browse, locate an XML, a CSV, or a CDB 
compounds file, and click Open.

4. To select a different target database, do one of the following:

a. Click Browse.

b. Locate an XML, a CSV, or a CDB compounds file.

c. Click Open.

–or–

a. Click Create.

b. Type a name for a new compound database.

c. Click OK.

5. Confirm that the import file and the target database are correct.

The dialog box reports the total number of compounds in the import file, the number of 
compounds with validation errors, and the number of compounds that already exist in 
the target database.

Note  If the import file is missing required compound information, the application 
warns that it is unable to parse the file and identifies the missing columns. 
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6. (Optional) Select one of these options:

• Skip: Imports only those compounds that do not already exist in the target database.

• Overwrite: Replaces compounds that already exist in the target database with the 
imported compounds.

7. Click Import.

The application imports the compounds from the imported file, adds them to any 
compounds already in the database, and alphabetically sorts them.

The application reports the number of imported compounds.

8. Click OK.

 To import compounds from Skyline, PepFinder™, or PinPoint 

1. Choose Compound Database > Import Compounds from the main menu.

The Select File to Import into the Current Compound Database dialog box opens.

You can import compounds from the following file types:

• Skyline

– Thermo transition list (Thermo Template)

– Thermo Quantiva transition list (Thermo Quantiva)

– Thermo isolation list (isolation list Quantiva)

• PepFinder 2.0 ion list

• PinPoint 

– Orbitrap™/LTQ inclusion list

– Q Exactive multiplexed list

– Q Exactive multiplexed list with formula 

– Q Exactive/LTQ inclusion list - with charge state 

– Quantiva 

– TSQ™

2. Locate the compound database file that you want to import and click Open.

Note  If you have unsaved changes in your current compound database, a message 
prompts you to save the changes. Click Yes and continue with the import procedure.
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The Import Compounds to CDB dialog box opens.

The application reports that a total of 0 compounds are available for importing. It notifies 
you that the CSV file is an unrecognized format and that you must use the Mapping 
Tool. To continue importing compounds from this CSV file to the current compound 
database, skip to step 5.

3. (Optional) To select a different import file, click Browse, locate an XML, a CSV, or a 
CDB compounds file, and click Open.

4. (Optional) To select a different target database, do one of the following:

a. Click Browse.

b. Locate an XML, a CSV, or a CDB compounds file.

c. Click Open.

–or– 

a. Click New Small Molecule CDB or New Peptide CDB.

b. Type a name for a new compound database.

c. Click OK.

5. Select a Mapping Template.

The template maps the unrecognized fields in the imported file to TraceFinder values and 
reports the number of compounds that it will import.

In the lower pane, the application reports the values that are not recognized and cannot 
be imported.

Note   The application displays the New... buttons only for the configured 
databases. See Activating Optional Features.



 2 Using Compound Databases in the Method Development Mode
Importing and Exporting

Thermo Scientific TraceFinder Lab Director User Guide 93

6. (Optional) To edit the mapping template to ignore specific parameters when it imports 
the compounds, click Map Tool. 

The Mapping Tool dialog box opens. See To edit a mapping template.

In the Mapping Tool, edit the mapped columns and then click Save Template and 
Return.

The application returns to the Import Compounds to CDB dialog box.

7. (Optional) Specify one of the following Import Options:

• To identify all peaks as target peaks, select the All option.

• To identify only the first peak as a target peak and identify all other peaks as 
confirming ions or fragments, select the One option and then select either the 
Confirming Ion or Fragment option.

8. Click Import.

The application imports the compounds from the imported file, adds them to any 
compounds already in the database, and alphabetically sorts them.

The application reports the number of imported compounds.

9. Click OK.

 To edit a mapping template 

1. Click Map Tool.

The Mapping tool dialog box opens, displaying a preview of the mapping template that 
you selected in the Import Compounds to CDB dialog box.

The preview displays only 20 compound rows, starting with the row specified in the Data 
Starts on Row box. 

Note   The application displays these options only when you are required to use a 
mapping template.
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2. (Optional) Specify the format that your template uses to display the columns of data:

• Comma

• Tab 

• Semicolon 

• Space 

• Other (specify the delimiter used in your template file)

3. (Optional) To change the starting row for the 20 compounds displayed in the preview, 
type a value in the Data Starts on Row box.

The preview displays 20 compounds starting with the row that you specified. 

4. For each parameter that you want the import operation to ignore, change the column 
header to <Ignore Column>.

To return the header values to the original values, click Refresh Preview.

5. When you have completed your edits, click Save Template and Return. 

6. When the application reports that the changes to the template were saved, click OK.

The application returns you to the Import Compounds to the CDB dialog box. Continue 
with step 7 of the procedure To import compounds from Skyline, PepFinder™, or 
PinPoint.

Figure 33. Mapping tool dialog box
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 To export all compounds to a CSV file

1. Choose Compound Database > Export All Compounds to CSV File from the main 
menu. 

The Export Compounds dialog box opens.

2. (Optional) Click Browse and locate a different folder or file name where you want to 
write the exported compound database.

Each parameter in the compound database editor is represented by a column of data in 
the spreadsheet. When you export compound data to a CSV file, each parameter is 
assigned to a column and each compound is assigned to a row.

Table 20. Mapping Tool parameters

Parameter Description

Template Specifies the name of the current mapping template.

Refresh Preview Returns the header values to the original template values.

Separator Options Specifies that the import file uses one of the following to 
separate parameter values: Comma, Tab, Semicolon, 
Space, Other (user-specified delimiter)

Data Starts on Row Specifies that the preview displays 20 compounds starting 
with this row.

Preview Displays 20 compound rows from the import file.

Save Template and Return Applies the current settings for importing the compounds 
and returns to the Import Compounds to CDB dialog 
box.

Cancel Does not apply any changes and returns to the Import 
Compounds to CDB dialog box.

Note  If you have unsaved changes in your current compound database, a message 
prompts you to save the changes. Click Yes and continue with the export procedure.
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3. Select one of these options:

• Export Only Columns with Data: Writes only columns that contain nondefault 
data for at least one compound. This option does not export columns that contain 
only default data. See Data Columns with Default Values.

• Export All Columns: Writes all columns to the CSV file, including columns that 
contain no data for any compound.

4. Click Export.

The application stores the database as

…\Thermo\TraceFinder\4.0\General\Databases\databaseName.csv

An Excel window opens with the compound data in spreadsheet format.

Figure 34. Compound data in an Excel spreadsheet

You can use the tools in the spreadsheet to edit the data in the compound database and then 
import the data in the CSV file back into the TraceFinder application. If you delete a column 
from the spreadsheet and then import the CSV file, the application replaces the data in that 
column with default values. For a list of default values, see Data Columns with Default 
Values. 

 To export selected compounds to a mass list

1. Select the compounds that you want to export.

2. Choose Compound Database > Export Selected Compounds to Mass List from the 
main menu. 

IMPORTANT   TraceFinder 4.1 uses the same data as TraceFinder 4.0. By default, the application 
stores the compound database data for the 4.1 release in the TraceFinder\4.0 folder.

Note  If you have unsaved changes in your current compound database, a message 
prompts you to save the changes. Click Yes and continue with the export procedure.
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The Save As dialog box opens. 

3. Locate the folder where you want to save the file, type a file name, and then click Save.

The application writes the mass data for the selected compounds to the specified file, 
using one of the following formats that is compatible with your configured instrument.

• TSQ format

The application writes the mass data to the specified .xml format file.

The data in the exported file matches the TSQ XML data, which you can use in the 
instrument method editor of a TSQ application.

• Q Exactive format

The application writes the mass data to the specified .xml.include-masses format file.

The data in this file matches the Exactive XML data, which you can use in the 
instrument method editor of a Q Exactive application.

• TSQ Quantiva/Endura SIM format

The application writes the mass data to the specified .xml format file.

The data in this file matches the TSQ Endura, TSQ Quantiva, and Xcalibur XML 
data, which you can use in the instrument method editors of the associated 
applications. The application exports only the following compound parameters to the 
XML file:

– Compound Name (as Name in the XML file)

– Product Mass (as Mass in the XML file)

– RT range (as StartTime and StopTime in the XML file)

– Polarity

– Lens (as TubeLens or S-Lens in the XML file)

• TSQ Quantiva/Endura SRM format

The application writes the mass data to the following file:

…\TraceFinderData\4.0\Methods\Methodname\Methodname.xml

Note   If your configured instrument is other than a TSQ, an ISQ™, a Q Exactive, a 
TSQ Endura™, or a TSQ Quantiva™ mass spectrometer, a message prompts you for 
the export format: Triple Quadrupole, Q Exactive, TSQ Quantiva/Endura SIM, or 
TSQ Quantiva/Endura SRM. Select one of the formatting options and click OK.

IMPORTANT   TraceFinder 4.1 uses the same data as TraceFinder 4.0. By default, the 
application stores the method data for the 4.1 release in the TraceFinderData\4.0 folder.
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The data in this file matches the TSQ Endura, TSQ Quantiva, and Xcalibur XML 
data, which you can use in the instrument method editors of the associated 
applications. The application exports only the following compound parameters to the 
XML file:

– Compound Name (as Name in the XML file)

– Precursor Mass

– Product Mass 

– RT range (as StartTime and StopTime in the XML file)

– Polarity

– Lens (as TubeLens or S-Lens in the XML file)

– Collision Energy

Data Columns with Default Values

When you export compounds to a CSV file with the Export Only Columns with Data 
option, the application writes only columns that contain nondefault data for at least one 
compound. This option does not export columns that contain only default data. 

When you import compounds from a CSV data file that has missing columns, the application 
replaces the missing columns and uses default values for all compounds. 

Table 21. Default values for compound parameters 

CDB parameter Default value

Compound Detail  
Formula Blank
CAS Blank
Category Blank
Ionization None
Response Threshold 5000
Target Peaks

Precursor Mass Blank
Collision Energy 0
Adduct None
Lens 0
Energy Ramp 0
Confirming Peaks

Precursor 0
Collision Energy Blank
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3

Using Instrument Methods in the Method 
Development Mode

You can also use the Instrument Method view for quantitation, target screening, and 
unknown screening methods. An instrument method is a set of experiment parameters that 
define the operating settings for an autosampler, mass spectrometer, and so on. Instrument 
methods are saved as file type .meth.

Follow these procedures:

• To open the Instrument View

• To create a new instrument method

• To create a new multiplexing instrument method

• To open an instrument method

 To open the Instrument View

1. Click Method Development in the navigation pane.

The Method Development navigation pane opens.

2. Click Instrument View.

The Instrument View opens.

IMPORTANT  Do not open the Thermo Foundation Instrument Configuration window 
while the TraceFinder application is running.
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 To create a new instrument method

1. Choose File > New Instrument Method from the main menu. 

The Thermo Instrument Setup window opens.

Figure 35. Example instrument setup showing multiple configured instruments

2. Click the icon for the instrument that you want to use for the method.

3. Edit the values on the instrument page.

4. From the main menu in the Thermo Instrument Setup window, choose File > Save As.

The Save As dialog box opens.
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5. Select an instrument method name to overwrite, or type a new name for the instrument 
method, and click Save.

The File Summary Information dialog box opens.

6. (Optional) Type a comment about the new instrument method.

7. Click OK.

The application saves the new instrument method in the following folder:

…\Xcalibur\methods

 To create a new multiplexing instrument method

1. Choose File > New Instrument Method from the main menu. 

The Thermo Xcalibur Instrument Setup window opens.

Figure 36. Example instrument setup showing a configured multiplexed instrument

2. Click the icon for the instrument that you want to use for the method.



3 Using Instrument Methods in the Method Development Mode

102 TraceFinder Lab Director User Guide Thermo Scientific

3. Edit the values for the instrument method.

For information about specifying multiplexing values, refer to the documentation for 
your multiplexed instrument.

4. Specify the channels that you want to use for acquisition, as in this example: 

5. From the main menu in the Thermo Xcalibur Instrument Setup window, choose File > 
Save As.

The Save As dialog box opens.

6. Select an instrument method name to overwrite or type a new name for the instrument 
method, and click Save.

The File Summary Information dialog box opens.

7. (Optional) Type a comment about the new instrument method.

8. Click OK.

The application saves the new instrument method in the following folder:

…\Xcalibur\methods 

 To open an instrument method

1. From the File menu, choose Open Instrument Method.

An instrument method browser opens.

2. Select an instrument method from the list and click Open.

The selected method opens in the Thermo Xcalibur Instrument Setup window. You can 
edit this method and save the changes, or you can save this method with another name.

Note  To open Help for any of your configured instruments, click Help on the 
instrument page.
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4

Using the Method Development Mode for 
Quantitation Methods

Use the method development mode and its associated features for creating and editing a 
quantitation method. (See Method Development navigation pane.) When user security is 
activated, you must have Method Development Access permission to use these features. 

The TraceFinder application uses a method to specify the types of acquisition, processing, and 
reporting that occur with a batch of samples. You can create a method designed specifically to 
test for compounds in your assay. A quantitation method contains a list of compounds and 
the settings for detecting, processing, and reporting those compounds. 

The quantitation method that you create determines how the application works with a set of 
samples to provide a set of meaningful results. Part of this method, the instrument method, 
defines how the application acquires raw data. The rest of the method defines how to process 
the raw data, how the flag information displays the results, and how the reporting 
functionality defines the output for your data and results. 

The application applies your method to a batch, which is a list of one or more samples. 
Together, the method and batch provide a workflow-oriented approach to the data processing 
and information reporting for batches of samples. 

To speed up the creation of methods, you can create a method template. Using a method 
template helps you to develop methods faster because the application saves all of your 
commonly used method settings in a template, such as the number of confirming ions or the 
use of data-dependent scans. 

IMPORTANT   TraceFinder 4.1 uses the same data as TraceFinder 4.0. By default, the application 
stores the method data for the 4.1 release in the TraceFinderData\4.0\Methods folder.

Contents

• Opening a Method

• Starting a New Master Method

• Editing a Quantitation Method

• Saving a Quantitation Method to a New Name

• Creating a Method Template

• Exporting Mass Data
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Figure 37. Method Development navigation pane 

Table 22. Method Development navigation pane commands 

Command Description

Method View Displays the Method View for the method. 

Acquisition Displays the Acquisition page. See Editing the Acquisition Page.

Quantitation

Processing Displays the Processing page. See Editing the Processing Page.

Compounds Displays the Compounds page. See Editing the Compounds Page.

QAQC Displays the QAQC page. See Editing the QAQC Page.

Groups Displays the Groups page. See Editing the Groups Page.

Intel Seq Displays the Intelligent Sequencing page. See Editing the Intelligent 
Sequencing Page. Available only when you activate the Intelligent 
Sequencing option in the Configuration console.

Reports Displays the Reports page. See Editing the Reports Page.

Compound Database
See Chapter 2, “Using Compound Databases in the Method 
Development Mode.” 

Instrument View
See Chapter 3, “Using Instrument Methods in the Method 
Development Mode.” 

Available only when you activate the Intelligent 
Sequencing option in the Configuration console
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Opening a Method
Use the TraceFinder application to open a method that was created and saved in the current 
application or converted from previous versions of TraceFinder. To convert legacy methods, 
refer to Chapter 2, “Getting Started” in the TraceFinder User Guide.

 To open a quantitation method in the Method Development mode

1. Click Method Development in the navigation pane.

The Method Development navigation pane opens. 

For descriptions of all the features in the Method Development navigation pane, see 
Starting a New Master Method.

2. Choose File > Open > Master Method from the main menu. 

The Open Master Method dialog box opens, displaying all available methods.

3. Select Quan in the Type list.

The method list displays all quantitation methods.

4. Select a quantitation method and click Open.

The Acquisition Page for the selected method opens. 

Tip  You can also open one of your most recently used method files. Choose Files > 
Recent Files > Method.
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Figure 38. Open Master Method dialog box

Table 23. Open Master Method dialog box parameters 

Parameter Description

Method Name of the methods for the selected type.

Type Type of method: Quan, Screening, or Unknown Only.

Date Changed Date the method was last updated.

Size Size of the method in megabytes.

Domain TraceFinder domain for which the method was created.

Type Type of method to display: Quan, Screening, Unknown 
Only, or Any.

Path Path to the selected method in the 
TraceFinderData\4.0\Methods folder.
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Starting a New Master Method
To create or start a specific method, select as applicable from one of the four different 
quantitation method procedures (or techniques) in the Create Master Method dialog box:

• Starting a New Method with Method Forge

• Importing an Xcalibur Master Method

• Starting a Blank Method

• Starting a Method Using the Compound Database

Then, use the features of the Method View to complete and save the method.

To open the Create Master Method dialog box, choose File > New > Master Method from 
the main menu. 

Figure 39. Create Master Method dialog box

IMPORTANT   The Unknown Screening Method - Only technique is displayed only when 
you select the Allow Unknown Screening option in the application configuration console. 
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Starting a New Method with Method Forge

With the Method Forge Dialog Box, you can manually create a new quantitation method by 
selecting peaks, selecting multiple compounds, renaming peaks, or comparing mass spectra 
from the library searches. You can also choose to let the application automatically create a 
method.

When the application automatically creates a method, it performs the following functions:

• Reviews your raw data file and identifies compounds that are present in your sample. 

• Uses your mass spectral reference libraries to assign compound names and CAS numbers.

• Uses mass spectral information to select potential quantification and confirming peaks 
and a reference mass spectrum for the compound. 

Follow these procedures:

• To automatically select compounds to create a new method

• To manually select compounds to create a new method

 To automatically select compounds to create a new method

1. From the File menu, choose New > Master Method.

The Create Master Method dialog box opens.

2. Select the Quan Using Method Forge option and click OK.

The Method Forge Dialog Box opens. 

Use Method Forge to create a method from an existing raw data file or to create a new raw 
data file to use for the method. 

Each method requires a processing method template. The application displays all saved 
method templates in the template list.

3. To select a processing method template, do one of the following:

• Click Open Method Template Editor to create and save a new method template.

See Creating a Method Template.

Note  When the identified peak is from an analog trace, the application does not perform 
a library search and does not identify confirming peaks.
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• Select a method template from the template list, and click Open Method Template 
Editor to edit and save the method template. 

• Select a method template from the template list.

The selected template is now selected by default each time you open the Method Forge 
dialog box until you restart the application. 

4. Select the Name the Master Method check box and type a name for your method.

You can enter a new method name, or you can enter an existing method name to 
overwrite when you create the method. If you do not select this option, the method is 
named for the raw data file used to create the method.

5. Select the Automatically Create the Master Method check box.

6. Specify a raw data file by doing one of the following:

a. In the Raw File Selection area, select the Use an Existing Raw Data File option.

b. Browse to and select a raw data file to use for the method.

c. Go to step 8.

–or–

a. In the Raw File Selection area, select the Acquire a New Raw Data File option.

b. From the Instrument method list, select a method (.meth) file to use for acquiring the 
data.

c. In the Raw Filename box, type the name of the file where the application will write 
the raw data file.

d. In the Path box, type a path or browse to and select a folder where the application will 
save the raw data file.

e. (Optional) Type a comment about the acquired sample or the data file.

7. To acquire a new raw data file, do one of the following:

Select the Manual Injection option.

–or–

Specify the autosampler settings:

a. Select the Use Autosampler option.

b. In the Vial Position box, type a vial position.

c. In the Injection Volume box, type an injection volume.

Valid range: 0.1 through 2000 μL

IMPORTANT  When you select the Name the Master Method check box, you must 
enter a method name. To let the application name the method with the raw data file 
name, be sure to clear the Name the Master Method check box.
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8. To automatically create the method, click OK (or Overwrite).

As the Method Forge creates the method, it displays the following status bars:

• For analog peaks, the Method Forge displays the detected peak as Peak@(RT)Analog. 
The Method Forge does not perform a library search for peaks found in analog traces.

• For mass spectral peaks, the Method Forge process searches the associated libraries 
and displays the identified compound names instead of the peak times.

When you selected to acquire a new raw data file in step 6, the application completes the 
acquisition and then performs the following processes.

• Method Forge performs peak detection, library searching (except for analog peaks), 
and identification of characteristic ion and reference spectra. 

• Method Forge then loads this information into a new method and opens the 
Acquisition Page of the Method View.

9. From the Instrument Method list, select an instrument method.

10. To save the new method, choose File > Save from the main menu.

For a detailed description of how to modify all the parameters in a method, see Editing a 
Quantitation Method.

 To manually select compounds to create a new method

1. From the File menu, choose New > Master Method.

The Create Master Method dialog box opens. 

2. Select the Quan Using Method Forge option and click OK.

The Method Forge dialog box opens. For detailed descriptions of all the features in the 
Method Forge dialog box, see Importing an Xcalibur Master Method.

Note  If you selected a previously acquired raw data file in step 6, the application 
immediately begins these processes.
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Each method requires a qualitative peak processing template. The application displays all 
saved method templates in the template list.

3. To select a qualitative peak processing template, do one of the following:

• Click Open Method Template Editor to create and save a new method template.

See Creating a Method Template.

• Select a method template from the template list, and click Open Method Template 
Editor to edit and save the method template. The application saves the methods to 
the following folder:

…\TraceFinderData\4.0\Templates\Methods\General 

• Select a method template from the template list.

The selected template is now selected by default each time you open the Method Forge 
dialog box until you restart the application. 

4. Select the Name the Master Method check box and type a name for your method.

You can enter a new method name, or you can enter an existing method name and 
overwrite it when you create the method. If you do not select this option, the method is 
named for the raw data file used to create the method.

5. Ensure that the Automatically Create the Master Method check box is cleared.

6. To select a raw data file, browse to the file location.

7. To manually create the method, click OK (or Overwrite).

The method forge results view opens, listing all peaks found in the raw data file.

For each peak listed in the RT column, the application displays a list of possible matches 
in the Libraries pane. The application selects the best match, displays the name in the 
Compound Name list, and displays the peak spectrum for that compound in the first 
Libraries pane. See Method forge results view. 

IMPORTANT  When you select the Name the Master Method check box, you must 
enter a method name. To let the application name the method with the raw data file 
name, be sure to clear the Name the Master Method check box.
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Figure 40. Method forge results view

8. (Optional) To use a library compound other than the compound chosen by the 
application, do the following:

a. Select the peak in the RT column.

b. In the Libraries pane, scroll to the spectrum for the compound that you want to use.

Peaks found in raw data file

Best match compound spectra

Possible matches Best match compound name
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c. Select the check box in the header of the spectrum pane. 

d. Repeat these steps for each peak that you want to replace.

9. In the Compound Name list, use the CTRL or SHIFT keys to select each compound that 
you want to include in the method compound.

10. (Optional) To exit the method forge results view without creating a method, click 
Cancel.

The method forge results view closes and the application returns to the Method View 
without creating a method. 

11. Click Create. 

The application uses all selected compounds to create the method and displays the 
Acquisition Page of the Method View. 

12. From the Instrument Method list, select an instrument method.

13. To save the new method, choose File > Save from the main menu.

For a detailed description of how to modify a method, see Editing a Quantitation 
Method. 

 To see how to create a new quantitation method using Method Forge

1. Choose Help > Animations.

2. From the list of animation topics, click Starting a New Method with Method Forge.

Note  When you select multiple compounds, the method forge results view does not 
display any spectrum panes.

Note  To return to the method forge results view to create a method from the same 
results, choose Method View > View Method Forge Results from the main menu.

Selected 
compound
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Method Forge Dialog Box

Use the Method Forge dialog box to create a new method.

Figure 41. Method Forge dialog box 

Table 24. Method Forge dialog box parameters  (Sheet 1 of 2)

Parameter Description

Method Template Selection

Open Method 
Template Editor

Opens the Method Template Editor, where you can edit the currently selected method 
template. See Creating a Method Template.

Template Specifies the method template to use to create this method. All methods require a method 
template. To view the parameters of each template, hold your cursor over the method name. 
See the Method Template Parameters example in To automatically select compounds to 
create a new method.

Name the Master 
Method

Specifies the name for the new method. If you do not specify a method name, the 
application uses the raw data file name for the method.

Automatically Create 
the Master Method

Specifies that when acquisition is completed, Method Forge performs peak detection, library 
searching, and identification of characteristic ion and reference spectra. This information is 
loaded into a new method. This process occurs immediately when you specify an existing 
raw data file.
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Raw File Selection

Use an Existing Raw 
Data File

Activates the Raw Filename box where you can select which raw data file to use to create the 
method. 

Acquire a New Raw 
Data File

Activates functions to acquire data for the new raw data file used to create the method.

Instrument 
Method

Specifies the saved method (.meth) file used for acquiring the data.

Raw Filename Specifies the file name where the application writes the raw data.
Path Specifies the location where the application saves the raw data file.
Sample Comment (Optional) Specifies a comment about the acquired sample or the data file.

Manual Injection Performs a manual acquisition.
Use Autosampler Performs an autosampler acquisition.

Vial Position Specifies the tray vial number used for the autosampler acquisition.
Injection Amount Specifies the volume (in milliliters) injected by the autosampler acquisition.

Check Instruments Opens the Submit to Acquisition dialog box that prompts you to prepare the instrument 
before you acquire the sample used to create a method. Available only when you select the 
Acquire a New Raw Data File option.

Function Buttons

Overwrite Overwrites the specified method name. This function is activated only when the specified 
method name already exists.

OK Creates a method using the data and parameters that you specified.
Cancel Closes Method Forge and does not create a method.

Table 24. Method Forge dialog box parameters  (Sheet 2 of 2)

Parameter Description
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Importing an Xcalibur Master Method

You can create a new method from an existing Xcalibur processing method.

 To import an Xcalibur method

1. Choose File > New > Master Method from the main menu.

The Create Master Method dialog box opens. 

2. Select the Quan by Importing an Xcalibur Processing Method option and click OK.

The Import an Xcalibur Method dialog box opens.

3. For the Xcalibur Method to Import box, browse to the location of the Xcalibur processing 
method file, and open the file.

The application imports the compound information from the Xcalibur method file.

4. (Optional) For the Raw Data File to Associate box, browse to the location of a raw data 
file to associate with the method (or select from the list of previously associated raw data 
files), and open the file.

To assure that this raw data file is always available to the method (for example, if you 
move the method to another system), the application saves the raw data file in the 
Methods folder:

…\TraceFinderData\4.0\Methods\Methodname
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5. (Optional) Change the number of decimal places in the Filter Precision box.

You can set the number of filter precision decimal places to any integer between 2 and 5, 
inclusive.

6. (Optional) Change the number of decimal places in the Mass Precision box.

You can set the number of mass precision decimal places to any integer between 2 and 6, 
inclusive.

7. Click OK.

The application adds all compounds found in the imported Xcalibur method and displays 
the Acquisition Page of the Method View. 

8. From the Instrument Method list, select an instrument method.

9. To save the new method, choose File > Save from the main menu.

For a detailed description of how to modify a method, see Editing a Quantitation 
Method. 

 To see how to import an Xcalibur method

1. Choose Help > Animations.

2. From the list of animation topics, click Importing an Xcalibur Master Method.

Note  When you select a raw data file to associate, the application reads the filter 
precision from the file and this feature is not available. 

Note  When you associate a raw data file, the application reads the filter precision 
from the associated file so that you cannot change the Filter Precision value.
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Starting a Blank Method

You can use the compounds in a previously acquired raw data file to create a new blank 
method.

 To start a blank method

1. From the File menu, choose New > Master Method.

The Create Master Method dialog box opens. 

2. Select the Quan – Blank Method option and click OK.

The Method View for a new, unnamed method opens. This method has no associated 
data. You can use the compounds in a previously acquired raw data file to create a new 
method.

3. From the Method View menu, choose Associate a Raw Data File.

The Associate a Raw Data File dialog box opens.

4. Browse to a raw data file to associate with the method (or select from the list of previously 
associated raw data files) and open the file.

To assure that this raw data file is always available to the method (for example, if you 
move the method to another system), the application saves the raw data file in the 
Methods folder:

…\TraceFinderData\4.0\Methods\Methodname

Browse to a data file.

Select a previously associated data file.
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5. Select the update options to use for creating your method:

• Update Instrument/Trace Selections: Reads the Detector and Trace options from 
the associated raw data file. On the Detection page, only detector types and traces 
that are defined in the raw data file are available. For detailed descriptions of the 
available Detector and Trace values, see Trace Selection.

• Update Target Ion Ratio Values: Reads the ion ratio values from the associated raw 
data file.

• Update Scan Filters for All Peaks: 

– Yes, All Peaks updates all peaks to use the scan filters from the associated raw 
data file. 

– Yes, Only Peaks Without Filters updates only peaks without scan filters to use 
the scan filters from the associated raw data file; it does not override any existing 
scan filter.

• Automatically Set Reference Spectrum: Reads a reference spectrum from the 
associated raw data file.

When you select Yes, with Background Subtraction, the application uses the 
background-subtracted reference spectrum during quantitative processing and 
reports the background-subtracted reference spectrum (indicated with BS in the scan 
heading) as the last scan for each compound in the Quantitation Report - 2 report.

• Order by Intensity: Reads intensity values from the associated raw data file and lists 
the peaks with the greatest intensity first. Intensity is based on either peak height or 
peak area, as specified for the method (see Detection Algorithm).

– When a compound contains only target peaks, the most intense ion is listed first. 

– When a compound contains both target peaks and confirming peaks, the most 
intense target peak is listed first, followed by its ordered confirming peaks. The 
second most intense target peak is listed next followed by its confirming peaks, 
and so forth.

– When you also select the Update Target Ion Ratio Values option, the application 
orders the ions by intensity first and then updates the target ion ratios. 

Options that are set to No use the standard values in the method. 

Note  The background subtraction option is available only when you select a 
background subtraction method on the Acquisition page in the method. See 
Editing the Acquisition Page.

Note  You can use the Order by Intensity option with required confirmation 
criteria only when all peaks are target peaks. Otherwise, the application ignores 
this option. See To specify confirmation criteria for compounds. 
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6. Click OK.

The application displays the Acquisition page of the Method View. 

7. Click Compounds in the navigation pane.

The method must include at least one compound.

8. Click the Detection tab.

The Detection page shows an empty Compounds pane. The Peaks pane displays the 
chromatographic data for the compounds in the raw data file.

9. Select the Show Peak Creator Panel check box.

The Manual Peak Creator pane opens.

10. (Optional) Select a different Trace.

11. (Optional) Select a filter from the Filter list.

12. In the Peaks chromatogram, click to select the peak that represents the compound that 
you want to add to the method. 

Note   When you process a sample with this method and then manually integrate a 
peak, the application updates only the integration and does not change the displayed 
peak unless you use Associate a Raw Data File again. 
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13. Right-click and choose Add This Peak as New Compound.

The application performs a library search for the selected compound. The application 
uses the first match it finds as the compound name, the base peak of the mass spectrum as 
the target peak, and the second and third largest ions as the confirming peaks. 

• When the name of the first match does not exist in the method, the application adds 
this compound to the method and displays the name in the Compound list. You can 
now view and edit the parameters for this compound.

• When the name of the first match is already in the method, the Add New Compound 
dialog box opens. You cannot overwrite a compound name in the method. If the 
selected peak already exists in the method, you must give it a new name to add it to 
the method. Or, you can select a different compound to add to the method, 
following step 14 through step 16.

Figure 42. Add New Compound dialog box

14. Do one of the following:

• Type a unique name for the first matched compound.

The application displays a red warning when the selected compound name already 
exists in the method. You cannot overwrite the compound name, and you cannot 
create a duplicate name in the method. 

–or–
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• To use a compound other than the first matched compound, scroll to the spectrum 
for that compound and select its corresponding check box in the title bar of the 
spectrum pane.

15. In the Type of Compound to Add list, select a compound type.

16. Click OK.

17. Repeat this procedure for each compound that you want to add to the method.

For detailed descriptions of all the features on the Detection page, see Editing the 
Compounds Page. 

18. Click Acquisition in the navigation pane.

The Acquisition Page for the method opens. 

19. From the Instrument Method list, select an instrument method.

20. To save the new method, choose File > Save from the main menu and name the method.

For a detailed description of how to modify the parameters in a method, see Editing a 
Quantitation Method. 

 To see how to create a blank method and associate a raw data file

1. Choose Help > Animations.

2. From the list of animation topics, click Starting a Blank Method.

Selected 
compound
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Starting a Method Using the Compound Database

You can select compounds from a compound database to create a new method. 

 To select compounds from the compound database

1. Choose File > New > Master Method from the main menu.

The Create Master Method dialog box opens. 

2. Select the Quan by Selecting Compounds from CDB option and click OK.

The Select Compounds from Database dialog box opens, listing all the compounds 
defined in the current compound database. 

Figure 43. Select Compounds from Database dialog box

3. Click Browse and locate the compound database that you want to use.

4. Select the check box for each of the compounds that you want to add to the method.
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5. To select all compounds in the database, select the Select All check box at the top of the 
list.

6. (Optional) To associate a raw data file with the method, do the following:

a. Select the Associate Raw File check box.

The application adds the appropriate options to the Select Compounds from 
Database dialog box.

Figure 44. Associate Raw File options on the Select Compounds … dialog box.

b. Browse to a raw data file to associate with the method (or select from the list of 
previously associated raw data files) and open the file.

To assure that this raw data file is always available to the method (for example, if you 
move the method to another system), the application saves the raw data file in the 
Methods folder:

…\TraceFinderData\4.0\Methods\Methodname

c. Select the update options to use for creating your method:

• Update Instrument/Trace Selections: Reads the Detector and Trace options 
from the associated raw data file. On the Detection page, only detector types and 
traces that are defined in the raw data file are available. For detailed descriptions 
of the available Detector and Trace values, see Trace Selection.

• Update Target Ion Ratio Values: Reads the ion ratio values from the associated 
raw data file.

• Update Scan Filters for All Peaks:

– Yes, All Peaks updates all peaks to use the scan filters from the associated raw 
data file. These scan filters are available on the Trace Selection. See To specify 
an MS filter.

– Yes, Only Peaks Without Filters updates only peaks without scan filters to 
use the scan filters from the associated raw data file; it does not override any 
existing scan filter.

Browse to a data file.

Select a previously associated data file.
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• Automatically Set Reference Spectrum: Reads a reference spectrum from the 
associated raw data file.

When you select Yes, with Background Subtraction, the application uses the 
background-subtracted reference spectrum during quantitative processing and 
reports the background-subtracted reference spectrum (indicated with BS in the 
scan heading) as the last scan for each compound in the Quantitation Report - 2.

• Order by Intensity: Reads intensity values from the associated raw data file and 
lists the peaks with the greatest intensity first. Intensity is based on either peak 
height or peak area, as specified for the method (see Detection Algorithm).

– When a compound contains only target peaks, the most intense ion is listed 
first. 

– When a compound contains both target peaks and confirming peaks, the 
most intense target peak is listed first, followed by its ordered confirming 
peaks. The second most intense target peak is listed next followed by its 
confirming peaks, and so forth.

– When you also select the Update Target Ion Ratio Values option, the 
application orders the ions by intensity first and then updates the target ion 
ratios. 

Options that are set to No use the standard values in the method. 

7. Click Add Selected Compounds to Method (or Add Selected Compounds to Method 
and Associate Raw File).

The application adds the selected compounds to the method and (optionally) associates 
the specified raw data file. 

8. Click Method View – Acquisition in the navigation pane. 

The Acquisition Page for the method opens. 

9. From the Instrument Method list, select an instrument method.

10. To save the new method, choose File > Save from the main menu and name the method.

For a detailed description of how to modify a method, see Editing a Quantitation 
Method. 

Note  The background subtraction option is available only when you select a 
background subtraction method on the Acquisition page in the method. See 
Editing the Acquisition Page.

Note  You can use the Order by Intensity option with required confirmation 
criteria only when all peaks are target peaks. Otherwise, the application 
ignores this option. See To specify confirmation criteria for compounds. 

Note  If you do not associate a raw data file, you might not see any peaks.
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 To see how to create a new quantitation method by selecting compounds from the 
compound database

1. Choose Help > Animations.

2. From the list of animation topics, click Starting a Method Using the Compound 
Database.

Editing a Quantitation Method
You can open a method to view or edit the compounds, method instructions, and reporting 
options.

See the instructions for the following tasks:

• Modifying Retention Times

• Enabling Auto Reprocessing

• Editing the Acquisition Page

• Editing the Processing Page

• Editing the Compounds Page

• Editing the QAQC Page

• Editing the Groups Page

• Editing the Intelligent Sequencing Page

• Editing the Reports Page
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Modifying Retention Times 

Use the Adjust Retention Times dialog box from any page in the Method View or Local 
Method view.

 To modify retention times in a method

1. Do one of the following:

• Choose Method View > Adjust Retention Times from the main menu of the 
Method View in the Method Development mode.

• Choose Local Method > Adjust Retention Times from the main menu of the Local 
Method view in the Analysis mode.

The Adjust Retention Times dialog box opens.

2. Do one of the following:

a. Select the Absolute option.

b. Specify a positive or negative value to increase or decrease the expected retention 
times. (Valid range: –100.00 through +100.00)

c. Click OK.

The application increases or decreases the expected retention times for all compounds 
in the method by the specified number of minutes. 

–or–

a. Select the Relative option.

b. Specify a positive or negative value to increase or decrease the expected retention 
times. (Valid range: –100.00 through +100.00)

c. Click OK.

The application increases or decreases the expected retention times for all compounds 
in the method by the specified percentage. 

–or–
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a. Select the By File option.

b. Click Select.

The Adjust Retention Time by File dialog box opens, displaying all processed 
samples.

c. Select the sample whose retention times you want to use in the method.

d. Click Select.

e. Click OK.

For each detected peak in the selected, processed sample, the application overwrites 
the retention times for the matching compounds in the method. If the method 
contains compounds not detected in the selected sample, the retention times for 
those compounds are not affected.

Enabling Auto Reprocessing 

The Auto Reprocess option is displayed in the banner of all TraceFinder application views.

• When you select this option, the application automatically reprocesses a batch and 
displays the updated results in Data Review when you make changes to the method or 
make any manual integration changes. 

• When you clear this option, the application does not automatically reprocess batches or 
update the results in Data Review when you make changes to the method or make any 
manual integration changes. The application simply stores the changes to the method or 
the manual integration. The application updates the Data Review results only when you 
manually reprocess the batch.

Note   This option is available only from the Local Method view after you have 
processed the samples in a batch.

Note  Batch processing can be slower when you use auto reprocessing.
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Editing the Acquisition Page 

The Acquisition Page defines basic information about the method.

Follow these procedures:

• To open the Acquisition page

• To specify acquisition information for a method

• To edit an instrument method

 To open the Acquisition page

Click Acquisition in the Method View navigation pane.

 To specify acquisition information for a method 

1. In the Lab Name box, type the name to be displayed at the top of each printed, saved, or 
exported report.

The default name is Default Laboratory.

2. In the Assay Type box, type the assay type to be targeted by the method.

3. From the Injection Volume box, select an injection volume (between 0.1 and 2000 μL) to 
be used for sample injection.

Use the up/down arrows to change the volume in increments/decrements of 1 μL, or use 
the keyboard to enter non-integer injection volumes. 

4. From the Mass Precision box, select a precision value (between 2 and 6 inclusive) as the 
number of decimal places to be used in reports and in peak and spectrum displays. 

IMPORTANT  The application uses this injection volume in the method, not the 
injection volume from the instrument method.

Available only when you activate the 
Intelligent Sequencing option in 
the Configuration console
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5. From the Ion Range Calc Method list, select a method for calculating the ion ratio range 
windows.

When you select Level, the application displays a Use Level list where you can choose a 
calibration level. To define the available calibration levels on the Compounds page, see 
Calibration Levels.

 To edit an instrument method

1. From the Instrument Method list on the Acquisition page, select an instrument method. 

2. To edit the selected instrument method, click Edit.

The Thermo Instrument Setup window opens. This example of an instrument setup 
shows multiple configured instruments.

Figure 45. Thermo Instrument Setup window

3. Edit the values on the instrument page for your instrument.

4. From the main menu in the Thermo Instrument Setup window, choose File > Save and 
then choose File > Exit.

The application returns you to the Acquisition Page. 

5. To update any changes to the instrument method after you created this quantitation 
method, click Update.
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The Update Instrument Method? dialog box opens.

6. Choose one of the following options:

• Send to System Methods: Overwrites the instrument method in the 
C:\TraceFinderData\4.0\Methods folder with the current instrument method.

• Get from System Methods: Overwrites the current instrument method with the 
instrument method in the C:\TraceFinderData\4.0\Methods folder.

• Cancel: Makes no changes to the instrument method in the current quantitation 
method.

Acquisition Page 

Use the features on the Acquisition page to define basic information about the method.

Figure 46. Acquisition page for a quantitation method

Table 25. Acquisition page parameters  (Sheet 1 of 2)

Parameter Description

Lab Name Specifies the laboratory name to be displayed at the top of each 
printed, saved, or exported report. 

Default: Default Laboratory

To specify this default laboratory name, see Specifying Application 
Defaults.
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Editing the Processing Page 

The Quantitation – Processing Page defines basic information about the method.

Follow these procedures:

• To open the Processing page

• To set automated background subtraction options

• To specify mass tolerance

• To specify a threshold override

• To specify qualitative peak processing parameters

Assay Type Specifies the name for the analysis type to be targeted by the 
method. The assay type associates the method with the analysis of a 
compound or specific class of compounds (for example, you might 
use an assay type of PAH for the analysis of Polynuclear Aromatic 
Hydrocarbons).

Injection Volume Specifies the system uses the injection volume (in μL) for sample 
injection. For a more detailed explanation, refer to the 
documentation for the autosampler.

The injection volume in the method overrides the injection volume 
in the instrument method. The injection volume in the batch 
overrides the injection volume in the method.

Valid range: 0.1 through 2000 μL
Mass Precision Specifies the number of decimal places used in reports and in peak 

and spectrum displays. 

Valid range: Integers from 2 through 6, inclusive.
Use Level Specifies a calibration level.
Instrument Method Specifies the instrument method used for acquiring samples.
Edit Opens the Thermo Xcalibur Instrument Setup window where you 

can edit the instrument method.
Update Specifies one of the following:

Send to System Methods: Overwrites the system method in the 
C:\TraceFinderData\4.0\Methods folder with the current 
instrument method.

Get from System Methods: Overwrites the current instrument 
method with the system method in the 
C:\TraceFinderData\4.0\Methods folder.

Table 25. Acquisition page parameters  (Sheet 2 of 2)

Parameter Description
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• To specify library selection

• To add unknown screening to the method

 To open the Processing page

Click Processing in the Method View navigation pane. See Processing Page.

 To set automated background subtraction options

1. In the Background Subtraction Range Option list, select how you want the subtraction 
range determined from the following options:

• Before Peak: Averages and subtracts a specified number of scans before the apex of 
the peak.

• After Peak: Subtracts a specified number of scans after the apex of the peak.

• Both Sides of Peak: Subtracts a specified number of scans from each side of the apex 
of the peak.

When you create a reference spectrum with background subtraction, the application uses 
the selected method to conduct background subtraction of peak spectra during 
quantitative processing. The application then reports the background-subtracted 
reference spectrum (indicated with BS in the scan heading) as the last scan for each 
compound in the Quantitation Report - 2 report. It does not use background subtraction 
with qualitative processing. 

2. In the Number of Scans to Subtract box, enter a number.

The application subtracts this number of scans from the background after averaging. 
When you select the Both Sides of Peak option, the application subtracts this number of 
scans from each side of the peak.

Available only when you activate the 
Intelligent Sequencing option in 
the Configuration console
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3. In the Stepoff Value box, enter a number.

The application uses this offset value to average and subtract scans that are not adjacent to 
the apex of the peak, as in this example:

Before Peak example:

When the Number of Scans to Subtract equals 3 and the Stepoff Value equals 5, the 
application ignores the first 5 scans to the left of the peak and applies the averaging and 
subtraction to the 6th, 7th, and 8th scans to the left of the peak.

After Peak example:

When the Number of Scans to Subtract equals 3 and the Stepoff Value equals 5, the 
application ignores the first 5 scans to the right of the peak and applies the averaging and 
subtraction to the 6th, 7th, and 8th scans to the right of the peak.

Both Sides of Peak example:

When the Number of Scans to Subtract equals 3 and the Stepoff Value equals 5, the 
application ignores the first 5 scans to the left of the peak and the first 5 scans to the right 
of the peak. Then it applies the averaging and subtraction to both the 6th, 7th, and 8th 
scans to the left of the peak and the 6th, 7th, and 8th scans to the right of the peak.

 To specify mass tolerance

1. Select the units of measure that you want to use. 

2. Specify the number of millimass units or parts per million to use as the m/z ± tolerance 
value.

The application applies this mass tolerance to the extracted chromatograms.

 To specify a threshold override

To set a threshold override and include only peaks with areas above this designated 
threshold, do the following:

a. Select the Threshold Override check box.

b. In the associated box, type the threshold as an area value.

This threshold overrides the Response Threshold value set in the compound 
database. The application ignores the peaks with areas below your specified threshold.
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 To specify qualitative peak processing parameters

1. To indicate whether to select peaks by relative height or area and specify the percentage of 
the largest peak that results in compound selection, select the Enable Peak Threshold 
check box. 

To consider a peak for a processing method, the application uses the Enable Peak 
Threshold filter to determine which peaks meet the specified percentage of the height or 
area of the largest peak. 

2. To display a specific number of the largest peaks by height or area, select the Only Select 
Top Peaks check box and enter the number of peaks to display.

3. To use the Genesis algorithm to match internal standards, select the Use Genesis 
Algorithm for Qual Processing check box and specify a value for internal standard 
matching. 

The application uses the Genesis algorithm to match internal standards in a range 
plus/minus the value that you specify. For additional information about the Genesis 
algorithm, see Genesis Detection Method.

4. Select or clear the Exclude Matching Quan Peaks check box and specify a value for the 
exclusion window.

The application excludes target peaks in a range plus or minus the value that you specify.

5. To process samples that include data-dependent scans, select the Use Data Dependent 
Scans check box.

When you process a sample using this feature, the application uses the TIC trace to find 
all data-dependent full scans, lists them, and performs a library search against the 
data-dependent MS/MS or MSn scan.

This option constrains the Data Review to only data-dependent scan spectra. 

In addition to the peak information, the TIC Report and TIC Summary Report display 
information about the data-dependent filtered data. 

6. To indicate whether to select peaks above a minimum percentage of the nearest internal 
standard peak that results in compound selection, select the Enable ISTD Threshold 
check box and specify a minimum percentage. 

To consider a peak for a processing method, the application uses the Enable ISTD 
Threshold filter to determine which peaks meet the specified percentage of the height of 
the nearest internal standard peak. 

When you select the Enable ISTD Threshold check box, the method ignores values set 
for the Enable Peak Threshold parameter. 

Note  When you create a method with the Method Forge, the application ignores the 
parameters in the Qualitative Peak Processing area.
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 To specify library selection

1. In the Library Selection area, select the check box for each library that you want to search.

All libraries loaded on your instrument are displayed in the Library Selection area. 

2. To limit the number of matches returned when the system searches a spectrum against the 
selected libraries, set a value in the Limit Library Hits box.

3. To specify how to sort the library searches, select a value from the Best Match Method 
list.

 To add unknown screening to the method

1. Select the Include Unknown Screening check box.

The application adds the Unknown Screening features to the Method View navigation 
pane.

2. To specify unknown screening settings for peaks, libraries, databases, elements, and 
ChemSpider™ searches, click Processing.

For further instructions, see Editing the Processing Pages.

3. To specify unknown screening peak detection settings, click Peak Detection Settings.

For further instructions, see Editing the Peak Detection Settings Page.

The application indicates that a quantitation method includes unknown screening 
features in the following locations:

• In the Batch View in the Analysis mode, when you create a batch using a quantitation 
method, the title bar indicates that the method includes unknown screening features.

• In the Analysis navigation pane, the application displays access to local methods for 
both quantitation and unknown screening.

IMPORTANT   The Include Unknown Screening option is available only when you 
select the Allow Unknown Screening option in the application configuration console. 
See Processing Options.
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• In the Submit Options dialog box, when you submit a batch, the Process Data area 
shows all available process data for the batch.

You can select the detection options for each processing method that you want to use 
when you submit the batch.

Processing Page 

Use the features on the Processing page to define basic information about the method.

Figure 47. Processing page for a quantitation method
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Table 26. Processing page parameters  (Sheet 1 of 2)

Parameter Description

Background 
Subtraction Range 
Option

Specifies the range used for background subtraction. 

Valid values: None, Before Peak, After Peak, Both Sides of Peak
Default: None

Number of Scans to 
Subtract

Valid values: Even numbered integers
Default: 0

Stepoff Value Offset from the selected peak to the first subtracted peak.
Mass Tolerance Specifies the m/z ± tolerance value in MMU or PPM. 

Valid range: 0.1 through 50 000
• MMU (millimass units): MMU is a static calculation to the 

extracted mass.
• PPM (parts per million): PPM is a variable calculation 

dependent on the actual mass. The smaller the mass, the 
narrower the tolerance range. The larger the mass, the wider the 
tolerance range.

The default value and units are specified in the Configuration 
Console. See Specifying Default Peak Detection Parameters.

Include Data 
Dependent Filters

Specifies that the method includes data-dependent filters. Available 
only for quantitation methods.

Threshold Override Overrides the Response Threshold value set in the compound 
database. The application ignores the peaks with areas below this 
specified threshold.

Valid range: 1000 through 1 000 000 000
Default: 5000

Qualitative Peak Processing

Enable Peak 
Threshold 

Specifies whether to select peaks by relative height or area and the 
percentage of the highest peak that results in compound selection.

Only Select Top 
Peaks 

Displays a specific number of the largest peaks by height or area.

Exclude Matching 
Quan Peaks

Exclusion 
Window

Compares the retention time of the internal standard in the method 
to the found retention time of the internal standard in the library 
search and excludes peaks outside the Exclusion Window range. 

Defines a range plus/minus the Exclusion Window value that you 
specify.

Use Data Dependent 
Scans

Constrains the Data Review to only data-dependent scan spectra. In 
addition to the peak information, the TIC Report and TIC 
Summary Report display information about the data-dependent 
filtered data.
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Editing the Compounds Page 

Use the Compounds page to set all parameters for identifying, detecting, and quantifying the 
target compound list. 

 To open the Compounds page

Click Compounds in the Method View navigation pane.

From the Compounds page of the Method View, you can access the following pages:

• Acquisition List

• Identification

• Detection

• Calibration

• Calibration Levels

Enable ISTD 
Threshold

% of Internal 
Standard

Specifies that, when identifying a peak, qualitative peak processing 
use the minimum threshold specified as a percentage of the nearest 
internal standard peak, rather than the threshold specified in the 
Enable Peak Threshold parameter in the method template.

Percentage of the nearest internal standard peak to use as the 
minimum threshold for identifying a peak.

Library Selection Specifies the libraries to use for qualitative peak processing.
Limit Library 
Hits

Specifies the number of matches returned when the system searches a 
spectrum against the selected libraries.

Best Match 
Method

Specifies how to sort the library searches. 

Valid values: Search Index, Reverse Search Index, Match Probability
Unknown Screening

Include Unknown 
Screening

Adds unknown screening features to the quantitation method.

Table 26. Processing page parameters  (Sheet 2 of 2)

Parameter Description
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• Chk Std Levels

• Real Time Viewer

Of these pages, the Identification, Calibration, Calibration Levels, and Chk Std Levels pages 
use a right-click shortcut menu. See Using the Shortcut Menu Commands.

Acquisition List 

The Acquisition List page displays all compounds defined for the current method in a display 
similar to the Compound Database view. From the Acquisition List Page, you can add 
additional compounds from the Compound Database or delete compounds from the method.

For detailed descriptions of all the features in the Compound Database views, see Working 
with a Compound Database View for Small Molecules or Working with a Compound 
Database View for Peptides.

 To remove a compound from the method

1. Select the compound in the Compound list.

2. Click the Remove Compound icon, .

3. To confirm that you want to delete the selected compound, at the prompt, click OK.

The application removes the selected compound and all its peak information.

4. To remove multiple compounds, use the CTRL or SHIFT keys.

The application confirms that you want to remove the selected compounds.

 To add a compound to the method

1. Click the Add Compound from Compound Database icon, .

The Select Compounds from Database dialog box opens, listing all the compounds 
defined in the compound database. You cannot edit the compound data from here; you 
can only choose which compounds you want to include in your method.

2. Click Browse and locate the compound database that you want to use.

3. Select the check box for each of the compounds that you want to add to the method.

Compounds that already exist in the method are grayed out. When you select one of these 
compounds, the application reminds you that it will overwrite the existing compound. 

4. To select all compounds in the database, select the Select All check box at the top of the 
list.

5. (Optional) To associate a raw data file with the method, do the following:

a. Select the Associate Raw File check box.
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The application adds the appropriate options to the Select Compounds from 
Database dialog box.

Figure 48. Associate Raw File options on the Select Compounds … dialog box.

b. Browse to a raw data file to associate with the method (or select from the list of 
previously associated raw data files) and open the file.

To assure that this raw data file is always available to the method (for example, if you 
move the method to another system), the application saves the raw data file in the 
Methods folder:

…\TraceFinderData\4.0\Methods\Methodname

c. Select the update options to use for creating your method:

• Update Instrument/Trace Selections: Reads the Detector and Trace options 
from the associated raw data file. On the Detection page, only detector types and 
traces that are defined in the raw data file are available. For detailed descriptions 
of the available Detector and Trace values, see Trace Selection.

• Update Target Ion Ratio Values: Reads the ion ratio values from the associated 
raw data file.

• Update Scan Filters for All Peaks: 

– Yes, All Peaks updates all peaks to use the scan filters from the associated raw 
data file. 

– Yes, Only Peaks Without Filters updates only peaks without scan filters to 
use the scan filters from the associated raw data file; it does not override any 
existing scan filter.

• Automatically Set Reference Spectrum: Reads a reference spectrum from the 
associated raw data file.

Browse to a data file.

Select a previously associated data file.
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When you also select Yes, with Background Subtraction, the application uses the 
background-subtracted reference spectrum during quantitative processing and 
reports the background-subtracted reference spectrum (indicated with BS in the 
scan heading) as the last scan for each compound in the Quantitation Report - 2 
report.

• Order by Intensity: Reads intensity values from the associated raw data file and 
lists the peaks with the greatest intensity first. Intensity is based on either peak 
height or peak area, as specified for the method (see Detection Algorithm).

– When a compound contains only target peaks, the most intense ion is listed 
first. 

– When a compound contains both target peaks and confirming peaks, the 
most intense target peak is listed first, followed by its ordered confirming 
peaks. The second most intense target peak is listed next followed by its 
confirming peaks, and so forth.

– When you also select the Update Target Ion Ratio Values option, the 
application orders the ions by intensity first and then updates the target ion 
ratios. 

Options that are set to No use the standard values in the method. 

6. Click Add Selected Compounds to Method (or Add Selected Compounds to Method 
and Associate Raw File).

The application adds the selected compounds to the method and (optionally) associates 
the specified raw data file. 

Note  The background subtraction option is available only when you select a 
background subtraction method on the Acquisition page in the method. See 
Editing the Acquisition Page.

Note  You can use the Order by Intensity option with required confirmation 
criteria only when all peaks are target peaks. Otherwise, the application 
ignores this option. See To specify confirmation criteria for compounds. 

Note  If you do not associate a raw data file, you might not see any peaks.
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Acquisition List Page 

Use the features on the Acquisition List page to display all compounds defined for the 
method.

Figure 49. Acquisition List page
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Identification 

The Identification Page lists the compounds that are targeted for analysis, reporting, and other 
compound-specific values. 

 To filter the displayed compounds

From the Show list, select the type of compounds that you want to display in the 
compounds list.

Identification Page 

Use the features on the Identification page to display all compounds targeted by the method.

Figure 50. Identification page

 

Compound type Description

Quan Compounds Displays only quantitation compounds, such as target 
compounds and internal standards. 

Target Compounds Displays only target compounds.

Internal Standards Displays only internal standard compounds.

Table 27. Identification page parameters  (Sheet 1 of 2)

Parameter Description

RT Retention time. The time after injection when the compound elutes. The total time that the 
compound is retained on the column. The application uses the RT and Window values to 
determine the start and stop time for the acquisition. 

Valid range: 0.00 through 999.00
Start time = RT – (Window/2)
Stop time = RT + (Window/2)
Start and stop range: 0.00 through 999.00
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Compound A list of identified compounds. To customize the compound names, click the cell and type a 
new name. To display a filtered list of compounds, use the Show list.

Compound Type Displays the compound types as Target Compound or Internal Standard. The application 
uses target compounds and internal standards in quantitative analysis.

Active Identifies each compound to be included in data review and reporting. By default, all added 
compounds are set to active. This active or inactive setting populates the Batch View and 
Data Review view in the Analysis mode. 

CAS No The Chemical Abstract Service (CAS) number that the application matched with each 
compound. To change or add a number, click the CAS No cell and enter a new number.

LIMS ID Laboratory Information Management System identification number.

Use as RT Reference When performing peak detection with retention time standards, the application first 
identifies those compounds identified as retention time standards and then uses their 
observed retention times to adjust any associated target compound.

Reference Compound To be used for retention time adjustment for a compound. This list includes all compounds 
that are selected in the Use as RT Reference column. 

Shortcut menu
The Identification page uses a right-click shortcut menu. See Using the Shortcut Menu 
Commands.

Table 27. Identification page parameters  (Sheet 2 of 2)

Parameter Description



4 Using the Method Development Mode for Quantitation Methods
Editing a Quantitation Method

146 TraceFinder Lab Director User Guide Thermo Scientific

Detection 

Use the Detection page to customize peak detection and integration for any ions that define 
peaks and compounds.

Figure 51. Detection page 

Table 28.  Detection page panes  (Sheet 1 of 2)

Pane Description

Compounds
Lists all compounds in the method. The Compound list uses a right-click shortcut menu. 
See Using the Shortcut Menu Commands.

Peaks Displays a chromatogram for the target peak and its confirming peaks. 

Peaks panePeak Settings pane

Selected compound

Peak settings 
menu icon
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On the Detection page, you can configure how the application detects and integrates 
characteristic ions for targeted compounds. You can also edit the list of characteristic ions for a 
specific compound. Refining these parameters in the method for each compound and its ions 
can reduce the degree of manual integration that would otherwise be required. 

You can change the parameters used to identify a target peak, mass range, or confirming peak. 
The application automatically uses the first match it finds as the compound name, the base 
peak of the mass spectrum as the target peak, and the second and third largest ions as the 
confirming peaks. 

Follow these procedures:

• To display only confirmed peaks

• To specify confirmation criteria for compounds

• To change the displayed information for detected peaks

• To add a new compound to the method

• To associate compounds from a raw data file

• To change the compound reference spectrum

• To replace a quantitation mass

• To add a mass to the existing quantitation mass ranges

• To add a target peak

• To add a spectral peak as a new compound

• To replace a target peak with a confirming peak

Peak Settings
The application displays the following additional pages when your method contains the 
relevant parameters: Retention Times, Trace Selection, Detection Algorithm, Suitability, 
Spectrum, NIST, mzVault, Isotopes, and Ratios.

Retention Times Defines the retention time and window for a target peak.

Trace Selection Displays a combination of the detector, trace, and filter values used for the compound.

Detection Algorithm Defines the peak detection algorithm and its options.

Suitability Determines if the column is degrading and identifies suspicious peaks eluting at the same 
time as the target compound.

Spectrum Defines a reference mass spectrum for a target peak or compound.

NIST Defines the criteria for NIST library matching.

mzVault Defines the criteria for library matching.

Isotopes Defines the criteria for identifying an isotope peak.

Ratios Defines the criteria for evaluating, confirming, or qualifying ions.

Table 28.  Detection page panes  (Sheet 2 of 2)

Pane Description
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• To set a confirming peak as an additional target peak

• To add a trace to the Real Time Status pane

• To remove a confirming peak

• To save the new method 

 To display only confirmed peaks

In the Compounds pane, select the Show Confirmed Peaks Only check box.

The Compounds pane displays only compounds that meet all required criteria. 

 To specify confirmation criteria for compounds

Select the Required check box for any of the following Peak Settings pages:

• NIST

• mzVault

• Isotopes 

• Suitability

• Ratios

• Trace Selection (for fragments only)

When peak detection finds a target peak at the specified location, it then confirms the 
peak by verifying these required criteria. If the target peak does not meet these criteria, 
then it is not confirmed. 

To display only confirmed peaks, select the Show Confirmed Peaks Only check box in 
the Compounds pane. 

Confirmed compounds are indicated in the Compound View in Data Review. 

Note  When you associate a raw data file, you can use the Order by Intensity option 
with required confirmation criteria only when all peaks are target peaks. Otherwise, 
the application ignores this option. See To specify confirmation criteria for 
compounds. 
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 To change the displayed information for detected peaks

1. Right-click the chromatogram plot for any of the target or confirming peaks and choose 
Peak Display Settings.

The Chromatogram Plot Settings dialog box opens.

Figure 52. Chromatogram Plot Settings dialog box

2. To change the label display, do the following:

a. Select the check box for the label that you want to display: peak retention time (RT), 
peak area (Area), peak height (Height), or signal-to-noise ratio (Signal to Noise).

b. To remove a label, clear the label check box.

Table 29.  Chromatogram Plot Settings dialog box parameters 

Parameter Description

Number of Rows Specifies the number of rows visible in the Peaks pane. When 
Number of Rows equals 1, the application scales the height of 
all chromatograms to fill the Y dimension of the Peaks pane. 

Default: 1

Number of Columns Specifies the number of columns visible in the Peaks pane. 
When Number of Columns equals 1, the application scales the 
width of all chromatograms to fill the X dimension of the Peaks 
pane.

Default: 3

Peak Plot Labels Displays or hides the following peak labels:
• RT
• Area
• Height
• Signal to Noise
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c. Click OK.

The application globally applies these label settings to all target peaks, confirming peaks, 
and internal standard peaks in the method. 

3. To change how many rows and columns you want to view at one time in the display, do 
the following:

a. Type a value for Number of Rows or Number of Columns.

b. Click OK.

c. Use the scroll bar to view peaks that are not visible in the Peaks pane.

These values do not change the number of rows (compounds) and columns (peaks) that 
are displayed in the Peaks pane. The default is one row and three columns.

 To add a new compound to the method

1. Select the Show Peak Creator Panel check box.

The Manual Peak Creator pane opens.

2. (Optional) Select a different Trace.

3. (Optional) Select a filter from the Filter list.

4. Click to select the peak in the chromatogram that represents the compound that you 
want to add to the method. 

5. Right-click and choose Add This Peak as New Compound.

The application performs a library search for the selected compound. The application 
uses the first match it finds as the compound name, the base peak of the mass spectrum as 
the target peak, and the second and third largest ions as the confirming peaks. 

• When the name of the first match does not exist in the method, the application adds 
this compound to the method and displays the name in the Compound list. You can 
now view and edit the parameters for this compound.

• When the name of the first match is already in the method, the Add New Compound 
dialog box opens. You cannot overwrite a compound name in the method. If the 
selected peak already exists in the method, you must give it a new name to add it to 
the method. Or, you can select a different compound to add to the method, 
following step 6 through step 8.
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Figure 53. Add New Compound dialog box

6. Do one of the following:

• Type a new name for the first matched compound.

The application displays a red warning when the selected compound name already 
exists in the method. You cannot overwrite the compound name, and you cannot 
create a duplicate name in the method. You must type a unique name.

–or–

• To use a compound other than the first matched compound, scroll to the spectrum 
for that compound and select its corresponding check box in the title bar of the 
spectrum pane.

7. In the Type of Compound to Add list, select a compound type.

8. Click OK.

Selected 
compound
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 To associate compounds from a raw data file

1. From the main menu, choose Method View > Associate a Raw Data File.

The Associate a Raw Data File dialog box opens.

2. Browse to a raw data file to associate with the method (or click the arrow and select from 
the list of previously associated raw data files) and open the file.

To assure that this raw data file is always available to the method (for example, if you 
move the method to another system), the application saves the file in the Methods folder:

…\TraceFinderData\4.0\Methods\Methodname

3. To update the target ion ratio values when you associate this raw data file, select the Yes 
option.

4. To update the scan filters when you associate this raw data file, select the Yes option.

5. To set a reference spectrum, do one of the following:

Select the Yes option.

–or–

Select the Yes, with Background Subtraction option.

The application uses the background-subtracted reference spectrum during quantitative 
processing and reports the background-subtracted reference spectrum (indicated with BS 
in the scan heading) as the last scan for each compound in the Quantitation Report - 2 
report.

Tip  You can add compounds from the current raw data file (begin at step 7), or you 
can associate another raw data file and add compounds from that file (begin at step 1).

Note  This option is available only when you select a background subtraction method 
on the Acquisition page in the method. See Editing the Acquisition Page.

Browse to a data file.

Select a previously associated data file.
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6. To read intensity values from the associated raw data file and order the peaks by intensity, 
select the Yes option.

7. Click OK.

The application displays the chromatographic and spectrum data for the compounds in 
the associated raw data file. 

8. Select a filter from the Filter list.

9. Click to select the peak in the chromatogram that represents the compound that you 
want to add to the method. 

10. Right-click and choose Add This Peak as New Compound.

The application performs a library search for the selected compound. The application 
uses the first match it finds as the compound name, the base peak of the mass spectrum as 
the target peak, and the second and third largest ions as the confirming peaks. 

• When the name of the first match does not exist in the method, the application adds 
this compound to the method and displays the name in the Compound list. You can 
now view and edit the parameters for this compound.

• When the name of the first match is already in the method, the Add New Compound 
dialog box opens. You cannot overwrite a compound name in the method. If the 
selected peak already exists in the method, you must give it a new name to add it to 
the method. Or, you can select a different compound to add to the method, 
following step 10 through step 12.

IMPORTANT  While the spectra pane displays the associated raw data file, you cannot 
display peak information for an original compound in the Compound list. You can 
display peak information only for compounds in the associated raw data file. To 
return the display functionality for all compounds in the method, save the method.
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Figure 54. Add New Compound dialog box

11. Do one of the following:

• Type a new name for the first matched compound.

The application displays a red warning when the selected compound name already 
exists in the method. You cannot overwrite the compound name, and you cannot 
create a duplicate name in the method. You must type a unique name.

–or–

• To use a compound other than the first matched compound, scroll to the spectrum 
for that compound and select its corresponding check box in the title bar of the 
spectrum pane.

12. In the Type of Compound to Add list, select a compound type.

13. Click OK.

Selected 
compound
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 To change the compound reference spectrum

1. Select the Show Peak Creator Panel check box.

The Manual Peak Creator pane opens.

2. In the chromatogram pane, click a peak.

The application displays the spectrum for the selected peak in the spectrum pane.

3. In the spectrum pane, right-click and choose Use This Spectrum for Compound 
Reference Spectrum.

 To replace a quantitation mass 

1. Select the Show Peak Creator Panel check box.

The Manual Peak Creator pane opens.

2. In the Manual Peak Creator pane, hold the cursor over a peak in the spectrum pane.

The red box indicates the selected peak.

3. Right-click and choose Set This Spectral Peak as Quan Value.

4. Choose either Don’t Update Ion Ratios or Update Ion Ratios Using This Spectrum.

You can see the updated ion ratios on the Ratios page for the confirming peaks.

 To add a mass to the existing quantitation mass ranges

1. Select the Show Peak Creator Panel check box.

The Manual Peak Creator pane opens.

2. In the spectrum pane, hold the cursor over a peak.
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The red box indicates the selected peak.

3. Right-click and choose Add This Spectral Peak to Existing Quan Ranges.

4. Choose either Don’t Update Ion Ratios or Update Ion Ratios Using This Spectrum.

The application adds the selected mass to the existing quantitation mass ranges to increase 
the signal. 

If you chose to update the ion ratios, you can see the updated ion ratios on the Ratios 
page for the confirming peaks.

 To add a target peak

1. Select the Show Peak Creator Panel check box.

The Manual Peak Creator pane opens.

2. In the spectrum pane, hold the cursor over a peak.

The red box indicates the selected peak.

3. Right-click and choose Add This Spectral Peak as New Quan Peak.

The application adds a new target peak to the compound.

4. To view the new target peak in the Peaks pane, use the vertical scroll bar or use the 
Chromatogram Plot Settings dialog box to add another row to the Peaks pane display.

You can use the shortcut menu in the spectrum pane for this new target peak to perform 
any of the tasks that you would perform on the original target peak.

 To add a spectral peak as a new compound

1. Select the Show Peak Creator Panel check box.

The Manual Peak Creator pane opens.

2. In the raw data file spectrum pane, hold the cursor over a peak.
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The red box indicates the selected peak.

3. Right-click and choose Add This Spectral Peak as New Compound.

The application performs a library search for the selected compound. The application 
uses the first match it finds as the compound name, the base peak of the mass spectrum as 
the target peak, and the second and third largest ions as the confirming peaks. 

When there are multiple matches, the Add New Compound dialog box opens. If the 
name of the first match is already in the library, the dialog box opens with the matching 
compound selected.

Figure 55. Add New Compound dialog box

4. (Optional) Make any of the following changes:

• Change the name for the compound in the Name of New Compound box.

• Use a compound other than the compound chosen by the application by scrolling to 
the spectrum for that compound and selecting the compound name in the title bar of 
the spectrum pane.
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• In the Type of Compound to Add list, select a compound type.

5. Click OK.

 To replace a target peak with a confirming peak

1. When you have multiple target peaks in the Peaks pane, select the target peak that you 
want to replace.

2. Right-click the confirming peak that you want to use as the target peak, and choose Swap 
with Target Peak.

The application swaps the target peak and the confirming peak. The application replaces 
all information for the target peak with information for the confirming peak. This 
includes the expected retention time that the confirming peak inherited from the original 
target peak. The original target peak replaces the confirming peak. The application 
recalculates the ratios for all confirming peaks.

 To set a confirming peak as an additional target peak

Right-click the confirming peak that you want to use as the new target peak and choose 
Promote to Separate Target Peak.

The application creates a new target peak, using information from the confirming peak. 
This includes the expected retention time that the confirming peak inherited from the 
original target peak. The application removes all references to the confirming peak from 
the method.

 To add a trace to the Real Time Status pane

Right-click the target peak or confirming peak that you want to add to the Real Time 
Status pane and choose Display in Real Time Viewer.

The application moves the peak to the Traces To Display in Real Time Viewer pane on 
the Real Time Viewer page. 

When you acquire samples with this method, the application displays the added trace in 
addition to the TIC in the Real Time Status pane.

 To remove a confirming peak

Right-click the confirming peak that you want to remove and choose Cut Confirming 
Peak.

Selected 
compound
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 To save the new method

1. Choose File > Save.

The Save Master Method dialog box opens.

2. Type a new name for the method and click Save, or type the name of an existing method 
to overwrite and click Overwrite.

The application saves the new method data in the following folder:

…\TraceFinderData\4.0\Methods 

Retention Times 

Use the features on the Retention Times page to define the expected retention time or a 
retention time range for a selected target peak.

Figure 56. Retention Times page for a target peak
 

Parameters for single 
RT detection types

Parameters for RT 
range detection types
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Table 30. Retention Times page parameters for target peaks (Sheet 1 of 2)

Parameter Description

Detection Type Single - Detected: (Default) Specified as a centered retention time 
window. The application integrates a distinct peak. In reports, the 
application displays the expected retention time and actual 
retention time values as Method RT and Detected RT, 
respectively. 

Range - Detected: Specified as a retention time start/end range. 

Range - Integrated: Specified as a retention time start/end range. 
The application integrates all peaks within the specified time 
range.

Expected RT Specifies the expected retention time in minutes for a single peak. 
Available only for the Single - Detected detection type. When you 
select this parameter:

• The specified retention time is required for confirming the 
peak.

• The application does not process the full trace. This speeds 
the processing time.

• The application also uses the Extraction Window parameter 
on the Detection Algorithm page.

Window (sec) Width of the window (in seconds) to indicate how far around the 
expected retention time the system looks for a peak apex. Available 
only for the Single - Detected detection type. 

Start/End RT (min) Beginning and ending retention time window that can encompass 
multiple peaks. Available only for the Range - Detected and the 
Range - Integrated detection types. When you change from a 
Single - Detected detection type, these values default to the 
previous beginning and ending time calculated from the Expected 
RT and Window values.

View Width (min) Viewable size of the ion chromatogram display. Changing the view 
width does not affect the peak detection process; the application 
uses it only for graphical display. When you select either Range - 
Detected or Range - Integrated as the detection type, you cannot 
select a View Width value less than the retention time range (end 
time minus start time).

Menu commands 

Apply Current Peak 
Settings to All Peaks in 
the Compound

Copies the View Width and Window values to all peaks for the 
compound and updates the compound. 

Available only when a compound has multiple peaks.
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Trace Selection 

Use the Trace Selection Pages for Target, Confirming, and Fragment Peaks pages to define the 
detector and filters for each chromatogram trace. 

Trace Selection parameters are different for target and confirming peaks, fragments, and mass 
spectrometer and analog detectors. See the following examples:

• Trace Selection page for a target peak using a mass spectrometer detector

• Trace Selection page for a target peak using an analog detector

• Trace Selection page for a confirming peak using a mass spectrometer detector

• Trace Selection page for a confirming peak using an analog detector

• Trace Selection page for fragments using a mass spectrometer detector

• Trace Selection page for fragments using an analog detector

Follow these procedures:

• To specify ranges of masses for detection and integration of target peaks

• To specify masses for detection and integration of confirming peaks

• To specify ranges of masses for detection and integration of fragments

• To specify an XIC scan filter

• To specify an MS filter

• To specify the minimum number of fragments

 To specify ranges of masses for detection and integration of target peaks 

1. Select a target peak in the Peaks pane.

2. Select MS from the Detector list.

3. Select Mass Range from the Trace list.

Apply Current Peak 
Settings to All Peaks in 
the Method

Copies the View Width and Window values to all peaks for the 
method and updates the method. 

Note  The parameters in the Mass Ranges area are available only when you set the 
Detector parameter to MS and the Trace parameter to Mass Range.

Table 30. Retention Times page parameters for target peaks (Sheet 2 of 2)

Parameter Description
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You can choose one of two methods for specifying the mass ranges. To specify a range 
around a center mass, follow step 3. To specify starting and ending values for mass ranges, 
follow step 4. 

4. To specify a center mass range, do the following:

a. Select the m/z option.

The application displays a table of center mass values.

b. (Optional) To create a new range, type a value in the m/z column of the last (empty) 
row and press ENTER.

The application adds a new empty row.

c. (Optional) Add as many center mass values as you want.

d. Select the Enable check box for each center mass that you want to use.

When you process a batch with this method, the application uses a range of one amu that 
is centered on the m/z value for each enabled mass.

5. To create a new range of masses, do the following:

a. Select the m/z Range option.

The application displays a table of mass range values.

b. (Optional) To create a new mass range, type values in the Start m/z and End m/z 
columns of the last (empty) row and press ENTER.

The application adds a new empty row.

c. (Optional) Add as many mass range values as you want.

d. Select the Enable check box for each mass range that you want to use.

When you process a batch with this method, the application sums the multiple ions 
specified by each enabled mass range.
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 To specify masses for detection and integration of confirming peaks 

1. Select a confirming peak in the Peaks pane.

2. Select MS from the Detector list.

3. Select Mass Range from the Trace list.

4. To specify a center mass range, type or select a value in the m/z box.

When you process a batch with this method, the application uses a range of one amu that 
is centered on the specified m/z value.

 To specify ranges of masses for detection and integration of fragments 

1. Select a fragment in the Peaks pane.

2. Select MS from the Detector list.

3. Select Mass Range from the Trace list.

4. (Optional) To create a new mass range, type values in the Start m/z and End m/z columns 
of the last (empty) row and press ENTER.

5. The application adds a new empty row.

6. (Optional) Add as many mass range values as you want.

7. In the Mass Ranges area, select the Enable check box for each mass range that you want 
to use.

When you process a batch with this method, the application sums the multiple ions 
specified by each enabled mass ranges.

 To specify an XIC scan filter 

1. Click the Scan Filter browse button, .

The XIC Filter Dialog Box opens.

2. Specify your filter options.

Note  The parameters in the Mass Ranges area are available only when you set the 
Detector parameter to MS and the Trace parameter to Mass Range.

Note  The parameters in the Mass Ranges area are available only when you set the 
Detector parameter to MS and the Trace parameter to Mass Range.
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3. Click OK.

The application updates the chromatogram data using the specified XIC filter options, 
and the Scan Filter box indicates the parameters of the specified XIC filter, as in this 
example:

XIC Filter Dialog Box

Use the XIC Filter dialog box to specify the parameters for an XIC filter.

Figure 57. XIC Filter dialog box

MS order 

Full-scan mode

Data-dependent filter

FTMS mass analyzer

Positive polarity
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Table 31. XIC Filter dialog box parameters 

Parameter Description

Mass Analyzer 
Type

Any: Any mass analyzer.
FTMS: Fourier Transform Mass Spectrometer
ITMS: Ion Trap Mass Spectrometer
Sector: Static electric or magnetic sectors, or a combination of the two
SQMS: Single Quad Mass Spectrometer
TOFMS: Time-of-Flight Mass Spectrometer
TQMS: Triple Quad Mass Spectrometer

MSX Any: For both MSX and non-MSX scans.
On: For only MSX scans.
Off: For only non-MSX scans.

Data 
Dependent

Any: For both data-dependent and non-data-dependent filters.
On: For only data-dependent filters.
Off: For only non-data-dependent filters.

MS Order Any: For any MS order.
MS: For only a single mass spec stage.
MS2-MS3: For only multiple mass spec stages.

Polarity Any: For both positive and negative scans.
Positive: For only positive scans.
Negative: For only negative scans. 

Scan Mode Any: For any scan mode.
Full: Full-scan mode
SIM: Selective ion monitoring
SRM: Selective reaction monitoring
CRM: Consecutive reaction monitoring
Q1MS: MS using quadrupole 1
Q3MS: MS using quadrupole 3

Activations Any: For any activation method.
CID: Collision-induced dissociation
MPD: Multiple photodissociation
ECD: Electron capture dissociation
PQD: Pulsed dissociation
ETD: Electron transfer dissociation
HCD: Higher energy collision-induced dissociation
This parameter is available only when the MS Order is set to MS2 or MS3.

First Precursor This parameter is available only when the MS Order is set to MS2 or MS3.

Second 
Precursor

This parameter is available only when the MS Order is set to MS3.

Mass Ranges Specifies a mass range in [x-y] format. Select from the list or type a custom 
range.
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 To specify an MS filter 

Select a filter from the Scan Filter list as shown in this example:

The Scan Filter list includes all available scan filters for the method.

The application updates the chromatogram data using the specified filter options, as in 
this example:

 To specify the minimum number of fragments

1. Select one of the following options on the Trace Selection page for fragments using a mass 
spectrometer detector:

• Global: Applies the detection settings to all peaks in the compound.

• By Peak: Applies the detection settings to only the selected fragment peak.

2. In the Minimum # of Fragments box, type the minimum number of fragments required 
to identify a compound.

The value you specify cannot be greater than the number of fragments defined in the 
compound database.

To identify a compound, the application must find at least this minimum number of 
fragments when you process a sample for fragment ions. 

MS order 

Scan mode

Polarity

 Centroid data

Activation method

Precursor

Product
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Trace Selection Pages for Target, Confirming, and Fragment Peaks

Figure 58. Trace Selection page for a target peak using a mass spectrometer detector
 

Figure 59. Trace Selection page for a target peak using an analog detector
 

Figure 60. Trace Selection page for a confirming peak using a mass spectrometer detector
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Figure 61. Trace Selection page for a confirming peak using an analog detector
 

Figure 62. Trace Selection page for fragments using a mass spectrometer detector
 

Figure 63. Trace Selection page for fragments using an analog detector
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Table 32. Trace Selection page parameters  (Sheet 1 of 3)

Parameter Description

Detector The available detector options depend on which detection options 
create the method. The method can use the standard options (all 
the listed options) or only the detection options used to acquire an 
associated raw data file. To specify the available detector options, 
see Specifying Default Peak Detection Parameters in Chapter 1, 
“Using the Configuration Console.” 

MS: Mass spectrometer that ionizes sample molecules and then 
separates the ions according to their mass-to-charge ratio (m/z).

PDA: Photodiode array detector providing a linear array of 
discrete photodiodes on an integrated circuit chip. It is placed at 
the image plane of a spectrometer to allow simultaneous detection 
of a range of wavelengths.

Analog: Supplemental detectors (for example, FID, ECD). When 
you select this detector, any reports that display a QIon value show 
the value as Analog and any reports that display spectra show the 
spectra as Not Available.

A/D card: If you have a detector not under data system control, 
you can capture the analog signal and convert it to digital using an 
interface box (for example, SS420X) for storage in the raw data 
file.

UV: A UV spectrophotometer (for variable-wavelength detection) 
or photometer (for single-wavelength detection) equipped with a 
low-volume flow cell. This detector detects analytes that readily 
absorb light at a selected wavelength.
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Trace Represents a specific range of the data. The application uses the 
trace to identify the characteristic ions for a compound. 

MS detector options: Mass Range, TIC, or Base Peak. When you 
select Mass Range, you are prompted to enter the start and end 
m/z values for the ranges.

PDA detector options: Spectrum Maximum, Wavelength Range, 
or Total Scan.

Analog detector options: Analog 1, Analog 2, Analog 3, or 
Analog 4. You can configure these channel names in your 
instrument configuration.

A/D Card detector options: AD Card ch1, AD Card ch2, 
AD Card ch3, or AD Card ch4. You can configure these channel 
names in your instrument configuration.

UV detector options: Channel A, Channel B, Channel C, or 
Channel D. You can configure these channel names in your 
instrument configuration.

Scan Filter Available only when you select the MS detector. Represents a 
particular data acquisition channel. 

For example, the filter option + c Full ms [35.00-500.00] 
represents a positive ion centroid signal acquired in single-stage, 
full-scan mode from m/z 35 to 500. 

Range Type Available only for target peaks when you select the Mass Range 
trace for an MS detector.

m/z: Specifies a single m/z value for detection and integration. The 
application uses a range of one amu centered on this value. 

m/z Range: Specifies a range of m/z values for detection and 
integration. The application sums the multiple ions specified by 
these ranges. 

Mass Ranges Specifies ranges of masses that the application uses to sum the 
multiple ions specified by each enabled mass range.

Minimum # of 
Fragments

(fragments only)

Specifies the minimum number of fragment masses that the 
application must identify when you process a sample for fragment 
ions. The value you specify for Minimum # of Fragments cannot 
be greater than the number of fragments defined in the compound 
database.

Table 32. Trace Selection page parameters  (Sheet 2 of 3)

Parameter Description
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Detection Algorithm 

Use the Detection Algorithm page to define the peak detection algorithm (sensitivity) and its 
options and to determine the area under a curve. There are four detection algorithms: 
Genesis, ICIS, Avalon, and Auto. Use the Genesis and Avalon detection algorithms for mass 
spectrometry detection. Use the ICIS detection algorithm primarily for analog detection. Use 
the Auto detection algorithm for a simplified analog detection.

On this page, you can specify how you want each mode to run. See the following for detailed 
descriptions of all the features on the Detection Algorithm page:

• For Genesis sensitivity, see Detection Algorithm Page for Genesis.

• For ICIS sensitivity, see Detection Algorithm Page for ICIS.

• For Avalon sensitivity, see Detection Algorithm Page for Avalon. 

• For Auto sensitivity, see Detection Algorithm Page for Auto.

Menu commands 

Apply Current Peak 
Settings to All Peaks in 
the Compound

Copies the peak settings to all peaks for the compound and 
updates the compound. 

Available only when a compound has multiple peaks.

Apply Current Peak 
Settings to All Peaks in 
the Method

Copies the peak settings to all peaks for the method and updates 
the method. 

Table 32. Trace Selection page parameters  (Sheet 3 of 3)

Parameter Description
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Detection Algorithm Page for Genesis

Use the Genesis detection algorithm for mass spectrometry detection. Specify applying the 
detection settings per peak or globally.

Figure 64. Detection Algorithm page for Genesis

Table 33. Detection Algorithm page parameters for Genesis  (Sheet 1 of 4)

Parameter Description

Global/By Peak Global: Applies the detection settings to all peaks in the compound.

By Peak: Applies the detection settings to only the selected target or confirming peak.

Detection Algorithm Specifies the Genesis peak detection algorithm.

Peak Detection Strategy 
(Analyte)

Highest Peak: Uses the highest peak in the chromatogram for component identification. 
Nearest RT: Uses the peak with the nearest retention time in the chromatogram for 
component identification.

Peak Detection Strategy 
(RT Reference)

Highest Peak: Uses the highest peak in the chromatogram for component identification. 
Nearest RT: Uses the peak with the nearest retention time in the chromatogram for 
component identification.

Peak Threshold Type Specifies whether to select peaks by height or area. 
Default for Global: Height
Default for By Peak: Area
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Threshold Specifies the peak threshold for peak integration. Peaks with area or height values less than 
this value are not integrated. Peaks with values greater than this value are integrated. 

Smoothing Determines the degree of data smoothing to be performed on the active component peak 
prior to peak detection and integration. 

Valid values: Any odd integer from 1 through 15 points
Default: 1f

Extraction Window 
(min)

(Target peaks only)

Specifies a window that limits how much of the entire trace the application processes. 
When cleared, the application processes the entire trace, which can slow processing.

Default: 3.00

Note   The application applies this same setting to all associated confirming peaks.

S/N Threshold Current signal-to-noise threshold for peak integration. Peaks with signal-to-noise values 
less than this value are not integrated. Peaks with signal-to-noise values greater than this 
value are integrated. 

Valid range: 0.0 through 999.0

Enable Valley Detection Uses the valley detection approximation method to detect unresolved peaks. This method 
drops a vertical line from the apex of the valley between unresolved peaks to the baseline. 
The intersection of the vertical line and the baseline defines the end of the first peak and 
the beginning of the second peak. 

Expected Width (sec) The expected peak width parameter (in seconds). This parameter controls the minimum 
width that a peak is expected to have if valley detection is enabled. 

With valley detection enabled, any valley points nearer than the expected width/2 to the top 
of the peak are ignored. If a valley point is found outside the expected peak width, the 
application terminates the peak at that point. The application always terminates a peak 
when the signal reaches the baseline, independent of the value set for the expected peak 
width. 

Valid range: 0.0 through 999.0

Constrain Peak Width Constrains the peak width of a component during peak integration of a chromatogram. 
You can then set values that control when peak integration is turned on and off by 
specifying a peak height threshold and a tailing factor. Selecting the Constrain Peak Width 
check box activates the Peak Height (%) and Tailing Factor options.

Peak Height (%) A signal must be above the baseline percentage of the total peak height (100%) before 
integration is turned on or off. This text box is active only when you select the Constrain 
Peak Width check box. 

Valid range: 0.0 through 100.0%

Table 33. Detection Algorithm page parameters for Genesis  (Sheet 2 of 4)

Parameter Description
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Tailing Factor A factor that controls how the application integrates the tail of a peak. This factor is the 
maximum ratio of the trailing edge to the leading side of a constrained peak. This text box 
is active only when you select the Constrain the Peak Width check box. 

Valid range: 0.5 through 9.0

Min Peak Height (S/N) Specifies the minimum peak height measured as a signal-to-noise ratio.

Valid range: 0.00 through 999.00
Default: 3.00

Peak S/N Cutoff The peak edge is set to values below this signal-to-noise ratio. 

This test identifies an edge of a peak when the baseline adjusted height of the edge is less 
than the ratio of the baseline adjusted apex height and the peak S/N cutoff ratio. 

When the S/N at the apex is 500 and the peak S/N cutoff value is 200, the application 
defines the right and left edges of the peak when the S/N reaches a value less than 200. 

Valid range: 50.0 through 10000.0

Valley Rise (%) The peak trace can rise above the baseline by this percentage after passing through a 
minimum (before or after the peak). 

This method drops a vertical line from the apex of the valley between unresolved peaks to 
the baseline. The intersection of the vertical line and the baseline defines the end of the 
first peak and the beginning of the second peak. 

When the trace exceeds the rise percentage, the application applies valley detection peak 
integration criteria. 

The application applies this test to both the left and right edges of the peak. 
The rise percentage criterion is useful for integrating peaks with long tails.

Valid range: 0.1 through 500.0

Valley S/N Specifies a value to evaluate the valley bottom. Using this parameter ensures that the 
surrounding measurements are higher. 

Valid range: 1.0 through 100.0
Default: 2.0

# Background Scans Number of background scans performed by the application.

Report Noise As Determines if the noise used in calculating S/N values is calculated using an RMS 
calculation or a peak-to-peak resolution threshold. Options are RMS or Peak to Peak.

Table 33. Detection Algorithm page parameters for Genesis  (Sheet 3 of 4)

Parameter Description
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By Peak menu commands 

Apply Current Peak 
Settings to All Peaks in 
the Method

Updates all compounds in the method with the current settings on the Detection 
Algorithm page. These updates apply to both target and confirming peaks.

Apply Current Peak 
Settings to All Target 
Peaks in the Method

Updates all compounds in the method with the current settings on the Detection 
Algorithm page. These updates apply only to target peaks.

Apply Current Peak 
Settings to All Peaks 
with the Same Detection 
Algorithm

Uses the current settings on the Detection Algorithm page to update all compounds in the 
method that use the Genesis detection algorithm. These updates apply to both target and 
confirming peaks that use the Genesis detection algorithm.

Apply Current Peak 
Settings to All Peaks in 
the Compound 

Updates all peaks in the current compound with the current settings on the Detection 
Algorithm page. These updates apply to both target and confirming peaks.

Apply Current 
Extraction Window 
Settings to All Peaks in 
the Method

Updates all peaks in the current method with the current Extraction Window value on the 
Detection Algorithm page. These updates apply to both target and confirming peaks.

Global menu command 

Push Global Settings to 
All Peaks

Pushes the global settings to all peaks for the method and updates the method. 

Table 33. Detection Algorithm page parameters for Genesis  (Sheet 4 of 4)

Parameter Description
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Detection Algorithm Page for ICIS

Use the ICIS detection algorithm primarily for analog detection.

Figure 65. Detection Algorithm for ICIS

Table 34. Detection Algorithm page parameters for ICIS  (Sheet 1 of 4)

Parameter Description

Global/By Peak Global: Applies the detection settings to all peaks in the compound.

By Peak: Applies the detection settings to only the selected target or confirming peak.

Detection Algorithm Specifies the ICIS peak detection algorithm, used primarily with analog detectors.

Peak Detection 
Strategy (Analyte)

Highest Peak: Uses the highest peak in the chromatogram for component identification. 
Nearest RT: Uses the peak with the nearest retention time in the chromatogram for 
component identification.

Peak Detection 
Strategy (RT 
Reference)

Highest Peak: Uses the highest peak in the chromatogram for component identification. 
Nearest RT: Uses the peak with the nearest retention time in the chromatogram for 
component identification.

Peak Threshold Type Specifies whether to select peaks by height or area. 
Default for Global: Height
Default for By Peak: Area
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Threshold Specifies the peak threshold for peak integration. Peaks with area or height values less than 
this value are not integrated. Peaks with values greater than this value are integrated. 

Smoothing Determines the degree of data smoothing to be performed on the active component peak 
prior to peak detection and integration. 

Valid values: Any odd integer from 1 through 15 points
Default: 1

Extraction Window 
(min)

(Target peaks only)

Specifies a window that limits how much of the entire trace the application processes. When 
cleared, the application processes the entire trace, which can slow processing.

Default: 3.00

Note   The application applies this same setting to all associated confirming peaks.

The application also uses the default values for the following parameters for the Auto detection algorithm. The Auto 
detection page does not display these parameters. See Detection Algorithm Page for Auto.

Area Noise Factor The noise level multiplier used to determine the peak edge after the location of the possible 
peak. 

Valid range: 1 through 500
Default: 5

Peak Noise Factor The noise level multiplier used to determine the potential peak signal threshold.

Valid range: 1 through 1000
Default: 10

Baseline Window The application looks for a local minima over this number of scans.

Valid range: 1 through 500
Default: 40

Constrain Peak Width Constrains the peak width of a component during peak integration of a chromatogram. You 
can then set values that control when peak integration is turned on and off by specifying a 
peak height threshold and a tailing factor. Selecting the Constrain Peak Width check box 
activates the Peak Height (%) and Tailing Factor options.

Peak Height (%) A signal must be above the baseline percentage of the total peak height (100%) before 
integration is turned on or off. This text box is active only when you select the Constrain 
Peak Width check box. 

Valid range: 0.0 through 100.0%

Tailing Factor A factor that controls how the application integrates the tail of a peak. This factor is the 
maximum ratio of the trailing edge to the leading side of a constrained peak. This text box is 
active only when you select the Constrain the Peak Width check box. 

Valid range: 0.5 through 9.0

Table 34. Detection Algorithm page parameters for ICIS  (Sheet 2 of 4)

Parameter Description
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Min Peak Height (S/N) Specifies the minimum peak height measured as a signal-to-noise ratio.

Valid range: 0.00 through 999.00
Default: 3.00

Noise Method The options are INCOS or Repetitive.

INCOS: Uses a single pass algorithm to determine the noise level.

Repetitive: Uses a multiple pass algorithm to determine the noise level. In general, this 
algorithm is more accurate in analyzing the noise than the INCOS Noise algorithm, but the 
analysis takes longer. 

Min Peak Width The minimum number of scans required in a peak.

Valid range: 0 through 100 scans
Default: 3

Multiplet Resolution The minimum separation in scans between the apexes of two potential peaks. This is a filter 
to determine if two peaks are resolved.

Valid range: 1 through 500 scans
Default: 10

Area Tail Extension The number of scans past the peak endpoint to use in averaging the intensity.

Valid range: 0 through 100 scans
Default: 5

Area Scan Window The number of allowable scans on each side of the peak apex. A zero value defines all scans 
(peak-start to peak-end) to be included in the area integration. 

Valid range: 0 through 100 scans
Default: 0

RMS Specifies that the application calculates noise as RMS. By default, the application uses Peak 
To Peak for the noise calculation and automatically selects RMS if you manually determine 
the noise region.

By Peak menu commands 

Apply Current Peak 
Settings to All Peaks in 
the Method

Updates all peaks in the current compound with the current settings on the Detection 
Algorithm page. These updates apply to both target and confirming peaks.

Apply Current Peak 
Settings to All Peaks 
with the Same 
Detection Algorithm

Uses the current settings on the Detection Algorithm page to update all compounds in the 
method that use the ICIS detection algorithm. These updates apply to both target and 
confirming peaks that use the ICIS detection algorithm.

Table 34. Detection Algorithm page parameters for ICIS  (Sheet 3 of 4)

Parameter Description
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Detection Algorithm Page for Avalon

Use the Avalon detection algorithm for mass spectrometry detection.

Figure 66. Detection Algorithm page for Avalon

Apply Current Peak 
Settings to All Peaks in 
the Compound 

Updates all compounds in the method with the current settings on the Detection Algorithm 
page. These updates apply to both target and confirming peaks.

Global menu command 

Push Global Settings to 
All Peaks

Pushes the global settings to all peaks for the method and updates the method. 

Table 34. Detection Algorithm page parameters for ICIS  (Sheet 4 of 4)

Parameter Description

Table 35. Detection Algorithm page parameters for Avalon  (Sheet 1 of 2)

Parameter Description

Global/By Peak Global: Applies the detection settings to all peaks in the compound.

By Peak: Applies the detection settings to only the selected target or confirming peak.

Detection Algorithm Specifies the Avalon peak detection algorithm. 

Peak Detection 
Strategy (Analyte)

Highest Peak: Uses the highest peak in the chromatogram for component identification. 
Nearest RT: Uses the peak with the nearest retention time in the chromatogram for 
component identification.

Peak Detection 
Strategy (RT 
Reference)

Highest Peak: Uses the highest peak in the chromatogram for component identification. 
Nearest RT: Uses the peak with the nearest retention time in the chromatogram for 
component identification.
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Avalon Event List

The event list includes both user-defined and noneditable default events. The application 
displays the default events when you choose Avalon sensitivity. You cannot delete these events 
or change their time or values. See Avalon Event List dialog box parameters. For a detailed list 
of events and value ranges, see Event types.

Peak Threshold Type Specifies whether to select peaks by height or area. 
Default for Global: Height
Default for By Peak: Area

Threshold Specifies the peak threshold for peak integration. Peaks with area or height values less than 
this value are not integrated. Peaks with values greater than this value are integrated. 

Smoothing Determines the degree of data smoothing to be performed on the active component peak 
prior to peak detection and integration. 

Valid values: Any odd integer from 1 through 15 points
Default: 1

Extraction Window 
(min)

(Target peaks only)

Specifies a window that limits how much of the entire trace the application processes. When 
cleared, the application processes the entire trace, which can slow processing.

Default: 3.00

Note   The application applies this same setting to all associated confirming peaks.

Autocalc Initial Events Automatically calculates the events in the Event list.

Edit Opens the Avalon Event List dialog box.

By Peak menu commands 

Apply Current Peak 
Settings to All Peaks in 
the Method

Updates all peaks in the current compound with the current settings on the Detection 
Algorithm page. These updates apply to both target and confirming peaks.

Apply Current Peak 
Settings to All Peaks 
with the Same 
Detection Algorithm

Uses the current settings on the Detection Algorithm page to update all compounds in the 
method that use the ICIS detection algorithm. These updates apply to both target and 
confirming peaks that use the ICIS detection algorithm.

Apply Current Peak 
Settings to All Peaks in 
the Compound 

Updates all compounds in the method with the current settings on the Detection Algorithm 
page. These updates apply to both target and confirming peaks.

Global menu command 

Push Global Settings to 
All Peaks

Pushes the global settings to all peaks for the method and updates the method. 

Table 35. Detection Algorithm page parameters for Avalon  (Sheet 2 of 2)

Parameter Description
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Figure 67. Avalon Event List dialog box

Table 36. Avalon Event List dialog box parameters 

Parameter Description

Time (Min) Specifies the start time of the event.
Event Specifies the type of event. For a detailed list of events and value 

ranges, see Event types.
Value Specifies the value of the event.
Add Adds a new event to the list with the current Time/Event/Value 

parameters.
Delete Removes the selected Time/Event/Value parameter from the event 

list.
Change Applies the current parameter values.
Cancel Closes the dialog box without making any changes. Any additions, 

deletions, or changes revert to their original state.
Apply Closes the dialog box.
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Figure 68. Event types

Table 37. Event type descriptions  (Sheet 1 of 2)

Event type Description

Start Threshold Specifies the threshold at the start of a peak. The Start Threshold is 
directly related to the RMS noise in the chromatogram.

Valid range: 0 through 999 999 999
End Threshold Specifies the threshold at the end of a peak. The End Threshold is directly 

related to the RMS noise in the chromatogram.

Valid range: 0 through 999 999 999
Area Threshold Controls the area cutoff. Any peaks with a final area less than the area 

threshold will not be detected. This control is in units of area for the data. 

Valid range: 0 through 999 999 999
P-P Threshold The peak-to-peak resolution threshold controls how much peak overlap 

must be present before two or more adjacent peaks create a peak cluster. 
Peak clusters have a baseline drop instead of valley-to-valley baselines. 
Specified as a percent of peak height overlap.

Valid range: 0.1 through 99.99
Negative Peaks Permits detection of a negative going peak. Automatically resets after 

finding a negative peak.

Valid values: On or Off
Bunch Factor Specifies the number of points grouped together during peak detection. 

This event controls the bunching of chromatographic points during 
integration and does not affect the final area calculation of the peak. A 
high bunch factor groups peaks into clusters.

Valid range: 0 through 999
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Tension Controls how closely the baseline should follow the overall shape of the 
chromatogram. A lower tension traces the baseline to more closely follow 
changes in the chromatogram. A high baseline tension follows the baseline 
less closely, over longer time intervals. 

Valid range: 0 through 999.99 minutes
Tangent Skim Using this event, you can tangent skim any peak clusters. By default, it 

chooses the tallest peak in a cluster as the parent. You can also identify 
which peak in the cluster is the parent. Tangent skim peaks are detected 
on either side (or both sides) of the parent peak. Tangent skim 
automatically resets at the end of the peak cluster.

Valid range: 0 through 1
Shoulders On Allows peak shoulders to be detected (peaks which are separated by an 

inflection rather than a valley) Sets a threshold for the derivative.
Shoulders Off Disables peak shoulder detection.

Valid range: 0 through 50
Force Cluster 
On

Force the following peaks to be treated as a cluster (single peak).

Force Cluster 
Off

End the forced clustering of peaks.

Disable Cluster 
On

Prevent any peaks from being clustered.

Disable Cluster 
Off

Permit clusters to occur again.

Table 37. Event type descriptions  (Sheet 2 of 2)

Event type Description



4 Using the Method Development Mode for Quantitation Methods
Editing a Quantitation Method

184 TraceFinder Lab Director User Guide Thermo Scientific

Detection Algorithm Page for Auto

Use the Auto detection algorithm primarily for analog detection.

Figure 69. Detection Algorithm for Auto

Table 38. Detection Algorithm page parameters for Auto  (Sheet 1 of 2)

Parameter Description

Global/By Peak Global: Applies the detection settings to all peaks in the 
compound.

By Peak: Applies the detection settings to only the selected target 
or confirming peak.

Detection Algorithm Specifies the Auto peak detection algorithm that is used 
primarily with analog detectors. The Auto algorithm uses 
parameters that are identical to ICIS parameters; however, you 
cannot edit most of the parameters. These parameters use default 
values and are not displayed on the Auto detection page. See 
Detection Algorithm Page for ICIS.

Peak Detection Strategy 
(Analyte)

Highest Peak: Uses the highest peak in the chromatogram for 
component identification. 
Nearest RT: Uses the peak with the nearest retention time in the 
chromatogram for component identification.

Peak Detection Strategy 
(RT Reference)

Highest Peak: Uses the highest peak in the chromatogram for 
component identification. 
Nearest RT: Uses the peak with the nearest retention time in the 
chromatogram for component identification.
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Peak Threshold Type Specifies whether to select peaks by height or area. 
Default for Global: Height
Default for By Peak: Area

Threshold Specifies the peak threshold for peak integration. Peaks with area 
or height values less than this value are not integrated. Peaks 
with values greater than this value are integrated. 

Smoothing Determines the degree of data smoothing to be performed on 
the active component peak prior to peak detection and 
integration. 

Valid values: Any odd integer from 1 through 15 points
Default: 1

Extraction Window 
(min)

(Target peaks only)

Specifies a window that limits how much of the entire trace the 
application processes. When cleared, the application processes 
the entire trace, which can slow processing.

Default: 3.00

Note   The application applies this same setting to all 
associated confirming peaks.

By Peak menu commands 

Apply Current Peak 
Settings to All Peaks in 
the Method

Updates all peaks in the current compound with the current 
settings on the Detection Algorithm page. These updates apply 
to both target and confirming peaks.

Apply Current Peak 
Settings to All Peaks with 
the Same Detection 
Algorithm

Uses the current settings on the Detection Algorithm page to 
update all compounds in the method that use the ICIS detection 
algorithm. These updates apply to both target and confirming 
peaks that use the ICIS detection algorithm.

Apply Current Peak 
Settings to All Peaks in 
the Compound 

Updates all compounds in the method with the current settings 
on the Detection Algorithm page. These updates apply to both 
target and confirming peaks.

Global menu command 

Push Global Settings to 
All Peaks

Pushes the global settings to all peaks for the method and 
updates the method. 

Table 38. Detection Algorithm page parameters for Auto  (Sheet 2 of 2)

Parameter Description
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Suitability 

Use the Suitability page to determine if the column is degrading and to identify suspicious 
peaks eluting at the same time as the target compound. Suspicious peaks caused by highly 
retained compounds from a previous injection tend to have a broader than expected peak 
profile. Tailing peaks frequently indicate a degrading column. The Suitability page displays 
the parameter values so that you can check the suitability of chromatographic peaks during 
processing.

 To set system suitability parameters 

1. Select one of the following check boxes:

• Enabled: Specifies that the application applies the suitability criteria when 
identifying the target peak. 

• Required: When peak detection finds a target peak at the specified location, the 
application then confirms the peak by performing these suitability processes. 

2. Select one of the following options:

• Global: Applies the suitability settings to all peaks in the compound.

• By Peak: Applies the suitability settings to only the selected fragment peak.

3. To perform symmetry testing, do the following:

a. Select the Symmetry Parameters check box. 

b. Type a peak height for symmetry testing in the Peak Height box.

c. Type a threshold for symmetry testing in the Symmetry Threshold box.

4. To carry out classification tests, do the following:

a. Select the Peak Classification Parameters check box.

b. To adjust Xcalibur peak width testing thresholds, type parameters in the Detect Peak 
Width area as follows:

• To enter a peak height for the test, type a value in the Peak Height box.

• To enter a minimum peak width threshold, type a value in the Min Peak Width 
box.

c. To adjust the Xcalibur peak tailing test, type parameters in the Detect Tailing area:

• To enter a peak height for the test, type a value in the Peak Height box.

• To enter a threshold limit for peak tailing, type a value in the Failure Threshold 
box.

d. To adjust the Xcalibur column overload test, type parameters in the Detect Column 
Overload area:

• To enter a peak height for the test, type a value in the Peak Height box.

• To enter a threshold limit for peak tailing, type a value in the Failure Threshold 
box.
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Figure 70. Suitability page

Table 39.  Suitability dialog box parameters  (Sheet 1 of 2)

Parameter Description

Enabled/Required Specifies one of the following:

Enabled: Specifies that the application applies the current suitability criteria when 
identifying the target peak. The application considers a peak as “found” when peak 
detection finds the peak at the specified retention time using the specified scan filter. 
See Retention Times and Trace Selection. A “found” peak that fails the enabled 
suitability criteria is not considered confirmed.

Required: When peak detection finds a target peak at the specified location, the 
application then confirms the peak by performing these suitability processes. If the 
target peak does not meet these suitability criteria, then it is not confirmed. 
Confirmed compounds are indicated in the Compound View in the Data Review. 
Refer to Chapter 4, “Using the Analysis Mode for Quantitation Batches” in the 
TraceFinder User Guide.

Global/By Peak Global: Applies the suitability settings to all peaks in the compound.

By Peak: Applies the suitability settings to only the selected target peak, confirming 
peak, or fragments.
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Symmetry Parameters
Determines the symmetry of the left and right sides of the detected peak. 

Peak Height The percentage of the peak height at which to compare the symmetry of the left and 
right peak widths.

Symmetry Threshold The minimum percentage difference to be considered symmetrical and pass the 
suitability test.

Peak Classification Parameters

Detect Peak Width Determines the minimum width of each side of the peak measured at the specified 
percentage of the peak height.

Peak Height The percentage of the peak height at which to measure the full peak width.

Min Peak Width Minimum peak width (measured at the specified percentage of the peak height) 
required to pass the suitability test.

Max Peak Width Maximum allowed peak width (measured at the specified percentage of the peak 
height) to pass the suitability test.

Detect Tailing The width of the right side of the peak divided by the width of the left side of the 
peak at the specified percentage of the peak height.

Peak Height The percentage of the peak height at which to measure the left and right sides of the 
peak.

Failure Threshold Minimum Detect Tailing value (RHS/LHS) required to pass the suitability test.

Detect Column Overload The width of the left side of the peak divided by the width of the right side of the 
peak at the specified percentage of the peak height.

Peak Height The percentage of the peak height at which to measure the left and right sides of the 
peak. 

Failure Threshold Minimum Detect Column Overload value (LHS/RHS) required to pass the 
suitability test.

Table 39.  Suitability dialog box parameters  (Sheet 2 of 2)

Parameter Description

Left and right widths measured at 30% 
and 50% of the peak height

Full width measured at 30% 
and 50% of the peak height

Left and right widths measured at 10% 
and 30% of the peak height

Left and right widths measured at 30% 
and 50% of the peak height



 4 Using the Method Development Mode for Quantitation Methods
Editing a Quantitation Method

Thermo Scientific TraceFinder Lab Director User Guide 189

Spectrum 

Use the Spectrum page to display a mass spectrum for a target peak.

 To zoom in on the chromatogram or spectrum displays

1. Drag the cursor to delineate a rectangle.

The display zooms in on the specified rectangle.

2. To return to the original display, right-click and choose Reset Scaling.

Spectrum Page 

Use the shortcut menu commands on the Spectrum page to change the display or copy the 
graphic to the Clipboard.

Figure 71. Spectrum page

Table 40. Spectrum page shortcut menu commands 

Command Description

Reset Scaling Returns the chromatogram or spectrum display to its original 
size after a zoom operation. 

Copy to Clipboard Copies the graphic display to the Clipboard.
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NIST 

Use the NIST Page to define the criteria for NIST library matching. 

This page is available only for target peaks when you have specified a NIST screening library 
in the Configuration Console. See Screening Libraries in Chapter 1, “Using the 
Configuration Console.”

 To activate NIST library matching

1. Select one of the following options:

• Enabled: Specifies that the application applies the NIST criteria when identifying the 
target peak. 

• Required: When peak detection finds a target peak at the specified location, the 
application then confirms the peak by performing these NIST processes. 

2. Select one of the following search types:

• Normal: Uses a more extensive set of presearch screenings—a total of four different 
criteria.

• MS/MS: Searches for an MS/MS spectrum in a library of MS/MS spectra.

• In-source HiRes: Searches for an in-source/EI with an accurate ion m/z or an 
MS/MS spectrum in a library that contains in-source/EI accurate ion m/z or MS/MS 
spectra.

3. Select one of the following options:

• Global: Applies the suitability settings to all peaks in the compound.

• By Peak: Applies the suitability settings to only the selected target peak.

4. Specify the NIST parameters that you want to use for processing batches with this 
method. 

 To specify an XIC scan filter 

1. Click the Scan Filter browse button, .

The XIC Filter Dialog Box opens.

2. Specify your filter options.

Note  Because the NIST library is large, using this library can slow sample processing.
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3. Click OK.

The application updates the chromatogram data using the specified XIC filter options, 
and the Scan Filter box indicates the parameters of the specified XIC filter, as in this 
example:

XIC Filter Dialog Box

Use the XIC Filter dialog box to specify the parameters for an XIC filter.

Figure 72. XIC Filter dialog box

MS order 

Full-scan mode

Data-dependent filter

MassAnalyzerFTMS analyzer

Positive polarity
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Table 41. XIC Filter dialog box parameters 

Parameter Description

Mass Analyzer 
Type

Any: Any mass analyzer.
FTMS: Fourier Transform Mass Spectrometer
ITMS: Ion Trap Mass Spectrometer
Sector: Static electric or magnetic sectors, or a combination of the two
SQMS: Single Quad Mass Spectrometer
TOFMS: Time-of-Flight Mass Spectrometer
TQMS: Triple Quad Mass Spectrometer

MSX Any: For both MSX and non-MSX scans.
On: For only MSX scans.
Off: For only non-MSX scans.

Data 
Dependent

Any: For both data-dependent and non-data-dependent filters.
On: For only data-dependent filters.
Off: For only non-data-dependent filters.

MS Order Any: For any MS order.
MS: For only a single mass spec stage.
MS2-MS3: For only multiple mass spec stages.

Polarity Any: For both positive and negative scans.
Positive: For only positive scans.
Negative: For only negative scans. 

Scan Mode Any: For any scan mode.
Full: Full-scan mode
SIM: Selective ion monitoring
SRM: Selective reaction monitoring
CRM: Consecutive reaction monitoring
Q1MS: MS using quadrupole 1
Q3MS: MS using quadrupole 3

Activations Any: For any activation method.
CID: Collision-induced dissociation
MPD: Multiple photodissociation
ECD: Electron capture dissociation
PQD: Pulsed dissociation
ETD: Electron transfer dissociation
HCD: Higher energy collision-induced dissociation
This parameter is available only when the MS Order is set to MS2 or MS3.

First Precursor This parameter is available only when the MS Order is set to MS2 or MS3.

Second 
Precursor

This parameter is available only when the MS Order is set to MS3.

Mass Ranges Specifies a mass range in [x-y] format. Select from the list or type a custom 
range.
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 To specify an MS filter

Select a filter from the Scan Filter list as shown in this example:

The Scan Filter list includes all available scan filters for the method.

The application updates the chromatogram data using the specified filter options, as in 
this example:

MS order 

Scan mode

Polarity

 Centroid data

Activation method

Precursor

Product
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NIST Page

Use the NIST page to define the criteria for NIST library matching.

Figure 73. NIST page

Table 42. NIST page parameters  (Sheet 1 of 3)

Command Description

Enabled/Required Specifies one of the following:

Enabled: Specifies that the application applies the NIST 
criteria when identifying the target peak. The application 
considers a peak as “found” when peak detection finds the 
peak at the specified retention time using the specified scan 
filter. See Retention Times and Trace Selection. A “found” 
peak that fails the enabled NIST criteria is not considered 
confirmed.

Required: When peak detection finds a target peak at the 
specified location, the application then confirms the peak by 
performing these NIST processes. If the target peak does not 
meet these NIST criteria, then it is not confirmed. Confirmed 
compounds are indicated in the Compound View in the Data 
Review. Refer to Chapter 4, “Using the Analysis Mode for 
Quantitation Batches” in the TraceFinder User Guide.
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Search Type Specifies the type of library search algorithm to use.

Normal: Uses a more extensive set of presearch screenings—a 
total of four different criteria.

MS/MS: Searches for an MS/MS spectrum in a library of 
MS/MS spectra.

In-source HiRes: Searches for an in-source/EI with an 
accurate ion m/z or an MS/MS spectrum in a library that 
contains in-source/EI accurate ion m/z or MS/MS spectra.

Global/By Peak Global: Applies the current NIST settings to all peaks in the 
compound.

By Peak: Applies the current NIST settings to only the 
selected target peak.

Scan Filter Represents a particular data acquisition channel. 
For example, the filter option + c Full ms [35.00-500.00] 
represents a positive ion centroid signal acquired in 
single-stage, full-scan mode from m/z 35 to 500. 

Precursor Tolerance Specifies the precursor m/z ± tolerance value as either amu or 
ppm.

Valid range: 0.015 through 100 000
Default: 1.60

Available only when you select MS/MS or In-source HiRes 
search types.

Product Tolerance Specifies the mass spectral peak m/z ± tolerance value as either 
amu or ppm.

Valid range: 0.015 through 100 000
Default: 1.60

Available only when you select MS/MS or In-source HiRes 
search types.

Ignore Precursor Ignores mass spectral peaks within the specified precursor 
tolerance range.

Available only when you select MS/MS or In-source HiRes 
search types.

Table 42. NIST page parameters  (Sheet 2 of 3)

Command Description
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Use Alt Peak Matching Specifies that the application uses alternate peak matching.

Available only when you select MS/MS or In-source HiRes 
search types.

Reverse Search Specifies that the NIST library search uses the reverse search 
method. A reverse search compares a library entry to an 
unknown compound (whereas a forward search compares the 
mass spectrum of an unknown compound to a mass spectral 
library entry).

Presearch Specifies that the application uses presearch screening before 
calculating the spectrum-by-spectrum match factor.

SI Threshold The lower threshold value for the search index method that is 
used to search the NIST library. The application does not 
return results below this value.

Valid values: 0 through 999
Default: 250

RSI Threshold The lower threshold value for the reverse search index method 
that is used to search the NIST library. The application does 
not return results below this value.

Valid values: 0 through 999
Default: 250

Probability Threshold Threshold value for the match probability.

Passing Score Valid values: 0.00 through 100.00
Default: 80.00

By Peak menu commands 

Apply Current Peak 
Settings to All Peaks in the 
Method

Updates all peaks in the current compound with the current 
settings on the NIST page. These updates apply to both target 
and confirming peaks.

Apply Current Peak 
Settings to All Peaks in the 
Compound 

Updates all compounds in the method with the current 
settings on the NIST page. These updates apply to both target 
and confirming peaks.

Global menu command 

Push Global Settings to All 
Peaks

Pushes the global settings to all peaks for the method and 
updates the method. 

Table 42. NIST page parameters  (Sheet 3 of 3)

Command Description
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mzVault 

Use the mzVault page to define the criteria for library matching. 

This page is available only for target peaks when you have specified an mzVault screening 
library in the Configuration Console. See Screening Libraries.

 To activate library matching

1. Select one of the following options:

• Enabled: Applies the current mzVault criteria when identifying the target peak. 

• Required: When peak detection finds a target peak at the specified location, the 
application then confirms the peak by performing the current mzVault processes. 

2. From the Search Type list, select one of the following search types to use for matching: 
Classic or HighChem.

3. Select one of the following options:

• Global: Applies the mzVault settings to all peaks in the compound.

• By Peak: Applies the mzVault settings to only the selected fragment peak.

4. Specify the mzVault parameters that you want to use for processing batches with this 
method.

The application searches the library, matches the fragment ion spectrum in the library to 
the compound’s ion spectrum, and returns the highest score (best match).

Figure 74. mzVault page
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Table 43. mzVault page parameters  (Sheet 1 of 2)

Command Description

Enabled/Required Specifies one of the following:

Enabled: Specifies that the application applies the current 
mzVault criteria when identifying the target peak. The 
application considers a peak as “found” when peak detection 
finds the peak at the specified retention time using the specified 
scan filter. See Retention Times and Trace Selection. A “found” 
peak that fails the enabled mzVault criteria is not considered 
confirmed.

Required: When peak detection finds a target peak at the 
specified location, the application then confirms the peak by 
performing these NIST processes. If the target peak does not 
meet these NIST criteria, then it is not confirmed. Confirmed 
compounds are indicated in the Compound View in the Data 
Review. Refer to Chapter 4, “Using the Analysis Mode for 
Quantitation Batches” in the TraceFinder User Guide.

Search Type Specifies the type of library search algorithm to use.
• Classic: Uses the standard library search algorithm.
• HighChem: Uses the HighChem™ library search algorithm.

Global/By Peak Global: Applies the detection settings to all peaks in the 
compound.

By Peak: Applies the detection settings to only the selected 
target or confirming peak.

Scan Filter Represents a particular data acquisition channel. 
For example, the filter option + c Full ms [35.00-500.00] 
represents a positive ion centroid signal acquired in single-stage, 
full-scan mode from m/z 35 to 500. 

Fragment Tolerance Specifies the fragment m/z ± tolerance value as either amu or 
ppm.

Valid range: 0.1 through 1000.00
Default: 5.00

Note   This parameter might be identified as 
LibManagerSpectrumTolerance in audit log files. 

Precursor Tolerance Specifies the precursor m/z ± tolerance value as either amu or 
ppm. Available only when you select MS/MS or In-source 
HiRes search types.

Valid range: 0.015 through 100 000
Default: 1.60
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Score Threshold Specifies the minimum height of a fragment ion peak. The peak 
of a fragment ion must be above this threshold for the 
application to find it. The application does not return results 
below this value.

Valid range: 0 through 100
Default: 80.00

Passing Score Valid range: 0 through 100
Default: 80.00

Ignore Precursor Ignores mass spectral peaks within the specified precursor 
tolerance range. Available only when you select MS/MS or 
In-source HiRes search types.

Reverse Search Specifies that the mzVault library search uses the reverse search 
method. A reverse search compares a library entry to an 
unknown compound (whereas a forward search compares the 
mass spectrum of an unknown compound to a mass spectral 
library entry).

Note   When you are using all ions fragmentation (AIF), 
data-independent (DIA), variable data-independent (vDIA), 
or source collision-induced dissociation (CID) data, the 
application automatically uses reverse search even if you do 
not select this option.

By Peak menu commands 

Apply Current Peak 
Settings to All Peaks in 
the Method

Updates all peaks in the current compound with the current 
settings on the mzVault page. These updates apply to both 
target and confirming peaks.

Apply Current Peak 
Settings to All Peaks in 
the Compound 

Updates all compounds in the method with the current settings 
on the mzVault page. These updates apply to both target and 
confirming peaks.

Global menu command 

Push Global Settings to 
All Peaks

Pushes the global settings to all peaks for the method and 
updates the method. 

Table 43. mzVault page parameters  (Sheet 2 of 2)

Command Description
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Isotopes 

Use the Isotopes page to define the criteria for identifying an isotope peak. To identify an 
isotopic pattern, the application must detect the compound for at least one of its defined 
adduct ions. The application identifies the elemental composition to match using the formula 
that is associated with the most intense adduct peak. The application then generates an 
isotopic pattern score (as a percentage value) for the match between the measured and 
expected isotopic patterns of the calculated elemental composition. 

 To specify isotope criteria

1. Select one of the following options:

• Enabled: Specifies that the application applies the isotope criteria when identifying 
the target peak. 

• Required: When peak detection finds a target peak at the specified location, the 
application then confirms the peak by performing these isotope processes. 

2. Select one of the following options:

• Global: Applies the isotope settings to all peaks in the compound.

• By Peak: Applies the isotope settings to only the selected fragment peak.

3. In the Fit Threshold box, type the fit threshold percentage.

The resulting score percentage from isotopic pattern matching must be higher than the 
specified fit threshold percentage. 

4. In the Allowed Mass Deviation box, type the parts per million to use as the minimum 
deviation from the expected m/z.

The isotopic pattern algorithm considers an isotope peak as found if its measured m/z is 
less than this amount away from its expected m/z. For best results, set this value to a 
number that causes up to 98 percent of all mass deviations to be smaller than the allowed 
mass deviation value. 

5. In the Allowed Intensity Deviation box, type a value to specify the allowed intensity 
deviation of the mass spectrometer relative to the monoisotopic ion, as a percentage of the 
base peak height.

The isotopic pattern algorithm considers an isotope peak as not found if its intensity, 
relative to the monoisotopic ion’s intensity, is more than the deviation percentage from 
the theoretical relative intensity of the isotope ion. For best results, set this value to a 
number that causes up to 98 percent of all intensity deviations to be smaller than the 
allowed intensity deviation value.
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Figure 75. Isotopes page

Table 44. Isotopes page parameters  (Sheet 1 of 2)

Parameter Description

Enabled/Required Specifies one of the following:

Enabled: Specifies that the application applies the current isotope 
criteria when identifying the target peak. The application considers a 
peak as “found” when peak detection finds the peak at the specified 
retention time using the specified scan filter. See Retention Times 
and Trace Selection. A “found” peak that fails the enabled isotope 
criteria is not considered confirmed.

Required: When peak detection finds a target peak at the specified 
location, the application then confirms the peak by performing these 
isotope processes. If the target peak does not meet these isotope 
criteria, then it is not confirmed. Confirmed compounds are 
indicated in the Compound View in the Data Review. Refer to 
Chapter 4, “Using the Analysis Mode for Quantitation Batches” in 
the TraceFinder User Guide.

Global/By Peak Global: Applies the detection settings to all peaks in the compound.

By Peak: Applies the detection settings to only the selected target or 
confirming peak.

Fit Threshold % To identify a compound, the resulting score percentage from isotopic 
pattern matching must be higher than the specified fit threshold 
percentage. 

Default: 90% 
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Ratios 

Use the Ratios page to define the criteria for evaluating target peaks, confirming peaks, and 
fragments. The application detects compounds that have peaks outside their acceptable 
window and flags them in the Acquisition mode and in reports. 

Ratio parameters are different for target peaks, confirming peaks, and fragments. 

• Ratios for Target Peaks

• Ratios for Confirming Peaks

• Ratios for Fragments

Allowed Mass 
Deviation (ppm)

Specifies the allowed mass deviation in the spectrum data.
The TraceFinder isotopic pattern algorithm considers an isotope peak 
as found if its measured m/z is less than this amount away from its 
expected m/z. For best results, set this value to a number that causes 
up to 98 percent of all mass deviations to be smaller than the allowed 
mass deviation value. 

Valid range: 3 through 100 ppm 
Default: 3 ppm

Allowed Intensity 
Deviation (%)

Specifies the allowed intensity deviation of the mass spectrometer, 
relative to the monoisotopic ion, as a percentage of the base peak 
height.

The TraceFinder isotopic pattern algorithm considers an isotope peak 
as not found if its intensity relative to the monoisotopic ion’s 
intensity is more than this deviation percentage from the theoretical 
relative intensity of the isotope ion. For best results, set this value to a 
number that causes up to 98% of all intensity deviations to be smaller 
than the allowed intensity deviation value.

Default: 10%

Shortcut menu 

Apply Current Peak 
Settings to All Peaks 
in the Method

Updates all compounds in the method with the current settings on 
the Isotopes page. These updates apply to both target and confirming 
peaks. When you use this command in the local method for a 
processed batch, the application prompts you to reprocess the batch 
to update the library settings.

Apply Current Peak 
Settings to All Peaks 
in the Compound 

Updates all peaks in the current compound with the current settings 
on the Isotopes page. These updates apply to both target and 
confirming peaks. The application reprocesses all peaks in the 
compound and performs a new library search.

Table 44. Isotopes page parameters  (Sheet 2 of 2)

Parameter Description
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Ratios for Target Peaks

Use the Ratios page to define the criteria for evaluating the selected target peak. The 
application detects compounds that have target peaks outside their acceptable window and 
flags them in the Acquisition mode and in reports. See Ratios page for target peaks.

 To specify ion ratio criteria 

1. To specify that the application applies the current ratios criteria when identifying the 
target peak, select the Enabled check box.

2. In the Target Ion Ratio box, enter a value for the theoretical ratio of the confirming ion’s 
response to the target ion’s response. 

3. From the Ion Range Calc Method list, select one of the following methods for calculating 
the ion ratio range windows:

• Manual (default): Uses the manually entered target ion ratio window ranges.

• Average: Uses the average ratio of the defined calibration levels.

• Level: Displays an additional list where you can select a calibration level amount. To 
define these calibration levels on the Compounds page, see Calibration Levels.

• Weighted Average: Uses the weighted average ratio of the defined calibration levels 
and assigns more weight to lower levels. 

4. Select one of the following options:

• Global: Applies the window type, response type, and window settings to all peaks in 
the compound.

• By Peak: Applies the window type, response type, and window settings to only the 
selected target peak.

5. In the Window Type list, select Absolute or Relative as the calculation approach for 
determining the acceptable ion ratio range. 

6. From the Response Type list, select Area or Height.

• Area: Specifies that the application uses this area value in response calculations.

• Height: Specifies that the application uses this height value in response calculations.

7. In the Window (+/-%) box, select the acceptable ion ratio range. 

8. (Optional) Do one of the following:

• To copy the Window Type, Response Type, and Window values to all target peaks for 
the compound, click the shortcut menu icon, , and choose Apply Current Peak 
Settings to All Peaks in the Compound.

• To copy the Window Type, Response Type, and Window values to all target peaks for 
the method and update the method, click the shortcut menu icon, , and choose 
Apply Current Peak Settings to All Peaks in the Method.
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Figure 76. Ratios page for target peaks
 

Table 45. Ratios page parameters for target peaks (Sheet 1 of 2)

Parameter Description

Enabled Specifies that the application applies the current ratio criteria 
when identifying the target peak. The application considers a peak 
as “found” when peak detection finds the peak at the specified 
retention time using the specified scan filter. See Retention Times 
and Trace Selection. A “found” peak that fails the enabled ratio 
criteria is not considered confirmed.

Target Ion Ratio Specifies the theoretical ratio of the confirming ion’s response to 
the target ion’s response. 
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Ratios for Confirming Peaks 

Use the Ratios page to define the criteria for evaluating the selected confirming peak. The 
application detects compounds that have confirming peaks outside their acceptable window 
and flags them in the Acquisition mode and in reports. See Ratios page for confirming peaks.

 To specify ion ratio criteria 

1. To specify that the application applies the current ratio criteria when identifying the 
confirming peak, select the Enabled check box.

Ion Range Calc 
Method

Specifies the selected ion range calc method used to calculate the 
ion ratio range windows: 

• Manual (default): Uses the manually entered target ion ratio 
window ranges.

• Average: Uses the average ratio of the defined calibration 
levels.

• Level: Displays an additional list where you can select a 
calibration level amount. To define these calibration levels on 
the Compounds page, see Calibration Levels.

• Weighted Average: Uses the weighted average ratio of the 
defined calibration levels, and assigns more weight to lower 
levels. 

Global/By Peak Global: Applies the Window Type, Response Type, and Window 
values to all target peaks in the compound.

By Peak: Applies the Window Type, Response Type, and Window 
values to only the selected target peak.

Window Type Specifies the absolute or relative calculation approach for 
determining the acceptable ion ratio range. 

Response Type Specifies that the application uses height or area in response 
calculations.

Window (+/-%) Specifies the acceptable ion ratio range.

Shortcut menu 

Apply Current Peak 
Settings to All Peaks in 
the Method

Copies the Window Type, Response Type, and Window values to 
all target peaks for the method and updates the method. 

Apply Current Peak 
Settings to All Peaks in 
the Compound 

Copies the Window Type, Response Type, and Window values to 
all target peaks for the compound and updates the compound. 
Available only when a compound has multiple target peaks.

Table 45. Ratios page parameters for target peaks (Sheet 2 of 2)

Parameter Description
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2. In the Target Ion Ratio box, enter a value for the theoretical ratio of the confirming ion’s 
response to the target ion’s response. 

3. From the Ion Range Calc Method list, select one of the following methods for calculating 
the ion ratio range windows:

• Manual (default)

• Average

• Level

When you select Level, the application displays a Level list where you can choose a 
calibration level. To define the available calibration levels on the Compounds page, 
see Calibration Levels.

• Weighted Average

4. Select one of the following options:

• Global: Applies the coelution, window type, response type, and window settings to 
all peaks in the compound.

• By Peak: Applies the coelution, window type, response type, and window settings to 
only the selected target peak.

5. To specify the maximum difference in retention time between a confirming peak and the 
quantification ion peak, set a value in the Coelution box. 

6. In the Window Type list, select Absolute or Relative as the calculation approach for 
determining the acceptable ion ratio range. 

7. From the Response Type list, select Area or Height.

• Area: Specifies that the application uses this area value in response calculations.

• Height: Specifies that the application uses this height value in response calculations.

8. In the Window (+/-%) box, select the acceptable ion ratio range. 

9. (Optional) Do one of the following:

• To copy the Coelution, Window Type, Response Type, and Window values to all 
target peaks for the compound, click the shortcut menu icon, , and choose Apply 
Current Peak Settings to All Peaks in the Compound.

• To copy the Coelution, Window Type, Response Type, and Window values to all 
target peaks for the method and then update the method, click the shortcut menu 
icon, , and choose Apply Current Peak Settings to All Peaks in the Method.
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Figure 77. Ratios page for confirming peaks
 

Table 46. Ratios page parameters for confirming peaks (Sheet 1 of 2)

Parameter Description

Enabled/Required Specifies one of the following:

Enabled: Specifies that the application applies the current ratio 
criteria when identifying the confirming peak. The application 
considers a peak as “found” when peak detection finds the peak at 
the specified retention time using the specified scan filter. See 
Retention Times and Trace Selection. A “found” peak that fails the 
enabled ratio criteria is not considered confirmed.

Required: When peak detection finds a confirming peak at the 
specified location, the application then confirms the peak by 
performing these ratio processes. If the confirming peak does not 
meet these ratio criteria, then it is not confirmed. Confirmed 
compounds are indicated in the Compound View in the Data 
Review. Refer to Chapter 4, “Using the Analysis Mode for 
Quantitation Batches” in the TraceFinder User Guide.

Target Ion Ratio Specifies the theoretical ratio of the confirming ion’s response to 
the target ion’s response. 
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Ion Range Calc 
Method

Specifies the selected ion range calc method used to calculate the 
ion ratio range windows: 

• Manual (default): Uses the manually entered target ion ratio 
window ranges.

• Average: Uses the average ratio of the defined calibration 
levels.

• Level: Displays an additional list where you can select a 
calibration level amount. To define these calibration levels on 
the Compounds page, see Calibration Levels.

• Weighted Average: Uses the weighted average ratio of the 
defined calibration levels, and assigns more weight to lower 
levels. 

Global/By Peak Global: Applies the ratio settings to all confirming peaks in the 
compound.

By Peak: Applies the ratio settings to only the selected confirming 
peak.

Coelution Specifies the maximum difference in retention time between a 
confirming peak and the target peak.

Valid range: 0.025 through 0.1

Window Type Specifies the absolute or relative calculation approach for 
determining the acceptable ion ratio range. 

Response Type Specifies that the application uses height or area in response 
calculations.

Window (+/-%) Specifies the acceptable ion ratio range.

Shortcut menu 

Apply Current Peak 
Settings to All Peaks in 
the Method

Copies the Coelution, Window Type, Response Type, and 
Window values to all confirming peaks for the method and 
updates the method. 

Apply Current Peak 
Settings to All Peaks in 
the Compound 

Copies the Coelution, Window Type, Response Type, and 
Window values to all confirming peaks for the compound and 
then updates the compound. 
Available only when a compound has multiple confirming peaks.

Table 46. Ratios page parameters for confirming peaks (Sheet 2 of 2)

Parameter Description
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Ratios for Fragments 

Use the Ratios page to define the criteria for evaluating the selected fragment. The application 
detects compounds that have fragments outside their acceptable window and flags them in the 
Acquisition mode and in reports. See Ratios page for fragments.

Follow these procedures:

• To specify ion ratio criteria

• To specify a reference fragment

 To specify ion ratio criteria 

1. Select one of the following options:

• Enabled: Specifies that the application applies the current ratio criteria when 
identifying the fragment. 

• Required: When peak detection finds a fragment peak at the specified location, the 
application then confirms the peak by performing these processes.

2. To edit the Target Ion Ratio table, do the following:

a. Click Edit.

The dialog box opens.

b. For each range, you can type a new low or high value, change the Window(+/-%) 
value or change the Window Type.

Ranges must be contiguous from 0 through 100. You cannot specify overlapping 
values or leave gaps between values.

c. When you have completed your changes, click OK.

3. In the Window Type list, select Absolute or Relative as the calculation approach for 
determining the acceptable ion ratio range. 

4. From the Ion Range Calc Method list, select a method for calculating the ion ratio range 
windows.
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When you select Level, the application displays a Use Level list where you can choose a 
calibration level. To define the available calibration levels on the Compounds page, see 
Calibration Levels.

 To specify a reference fragment

1. In the mass table, select the Reference option for the appropriate mass.

Each fragment mass in the Peaks pane is identified as a possible reference fragment.

2. Enter a value for the Target Ion Ratio. 

Figure 78. Ratios page for fragments
 

Peaks pane Ratios page 
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Calibration 

Use the Calibration Page to set or edit the mathematical model used for preparing the initial 
calibration evaluation for one or more calibration standards. 

Each target compound can have its own initial calibration settings, independent of the other 
compounds. You can modify the calibration approach on this page or in Acquisition mode 
when you view the results of an actual calibration batch. 

Table 47. Ratios page parameters for fragments 

Parameter Description

Enabled/Required Specifies one of the following:

Enabled: Specifies that the application applies the current ratio 
criteria when identifying the fragment. The application considers 
a fragment as “found” when peak detection finds the fragment at 
the specified retention time using the specified scan filter. See 
Retention Times and Trace Selection. A “found” fragment that 
fails the enabled ratios criteria is not considered confirmed.

Required: When peak detection finds a fragment at the specified 
location, the application then confirms the fragment by 
performing these ratios processes. If the fragment does not meet 
these ratio criteria, then it is not confirmed. Confirmed 
compounds are indicated in the Compound View in the Data 
Review. Refer to Chapter 4, “Using the Analysis Mode for 
Quantitation Batches” in the TraceFinder User Guide.

Target Ion Ratio Table Displays the ion ratio ranges and windows as specified in the 
dialog box. To open the dialog box and edit these values, click 
Edit. 

Window Type Specifies the absolute or relative calculation approach for 
determining the acceptable ion ratio range. 

Ion Range Calc 
Method

Specifies the selected ion range calc method used to calculate the 
ion ratio range windows: 

• Manual (default): Uses the manually entered target ion ratio 
window ranges.

• Average: Uses the average ratio of the defined calibration 
levels.

• Level: Displays an additional list where you can select a 
calibration level amount. To define these calibration levels on 
the Compounds page, see Calibration Levels.

• Weighted Average: Uses the weighted average ratio of the 
defined calibration levels, and assigns more weight to lower 
levels. 
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Typically, general quantitation uses a measured response (area or height) to determine the 
amount of a compound contained in a sample. The application compares the response of an 
unknown, target compound to the response of a calibration sample that contains a known 
amount of the compound by building a calibration curve to interpolate the amount in the 
target compound. 

To use a semi-quantitative process, you specify the compound’s standard type as Estimated 
and then identify another compound as the linked compound. Instead of using the target 
compound to create a calibration curve, the application uses a calibration curve from the 
linked compound to calculate the amount in the target compound.

To use a real sample for the calibration procedure, you specify the compound’s standard type 
as Std Addition. The autosampler divides the sample into multiple portions (one unspiked 
portion and at least two spiked portions). To maintain consistent conditions across all 
samples, the autosampler adds selected amounts of standard into the vials and adds a volume 
of a solvent calculated to maintain constancy in the total volume of liquid in each vial. 

To exclude a compound when the application generates a calibration curve, you specify the 
compound’s standard type as None. 

Follow these procedures:

• To specify an internal standard type for a compound

• To specify an estimated standard type for a compound

• To specify a standard addition standard type for a compound

• To exclude a compound

 To specify an internal standard type for a compound

1. On the Identification page, specify at least one compound in the method as an internal 
standard compound type.

2. On the Calibration page, do the following:

a. In the Standard Type column, select Internal.

b. In the ISTD column, select the compound that you want to use as the internal 
standard for this compound.

The application lists only compounds specified as internal standards on the 
Identification page.

To view the internal standard peak in Data Review, refer to Chapter 4, “Using the Analysis 
Mode for Quantitation Batches” in the TraceFinder User Guide.

Note  To automatically link compounds to their internal standards, see Linking Internal 
Standards.
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 To specify an estimated standard type for a compound

1. In the Standard Type column, select Estimated.

2. In the Linked Compound column, select any other compound in the method that you 
want to link to this compound.

The Estimation Method value defaults to Ext Curve and is read-only.

The Compound Results in Data Review display the Calculated Amt value as “N/F” (not 
found) highlighted in green.

 To specify a standard addition standard type for a compound 

In the Standard Type column, select Std Addition.

• The Curve Type column value defaults to Linear and is read-only.

• The Origin column value defaults to Ignore and is read-only.

• The Weighting column value defaults to Equal and is read-only.

When you process this sample, the application divides the sample into multiple portions: 
one portion is not spiked and at least two portions are spiked. The application calculates 
the analyte concentration as intercept/slope, where intercept is the y-intercept of the 
regression line and slope is the slope of the regression line.

When you use the Std Addition calibration, the y-intercept on the calibration curve might 
not be at 0, as shown in the following figure:

The Compound Results in Data Review display the following:

• The Calculated Amt value is the spiked amount from the calibration curve.

• The Theoretical Amt value is the level defined in the method.

• The Sample Amt value is the actual amount in the standard spike plus the spiked 
amount in each standard. 
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 To exclude a compound 

In the Standard Type column, select None.

• When the application generates a calibration curve, this compound is excluded. 

• All values for this compound are grayed out on the Calibration page.

• The application excludes this compound from the Limits page in the QAQC view.

• The application excludes this compound from the Calibration Levels page in the 
Compounds view. 

Calibration Page 

Use the features on the Calibration page to define the mathematical model used for preparing 
the initial calibration evaluation for one or more calibration standards. 

Figure 79. Calibration page

Table 48. Calibration page parameters  (Sheet 1 of 2)

Parameter Description

RT Retention time. The time after injection when the compound elutes. The total time that the 
compound is retained on the column. 

Compound The compound name.

Compound Type Displays the compound type as a Target Compound or an Internal Standard. 

Standard Type Specifies the standard type as Internal, External, Estimated, Std Addition, or None.

Response Via Specifies the use of area or height. When you set the standard type to Estimated, this column is 
inactive.

Curve Type Specifies Linear, Quadratic, or AverageRF curve types. When you set the standard type to 
Estimated, this column is inactive. When you set the standard type to Std Addition, this 
column value defaults to Linear and is read-only.

Origin The origin treatment is Ignore, Include, or Force. The Origin and Weighting columns are 
available only when you use Linear or Quadratic curve types. When you set the standard type 
to Estimated, this column is inactive. When you set the standard type to Std Addition, this 
column value defaults to Ignore and is read-only.
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Calibration Levels 

On the Calibration Levels page for a method, you can define the standards for calibration. 
You can edit calibration levels and concentrations for methods only. The contents of this page 
are read-only when you are editing a local method. 

You can use the copy-and-paste functions in the shortcut menu to copy calibration levels from 
one column to another, from one method to another, or from the Clipboard. For detailed 
instructions, see Copying and Pasting Column Values.

 To specify calibration levels and concentrations

1. Select the compound whose calibration levels and concentrations you want to define. 

2. In the Manage Calibration Levels area, type a value for the first calibration level.

Weighting Specifies the weighting as Equal, 1/X, 1/X^2, 1/Y, or 1/Y^2. When you set the standard type 
to Estimated, this column is inactive. When you set the standard type to Std Addition, this 
column value defaults to Equal and is read-only.

Units The units to be displayed with the calculated values.

ISTD The internal standard (ISTD) for a target compound or surrogate. The list displays all 
compounds with the compound type of Internal Standard. This column is available only when 
you set the standard type to Internal.

Amount The amount of the internal standard for ISTD compounds. When you set the standard type to 
Estimated, this column is inactive.

Linked Compound This column is available only when the standard type is set to Estimated. The list of available 
compounds to be linked does not include any compounds whose standard type is set to 
Estimated.

Estimation Method This column is unavailable for editing when the standard type is set to Estimated. 
• When the compound type for the associated linked compound is Target Compound, the 

estimation method is automatically set to Ext Curve. 
• When the compound type for the associated linked compound is Internal Standard, the 

estimation method is automatically set to Ratio. 

Shortcut menu
The Calibration page uses a right-click shortcut menu. See Using the Shortcut Menu 
Commands.

Table 48. Calibration page parameters  (Sheet 2 of 2)

Parameter Description
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The application adds a new, empty calibration level row beneath the edited row.

3. Continue adding calibration levels.

When you finish adding calibration levels, you can specify the concentrations for each 
compound at each level.

4. To enter the concentrations in the table, do the following:

a. Select the first calibration level table cell.

b. Click the cell again to make it editable.

c. Type a concentration value.

5. Repeat step 4 for all calibration levels associated with the first compound.

6. To specify the same concentration values for all compounds, select the value that you 
want to copy, right-click, and choose Copy Down. 

Figure 80. Calibration Levels page
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Chk Std Levels 

Use the Chk Std Levels page for a method to define the standards for Chk Std levels. You can 
edit Chk Std levels for master methods only. The contents of this page are read-only when you 
are editing a local method. 

You can use the copy-and-paste functions in the shortcut menu to copy Chk Std levels from 
one column to another or from one master method to another. For detailed instructions, see 
Copying and Pasting Column Values.

 To specify Chk Std levels and concentrations

1. Select the compound whose Chk Std levels, percentage test values, and concentrations 
you want to define.

2. In the Manage Chk Std Levels area, type a name for the first Chk Std level.

The application adds a new, empty Chk Std level row below the edited row.

3. Type a value for the % Test.

The % Test is the acceptable difference (as a percentage) between the known amount and 
the calculated (measured) amount of each Chk Std level.

Table 49. Calibration Levels page parameters 

Parameter Description

RT Retention time. The time after injection when the compound 
elutes. The total time that the compound is retained on the 
column. 

Compound The compound name.

CalLevel_1–CalLevel_n User-defined calibration levels for the compound. The names you 
enter here become the column headers for the calibration levels.

Manage Calibration 
Levels

Defines values for each of the calibration level values for the 
selected compound.

Shortcut menu
The Calibration Levels page uses a right-click shortcut menu. See 
Using the Shortcut Menu Commands.
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4. Continue adding Chk Std levels and values for the percentage test.

When you finish adding Chk Std levels, you can specify the concentrations for each level 
for each compound.

5. To enter the concentration values in the table, do the following:

a. Select the first Chk Std level table cell.

b. Click the cell again to make it editable.

c. Type a concentration value.

6. Repeat step 5 for all Chk Std levels associated with the first compound.

7. To specify the same concentration values for all compounds, select the value that you 
want to copy, right-click, and choose Copy Down.

Figure 81. Chk Std Levels page
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Real Time Viewer 

Use the Real Time Viewer page to specify which traces display in the Real Time Status pane 
when you perform acquisition in the Acquisition mode. Refer to Chapter 3, “Using the 
Acquisition Mode” in the TraceFinder User Guide.

Figure 82. Real Time Viewer page

Table 50.  Levels page parameters 

Parameter Description

RT Retention time. The time after injection when the compound elutes. 
The total time that the compound is retained on the column. 

Compound The compound name.
Level_1–Level_n User-defined quality control levels for the compound.
Manage Levels

Level User-defined quality control level names. The names you enter here 
become the column headers for the levels.

% Test A value for the acceptable difference (as a percentage) between the 
known amount and calculated (measured) amount of each level.

Shortcut menu
The Levels page uses a right-click shortcut menu. See Using the 
Shortcut Menu Commands.
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Table 51. Real Time Viewer page parameters 

Parameter Description

Show Quan Peaks 
Only

Displays only target peaks in the compounds list. Quantitative peaks are indicated with a 
black dot in the Quan Peak column.

Displayable Traces

Quan Peak Dots indicate target peak traces. Unmarked traces indicate confirming peaks.

Compound Name Names of all compounds in the method.

Trace Lists the simple mass or precursor mass for all traces—both target peak and confirming 
peak—for each compound.

Moves the selected trace to the Traces to Display in Real Time Viewer pane.

Moves the selected trace to the Displayable Traces pane.

Moves all traces to the Displayable Traces pane. 

To move multiple traces to the Traces to Display... pane, hold down the SHIFT key, select 
multiple traces, and then click .

Traces to Display in 
Real Time Viewer (n/25)

List the traces to be displayed and the display order used in the real-time display in the 
Acquisition mode. Refer to “Real-Time Trace Display” in Chapter 3 of the TraceFinder User 
Guide.

The maximum number of traces is 25. 

Move to Top Moves the selected trace to the top of the Traces to Display... list and the second position in 
the real-time display. The TIC is always the first position in the real-time display in the 
Acquisition mode.

Move Up Moves the selected trace up one position in the list.

Move Down Moves the selected trace down one position in the list.

Move to Bottom Moves the selected trace to the bottom of the list.
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Using the Shortcut Menu Commands 

Each page on the Compounds page (except the Acquisition List, Detection, and Real Time 
Viewer pages) uses right-click, shortcut menu commands to display or hide the retention 
column, remove compounds from the method, copy data, or save the compound list to a CSV 
file.

Table 52.  Compounds page shortcut menu commands

Command Description
Copy Down Copies the value in the selected row to all rows below it. This 

command is available only when you have selected a value that can be 
copied down. Refer to Appendix C, “Using Copy Down and Fill 
Down.”  in the TraceFinder User Guide.

Display Retention 
Time Column

Displays or hides the RT column in the compound list.

Delete Compound 
From Method

Removes the selected compound from the current method.

Copy Copies the data in the selected rows or columns to the Clipboard. Use 
this command to copy compound information to a text editor or 
spreadsheet application. You cannot paste this data back into the 
method development compound list.

Copy With Headers Copies the data in the selected rows or columns and the associated 
column headers to the Clipboard. Use this command to copy sample 
information to a text editor or spreadsheet application. You cannot 
paste this data back into the method development compound list.

Paste 

Undo Last Paste

Pastes a single column of copied data from a text editor or spreadsheet 
application into the selected column. The pasted data must be valid 
data for the selected column.

Removes the last pasted item in the method development compound 
list. 

Export to CSV File Opens the Save As dialog box where you can save the current 
compound list to a CSV file.

Sort by Compound 
Name

Sorts the compounds alphabetically from A to Z.

Sort by Retention 
Time

Sorts the compounds from shortest retention time to longest 
retention time.
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Copying and Pasting Column Values 

You can use the copy-and-paste functions in the shortcut menu to copy column values within 
a method or from one method to another. You can use these copy-and-paste techniques on 
any pages with grids of data in the Compounds and QAQC views.

After you copy grid values to the Clipboard, you can paste them into a text application such as 
Notepad, an email, a spreadsheet, other grid cells in the same method, or another method. 

Follow these procedures:

• To copy a value from one cell to another cell

• To copy all values in a column to another column

• To copy multiple columns

• To copy an entire grid to another method

• To copy an entire grid from another application, such as an Excel spreadsheet

 To copy a value from one cell to another cell

1. Select a cell value to copy to the Clipboard.

You can select either an entire table cell or just a cell value.

2. Right-click and choose Copy.

The application copies either the selected cell value or the selected cell to the Clipboard.

3. In this or another method, select the cell value or table cell that you want to overwrite.

• If you copied a cell value, you can select the cell value or simply click in the cell.

• If you copied an entire cell, you must select a table cell to overwrite.

4. Right-click and choose Paste.

The application replaces the selected value with the value copied to the Clipboard.

Tip  When copying data into an application other than a TraceFinder method grid, use the 
Copy with Headers command, instead of the Copy command in the shortcut menu, to 
preserve the column headers.

Tip  You can also use the keyboard CTRL-C and CTRL-V to copy and paste the values.

Cell is selected.

Cell value is selected.
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 To copy all values in a column to another column

1. Use the SHIFT key to select the column to copy.

2. Right-click and choose Copy.

3. In this or another method, use the SHIFT key to select the column to overwrite.

4. Right-click and choose Paste.

The application overwrites the selected cells with the cells that you copied to the 
Clipboard.

 To copy multiple columns

1. Use the SHIFT key to select the columns to copy.

2. Right-click and choose Copy.

3. In this or another method, use the SHIFT key to select the columns to overwrite.

4. Right-click and choose Paste.

Tip  You can also use the keyboard CTRL-C and CTRL-V to copy and paste the values.
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The application overwrites the selected cells with the cells that you copied to the 
Clipboard.

 To copy an entire grid to another method

1. Use the SHIFT key to select all the columns in the grid.

2. Right-click and choose Copy.

3. In another method, use the SHIFT key to select the columns to overwrite.

4. Right-click and choose Paste.

The application overwrites the selected cells with the cells that you copied to the 
Clipboard.

 To copy an entire grid from another application, such as an Excel spreadsheet

1. In the spreadsheet, select and copy the contents of the cells.

2. In the Calibration Levels grid, click the cell where you want the copied values to begin.

3. Right-click the cell and choose Paste.

The application overwrites the grid with the cell values that you copied to the Clipboard. 

Tip  You can also use the keyboard CTRL-C and CTRL-V to copy and paste the values.

Note  When the Clipboard contains more cells of data than there are selected target 
cells for the paste operation, the application overwrites the selected cells and reports 
that the Clipboard contents were truncated to fit the grid.

Tip  You can also use the keyboard CTRL-C and CTRL-V to copy and paste the values.

IMPORTANT  You cannot use the keyboard CTRL-V to paste the values.
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Editing the QAQC Page 

Use the QAQC page to set limits and ranges so that the application can review the data and 
results as an aid to final approval.

On most QAQC pages, you can use the copy-and-paste functions in the shortcut menu to 
copy grid values from one column to another or from one method to another. For detailed 
instructions, see Copying and Pasting Column Values.

 To open the QAQC page

Click QAQC in the Method View navigation pane.

From the QAQC page of the Method View, you can access these additional pages:

• Limits

• Calibration

• Chk Std

• Matrix Blank

• ISTD

• Solvent Blank

• Threshold

Available only when you activate the 
Intelligent Sequencing option in 
the Configuration console
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Limits 

Use the Limits page to define levels of review for quantified results. Quantified results appear 
in printed and electronic reports. You can also define when a quantified value is reported 
instead of reporting less than a particular limit. 

Figure 83. Limits page

Table 53. Limits page parameters 

Parameter Description

RT Retention time. The time after injection when the compound elutes. The total time that the 
compound is retained on the column. 

Compound The compound name.

LOD 
(Detection Limit)

Limit of detection. The lowest amount that can be detected. Usually derived from a method 
detection limit (mdl) study.

LOQ 
(Quantitation Limit)

Limit of quantitation. The lowest amount that can be confidently and accurately 
quantitated. This is usually the lowest calibration amount.

LOR Limit of reporting. Also called cutoff in some industries. This is the lowest amount that can 
be reported, as determined by each laboratory’s standard operating practices.

ULOL 
(Linearity Limit)

Upper limit of linearity. This is usually the highest calibrator amount.

Carryover Limit The highest amount of a substance that does not leave a residual amount in the instrument. 
If a substance has a carryover limit of 5, amounts higher than 5 usually dirty the instrument 
and leave residue behind, tainting the following sample. A carryover limit of less than 5 does 
not leave any residual amounts of the substance.
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Calibration 

Use the Calibration page to define acceptable criteria for initial calibration. The application 
compares the initial calibration results for each compound found in the sample to the values 
defined on this page. 

In the Calibration report, the application flags the calculated values for internal standard 
compounds that exceed these limits.

Figure 84. Calibration page

Table 54. Calibration page parameters

Parameter Description

RT Retention time. The time after injection when the compound elutes. The total time that the 
compound is retained on the column. 

Compound The compound name.

R^2 Threshold The minimum correlation coefficient (r2) for an acceptable calibration (when in linear or 
quadratic mode). 

Max RSD (%) The maximum relative standard deviation (RSD) for an acceptable calibration (when in 
average RF mode). 

Note   This RSD value is not the same value used in Data Review or the Compound 
Calibration Report. The application uses this RSD value when you select AverageRF as 
the curve type for the method. See Calibration Page.

Min RF The minimum average response factor (RF) for an acceptable calibration (when in average 
RF mode). 

Max Amt Diff (%) The maximum deviation between the calculated and theoretical concentrations of the 
calibration curve data points (when in linear or quadratic mode). 

CV Test (%) Coefficient of Variance test. The coefficient of variance percentage is the standard deviation 
of the multiple samples of one level, multiplied by 100, and then divided by the average of 
the multiple samples of that level. This calculation is based on the areas of the peaks.
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Chk Std 

Use the Chk Std page to review the calibration on an ongoing basis. The application compares 
the quality check standard results for each compound in the sample to the initial calibration 
using values defined on this page. 

In the QC Standard report, the application flags the calculated values for internal standard 
compounds that exceed these limits.

For linear and quadratic modes, the maximum difference for the calculated concentration in 
the QC Std sample versus the theoretical value is set on the QC Levels page of the 
Compounds page.

Figure 85. Chk Std page

Table 55. Chk Std page parameters

Parameter Description

RT Retention time. The time after injection when the compound 
elutes. The total time that the compound is retained on the 
column. 

Compound The compound name.

Max RF Diff (%) The maximum deviation between the response factor (RF) of the 
QC Std sample and the average response factor from the 
calibration (when in average RF mode). 

Min RF The minimum response factor for the QC Std sample (when in 
average RF mode). 

CV Test (%) Coefficient of Variance test. The coefficient of variance percentage 
is the standard deviation of the multiple samples of one level, 
multiplied by 100, and then divided by the average of the multiple 
samples of that level. This calculation is based on the areas of the 
peaks.
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Matrix Blank

Use the Matrix Blank page to define acceptable levels of target compounds in blank samples. 
The application compares the calculated concentration for each compound in the sample to 
the maximum concentration defined on this page. You can enter the maximum concentration 
as a percentage of a flag value or as a specified value. 

In the Matrix Blank report, the application flags the calculated values for target compounds 
that exceed these limits. 

 To specify the maximum concentration as a percentage

1. From the Method column list, select one of the following methods:
• % of LOD
• % of LOQ
• % of LOR

2. In the Percentage column, type a percentage value.

 To specify the maximum concentration

1. From the Method column list, select Concentration.

2. In the Max Conc column, type an absolute value.

Figure 86. Matrix Blank page

Table 56.  Matrix Blank page parameters 

Parameter Description

RT Retention time. The time after injection when the compound 
elutes. The total time that the compound is retained on the 
column. 

Compound The compound name.
Method The evaluation process used for comparing the calculated 

concentration. You can specify no maximum, a specific 
concentration, or a percentage of the LOR, LOD, or LOQ. 

Percentage The percentage of the LOR, LOD, or LOQ if you are using the 
percentage approach. 

Max Conc The maximum concentration if you are using an absolute value. 
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ISTD 

Use the ISTD page to review the response and retention time of internal standards (when 
available). The application compares the area and retention time results for each internal 
standard compound in the sample to a specified range.

If all of your target compounds are set to external calibration mode or if you have not 
identified any compounds as internal standards, this page does not show any values. 

Figure 87. ISTD page

Table 57. ISTD page parameters 

Parameter Description

RT Retention time. The time after injection when the compound elutes. The total time that the 
compound is retained on the column. 

Compound The compound name.

Min Recovery (%) The minimum and maximum percent recoveries for the internal standards to define an 
acceptable range. For check standards, the application compares the response of each internal 
standard in each sample to a range around the average of the responses of that compound in all 
of the calibration standards. For all other samples, the application calculates the comparison 
range around the check standard responses if a check standard is available in the batch. If no 
check standard is available, the application tests against the initial calibration.

Max Recovery (%)

Min RT (–min) The minimum and maximum drift (in minutes) for the internal standards to define an 
acceptable range. For check standards, the application compares the retention time of each 
internal standard in each sample to a range around the average of the retention times of that 
compound in all of the calibration standards. For all other samples, the application calculates 
the comparison range around the check standard retention times if a check standard is available 
in the batch. If no check standard is available, the application tests against the initial 
calibration.

Max RT (+min)

CV Test (%) Coefficient of Variance test. The coefficient of variance percentage is the standard deviation of 
the multiple samples of one level, multiplied by 100, and then divided by the average of the 
multiple samples of that level. This calculation is based on the areas of the peaks.
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Solvent Blank 

Use the Solvent Blank page to view or edit QC values for solvent reporting. The application 
compares the calculated response for each compound in the sample to the maximum response 
defined on this page. 

In the Solvent Blank report, the application flags the calculated values for target compounds 
that exceed these limits. 

Figure 88. Solvent Blank page

Threshold

Use the Threshold page (see Threshold page) to specify how to create a threshold guide to 
overlay on compounds in the Comparative View in the Data Review mode. For each 
compound, you can specify an absolute value or you can specify a percentage of the peak 
height. The application uses the selected threshold method and the specified amount to create 
a threshold guide in the Comparative View chromatograms. 

When you create a batch, you can group samples and then specify a sample in the group as the 
threshold sample to use in the Comparative View. For instructions about specifying a 
threshold sample, refer to Chapter 4, “Using the Analysis Mode for Quantitation Batches” in 
the TraceFinder User Guide.

Table 58. Solvent Blank page parameters

Parameter Description

RT Retention time. The time after injection when the compound elutes. The 
total time that the compound is retained on the column. 

Compound The compound name.

Method The evaluation process to use as a response for the quantitation ion only 
(Quan Ion RT) or as a summed response for the quantitation ion and any 
confirming ions (All Ion RT). To deactivate the solvent blank test for a 
specific compound, select None. 

Upper Limit Specifies an upper limit for each compound in the sample when you select 
an evaluation process. These values are not concentrations; they are raw 
response values.
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In the following figures, the threshold for the dibutyl phthalate compound is 50 percent of 
the peak height in the threshold sample; the samples Benzo26473, Benzo25557, and 
Benzo26154 are members of groupB; and the threshold sample for the group is Benzo26473. 
In the Comparative Data view, you can easily see that the peak height of dibutyl phthalate in 
the other samples in the group is less than 50 percent of the peak height in the threshold 
sample.

• Threshold page in Method View

• Samples page in Batch View

• Threshold Samples page in Batch View

• Comparative View in Data Review 

Figure 89. Threshold page in Method View

Figure 90. Samples page in Batch View

Figure 91. Threshold Samples page in Batch View

Threshold method
Threshold at 50% of the 
peak height in the threshold 
sample

Samples belonging to the same group

Benzo26473 selected as the 
threshold sample for groupb
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Figure 92. Comparative View in Data Review

Figure 93. Threshold page

Table 59. Threshold page parameters 

Parameter Description

RT Retention time. The time after injection when the compound elutes. The 
total time that the compound is retained on the column. 

Compound The compound name.

Method Specifies the threshold method as a specific peak height value (Threshold) or 
as a percentage of the peak height in the threshold sample (% of Threshold 
Sample).

Threshold Specifies the absolute peak height value to use when you select the Threshold 
method. This value represents the default threshold value to use when you do 
not specify a Threshold Sample for a group of samples.

Default: 1.000

Percentage Specifies the percentage of the peak height value to use when you select 
the % of Threshold Sample method. This value represents a percentage of the 
actual peak height in the Threshold Sample you select for a group of samples. 
For instructions about specifying a Threshold Sample, refer to Chapter 4, 
“Using the Analysis Mode for Quantitation Batches” in the TraceFinder User 
Guide.

Valid range: 0.1 through 100.1
Default: 0.1

Threshold sample

Threshold percentage at 50%
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Editing the Groups Page 
Use the Groups Page of the Method View to organize compounds into functional or logical 
groups. You can use these groups for creating a subset of target compounds. 

For quantitative processing, the application processes all compounds in the method and stores 
the complete result set, but only those in the selected group are visible in the Acquisition 
mode. Limiting the displayed compounds to those in the selected group can be useful when 
working with a method containing a large list of compounds, only some of which are required 
for analysis in certain samples. In that case, the application requires only a single method and 
can reduce the results. 

You can create multiple groups and include the same compound in more than one group. 

When the master method was created from a compound database, the Groups pane displays 
any compound groups defined in the compound database. See Compound Details Pane.

 To open the Groups page

Click Groups in the Method View navigation pane.

 To create a group

1. At the bottom of the Groups area, click Add Group.

The Add a New Group dialog box opens.

2. Type a name for the new group and click OK.

The new group appears in the Groups area.

3. Drag a compound from the Compounds area onto a group name (as if you were moving 
files into a folder).

Available only when you activate the 
Intelligent Sequencing option in 
the Configuration console
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4. To remove all the compounds from a group, rename the group, or delete it, right-click the 
group name and choose the applicable command.

5. To remove a single compound, right-click the compound name in the group and choose 
Remove from Group.

Groups Page

Use the features on the Groups page to organize compounds into functional or logical groups.

Figure 94. Groups page

Table 60. Groups page parameters 

Parameter Description

Compounds Lists all available compounds.

Groups Lists all available groups.

Add Group Opens the Add a New Group dialog box where you can create a 
new group.

Shortcut menu

Empty Group Removes all compounds from the selected group.

Rename Group Changes the name of the selected group.

Delete Group Removes the selected group and all the compounds in it.

Remove From Group Removes the selected compound from its group.
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Editing the Intelligent Sequencing Page 

Use the Intelligent Sequencing page to specify the actions you want the application to take 
when there are acquisition failures with each sample type. The Intelligent Sequencing page is 
available only when you activate the Intelligent Sequencing option in the Configuration 
console.

 To open the Intelligent Sequencing page

Click Intel Seq in the Method View navigation pane.

The Intelligent Sequencing page opens.

 To specify actions for sample acquisition failures

1. In the Sample Types list, select a sample type.

Each sample type has a specific set of failure flags. See Sample-Specific Failure Flags.

2. For each failure flag, select a failure action.
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The failure action choices are the same for each failure flag except flags for Solvent or 
Matrix Blank sample types. The Solvent and Matrix Blank sample types do not have Auto 
Sample or Auto Sample and Reinject failure actions.

Each Failure Action requires one or more of the following values:

• Sample Type

• Priority

• Max Action Count

• Failure Continuation

For a detailed description of each of these parameters, see Actions.

3. Select a sample type to use for the failure action.

This value is available only for Auto Sample and Auto Sample and Reinject failure 
actions. When you create your samples list on the Auto Samples page, you must include 
at least one sample with this sample type for the autosampler to use when it encounters 
this error condition. Refer to Chapter 4, “Using the Analysis Mode for Quantitation 
Batches” in the TraceFinder User Guide.

4. In the Priority column, type a priority value for this action.

The priority value can be any positive or negative integer. 

• The application performs the failure action for the highest priority failure it 
encounters and ignores all others.

• When you assign the same priority to two or more failures, the application performs 
the failure action for the first failure it encounters and ignores all others.

5. In the Max Action Count column, type a value for the maximum number of times the 
application should repeat a sample.

6. In the Failure Continuation column, do one of the following:

• Select the check box to skip this sample and continue to the next sample when this 
sample exceeds the Max Action Count value.

• Clear the check box to stop the batch when this sample exceeds the Max Action 
Count value. 
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Example

The following example shows the actions that the application uses when the acquisition for a 
sample fails.

1. The acquisition encounters an Ion Ratio Failure error on a sample.

2. The application runs a Solvent sample.

3. The application reinjects the original sample. 

4. This action is priority 0 in the Acquisition queue. 

5. The application repeats this autosample and reinject process two times.

6. After repeating the failure action two times, the application skips the sample and 
continues to the next sample.

Actions

Use the Actions pane to specify what action the application takes when it encounters a 
submission failure for the type of failure flag associated with each sample type. 

1 3 4 5 6

2

Table 61.  Actions parameters  (Sheet 1 of 2)

Parameter Description

Flag Flag (error) types specific to each sample type. See Sample-Specific Failure 
Flags. Each flag type has a set of user-specified actions that the application 
follows when it encounters this error.

Failure Action In the event of a failed sample, the application does one of the following:
• Continue: Continues to the next sample in the batch.
• Stop: Stops the batch.
• Auto Sample: Injects the sample type specified for the Auto Sample 

Type parameter and continues to the next sample.
• Reinject: Reinjects the current sample by inserting a “reinject” sample 

in the batch.
• Auto Sample and Reinject: Injects the sample type specified for the 

Auto Sample Type parameter and then reinjects the failed sample.
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Sample-Specific Failure Flags 

Each sample type has a specific set of failure flags. 

Sample Type Specifies either a Solvent or Matrix Blank sample type to use for the auto 
sample injection. 

Default: Solvent
Priority The priority value can be any positive or negative integer. 

When two or more failures have the same priority, the application 
performs the failure action for the first failure it encounters and ignores all 
others.

The application performs the failure action for the highest priority failure 
and ignores all others.

Max Action 
Count

Specifies the maximum number of times the application should repeat a 
sample before it continues to the next sample or stops the sequence, as 
determined by the value in the Failure Continuation parameter. 

Default: 1
Failure 
Continuation

When this check box is selected, samples that exceed the value specified 
for the Max Action Count parameter cause the application to skip the 
sample and continue to the next sample. 

When this check box is cleared, samples that exceed the value specified for 
the Max Action Count parameter cause the application to stop the batch.

Default: Selected

Table 61.  Actions parameters  (Sheet 2 of 2)

Parameter Description

Sample Type Flag

Matrix Blank • Blank

Cal Std • Out of Range
• Ion Ratio Failure
• Carryover

QC Std • Ion Ratio Failure
• Carryover
• Out of Range

Solvent • Solvent Flag

Unknown • Ion Ratio Failure
• Carryover
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Editing the Reports Page 

Use the Reports Page to specify how you want to save or print your reports. 

For the quantitation report types, you can modify quantitation limits flags, user interface 
options, and quantitation flag options on the Quan Report Settings page. 

See the instructions for the following tasks:

• Specifying Report Formats

• Specifying Quan Report Settings

Specifying Report Formats 

For each report type, you can create a hard-copy printout, a PDF file, a CSV file, or an Excel 
file. 

 To open the Reports page

Click Reports in the Method View navigation pane.
 

The Reports page opens with a list of all configured reports.

To configure which reports are available when you create a method or which reports 
create a batch-level report, see Specifying the Reports. 

 To specify report types and output formats

1. To edit the Report Title, double-click the name and type your new custom title.

The application uses this title for all reports that use this method. You cannot edit the 
Report Title from other report views.

2. To specify the type of report output to create for each report type, select the check box in 
the appropriate column.

Available only when you activate the 
Intelligent Sequencing option in 
the Configuration console



 4 Using the Method Development Mode for Quantitation Methods
Editing a Quantitation Method

Thermo Scientific TraceFinder Lab Director User Guide 241

3. To duplicate an output type for all reports, click the cell to select it, and then right-click 
and choose Copy Down.

All check boxes in the column below the selected cell duplicate the selected or cleared 
state of the selected cell. This action applies only to reports where this output format is 
available. By default, all report types are cleared. 

Reports Page 

Use the features on the Reports page to specify how you want to save or print your reports. 

Figure 95. Reports page

Table 62. Reports page parameters 

Parameter Description

Report list columns

Report The name of a report. 

Print Sends reports to the default printer. 

Create PDF Saves reports as PDF files. 

Create CSV Saves reports as CSV files. 

Create Excel Saves reports as Excel files. 

Exists Indicates that the report template is identified in the 
C:\TraceFinderData\4.0\Templates\ReportTemplates folder.
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Specifying Quan Report Settings 

Use the options on the Quan Report Settings Page to choose parameters for flagging values 
and displaying information in reports.

Follow these procedures:

• To specify quantitation limits

• To specify user interface options

• To specify quantitation flag options

 To specify quantitation limits

1. To report the calculated concentration at all times or only when the quantified value 
exceeds LOD, LOQ, or LOR, choose the appropriate value from the Report 
Concentration list.

For a description of concentration limits, see Editing the QAQC Page. 

2. To select the number of decimal places to report for calculated concentrations, set the 
value in the Decimal Places to be Reported box.

3. To include a chromatogram of the sample in the Quantitation Report, select the Show 
Chromatogram on Quantitation Report check box.

4. To display only valid compounds, select the Display Compounds Above Set Limit 
check box.
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 To specify user interface options

1. To shade a compound row in any of the reports if a value fails one of the criteria used for 
evaluation, select the Shade Row when Sample is Outside of Evaluation Criteria 
check box.

2. To separate the ion overlay pane from the confirming peak plots, select the Separate Ion 
Overlay Display check box.

3. To use an alternate format for the Calibration Report designed to print more concisely 
and limit the report to a maximum of seven calibration standards, select the Use 
Alternate Calibration Report Format check box.

 To specify quantitation flag options

Select the values that you want to display in the report.

Values are above or below the limits defined on the Quan page. 

These flags appear in a variety of reports and are defined in Quan Report Settings page 
parameters.
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Quan Report Settings Page

Use the features on the Quan Report Settings page to specify parameters for flagging values 
and displaying information in reports.

Figure 96. Quan Report Settings page
 

 

Table 63. Quan Report Settings page parameters  (Sheet 1 of 2)

Parameter Description

Quan Limits Flags

Report Concentration Reports the concentration at all times or only when the quantified value exceeds either the 
limit of detection (LOD), the limit of quantitation (LOQ), or the limit of reporting (LOR). 
Report concentration: Always, >LOD, >LOQ, or >LOR.

Decimal Places to be 
Reported

Number of decimal places to be included in the report. Maximum value is 6.

Show Chromatogram 
on Quantitation 
Report

Displays a chromatogram (TIC trace) of the sample in the quantitation report. 

Display Compounds 
Above Set Limit

Prints reports for only the compounds that are found in a sample. If a compound is above 
the specified Quan Flag Options limits, the application reports the compound. This 
prevents generating “empty” reports for the compounds that are not found.

User Interface Options

Shade Row When 
Sample is Outside of 
Evaluation Criteria

Shades a compound row in any of the reports if a value fails one of the criteria used for 
evaluation. 
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Separate Ion Overlay 
Display

Separates the ion overlay pane from the confirming peak plots in an analysis. 

Use Alternate 
Calibration Report 
Format

Uses an alternate format for the Calibration Report that is designed to print more concisely 
(this report is limited to a maximum of seven calibration standards). 

Display Quan Flags 
and Legend

Displays the flags and legend in reports.

Quan Flag Options
Values that are above or below limits defined on the Limits page. These flags appear in a 
variety of reports. 

Flag Values Below 
LOD

Flags values below the limit of detection (LOD).

Flag Values Below 
LOQ

Flags values below the limit of quantitation (LOQ).

Flag Values Above 
Cutoff

Flags values above the cutoff or limit of reporting (LOR).

Flag Values Above 
ULOL

Flags values above the upper limit of linearity (ULOL).

Flag Values Above 
Carryover

Flags values above the carryover limit.

Flag Values Between 
LOD and LOQ

Flags values between the limit of detection and the limit of quantitation known as the J flag.

Table 63. Quan Report Settings page parameters  (Sheet 2 of 2)

Parameter Description
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Saving a Quantitation Method to a New Name
You can save any method to a new name, or you can use the current method data to overwrite 
an existing method. The new method contains all the data of the saved method.

 To save a method to a new name

1. From the main menu, choose File > Save As.

The Save Master Method As dialog box opens, displaying all available methods.

2. Do one of the following:

• In the New Method box, type a name for the new method.

The application enables the Save button.

• In the New Method box, type the name of an existing method.

The application enables the Overwrite button.

• Select an existing method name (the application enables the Overwrite button) and 
optionally modify the selected name (the application disables the Overwrite button 
and enables the Save button) in the New Method box.

3. Click Save or Overwrite.

The application saves all the method data using the specified name and opens the 
Acquisition page of the new method.

Table 64. Save Master Method As dialog box parameters 

Parameter Description
Method Name of the methods for the selected type.
Type Type of method: Quan, Screening, or Unknown Only.
Date Changed Date the method was last updated.
Size Size of the method in megabytes.
Domain TraceFinder domain for which the method was created.
New Method Name of the new method to create.
Path Path to the selected method in the Methods folder.
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Creating a Method Template
In the TraceFinder application, you can create a processing method using a method template 
that contains common settings. You can use the Method Template Editor to create a method 
template that specifies peak detection criteria, screening libraries, confirming ion criteria, 
compound calibration, and qualitative peak processing. 

The application uses the settings in the method template to identify the data to display in the 
Qualitative View. Refer to Chapter 4, “Using the Analysis Mode for Quantitation Batches” in 
the TraceFinder User Guide.

Only quantitation methods use method templates. 

Follow these procedures:

• To specify a search type

• To open the Method Template Editor

• To specify peak criteria for a Trace search type

• To specify peak criteria for a Target List search type

• To identify the peaks for a Trace search type

• To identify the peaks for a Target List search type

• To specify the confirming ions to include

• To specify the target peaks to include

• To calibrate the compounds

• To save the method template

 To open the Method Template Editor

1. Click Method Development in the navigation pane.

The Method Development navigation pane opens.

2. Click Method View.

3. From the main menu, choose File > New > Method Template.

The Method Template Editor opens.
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 To specify a search type

From the Search Type list, select one of the following:

• Trace: Specifies that the method automatically selects peaks and ratios. Supports 
SRM and TSQ data.

• Target List: Specifies that the method uses a target list of peaks. Supports Exactive 
data.

 To specify peak criteria for a Trace search type

1. In the Find the Peaks area, select a sensitivity level.

In selecting the degree of sensitivity, you define how extensively the peak detector 
algorithm searches for low-level peaks. 

• The Genesis peak detection algorithm provides backward compatibility with 
Xcalibur 1.0 studies. 

• The ICIS peak detection algorithm is designed for integrating UV/Vis and analog 
chromatograms. 

• The Avalon peak detection algorithm is designed for MS data and has superior peak 
detection efficiency at low MS signal levels. 

• The Auto peak detection algorithm is designed for integrating UV/Vis and analog 
chromatograms. The Auto algorithm uses parameters that are identical to ICIS 
parameters with the following exception: The Use Genesis Algorithm for Qual 
Processing parameter is required and cannot be cleared.

Note  Parameters in the Find the Peaks area might also be used for qualitative peak 
processing.
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2. To look for peaks only in a certain range of the entire chromatogram, select the Limit the 
Retention Time Range check box and specify a retention time (RT) range. 

3. To indicate whether to select peaks by relative height or area and the percentage of the 
highest peak that results in compound selection, select the Enable Peak Threshold check 
box. 

To consider a peak for a processing method, the application uses the Enable Peak 
Threshold filter to determine which peaks meet the specified percentage of the height or 
area of the largest peak. 

4. To display a specific number of the largest peaks by height or area, select the Only Select 
Top Peaks check box and enter the number of peaks to display.

 To specify peak criteria for a Target List search type

1. In the Find the Peaks area, select a sensitivity level.

In selecting the degree of sensitivity, you define how extensively the peak detector 
algorithm searches for low-level peaks. 

• The Genesis peak detection algorithm provides backward compatibility with 
Xcalibur 1.0 studies. 

• The ICIS peak detection algorithm is designed for integrating UV/Vis and analog 
chromatograms. 

• The Avalon peak detection algorithm is designed for MS data and has superior peak 
detection efficiency at low MS signal levels. 

• Auto

2. To look for peaks only in a certain range of the entire chromatogram, select the Limit the 
Retention Time Range check box and specify a retention time (RT) range. 

Note  Parameters in the Find the Peaks area might also be used for qualitative peak 
processing.
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 To identify the peaks for a Trace search type

1. In the Use these Libraries box, select the libraries that you want to search.

All libraries installed on your instrument are displayed in the Use These Libraries box. 

2. To limit the number of matches returned when the system searches a spectrum against the 
selected libraries, set a value in the Limit Library Hits box.

3. To specify how to sort the library searches, select a value from the Best Match Method 
list.

4. To specify a compound database, browse to and select a compound database to use for the 
method.

When there are no libraries selected in the Use These Libraries box, the application 
searches this compound database to identify peaks.

When there are libraries selected in the Use These Libraries box, the application first 
searches the libraries and, if it finds no matches, the application then searches the 
specified compound database.

 To identify the peaks for a Target List search type

Note  Parameters in the Identify the Peaks area might also be used for qualitative peak 
processing.

Note  The application can also use the parameters in the Identify the Peaks area for 
qualitative peak processing.
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1. To specify the compound database to use for peak identification when no library is 
specified, browse to and select a compound database to use for the method.

2. To specify the Mass Tolerance, do the following:

a. Select the units of measure that you want to use. 

b. Specify the number of millimass units or parts per million to use as the m/z ± 
tolerance value.

The application applies this mass tolerance to the extracted chromatograms.

3. To specify how the method identifies analyte peaks, select one of the following peak 
detection strategies:

• Highest Peak: Uses the highest peak in the analyte chromatogram for component 
identification. 

• Nearest RT: Uses the peak with the nearest retention time in the chromatogram for 
component identification.

4. To specify how the method identifies internal standard peaks, select one of the following 
peak detection strategies:

• Highest Peak: Uses the highest peak in the internal standard chromatogram for 
component identification. 

• Nearest RT: Uses the internal standard peak with the nearest retention time in the 
chromatogram for component identification.

5. To specify that the method use retention time, select the RT option.

To specify that the method not use retention time for peak detection, select the No RT 
option.

 To specify the confirming ions to include

Note  The application uses this compound database when you do not specify 
screening libraries in the method or when it cannot identify a compound in any of the 
specified libraries.
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1. To set the number of confirming ions, select the Confirming Ions option and enter a 
value in the Number of Confirming Peaks box.

This value is the number of other ions in the spectrum whose ratio is compared to the 
quantitation ion. Using this ratio, you can then determine if it is the target compound or 
something else. You can set this value to integers from 1 through 10, inclusive. This value 
defaults to 2 because you typically perform a 3-ion experiment with one quantitation 
mass and two confirming ions. 

Using the confirming ions in the target list, the application limits the search to the 
specified number of confirming ions, selects the most intense ion to use as the 
quantitation mass, and then uses this mass for the mathematical operations. 

When this parameter is not selected, the application searches all confirming ions in the 
target list.

2. To define the criteria for evaluating confirming or qualifying ions, select the Specify 
Default Ion Ratio Ranges check box and set the following values:

a. To specify the maximum difference in retention time between a confirming peak and 
the quantification ion peak, set a value in the Ion Coelution (min) box. 

b. To specify an absolute or relative calculation approach for determining the acceptable 
ion ratio range, select Absolute or Relative from the Window Type list.

c. To specify the acceptable ion ratio range, set a value in the Window (+/– %) box.

3. To include the peak spectrum in the processing method, select the Include Compound 
Peak Spectrum as Reference Spectrum check box.

 To specify the target peaks to include

1. To set the number of target peaks, select the Target Peaks option and enter a value in the 
Number of Target Peaks box.

This value defaults to 2 to represent the total number of ions. 

2. To include the peak spectrum in the processing method, select the Include Compound 
Peak Spectrum as Reference Spectrum check box.

Note  The Target Peaks option is not available when you set the Search Type to Target 
List. See To specify a search type.
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 To calibrate the compounds

1. From the Calibration Method list, select Internal or External.

2. From the Curve Type list, select one of the following:

• Linear: All other settings are available with this exception: When you select Include 
in the Origin list, the Weighting parameter is unavailable.

• Quadratic: All other settings are available with this exception: When you select 
Include in the Origin list, the Weighting parameter is unavailable.

• Average RF: The Weighting and Origin parameters are unavailable. 

3. From the Origin list, select one of the following:

• Ignore: Specifies that the origin is not included as a valid point in the calibration 
curve when the curve is generated. When you select Ignore, the calibration curve 
might or might not pass through the origin. 

• Force: Specifies that the calibration curve passes through the origin of the data point 
plot when the calibration curve is generated.

• Include: Specifies that the origin is included as a single data point in the calculation 
of the calibration curve. When you select Include, the calibration curve might or 
might not pass through the origin.

4. From the Weighting list, select one of the following:

• Equal: Specifies that the origin is included as a single data point in the calculation of 
the calibration curve. When you select Equal, the calibration curve might or might 
not pass through the origin.

• 1/X: Specifies a weighting of 1/X for all calibration data points during the 
least-squares regression calculation of the calibration curve. Calibrants are weighted 
by the inverse of their quantity. 

• 1/X^2: Specifies a weighting of 1/X^2 for all calibration data points during the 
least-squares regression calculation of the calibration curve. Calibrants are weighted 
by the inverse of the square of their quantity. 

• 1/Y: Specifies a weighting of 1/Y for all calibration data points during the 
least-squares regression calculation of the calibration curve. Calibrants are weighted 
by the inverse of their response (or response ratio). 
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• 1/Y^2: Specifies a weighting of 1/Y^2 for all calibration data points during the 
least-squares regression calculation of the calibration curve. Calibrants are weighted 
by the inverse of the square of their response (or response ratio). 

5. From the Response Via list, select Area or Height.

• Area: Specifies that the application uses this area value in response calculations.

• Height: Specifies that the application uses this height value in response calculations. 

 To specify qualitative peak processing

1. Select the Use Genesis Algorithm for Qual Processing check box and specify a value for 
internal standard matching. 

The application uses the Genesis algorithm to match internal standards in a range 
plus/minus the value that you specify. For additional information about the Genesis 
algorithm, see Genesis Detection Method.

This parameter is available only when you set the Sensitivity parameter in the Find the 
Peaks area to ICIS or Avalon. When you select the Use Genesis Algorithm for Qual 
Processing check box, the application ignore the Sensitivity parameter in the Find the 
Peaks area. 

2. Select or clear the Exclude Matching Quan Peaks check box and specify a value for the 
exclusion window.

The application excludes target peaks in a range plus or minus the value that you specify.

3. To process samples that include data-dependent scans, select the Use Data Dependent 
Scans check box.

When you process a sample using this feature, the application uses the TIC trace to find 
all data-dependent full scans, lists them, and performs a library search against the 
data-dependent MS/MS or MSn scan.

This option constrains the Data Review to only data-dependent scan spectra. Refer to 
Chapter 4, “Using the Analysis Mode for Quantitation Batches” in the TraceFinder User 
Guide.

In addition to the peak information, the TIC Report and TIC Summary Report display 
information about the data-dependent filtered data. 
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4. To indicate whether to select peaks above a minimum percentage of the nearest internal 
standard peak that results in compound selection, select the Enable ISTD Threshold 
check box and specify a minimum percentage. 

To consider a peak for a processing method, the application uses the Enable ISTD 
Threshold filter to determine which peaks meet the specified percentage of the height of 
the nearest internal standard peak. 

When you select the Enable ISTD Threshold parameter, the method ignores values set for 
the Enable Peak Threshold and Only Select Top Peaks parameters. See To specify peak 
criteria for a Trace search type. 

 To save the method template

1. Choose File > Save from the Method Template Editor menu.

The Save Method Template dialog box opens.

2. Do one of the following:

• Type a name for the new method.

The application enables the Save button.

• Type the name of an existing method.

The application enables the Overwrite button.

3. Click Save or Overwrite.

The application saves the new method template in the following folder:

…\TraceFinderData\4.0\Templates\Methods\General 

Saved method templates are available when you create a method using Method Forge. See 
Starting a New Method with Method Forge. 

Note  When you create a method with the Method Forge, the application ignores the 
parameters in the Qualitative Peak Processing area.
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Method Template Editor

Use the features in the Method Template Editor to specify peak detection criteria, screening 
libraries, confirming ion criteria, compound calibration, and qualitative peak processing.

Figure 97. Method Template Editor dialog box
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Table 65. Method Template Editor dialog box parameters  (Sheet 1 of 4)

Parameter Description

Search Type
Specifies the search type as Trace or Target List. 

Default: Trace

Find the Peaks

Sensitivity Defines how extensively the peak detector algorithm searches for low-level peaks. 

Limit the Retention 
Time Range

Min RT specifies the beginning of the range. Max RT specifies the end of the range. 

Enable Peak Threshold 
(Trace only)

Specifies whether to select peaks by relative height or area and the percentage of the highest 
peak that results in compound selection.

Only Select Top Peaks
(Trace only)

Displays a specific number of the largest peaks by height or area.

Identify the Peaks
(Trace)

Use These Libraries Lists the libraries that you can search.

Limit Library Hits Specifies the number of matches returned when the system searches a spectrum against the 
selected libraries.

Best Match Method Specifies how to sort the library searches. 

Valid values: Search Index, Reverse Search Index, Match Probability

Database Specifies the compound database used to identify peaks. If you do not specify a compound 
database, the application uses the system database. 

If the specified database is no longer on the disk, the application highlights the database 
name. 

Identify the Peaks
(Target List)

Database Specifies the compound database used to identify peaks. If you do not specify a compound 
database, the application uses the system database. 

If the specified database is no longer on the disk, the application highlights the database 
name. 
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Mass Tolerance Specifies the m/z ± tolerance value of MMU or PPM. 

Valid range: 0.01 through 50 000
• MMU (millimass units): MMU is a static calculation to the extracted mass.
• PPM (parts per million): PPM is a variable calculation dependent on the actual mass. 

The smaller the mass, the narrower the tolerance range. The larger the mass, the wider 
the tolerance range.

The default value and units are specified in the Configuration Console. See Specifying 
Default Peak Detection Parameters.

Peak Detection Strategy 
(Analyte)

Highest Peak: Uses the highest peak in the chromatogram for component identification. 
Nearest RT: Uses the peak with the nearest retention time in the chromatogram for 
component identification.

Peak Detection Strategy 
(ISTD)

Highest Peak: Uses the highest peak in the internal standard chromatogram for component 
identification. 
Nearest RT: Uses the peak with the nearest retention time in the chromatogram for 
component identification.

Retention Time Specifies that the method use or not use retention time for peak identification.

Handle Confirming Ions / Target Peaks

Include – Confirming 
Ions

Specifies the number of confirming ions, which are other ions in the spectrum whose ratio 
is compared to the quantitation ion to identify the compound.

Number of 
Confirming Peaks 

This value defaults to 2 because you typically perform a 3-ion experiment with one 
quantitation mass and two confirming ions.

Valid values: Integers from 1 through 10, inclusive.

Specify Default Ion 
Ratio Ranges

Enables the ion ratio range features.

Ion Coelution specifies the maximum difference in retention time between a confirming 
peak and the target peak. 

Window Type specifies an Absolute or Relative calculation approach for determining the 
acceptable ion ratio range.

Window (+/-%) specifies the acceptable ion ratio range.

Include – Target Peaks 

Number of Target 
Peaks

Valid values: Integers from 1 through 10, inclusive.
Default: 2

Include Compound 
Peak Spectrum as 
Reference Spectrum

Includes the peak spectrum in the processing method. Use this setting to perform a spectra 
comparison in Data Review. 

Table 65. Method Template Editor dialog box parameters  (Sheet 2 of 4)

Parameter Description
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Calibrate the Compounds

Calibration Method Specifies an internal or external calibration method.

Curve Type Specifies a linear, quadratic, or average RF curve type.

Origin Specifies that the origin is ignored, forced, or included in the generated calibration curve.
• Ignore: Specifies that the origin is not included as a valid point in the calibration curve 

when the curve is generated. When you select Ignore, the calibration curve might or 
might not pass through the origin. 

• Force: Specifies that the calibration curve passes through the origin of the data point 
plot when the calibration curve is generated.

• Include: Specifies that the origin is included as a single data point in the calculation of 
the calibration curve. When you select Include, the calibration curve might or might 
not pass through the origin.

Weighting Specifies the weighting for the calibration data points.
• Equal: Specifies that the origin is included as a single data point in the calculation of 

the calibration curve. When you select Equal, the calibration curve might or might not 
pass through the origin.

• 1/X: Specifies a weighting of 1/X for all calibration data points during the least-squares 
regression calculation of the calibration curve. Calibrants are weighted by the inverse 
of their quantity. 

• 1/X^2: Specifies a weighting of 1/X^2 for all calibration data points during the 
least-squares regression calculation of the calibration curve. Calibrants are weighted by 
the inverse of the square of their quantity. 

• 1/Y: Specifies a weighting of 1/Y for all calibration data points during the least-squares 
regression calculation of the calibration curve. Calibrants are weighted by the inverse 
of their response (or response ratio). 

• 1/Y^2: Specifies a weighting of 1/Y^2 for all calibration data points during the 
least-squares regression calculation of the calibration curve. Calibrants are weighted by 
the inverse of the square of their response (or response ratio). 

Response Via Specifies if the application uses area or height in response calculations.
• Area: Specifies that the application uses this peak area value in response calculations.
• Height: Specifies that the application uses this peak height value in response 

calculations. 

Qualitative Peak Processing

Use Genesis Algorithm 
For Qual Processing

The application uses the Genesis algorithm to match internal standards. 

ISTD Matching Excludes all the target compounds found in the method and does not list these compounds 
in the TIC Report or in the Qual Mode view in the Data Review.

Table 65. Method Template Editor dialog box parameters  (Sheet 3 of 4)

Parameter Description
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Exclude Matching Quan 
Peaks

Exclusion Window

Compares the retention time of the internal standard in the method to the found retention 
time of the internal standard in the library search and excludes peaks outside the Exclusion 
Window range. 

Defines a range plus/minus the Exclusion Window value that you specify.

Use Data Dependent 
Scans

Constrains the Data Review to only data-dependent scan spectra. Refer to Chapter 4, 
“Using the Analysis Mode for Quantitation Batches” in the TraceFinder User Guide. 

In addition to the peak information, the TIC Report and TIC Summary Report display 
information about the data-dependent filtered data.

Enable ISTD Threshold Specifies that, when identifying a peak, qualitative peak processing use the minimum 
threshold specified as a percentage of the nearest internal standard peak, rather than the 
threshold specified in the Enable Peak Threshold and Only Select Top Peaks parameters.

% of Internal 
Standard

Percentage of the nearest internal standard peak to use as the minimum threshold for 
identifying a peak.

Table 65. Method Template Editor dialog box parameters  (Sheet 4 of 4)

Parameter Description
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Exporting Mass Data
You can export the mass data list from the Compounds page to an XML file that can be read 
by the TSQ, ISQ, Q Exactive, TSQ Endura, or TSQ Quantiva applications. You can export 
mass data only from quantitation methods.

 To export mass data list to an XML file

1. Open the method whose mass data list you want to export. 

If you make changes to the method, you must save it before you can export the mass data 
list.

2. To view a list of your mass data, click the Acquisition List tab on the Compounds page.

You do not have to display the Acquisition List to export the data. For information about 
displaying the Acquisition List, see Acquisition List. 

3. Choose Method View > Export Mass List from the main menu.

The application writes the mas data in the Acquisition List to the following folder, using a 
format compatible with your configured instrument:

…\TraceFinderData\4.0\Methods\Methodname

IMPORTANT   If you have neither a TSQ, an ISQ, a Q Exactive, a TSQ Endura, nor 
TSQ Quantiva instrument configured, a message asks which format you want to 
export: Triple Quadrupole, Q Exactive, TSQ Quantiva/Endura SIM, or TSQ 
Quantiva/Endura SRM.
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5

Using the Method Development Mode for Target 
Screening Methods

This chapter includes method development tasks for creating and editing screening methods. 
(See Method Development navigation pane.) When user security is activated, you must have 
Method Development Access permission to use these features.

The TraceFinder application uses a method to specify the types of acquisition, processing, and 
reporting that occur with a batch of samples. You can create a method designed specifically to 
test for compounds in your assay. 

When you create a method, the TraceFinder application uses it to determine how to process a 
set of samples and provide a set of meaningful results. The application uses an instrument 
method to define how to acquire raw data. The rest of the method defines how to process the 
raw data, how the flag information displays the results, and how the reporting functionality 
defines the output for your data and results. 

The application applies your method to a batch, which is a list of one or more samples. 
Together, the method and batch provide a workflow-oriented approach to the data processing 
and information reporting for batches of samples. 

IMPORTANT   TraceFinder 4.1 uses the same data as TraceFinder 4.0. By default, the application 
stores the method data for the 4.1 release in the TraceFinderData\4.0\Methods folder.

Contents

• Opening a Target Screening Method

• Starting a Target Screening Method

• Editing a Target Screening Method

• Saving a Target Screening Method to a New Name
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Figure 98. Method Development navigation pane

Table 66. Method Development navigation pane commands 

Command Description

Method View

Acquisition Displays the Acquisition page of the Method View. Use the 
features on the Acquisition page to define basic information about 
the method. See Editing the Acquisition Page.

Target Screening

Processing Displays the Processing page of the Method View. Use the features 
on the Processing page to specify peak filter settings, screening 
databases, and identification and confirmation settings for a target 
screening method. See Editing the Processing Page.

Peak Detection Displays the Peak Detection page of the Method View. Use the 
features on the Peak Detection page to specify any of the following 
peak detection algorithms: Genesis, ICIS, or Avalon. See Editing 
the Peak Detection Page.

Reports Displays the Reports page of the Method View. See Editing the 
Reports Page.

Compound Database
See Chapter 2, “Using Compound Databases in the Method 
Development Mode.” 

Instrument View
See Chapter 3, “Using Instrument Methods in the Method 
Development Mode.” 
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Opening a Target Screening Method
A target screening method contains compound databases, identification and confirmation 
criteria used in detecting and processing, and settings for reporting compounds. 

When you open a target screening method, the Method View navigation pane displays the 
available pages for target screening methods. For descriptions of all the features in the Method 
Development navigation pane, see Starting a Target Screening Method.

 To open a target screening method in the Method Development mode

1. Click Method Development in the navigation pane.

The Method Development navigation pane opens. 

2. Choose File > Open > Master Method from the main menu. 

The Open Master Method dialog box opens, displaying all available methods.

3. Select Screening in the Type list.

The method list displays only target screening methods. See Open Master Method dialog 
box.

4. Select a method and click Open.

The Acquisition page for the selected method opens. To edit the method, see Editing a 
Target Screening Method.

The navigation pane displays the available pages for target screening methods. For 
descriptions of all the features in the Method Development navigation pane, see Starting 
a Target Screening Method.

Tip  You can also open one of your most recently used method files. Choose Files > 
Recent Files > Method.
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Figure 99. Open Master Method dialog box

Table 67. Open Master Method dialog box parameters 

Parameter Description

Method Name of the methods for the selected type.
Type Type of method: Quan, Screening, or Unknown Only.
Date Changed Date the method was last updated.
Size (MB) Size of the method in megabytes.
Domain TraceFinder domain for which the method was created.
Type Type of method to display: Quan, Screening, Unknown Only, or 

Any.
Path Path to the selected method in the 

TraceFinderData\4.0\Methods\General folder.
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Starting a Target Screening Method
You can create a target screening method that uses a target list of compounds in selected 
compound databases to identify the compounds in the samples. The following procedure 
includes the basic parameters you must define to create and save a target screening method. 
For a detailed description of how to modify all parameters in a method, see Editing a Target 
Screening Method.

 To create a new method

1. Choose File > New > Master Method from the main menu.

The Create Master Method dialog box opens. 

Figure 100. Create Master Method dialog box

2. Select the Target Screening Method option and click OK.

The Method View for a target screening method includes the Acquisition, Processing, 
Peak Detection, and Reports pages. 

IMPORTANT   The Unknown Screening Method - Only feature is available only when 
you select the Allow Unknown Screening option in the application configuration 
console. See Processing Options.
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The Acquisition page for the method opens.

3. From the Instrument Method list, select an instrument method. 

4. Click Processing in the Method View navigation pane.

The Processing page for the method opens. The application lists the compound databases 
(.cdb) that are stored in the following folder:

…\Thermo\TraceFinder\4.0\General\Databases

5. Select the Enabled check box for at least one compound database.

You must select at least one compound database before you can save the method. The 
target screening method uses only the target list of compounds in the selected compound 
databases to identify the compounds in the samples.

6. To save the new method, choose File > Save from the main menu.

7. In the Save Master Method dialog box, type a name for the method and click OK.

For a detailed description of how to modify a method, see Editing a Target Screening 
Method. 

 To see how to create a new target screening method

1. Choose Help > Animations.

2. From the list of animation topics, click Starting a Target Screening Method.
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Editing a Target Screening Method
You can open a method to specify method instructions, reporting options, peak filter settings, 
screening databases, identification and confirmation settings, and peak detection parameters.

See the instructions for the following tasks:

• Editing the Acquisition Page

• Editing the Processing Page

• Editing the Peak Detection Page

• Editing the Reports Page

Editing the Acquisition Page

Use the features on the Acquisition page to define basic information about the method.

 To edit the parameters on the Acquisition page

1. Click Acquisition in the Method View navigation pane.

The Acquisition Page for the method opens.

2. In the Lab Name box, type the name to be displayed on the top of each printed, saved, or 
exported report.

The default name is Default Laboratory.

3. In the Assay Type box, type the assay type to be targeted by the method.

4. From the Injection Volume box, select the injection volume (in μL) to be used for sample 
injection.

Valid range: 0.1 through 2000 μL

Use the up/down arrows to change the volume in increments/decrements of 1.0 μL, or 
use the keyboard to enter non-integer injection volumes. 

5. From the Mass Precision box, select the number of decimal places to be used in reports 
and in peak and spectrum displays. 

Valid values: Integers from 2 through 6, inclusive 

6. From the Instrument Method list, select an instrument method. 

IMPORTANT  The application uses this injection volume in the method, not the 
injection volume in the instrument method.
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7. To edit the instrument method, click Edit.

The Thermo Instrument Setup window opens. This example of an instrument setup 
shows multiple configured instruments.

Figure 101. Thermo Instrument Setup window

8. Edit the values on the instrument page for your instrument.

9. From the main menu in the Thermo Instrument Setup window, 
choose File > Save and then choose File > Exit.

The application returns you to the Acquisition page of the Method View.
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Acquisition Page 

Use the features on the Acquisition page to define basic information about the method. 

Figure 102. Acquisition page for a target screening method 

Table 68. Acquisition page parameters  (Sheet 1 of 2)

Parameter Description

Lab Name The laboratory name to be displayed on the top of each printed, 
saved, or exported report. 

Default: Default Laboratory

To specify this default laboratory name, see Specifying Application 
Defaults.

Assay Type The name for the analysis type to be targeted by the method. The 
assay type associates the method with the analysis of a compound 
or specific class of compounds (for example, you might use an 
assay type of PAH for the analysis of Polynuclear Aromatic 
Hydrocarbons).

Injection Volume The system uses the injection volume (in μL) for sample injection. 
For a more detailed explanation, refer to the documentation for 
the autosampler.

The injection volume in the method overrides the injection 
volume in the instrument method. 

The injection volume in the batch overrides the injection volume 
in the method.

Valid range: 0.1 through 2000 μL
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Editing the Processing Page

Use the features on the Processing page to specify peak filter settings, screening databases, and 
identification and confirmation settings for a method.

Follow these procedures:

• To open the Processing page

• To specify peak filter settings for limiting the display of unwanted data

• To add unknown screening to the method

• To specify compound databases

• To specify identification and confirmation settings

 To open the Processing page

Click Processing in the Method View navigation pane.

The Processing Page for the method opens.

Mass Precision Number of decimal places used in reports and in peak and 
spectrum displays. 

Valid values: Integers from 2 through 6, inclusive

Instrument Method Instrument method used for acquiring samples.

Edit Opens the Thermo Instrument Setup window where you can edit 
the instrument method.

Update Choose one of the following:

• Send to System Methods: Overwrites the instrument method 
in the C:\TraceFinderData\4.0\Methods folder with the 
current instrument method.

• Get from System Methods: Overwrites the current instrument 
method with the instrument method in the 
C:\TraceFinderData\4.0\Methods folder.

Table 68. Acquisition page parameters  (Sheet 2 of 2)

Parameter Description
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 To specify peak filter settings for limiting the display of unwanted data

1. To set a retention time range that excludes searching for peaks outside the range, do the 
following:

a. Select the Use RT Limits check box.

The application activates the Search From and To options.

b. In the Search From box, enter the lower limit; in the To box, enter the upper limit.

2. To use one or more matrix blank samples for subtraction to filter the resulting peaks, do 
the following:

a. Select the Use Matrix Blank check box.

The application activates the Amplifier option.

During automatic processing, the application subtracts the areas of the peaks in the 
matrix blank samples from the matching areas in the unknown samples. 

To determine the pair of peaks to subtract from each other, the application selects the 
two peaks with the mass and the retention time that are closest to each other (as 
defined in the compound database), within the mass tolerance range specified in the 
method.

When the same compound peak (same mass and retention time within the 
predefined tolerance windows) is in multiple selected matrix blank samples, the 
application subtracts only the one with the highest area.

When a compound peak in one matrix blank sample has the same primary ion as 
another peak in a different matrix blank sample but has different adducts, the 
application uses all the adducts from both these peaks for subtraction purposes. For 
example, if a compound has the M+H and M+Na ions in one matrix blank sample, 
and this same compound has the M+H and M+NH4 ions in another matrix blank 
sample, the application uses for subtraction the area that results from all of these ions.

When no matrix blank sample exists in the sequence, or if one or more matrix blank 
samples exist but you do not select the Use Matrix Blank check box, then subtraction 
does not occur. If subtraction occurs and the subtracted area is less than 0, the 
application sets the subtracted area to 0.
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b. In the Amplifier box, type an amplifier value. 

Use the up/down arrows to change the value in increments/decrements of 1 unit, or 
use the keyboard to enter non-integer values. 

The application multiplies a matrix blank area by this value before performing 
subtraction. The larger the amplifier value, the more peaks the application filters 
from the final results.

In the Batch View for sequences created with this method, you can select which matrix 
blank samples to use for subtraction. Refer to Chapter 5, “Using the Analysis Mode for 
Target Screening Batches” in the TraceFinder User Guide.

3. In the Chromatogram View Width box, type a value to define the chromatogram viewing 
range in the Data Review view. 

4. To use source CID scans for target screening confirmation (fragment ion or library 
search), select the Use Source CID Scans check box.

When you select this check box, the application uses the source CID scans when they are 
available in the data file. If they are not available, then the application uses AIF or 
MS/MS scans when available.

5. To display all compounds from the compound databases in the Data Review display 
(regardless of whether there is a match in the samples), select the Show All Compounds 
check box.

 To add unknown screening to the method

1. Select the Include Unknown Screening check box.

The application adds the Unknown Screening features to the Method View navigation 
pane.

2. To specify unknown screening settings for peaks, libraries, databases, elements, and 
ChemSpider searches, click Processing.

For further instructions, see Editing the Processing Pages.

IMPORTANT   The Include Unknown Screening check box is available only when you 
select the Allow Unknown Screening option in the application configuration console. 
See Processing Options.
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3. To specify unknown screening peak detection settings, click Peak Detection Settings.

For further instructions, see Editing the Peak Detection Settings Page.

The application indicates that a target screening method includes unknown screening in 
the following locations:

• In the Batch View in the Analysis mode, when you create a batch using a target 
screening method, the title bar indicates that the method includes unknown 
screening.

• In the Analysis navigation pane, the application displays access to local methods for 
both target screening and unknown screening.

• In the Submit Options dialog box, when you submit a batch, the Process Data area 
shows all processing method types for the batch.

You can select the detection options for each processing method that you want to use 
when you submit the batch.

 To specify compound databases

1. Select the Enabled check box for at least one compound database.

The Compound Databases pane displays all compound databases stored in the 
…\Thermo\TraceFinder\4.0\General\Databases folder.

2. (Optional) To edit a database, click Open and do the following:

a. Edit the database. 

See Chapter 2, “Using Compound Databases in the Method Development Mode.” 

b. When you finish editing the database, click Processing in the Method View 
navigation pane to return to the Processing page.
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 To specify identification and confirmation settings

1. To set a target threshold override and include only peaks with areas above this designated 
threshold, specify the following Peaks parameters: 

a. Select the Threshold Override check box.

b. In the associated box, type the threshold as an area value.

This threshold overrides the Response Threshold value set in the compound 
database. The application ignores the peaks with areas below your specified threshold.

c. To include only peaks with signal-to-noise ratios (S/Ns) that are above a specified 
value, in the S/N Ratio Threshold box, type the threshold as a ratio value.

The application ignores the peaks with S/Ns that are below the specified threshold. 

d. In the Mass Tolerance box, type an m/z ± tolerance value and then select ppm or 
mmu for the mass tolerance units.

The application applies this mass tolerance range to the extracted chromatograms.

Figure 103. Peaks parameters

2. To specify the Retention Time parameters, do the following:

a. Select either the Identity or Confirm check box.

b. Select the Window Override check box and type the window value.

This window overrides the RT Window value that was set in the compound database 
and includes only peaks within this designated window. The application identifies or 
confirms the presence of a compound only when its measured retention time matches 
the target compound’s expected retention time within the specified Window 
Override retention time. 

Figure 104. Retention Time parameters

For additional information about how the application identifies retention time, see 
Retention Time.

Note  The Identification and Confirmation Settings pane displays parameters for 
identifying or confirming compounds. For additional information about the 
confirmation and identification process, see Understanding the Identification and 
Confirmation Process.
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3. To specify the Fragment Ions parameters, do the following:

a. Select either the Identity or Confirm check box.

b. To ignore the Fragment Ions options when no fragment is defined in the compound 
database, select the Ignore if Not Defined check box.

When the compound database does not define fragments for a compound, the 
application does not include the results of identification or confirmation for fragment 
ions in the target screening results.

c. In the Min. # of Fragments box, type the minimum number of fragments required to 
identify or confirm the presence of a compound.

d. In the Intensity Threshold box, type the intensity threshold value.

The intensity of a fragment must be above this threshold to be identified or 
confirmed.

e. In the Mass Tolerance box, type an m/z ± tolerance value and then select ppm or 
mmu for the mass tolerance units.

This mass tolerance value indicates the number of millimass units or parts per million 
to use as the m/z ± tolerance value for the fragment ions. It is separate from the mass 
tolerance value specified for the parent peak. 

Figure 105. Fragment Ions parameters

For additional information about how the application identifies fragment ions, see 
Fragment Ions.

4. To specify the Isotopic Pattern parameters, do the following:

a. Select either the Identity or Confirm check box.

b. In the Fit Threshold box, type the fit threshold percentage.

To identify or confirm the presence of a compound, the resulting score percentage 
from isotopic pattern matching must be higher than the specified fit threshold 
percentage. 

Note   When using ion trap data, the application uses 300 mmu regardless of the 
value you enter here.
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c. In the Allowed Intensity Deviation box, type a value to specify the allowed intensity 
deviation of the mass spectrometer relative to the monoisotopic ion, as a percentage 
of the base peak height.

The TraceFinder isotopic pattern algorithm considers an isotope peak as not found if 
its intensity, relative to the monoisotopic ion’s intensity, is more than the deviation 
percentage from the theoretical relative intensity of the isotope ion. For best results, 
set this value to a number that causes up to 98% of all intensity deviations to be 
smaller than the allowed intensity deviation value.

d. To specify that isotopic pattern calculations use internal mass calibration instead of 
external mass calibration, select the Use Internal Mass Calibration check box. 

When you select this check box, the application applies a requirement that an 
isotope’s m/z must be closer to its theoretical value to avoid a score penalty.

Figure 106. Isotopic Pattern parameters

For additional information about how the application calculates isotopic pattern scores, 
see Isotopic Pattern.

5. To specify the General Library Search parameters, do the following:

a. Select either the Identity or Confirm check box.

b. Select a Library Search Type: mzVault, NIST, or NIST High Resolution.

c. In the General Library Settings area, do the following:

i. To specify the source for the peaks, set the MS Order to MS, MS2, or MS–In 
Source CID.

ii. To specify that the application uses the isolation width to determine if there is an 
MS/MS scan within the same peak RT window that includes the precursor 
fragments, select the Use Isolation Width check box.

Figure 107. General Library Search parameters

Note  This option is available only when you set the MS Order to MS2.
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d. To specify the NIST Settings parameters, do the following:

i. Specify the Search Type as Normal, MS/MS, or In Source HiRes.

ii. Specify the m/z ± tolerance value for the Precursor Tolerance and the Product 
Tolerance, and then specify the units of measure.

– For accurate mass libraries, choose amu.

– For exact mass libraries, choose ppm (default).

iii. To ignore the mass spectral peaks within the specified precursor tolerance range, 
select the Ignore Precursor check box.

iv. To use an alternate peak matching method for searching the mass spectra, select 
the Use Alt Peak Matching check box.

v. To compare a library entry to an unknown compound, select the Reverse Search 
check box.

A forward search compares the mass spectrum of an unknown compound to a 
mass spectral library entry.

vi. To specify that the application uses presearch screening before calculating the 
spectrum-by-spectrum match factor, specify the Presearch as Default.

vii. Specify the lower SI Threshold value for the search index method to use in the 
NIST library search. 

viii. Specify the lower RSI Threshold value for the reverse search index method to use 
in the NIST library. 

ix. Specify the lower Probability Threshold value for the match probability.

x. Specify a value for Passing Score.

Note  These options are available only when you select the MS/MS or 
In-source HiRes search types.

Note  This option is available only when you select the MS/MS or In-source 
HiRes search types.

Note  This option is available only when you select the MS/MS or In-source 
HiRes search types.
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Figure 108. NIST Settings parameters

e. To specify the mzVault parameters, do the following:

i. From the Search Type list, select either Classic or HighChem.

ii. Specify an m/z ± tolerance value for Precursor Tolerance, and then select the units 
of measure for precursor tolerance.

iii. Specify an m/z ± tolerance value for Fragment Tolerance, and then select the 
units of measure for fragment tolerance.

iv. Select a threshold value for Score Threshold.

The application uses this lower threshold value for the Library Score in Data 
Review. The application does not return results below this value. 

v. Specify a value for Passing Score.

vi. To ignore mass spectral peaks within the specified precursor tolerance range, 
select the Ignore Precursor check box.

vii. To specify that the application use the reverse search method, select the Reverse 
Search check box. 

A reverse search compares a library entry to an unknown compound (whereas a 
forward search compares the mass spectrum of an unknown compound to a mass 
spectral library entry).
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Figure 109. mzVault parameters

For additional information about how the application performs library searches, see 
Library Search.

Processing Page 

The Processing page includes the following panes:

• Settings

Use the features in the Settings Pane to specify peak filter settings.

• Target Screening Settings

Use the features in the Target Screening Settings Pane (part 1) to specify screening 
databases and identification and confirmation settings for Retention Time, Fragment 
Ions, and Isotopic Pattern, or use the features in the Target Screening Settings Pane 
(part 2) to specify identification and confirmation settings for Library Search.

Settings Pane

Use the features in the Settings pane to specify peak filter settings. 

Figure 110. Settings pane on the Processing page
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Table 69. Settings pane parameters 

Parameter Description

Peak Filter Settings

Use RT Limits Specifies a lower and upper limit for searches. 

Valid range: 0.00 through 999.99 minutes
Default: 0.00 minutes for lower limit; 999.00 minutes for upper limit

Use Matrix 
Blank

Specifies that during automatic processing, the application subtracts the 
areas of the peaks in the selected matrix blank samples from the matching 
areas in the unknown samples. 

Amplifier The application multiplies a matrix blank area by this value before 
performing subtraction. The larger the amplifier value, the more peaks 
the application filters from the final results.

Valid range: 0.01 through 1000.00
Default: 1.00

Chromatogram 
View Width

Specifies a window width to define the chromatogram viewing range in 
the Data Review view. 

Valid range: 0.10 through 999.00 minutes
Default: 0.75 minutes

Use Source CID 
Scans

Specifies that the application uses the source CID scans when they are 
available in the data file. If they are not available, then the application 
uses available AIF or MS/MS scans.

Show All 
Compounds

Displays results for all compounds in the method, regardless of whether 
they are found in any samples.
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Target Screening Settings Pane (part 1)

Use the features in the Target Screening Settings pane to specify screening databases and 
identification and confirmation settings for Retention Time, Fragment Ions, and Isotopic 
Pattern. 

Figure 111. Target Screening Settings pane (part 1)

Table 70. Target Screening Settings pane parameters (part 1)  (Sheet 1 of 4)

Parameter Description

Compound Databases

Enabled Specifies databases to use for target screening processing.

Database Name Lists available databases in the Databases folder.
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Identification and Confirmation Settings

Peaks
Specifies that the application uses the mass-to-charge ratio (m/z) 
for filtering compound peaks.

Threshold Override Overrides the Response Threshold value set in the compound 
database. The application ignores the peaks with areas below this 
specified threshold.

Valid range: 1000 through 1 000 000 000
Default: 5000

S/N Ratio Threshold Includes only peaks with signal-to-noise ratios (S/Ns) above the 
specified value.

Valid range: 1.0 through 100 000
Default: 5.0

Mass Tolerance Specifies the number of millimass units or parts per million to use 
as the m/z ± tolerance value for the peak identification.

Valid range: 0 through 500 
Default: 5
Unit: mmu or ppm

Retention Time

Specifies either the Identify or Confirm option for a retention time 
search. To identify a compound, the application searches the 
specified RT window for a match. To confirm a compound, the 
application searches the entire raw data file.

Ignore if Not Defined Ignores the values you specify for Retention Time options when 
no retention time is defined in the compound database, and does 
not include the results of identification or confirmation for 
retention time in the Data Review target screening results.

Window Override Specifies the number of seconds to override the RT Window value 
set in the compound database and include only peaks within this 
designated window. The application identifies or confirms the 
presence of a compound only when its measured retention time 
matches the target compound’s expected retention time within the 
specified Window Override retention time. 

Valid range: 0 through 999 seconds
Default: 30 seconds

Fragment Ions

Specifies either the Identify or Confirm option for a fragment ion 
match. To identify a fragment, the application searches the 
specified RT window for a match. To confirm a fragment, the 
application searches the entire raw data file.

Table 70. Target Screening Settings pane parameters (part 1)  (Sheet 2 of 4)

Parameter Description



 5 Using the Method Development Mode for Target Screening Methods
Editing a Target Screening Method

Thermo Scientific TraceFinder Lab Director User Guide 285

Ignore if Not Defined Ignores the values you specify for Fragment Ions options when no 
fragment is defined in the compound database, and does not 
include the results of identification or confirmation for fragment 
ions in the Data Review target screening results.

Min. # of Fragments Specifies the minimum number of fragments required to identify 
or confirm the presence of a compound.

Valid range: 1 through 5
Default: 1

Intensity Threshold Specifies the minimum height of a fragment ion peak. The peak of 
a fragment ion must be above this intensity threshold to be 
identified or confirmed.

Valid range: 1 through 1e9
Default: 10 000

Mass Tolerance Specifies the number of millimass units or parts per million to use 
as the m/z ± tolerance value for the fragment ions and is separate 
from the mass tolerance specified for the parent (see Editing the 
Acquisition Page).

Valid range: 0 through 500 
Default: 5
Unit: mmu or ppm

Note  When using ion trap data, the application uses 300 mmu 
regardless of the value you enter here.

MS Order Specifies that the confirming peaks come from the same scan 
(MS), are fragments from an adjacent scan (MS2), or come from 
the Source CID (MS–In Source CID). 

Isotopic Pattern 

Specifies either the Identify or Confirm option for an isotopic 
pattern match. To identify a compound, the application searches 
the specified RT window for a match. To confirm a compound, 
the application searches the entire raw data file.

Fit Threshold To identify or confirm the presence of a compound, the resulting 
score percentage from isotopic pattern matching must be higher 
than the specified fit threshold percentage. 

Default: 90% 

Table 70. Target Screening Settings pane parameters (part 1)  (Sheet 3 of 4)

Parameter Description
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Allowed Mass 
Deviation

Specifies the allowed mass deviation in the spectrum data.

The TraceFinder isotopic pattern algorithm considers an isotope 
peak as found if its measured m/z is less than this amount away 
from its expected m/z. For best results, set this value to a number 
that causes up to 98 percent of all mass deviations to be smaller 
than the allowed mass deviation value. 

Valid range: 3 through 100 ppm 
Default: 3 ppm

Allowed Intensity 
Deviation

Specifies the allowed intensity deviation of the mass spectrometer, 
relative to the monoisotopic ion, as a percentage of the base peak 
height.

The TraceFinder isotopic pattern algorithm considers an isotope 
peak as not found if its intensity relative to the monoisotopic ion’s 
intensity is more than this deviation percentage from the 
theoretical relative intensity of the isotope ion. For best results, set 
this value to a number that causes up to 98% of all intensity 
deviations to be smaller than the allowed intensity deviation value.

Default: 10%

Use Internal Mass 
Calibration

Specifies that the application requires an isotope’s m/z to be closer 
to its theoretical value to avoid a score penalty.

Table 70. Target Screening Settings pane parameters (part 1)  (Sheet 4 of 4)

Parameter Description
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Target Screening Settings Pane (part 2)

Use the features in the Target Screening Settings pane to specify identification and 
confirmation settings for Library Search. 

Figure 112. Target Screening Settings pane (part 2)
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Table 71. Target Screening Settings pane parameters (part 2)  (Sheet 1 of 3)

Parameter Description

Identification and Confirmation Settings (continued)

Library Search

Specifies either the Identify or Confirm option for a library search. 
To identify a compound, the application searches the specified RT 
window for a match. To confirm a compound, the application 
searches the entire raw data file.

Library Search Type Specifies the type of library to search: mzVault, NIST, or NIST 
High Resolution.

General Library Settings

MS Order Specifies that the confirming peaks come from the same scan 
(MS), are fragments from an adjacent scan (MS2), or come from 
the Source CID (MS–In Source CID). 

Use Isolation Width Specifies that the application uses the isolation width to determine 
if there is an MS/MS scan within the same peak RT window that 
includes the precursor fragments. Available only when you set the 
MS Order to MS2.

NIST Settings

Search Type Specifies the type of library search algorithm to use.

Normal: Uses a more extensive set of presearch screenings—a total 
of four different criteria.

MS/MS: Searches for an MS/MS spectrum in a library of MS/MS 
spectra.

In-source HiRes: Searches for an in-source/EI with an accurate ion 
m/z or an MS/MS spectrum in a library that contains in-source/EI 
accurate ion m/z or MS/MS spectra.

Precursor Tolerance Specifies the precursor m/z ± tolerance value as either amu or ppm. 
Available only when you select MS/MS or In-source HiRes search 
types.

Note  Use amu for accurate mass libraries (such as libraries from 
Exactive, Q Exactive, or Orbitrap instruments).

Valid range: 0.01 through 100 000.00
Default: 1.60 ppm
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Product Tolerance Specifies the product m/z ± tolerance value as either amu or ppm. 
Available only when you select MS/MS or In-source HiRes search 
types.

Note  Use amu for accurate mass libraries (such as libraries from 
Exactive, Q Exactive, or Orbitrap instruments).

Valid range: 0.01 through 100 000.00
Default: 1.60 ppm

Ignore Precursor Ignores mass spectral peaks within the specified precursor 
tolerance range.
Available only when you select MS/MS or In-source HiRes search 
types.

Use Alt Peak Matching Specifies that the application uses an alternate peak matching 
method for searching the mass spectra.
Available only when you select MS/MS or In-source HiRes search 
types.

Reverse Search Specifies that the NIST library search uses the reverse search 
method. A reverse search compares a library entry to an unknown 
compound (whereas a forward search compares the mass spectrum 
of an unknown compound to a mass spectral library entry).

Presearch Specifies that the application uses presearch screening before 
calculating the spectrum-by-spectrum match factor.

SI Threshold Specifies the lower threshold value for the search index method 
used to search the NIST library. The application does not return 
results below this value.

Valid range: 0 through 999
Default: 250

RSI Threshold Specifies the lower threshold value for the reverse search index 
method used to search the NIST library. The application does not 
return results below this value.

Valid range: 0 through 999
Default: 250

Probability Threshold Threshold value for the match probability.

Passing Score Valid range: 0.00 through 100.00
Default: 80.00

Table 71. Target Screening Settings pane parameters (part 2)  (Sheet 2 of 3)

Parameter Description
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mzVault Settings

Search Type Specifies the type of library search algorithm to use.
• Classic: Uses the standard library search algorithm.
• HighChem: Uses the HighChem library search algorithm.

Precursor Tolerance Specifies the spectrum m/z ± tolerance value as either amu or ppm.

Valid range: 0.1 through 1000.0
Default: 5.00 ppm

Fragment Tolerance Specifies the spectrum m/z ± tolerance value as either amu or ppm.

Valid range: 0.1 through 1000.0
Default: 5.00 ppm

Score Threshold Specifies that the application does not return results below this 
value. The resulting score percentage from a library search match 
must be higher than your specified threshold value to identify or 
confirm the presence of a compound. 

Valid range: 0 through 100
Default: 80.00

Passing Score Valid range: 0.00 through 100.00
Default: 80.00

Ignore Precursor Specifies that the application ignores mass spectral peaks within 
the specified precursor tolerance range.

Reverse Search Specifies using the reverse search method for an mzVault search. A 
reverse search compares a library entry to an unknown compound 
(whereas a forward search compares the mass spectrum of an 
unknown compound to a mass spectral library entry).

Note   When you are using all ions fragmentation (AIF), 
data-independent (DIA), variable data-independent (vDIA), or 
source collision-induced dissociation (CID) data, the application 
automatically uses reverse search even if you do not select this 
option.

Table 71. Target Screening Settings pane parameters (part 2)  (Sheet 3 of 3)

Parameter Description
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Understanding the Identification and Confirmation Process

By default, the application uses the mass-to-charge ratio (m/z) for filtering compound peaks. 
In the Identification and Confirmation Settings area, you can select additional criteria to help 
increase confidence using either of the following:

• Compound identification for identifying a sample compound as a minimum requirement 
for a match to be displayed in the results.

To identify a compound, the application searches within the specified RT window (or the 
RT window override if specified in the method) and compares the measured m/z of the 
sample peak against the expected m/z of the target compound. When the sample peak’s 
m/z is within the default ±5 ppm tolerance of the target compound’s m/z, the application 
considers that this target compound is identified.

• Compound confirmation for confirming a sample compound and to increase confidence 
in the match results.

To confirm a compound, the application searches the entire raw data file and compares 
the measured m/z of the sample peak against the expected m/z of the target compound. 
When the sample peak’s m/z is within the tolerance of the target compound’s m/z, the 
application considers that this target compound is confirmed.

The application processes identification and confirmation settings in a specific order. When a 
compound passes identification at each point in the order of processing, the application 
continues to the next automatic or selected identification or confirmation test. 

When a compound fails identification at a point in the processing, the application skips the 
testing of all remaining criteria, even when they are selected, and the flags for those criteria are 
blank.

The application processes identification and confirmation settings in the following order:

1. m/z and Retention Time

The application automatically identifies the mass to charge ratio for all compounds. 
When you select the Retention Time settings, the compound must pass this criteria first. 
When a compound fails the m/z or the Retention Time identification test, the application 
does not perform identification or confirmation testing for any other selected criteria 
lower in the processing order.

For additional information about the m/z and Retention Time parameters, see Mass to 
Charge (m/z) and Retention Time.

Note   When you select the Ignore if Not Defined option and the related data is not 
defined in the compound databases, the application skips that criteria test.
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2. Threshold

The application automatically identifies the default area threshold (5000) for the 
compound after the compound passes the m/z and Retention Time criteria. When you 
specify a Threshold Override, the application uses the specified threshold value instead.

When a compound fails the Threshold identification test, the application does not 
perform the selected Fragment Ions or Library Search testing for identification or 
confirmation.

For additional information about the Threshold parameter, see Threshold.

3. Isotopic Pattern

For additional information about the Isotopic Pattern parameter, see Isotopic Pattern.

4. Fragment Ions

For additional information about the Fragment Ions parameter, see Fragment Ions.

5. Library Search 

For additional information about the Library Search parameter, see Library Search.

Mass to Charge (m/z)

The application automatically uses the m/z and mass tolerance ranges to identify each 
compound, using the mass tolerance value you specified on the Acquisition page. See Editing 
the Acquisition Page.

The application compares the measured m/z of the sample peak against the expected m/z of 
the target compound. When the measured m/z is within the mass tolerance range of the 
expected m/z, the application considers that this target compound is found and the m/z 
criteria passes.

On the Target Screening page in Data Review, the MZ column in the Compounds table 
indicates whether this criteria passes or fails. The Flag column indicates whether the target 
compound is identified, fully confirmed, or both. For details, refer to Chapter 5, “Using the 
Analysis Mode for Target Screening Batches” in the TraceFinder User Guide.

The Compounds table also displays the m/z Expected, m/z Measured, and m/z Delta values for 
each compound.

Threshold

To identify each sample compound, the application automatically uses the area and threshold 
values defined in the selected compound database. 

In the Identification and Confirmation Settings pane, you can specify a threshold override to 
use instead of the area threshold defined in the compound database.
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The application compares the area of the sample peak against the defined area thresholds. 
When the sample peak’s area is greater than or equal to the corresponding area threshold from 
the compound database or the override area threshold, the target compound is identified.

On the Target Screening page in Data Review, the Flag column in the Compounds table 
indicates whether this criteria passes or fails. The Flag column indicates whether the target 
compound is identified, fully confirmed, or both. For details, refer to Chapter 5, “Using the 
Analysis Mode for Target Screening Batches” in the TraceFinder User Guide.

The Compounds table also displays Measured Area column displays the area value in green to 
indicate that the peak’s area is greater than or equal to the area threshold; otherwise, this 
column displays the area value in red.

Retention Time

The application uses the expected retention time and retention time window values defined in 
the selected compound database to identify or confirm each sample compound. 

In the Identification and Confirmation Settings pane, you can set an override value to use for 
the retention time window instead of using the retention time window that is specified in the 
compound database.

When the compound database defines an expected retention time for a compound, it uses the 
following process to identify or confirm the compound.

• Identify: The application searches within the specified retention time window (or the 
retention time window override) and compares the measured m/z of the sample peak 
against the expected m/z of the target compound. When the measured m/z is within 
the mass tolerance range of the expected m/z, this target compound is identified.

• Confirm: The application searches the entire raw data file and compares the 
measured m/z of the sample peak against the expected m/z of the target compound. 
When the measured m/z is within the specified mass tolerance range of the expected 
m/z, the target compound is confirmed.

When the compound database does not define an expected retention time for a compound, 
the application cannot identify or confirm the compound. If you select the Ignore if Not 
Defined option, the application does not perform testing for the retention time and the RT 
flag is blank on the Target Screening page in Data Review. 

On the Target Screening page in Data Review, the RT column in the Compounds table 
indicates whether this criteria passes or fails. The RT column indicates whether the target 
compound is identified, fully confirmed, or both. For details, refer to Chapter 5, “Using the 
Analysis Mode for Target Screening Batches” in the TraceFinder User Guide. The Compounds 
table also displays the RT Expected, RT Measured, and RT Delta values for each compound.
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Fragment Ions

To use fragment ions for identification or confirmation, the application requires the following 
conditions:

• The selected compound databases contain the charged mass for each defined fragment 
ion of interest for the compounds in the target list.

• The HCD (higher energy collision-induced dissociation), source CID (source 
collision-induced dissociation), or AIF (all ions fragmentation) ion spectra exist at a time 
point within the compound’s elution time range.

When no fragment is defined in a compound database for a target compound, the following 
apply:

• When the Ignore if Not Defined option is selected in the method, the application does 
not perform filtering for the Fragment Ions. In the Data Review view, the FI column is 
blank.

• When the Ignore if Not Defined option is not selected in the method, the application 
considers that this target compound is not identified. The Fragment Ions filter fails.

The application uses the number of fragment masses defined in the compound database when 
it processes a sample for fragment ions. The value you specify for Min. # of Fragments cannot 
be greater than the number of fragments defined in the compound database.

For example, if a compound has three fragment ion masses defined in a compound database, 
any of the following scenarios can occur:

• You enter “2” in the Min. # of Fragments box of the method, and the application finds at 
least two out of the three defined fragment ions. The Fragment Ions filter passes.

• You enter “4” in the Min. # of Fragments box of the method, and the application finds 
only the three defined fragment ions. The Fragment Ions filter fails.

• You enter “2” in the Min. # of Fragments box of the method, but the application finds 
only one of the three defined fragment ions. The Fragment Ions filter fails.

The application repeats the following process for each of the fragment ions:

1. When the mass of the parent (plus or minus half of the isolation window value from the 
acquired raw data file) is not within the mass range of the extracted ion chromatogram 
shown in the Chromatogram pane of the Data Review view, the application considers the 
fragment ion as not found and the application fails the Fragment Ions filter; otherwise, 
the application continues.

2. The application inspects the processed fragment ion scan closest to the target compound’s 
expected retention time and locates the MS/MS spectrum closest to the compound’s apex.

Within this spectrum, the application finds the intensity for the tallest fragment whose 
mass is within the mass tolerance range of an entered fragment ion mass. When this 
intensity is not found or when it is less than the intensity threshold defined in the 
method, the application determines that the entered fragment ion is not found; 
otherwise, it determines that the fragment ion is found.
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Isotopic Pattern

You can choose to either identify or confirm the isotopic patterns for all compounds in a 
batch. The application calculates an isotopic pattern score (as a percentage value), using the 
target compound’s formula. 

For the isotopic pattern filter, enter the isotopic pattern parameters, including a fit threshold 
value, in the processing method. To identify or confirm the presence of a compound, the 
resulting score from isotopic pattern matching must be higher than the fit threshold. 

To identify or confirm an isotopic pattern, the application must detect the compound for at 
least one of its defined adduct ions. The application identifies the elemental composition to 
match using the formula that is associated with the most intense adduct peak. The application 
then generates an isotopic pattern score (as a percentage value) for the match between the 
measured and expected isotopic patterns of the calculated elemental composition. 

• For profile data, the application calculates the measured isotopic pattern using the average 
of all scans (within the allowed intensity deviation of the spectrum closest to the 
compound’s apex retention time). In the Data Review view, the application displays both 
the expected and measured spectra.

• For centroid data, the application calculates the measured isotopic pattern using the apex 
scan. In the Data Review view, the application displays the expected spectra.

A high isotopic pattern score (approaching 100 percent) occurs when the measured isotope 
patterns, the expected isotope patterns, and the intensities are almost identical using the 
scoring parameters specified in the processing method. When the patterns are not similar, the 
score is closer to 0 percent. When the score is greater than or equal to the specified fit 
threshold and the number of isotopes matched is not 1 out of 1, this filter passes. 

When you view results in the Data Review view, the IP column displays a green or red flag to 
indicate whether the compound passed or failed based on the criteria specified in the method. 

For additional information about isotopic scorings, see Isotopic Pattern Details.

Library Search

For a target screening analysis, you can select the Library Search criterion for either 
identification or confirmation in the processing method. The application identifies or 
confirms the sample compound by searching the selected library and returning the library 
entry with the highest score (as a percentage value) for the fragment ion spectrum in that 
library that matches the compound’s ion spectrum. 

For this criterion, you enter a score threshold value in the processing method. The resulting 
score from a library search match must be higher than your entered threshold value, and the 
library entry must match a compound’s name, a compound’s formula, or both to identify or 
confirm the presence of the compound.
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The application uses the following logic to determine when a match is successful:

• When a formula is available in the library entry and the formula matches the target 
compound formula:

– A library score that is higher than or equal to the score threshold meets the criteria.

– A library score that is lower than the score threshold fails to meet the criteria.

• When a formula is available in the library entry and the name in the library entry matches 
the target compound name but the formula does not match the target compound formula 
(or it is not available):

– A library score that is higher than or equal to the score threshold meets the criteria.

– A library score that is lower than the score threshold fails to meet the criteria.

• When neither the formula nor the library entry name match the target compound, the 
criteria fails and the Lib Match Name, Library Score, and Library Match Rank columns 
display N/A in black text.

• When an MS/MS scan has been performed and both the library entry and the formula 
match the target compound:

– A library score that is higher than or equal to the score threshold meets the criteria. 
The Lib Match Name, Library Score, and Library Match Rank columns display their 
values in green text.

– A library score that is lower than the score threshold fails to meet the criteria. The Lib 
Match Name, Library Score, and Library Match Rank columns display their values in 
red text.

To use a library search for identification or confirmation, the application requires that the data 
meet these conditions:

• The raw data file contains HCD (higher energy collision-induced dissociation), source 
CID (source collision-induced dissociation), or AIF (all ions fragmentation) ion spectra.

• The spectra exist at a time point within the compound’s elution time range.

The application performs either a forward library search or a reverse library search. A forward 
search compares the mass spectrum of an unknown compound to a mass spectral library 
entry, whereas a reverse search compares a library entry to an unknown compound.

When a parent-selected MS/MS spectrum does not exist, the application performs a reverse 
library search because the compound scan contains a mixture of fragments from all co-eluting 
parents. A forward search with such a mixture biases the results toward the strongest parent 
because its fragments would be dominant, and a forward search also takes more time because 
the application must search every spectrum in the library.

Note  When the compound is identified, but no MS/MS scan has been performed, 
the Lib Match Name, Library Score, and Library Match Rank columns display N/A 
in red text.



 5 Using the Method Development Mode for Target Screening Methods
Editing a Target Screening Method

Thermo Scientific TraceFinder Lab Director User Guide 297

When a parent-selected MS/MS spectrum exists, the application performs a forward library 
search because the scan usually contains fragments of only one or two parents, so matching 
this spectrum against the library is faster and more accurate. When you select the Use Reverse 
Library Searching Only check box in the processing method, the application performs only a 
reverse library search.

When you use profile data, the application uses the averaged spectrum of the unknown peak 
as the input spectrum for the library search. This averaged spectrum is based on the average of 
all scans within 10 percent of the spectrum closest to the peak’s apex retention time. When 
you use centroid data, the application uses the apex scan as the input spectrum for the library 
search.

When the application locates a match, it generates a score percentage for the matching library 
entry. This library search can result in multiple matches with different scores.

After searching based on the m/z in the input spectrum, the application performs another 
search for only the matches from the first library search, but this time based on the name, and 
then the formula, of the target compound. If at least one match is found, the application 
displays the highest scoring match from the second search for data review. If no match is 
found from the second search, the application displays the highest scoring match from the 
first search.
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Editing the Peak Detection Page 

Use the features on the Peak Detection page to specify any of the following peak detection 
algorithms: Genesis, ICIS, or Avalon.

 To specify peak detection parameters

1. Click Peak Detection in the Method View navigation pane. 

The Peak Detection page for the method opens. 

2. In the Peak Detection Parameters area, select one of the detection algorithms: Genesis, 
ICIS, or Avalon.

• The Genesis peak detection algorithm provides backward compatibility with 
Xcalibur 1.0 studies. For detailed descriptions of the Genesis method parameters, see 
Genesis peak detection parameters.

• The ICIS peak detection algorithm is designed for MS data and has superior peak 
detection efficiency at low MS signal levels. For detailed descriptions of the ICIS 
method parameters, see ICIS peak detection parameters.

• The Avalon peak detection algorithm is designed for integrating UV/Vis and analog 
chromatograms. For detailed descriptions of the Avalon method parameters, see 
Avalon peak detection parameters.

3. Specify the parameters for the selected detection algorithm. 
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Genesis Detection Method 

The application provides the Genesis peak detection algorithm for backward compatibility 
with Xcalibur 1.0 studies. 

Figure 113. Genesis peak detection

Table 72. Genesis peak detection parameters  (Sheet 1 of 3)

Parameter Description

Detection 
Algorithm

Specifies the Genesis peak detection algorithm.

S/N threshold Current signal-to-noise threshold for peak integration. Peaks with 
signal-to-noise values less than this value are not integrated. Peaks with 
signal-to-noise values greater than this value are integrated. 

Valid range: 0.0 through 999.0
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Enable Valley 
Detection

Uses the valley detection approximation method to detect unresolved 
peaks. This method drops a vertical line from the apex of the valley 
between unresolved peaks to the baseline. The intersection of the 
vertical line and the baseline defines the end of the first peak and the 
beginning of the second peak. 

Expected Width The expected peak width parameter (in seconds). This parameter 
controls the minimum width that a peak is expected to have if you 
enable valley detection. 

With valley detection enabled, any valley points nearer than the 
expected width/2 to the top of the peak are ignored. If a valley point is 
found outside the expected peak width, the application terminates the 
peak at that point. The application always terminates a peak when the 
signal reaches the baseline, independent of the value set for the 
expected peak width. 

Valid range: 0.0 through 999.0

Constrain Peak 
Width

Constrains the peak width of a component during peak integration of 
a chromatogram. You can then set values that control when peak 
integration is turned on and off by specifying a threshold and a tailing 
factor. Selecting the Constrain Peak Width check box activates the 
Peak Height (%) and Tailing Factor options.

Peak Height (%) A signal must be above the baseline percentage of the total peak height 
(100%) before integration is turned on or off. This text box is active 
only when you select the Constrain Peak Width check box. 

Valid range: 0.0 through 100.0%

Tailing Factor A factor that controls how the application integrates the tail of a peak. 
This factor is the maximum ratio of the trailing edge to the leading 
side of a constrained peak. This text box is active only when you select 
the Constrain the Peak Width check box. 

Valid range: 0.5 through 9.0

Min Peak Height 
(S/N)

Specifies the minimum peak height measured as a signal-to-noise ratio.

Valid range: 0.00 through 999.00
Default: 3.00

Table 72. Genesis peak detection parameters  (Sheet 2 of 3)

Parameter Description
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Peak S/N Cutoff The peak edge is set to values below this signal-to-noise ratio. 

This test assumes it has found an edge of a peak when the baseline 
adjusted height of the edge is less than the ratio of the baseline 
adjusted apex height and the peak S/N cutoff ratio. 

When the S/N at the apex is 500 and the peak S/N cutoff value is 200, 
the application defines the right and left edges of the peak when the 
S/N reaches a value less than 200. 

Valid range: 50.0 through 10000.0

Valley Rise (%) The peak trace can rise above the baseline by this percentage after 
passing through a minimum (before or after the peak). This criteria is 
useful for integrating peaks with long tails.

This method drops a vertical line from the apex of the valley between 
unresolved peaks to the baseline. The intersection of the vertical line 
and the baseline defines the end of the first peak and the beginning of 
the second peak. 

When the trace exceeds rise percentage, the application applies valley 
detection peak integration criteria. This test is applied to both the left 
and right edges of the peak. 

Valid range: 0.1 through 500.0

Valley S/N Specifies a value to evaluate the valley bottom. Using this parameter 
ensures that the surrounding measurements are higher. 

Valid range: 1.0 through 100.0
Default: 2.0

# Background 
Scans

Number of background scans performed by the application.

Report Noise As Determines if the noise used in calculating S/N values is calculated 
using an RMS calculation or peak-to-peak resolution threshold. 
Options are RMS or Peak To Peak.

Table 72. Genesis peak detection parameters  (Sheet 3 of 3)

Parameter Description
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ICIS Detection Method 

The ICIS peak detection algorithm is designed for MS data and has superior peak detection 
efficiency at low MS signal levels. 

Figure 114. ICIS peak detection 

Table 73. ICIS peak detection parameters  (Sheet 1 of 3)

Parameter Description

Detection Algorithm Specifies the ICIS peak detection algorithm.

Area Noise Factor The noise level multiplier used to determine the peak edge after 
the location of the possible peak. The ICIS peak detection 
algorithm uses this value. 

Valid range: 1 through 500
Default: 5
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Peak Noise Factor The noise level multiplier used to determine the potential peak 
signal threshold. The ICIS peak detection algorithm uses this 
value.

Valid range: 1 through 1000
Default: 10

Baseline Window The application looks for a local minima over this number of 
scans. The ICIS peak detection algorithm uses this value.

Valid range: 1 through 500
Default: 40

Constrain Peak Width Constrains the peak width of a component during peak 
integration of a chromatogram. You can then set values that 
control when peak integration is turned on and off by specifying a 
peak height threshold and a tailing factor. Selecting the Constrain 
Peak Width check box activates the Peak Height (%) and Tailing 
Factor options.

Peak Height (%) A signal must be above the baseline percentage of the total peak 
height (100%) before integration is turned on or off. This text box 
is active only when you select the Constrain Peak Width check 
box. 

Valid range: 0.0 through 100.0%

Tailing Factor A factor that controls how the application integrates the tail of a 
peak. This factor is the maximum ratio of the trailing edge to the 
leading side of a constrained peak. This text box is active only 
when you select the Constrain the Peak Width check box. 

Valid range: 0.5 through 9.0

Min Peak Height (S/N) Specifies the minimum peak height measured as a signal-to-noise 
ratio.

Valid range: 0.00 through 999.00
Default: 3.00

Noise Method The options are INCOS or Repetitive.

INCOS: Uses a single pass algorithm to determine the noise level. 
The ICIS peak detection algorithm uses this value. 

Repetitive: Uses a multiple pass algorithm to determine the noise 
level. The ICIS peak detection algorithm uses this value. In 
general, this algorithm is more accurate in analyzing the noise than 
the INCOS Noise algorithm, but the analysis takes longer. 

Table 73. ICIS peak detection parameters  (Sheet 2 of 3)

Parameter Description
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Min Peak Width The minimum number of scans required in a peak. The ICIS peak 
detection algorithm uses this value.

Valid range: 0 through 100 scans
Default: 3

Multiplet Resolution The minimum separation in scans between the apexes of two 
potential peaks. This is a criteria to determine if two peaks are 
resolved. The ICIS peak detection algorithm uses this value.

Valid range: 1 through 500 scans
Default: 10 

Area Tail Extension The number of scans past the peak endpoint to use in averaging 
the intensity. The ICIS peak detection algorithm uses this value.

Valid range: 0 through 100 scans
Default: 5

Area Scan Window The number of allowable scans on each side of the peak apex. A 
zero value defines all scans (peak-start to peak-end) to be included 
in the area integration. 

Valid range: 0 through 100 scans
Default: 0 

RMS Specifies that the application calculates noise as RMS. By default, 
the application uses Peak To Peak for the noise calculation. RMS is 
automatically selected if you manually determine the noise region.

Table 73. ICIS peak detection parameters  (Sheet 3 of 3)

Parameter Description
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Avalon Detection Method 

The Avalon peak detection algorithm is designed for UV data. The Avalon peak detection 
algorithm also supports negative peaks. You can edit the Event values from the Avalon Event 
List.

Figure 115. Avalon peak detection 

Table 74. Avalon peak detection parameters 

Parameter Description

Detection Algorithm Specifies the Avalon peak detection algorithm.

Time/Event/Value Displays the events specified in the Avalon Event List dialog box. 
Initially displays only the default events that cannot be edited or 
deleted.

Autocalc Initial Events Automatically calculates the events in the Event list.

Edit Opens the Avalon Event List dialog box where you can edit the 
Time/Event/Value parameters.
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Avalon Event List 

The event list includes both user-defined and noneditable default events. The application 
displays the default events when you choose Avalon sensitivity. You cannot delete these events 
or change their time or values. For a detailed list of events and value ranges, see Event types.

Figure 116. Avalon Event List dialog box

Table 75. Avalon Event List dialog box parameters 

Parameter Description

Time (Min) Specifies the start time of the event.

Event Specifies the type of event. For a detailed list of events and value 
ranges, see Event types.

Value Specifies the value of the event.

Add Adds a new event to the list with the current Time/Event/Value 
parameters.

Delete Removes the selected Time/Event/Value parameter from the event 
list.

Change Applies the current parameter values.

Cancel Closes the dialog box without making any changes. Any additions, 
deletions, or changes revert to their original state.

Apply Closes the dialog box.
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Figure 117. Event types

Table 76. Event type descriptions  (Sheet 1 of 2)

Event type Description

Start Threshold Specifies the threshold at the start of a peak. The Start Threshold is 
directly related to the RMS noise in the chromatogram.

Valid range: 0 through 999 999 999

End Threshold Specifies the threshold at the end of a peak. The End Threshold is 
directly related to the RMS noise in the chromatogram.

Valid range: 0 through 999 999 999

Area Threshold Controls the area cutoff. Any peaks with a final area less than the area 
threshold will not be detected. This control is in units of area for the 
data. 

Valid range: 0 through 999 999 999

P-P Threshold The peak-to-peak resolution threshold controls how much peak 
overlap must be present before two or more adjacent peaks create a 
peak cluster. Peak clusters have a baseline drop instead of 
valley-to-valley baselines. Specified as a percent of peak height 
overlap.

Valid range: 0.1 through 99.99

Negative Peaks Permits detection of a negative going peak. Automatically resets after 
finding a negative peak.

Valid values: On or Off
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Bunch Factor Specifies the number of points grouped together during peak 
detection. This event controls the bunching of chromatographic 
points during integration and does not affect the final area 
calculation of the peak. A high bunch factor groups peaks into 
clusters.

Valid range: 0 through 999

Tension Controls how closely the baseline should follow the overall shape of 
the chromatogram. A lower tension traces the baseline to more 
closely follow changes in the chromatogram. A high baseline tension 
follows the baseline less closely, over longer time intervals. 

Valid range: 0 through 999.99 minutes

Tangent Skim Using this event, you can tangent skim any peak clusters. By default, 
it chooses the tallest peak in a cluster as the parent. You can also 
identify which peak in the cluster is the parent. Tangent skim peaks 
are detected on either side (or both sides) of the parent peak. Tangent 
skim automatically resets at the end of the peak cluster.

Valid range: 0 through 1

Shoulders On Allows peak shoulders to be detected (peaks which are separated by 
an inflection rather than a valley) Sets a threshold for the derivative.

Shoulders Off Disables peak shoulder detection.

Valid range: 0 through 50

Force Cluster On Force the following peaks to be treated as a cluster (single peak).

Force Cluster Off End the forced clustering of peaks.

Disable Cluster On Prevent any peaks from being clustered.

Disable Cluster Off Permit clusters to occur again.

Table 76. Event type descriptions  (Sheet 2 of 2)

Event type Description
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Editing the Reports Page 

Use the Reports Page to specify the reports and report output formats that you want to create 
for the method.

Follow these procedures:

• To open the Reports page

• To configure the compounds in the reports

• To specify output formats

 To open the Reports page

Click Reports in the Method View navigation pane.

The Reports page for the method opens, displaying only the reports that are configured in 
the Configuration Console. To configure the reports that are available, see Specifying the 
Reports.

 To configure the compounds in the reports

In the Target Screening pane, select one of the following options:

• Include All Compounds: Generates reports that include all compounds from the 
screening library, whether or not they are found in the samples.

• Include Only Found Compounds: Generates reports that include only the 
compounds from the screening library that are found in the samples.

 To specify output formats

1. To edit the Report Title, double-click the name and type a new title.

The application uses this title for all reports that use this method. You cannot edit the 
Report Title from other report views.

2. To specify the type of report output to create for each report (hard copy, PDF, CSV, or 
Excel), select the check box in the appropriate column.

3. To duplicate an output type for all reports, click the cell to select it, and then right-click 
and choose Copy Down.

All check boxes in the column below the selected cell duplicate the selected or cleared 
state of the selected cell. 

By default, all report types are cleared.
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Reports Page 

Use the features on the Reports page to specify the reports and report output formats that you 
want to create with the method.

Figure 118. Reports page 

Table 77. Reports page parameters 

Parameter Description

Report list columns

Report The name of a report. 
Print Sends reports to the default printer. 
Create PDF Saves reports as PDF files. 
Create CSV Saves reports as CSV files. 
Create Excel Saves reports as Excel files. 
Exists Identifies the report template in the 

C:\TraceFinderData\4.0\Templates\ReportTemplates folder.



 5 Using the Method Development Mode for Target Screening Methods
Saving a Target Screening Method to a New Name

Thermo Scientific TraceFinder Lab Director User Guide 311

Saving a Target Screening Method to a New Name
You can save any method to a new name, or you can use the current method data to overwrite 
an existing method. The new method contains all the data of the original method.

 To save a method to a new name

1. From the main menu, choose File > Save As.

The Save Master Method As dialog box opens, displaying all quantitation, target 
screening, and unknown screening methods.

2. Do one of the following:

• In the New Method box, type a name for the new method.

The application enables the Save button.

• In the New Method box, type the name of an existing method.

The application enables the Overwrite button.

• Select an existing method name (the application enables the Overwrite button) and 
optionally modify the selected name (the application disables the Overwrite button 
and enables the Save button) in the New Method box.

3. Click Save or Overwrite.

The application saves all the method data using the specified name and opens the 
Acquisition page of the new method.

Table 78. Save Master Method As dialog box parameters 

Parameter Description
Method Name of the methods for the selected type.
Type Type of method: Quan, Screening, or Unknown Only.
Date Changed Date the method was last updated.
Size Size of the method in megabytes.
Domain TraceFinder domain for which the method was created.
New Method Name of the new method to create.
Path Path to the selected method in the Methods folder.
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6

Using the Method Development Mode for Unknown 
Screening Methods

This chapter includes method development tasks for creating and editing an unknown 
screening method. (See Method Development navigation pane.) When user security is 
activated, you must have Method Development Unknown Screening Access permission to use 
these features. 

The TraceFinder application uses a method to specify the types of acquisition, processing, and 
reporting that occur with a batch of samples. You can create a method designed specifically to 
test for compounds in your assay. 

The application identifies or confirms sample peaks that are in a database or library and 
performs preliminary analysis of unknown peaks by assigning probable elemental composition 
to them.

When you create a method, the TraceFinder application uses it to determine how to process a 
set of samples and provide a set of meaningful results. The application uses an instrument 
method to define how to acquire raw data. The rest of the method defines how to process the 
raw data, how the flags information displays the results, and how the reporting functionality 
defines the output for your data and results. 

The application applies your method to a batch, which is a list of one or more samples. 
Together, the method and batch provide a workflow-oriented approach to the data processing 
and information reporting for batches of samples.

IMPORTANT   TraceFinder 4.1 uses the same data as TraceFinder 4.0. By default, the application 
stores the method data for the 4.1 release in the TraceFinderData\4.0\Methods folder.

Contents

• Opening an Unknown Screening Method

• Starting a New Unknown Screening Method

• Editing an Unknown Screening Method
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Figure 119. Method Development navigation pane 

Table 79. Method Development navigation pane commands 

Command Description

Method View Displays the Method View for the method. 

Acquisition Displays the Acquisition page of the Method View. See Editing the 
Acquisition Page.

Unknown Screening

Processing Displays the Processing page of the Method View. See Editing the 
Processing Pages.

Peak Detection 
Settings

Displays the Peak Detection Settings page of the Method View. See 
Editing the Peak Detection Settings Page.

Reports Displays the Reports page of the Method View. See Editing the 
Reports Page.

Compound Database
See Chapter 2, “Using Compound Databases in the Method 
Development Mode.” 

Instrument View
See Chapter 3, “Using Instrument Methods in the Method 
Development Mode.” 
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Opening an Unknown Screening Method
Use the TraceFinder application to open an unknown screening method that was created and 
saved in the TraceFinder application.

 To open an unknown screening method in the Method Development mode

1. Click Method Development in the navigation pane.

The Method Development navigation pane opens. 

For descriptions of all the features in this navigation pane, see Starting a New Unknown 
Screening Method.

2. Choose File > Open > Master Method from the main menu. 

The Open Master Method dialog box opens, displaying all available methods. 

3. Select Unknown Only in the Type list.

The method list displays all unknown screening methods.

4. Select an unknown screening method and click Open.

The Acquisition page for the selected method opens. For detailed descriptions of all the 
features on the Acquisition page, see Acquisition Page.

Figure 120. Open Master Method dialog box

Tip  You can also open one of your most recently used method files. Choose Files > 
Recent Files > Method.

Table 80. Open Master Method dialog box parameters  (Sheet 1 of 2)

Parameter Description

Method Name of the methods for the selected type.

Type Type of method: Quan, Screening, or Unknown Only.

Date Changed Date the method was last updated.
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Size Size of the method in megabytes.

Domain TraceFinder domain for which the method was created.

Type Type of method to display: Quan, Screening, Unknown Only, or Any.

Path Path to the selected method in the TraceFinderData\4.0\Methods 
folder.

Table 80. Open Master Method dialog box parameters  (Sheet 2 of 2)

Parameter Description
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Starting a New Unknown Screening Method
The following procedure includes the basic parameters you must define to create and save an 
unknown screening method. For a detailed description of how to modify all parameters in a 
method, see Editing an Unknown Screening Method.

 To create a new method

1. Choose File > New > Master Method from the main menu.

The Create Master Method dialog box opens. 

2. Select the Unknown Screening Method – Only option and click OK.

The Method View for an unknown screening method includes the Acquisition, 
Processing, Peak Detection Settings, and Reports pages. 

The Acquisition page for the method opens.

3. From the Instrument Method list, select an instrument method. 

4. Click Processing in the Method View navigation pane.

The Processing page for the method opens. See Processing page for an unknown 
screening method.

 To see how to create a new unknown screening method

1. Choose Help > Animations.

2. From the list of animation topics, click Starting an Unknown Screening Method.

IMPORTANT   The Unknown Screening Method - Only feature is available only when 
you select the Allow Unknown Screening option in the application configuration 
console. See Processing Options.
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Figure 121. Processing page for an unknown screening method
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Editing an Unknown Screening Method
You can open an unknown screening method to specify acquisition instructions and the 
settings for processing, peak detection, and reports.

See the instructions for the following tasks:

• Editing the Acquisition Page

• Editing the Processing Pages

• Editing the Peak Detection Settings Page

• Editing the Reports Page

Editing the Acquisition Page

The Acquisition Page defines basic information used to acquire samples. 

Follow these procedures:

• To open the Acquisition page

• To specify acquisition information for a method

• To edit an instrument method

 To open the Acquisition page

Click Acquisition in the Method View navigation pane.

The Acquisition Page opens.

 To specify acquisition information for a method 

1. In the Lab Name box, type the name to be displayed at the top of each printed, saved, or 
exported report.

The default name is Default Laboratory.

2. In the Assay Type box, type the assay type for the method.

3. From the Injection Volume box, select an injection volume (between 0.1 and 2000 μL) 
that the method uses for sample injection.

Use the Up/Down arrows, , to change the volume in increments/decrements of 1 μL, or 
use the keyboard to enter non-integer injection volumes. 

4. From the Mass Precision box, select a precision value (between 2 and 6 inclusive) for the 
number of decimal places to use in reports and in peak and spectrum displays. 

IMPORTANT  The application uses this injection volume in the method, not the 
injection volume from the instrument method.
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 To edit an instrument method

1. From the Instrument Method list on the Acquisition page, select an instrument method. 

2. To edit the selected instrument method, click Edit.

The Thermo Instrument Setup window opens. This example of an instrument setup 
shows multiple configured instruments.

Figure 122. Thermo Instrument Setup window

3. Edit the values on the instrument page for your instrument.

4. From the main menu in the Thermo Instrument Setup window, 
choose File > Save and then choose File > Exit.

The application returns you to the Acquisition Page.

5. To update any changes that were made to the instrument method after you created this 
method, click Update.

The Update Instrument Method? dialog box opens.
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6. Choose one of the following options:

• Send to System Methods: Overwrites the instrument method in the 
C:\TraceFinderData\4.0\Methods folder with the current instrument method.

• Get from System Method: Overwrites the current instrument method with the 
instrument method in the C:\TraceFinderData\4.0\Methods folder.

• Cancel: Makes no changes to the instrument method in the current method.

Acquisition Page

Use the features on the Acquisition page to define basic information about the method.

Figure 123. Acquisition page for an unknown screening method

Table 81. Acquisition page parameters  (Sheet 1 of 2)

Parameter Description

Lab Name Specifies the laboratory name to be displayed at the top of each 
printed, saved, or exported report. 

Default: Default Laboratory

To specify this default laboratory name, see Specifying Application 
Defaults.

Assay Type Specifies the name for the analysis type to be targeted by the 
method. The assay type associates the method with the analysis of a 
compound or specific class of compounds (for example, you might 
use an assay type of PAH for the analysis of Polynuclear Aromatic 
Hydrocarbons).
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Injection Volume Specifies the system uses the injection volume (in μL) for sample 
injection. For a more detailed explanation, refer to the 
documentation for the autosampler.

The injection volume in the method overrides the injection volume 
in the instrument method. The injection volume in the batch 
overrides the injection volume in the method.

Valid range: 0.1 through 2000 μL
Mass Precision Specifies the number of decimal places used in reports and in peak 

and spectrum displays. 

Valid range: Integers from 2 to 6, inclusive
Instrument Method Specifies the instrument method used for acquiring samples.
Edit Opens the Thermo Instrument Setup window where you can edit 

the instrument method.
Update Specifies one of the following:

Send to System Methods: Overwrites the system method in the 
C:\TraceFinderData\4.0\Methods folder with the current 
instrument method.

Get from System Methods: Overwrites the current instrument 
method with the system method in the 
C:\TraceFinderData\4.0\Methods folder.

Table 81. Acquisition page parameters  (Sheet 2 of 2)

Parameter Description
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Editing the Processing Pages 

The Unknown Screening – Processing pages define basic information about the method. 

 To open the Processing pages

Click Processing in the Method View navigation pane.

The Processing pages include settings for peaks and settings for library, database, element, and 
ChemSpider searches. 

See the following topics:

• Editing the Peak Settings

• Editing the Library Settings

• Editing the Database Settings

• Editing the Element Settings

• Editing the ChemSpider Settings

IMPORTANT   After the first processing, you might see an error message stating that the 
total number of results is too large for a single batch (more than 500 000). Return to the 
Processing pages in the method and make one or more of these parameter adjustments:

• Limit the RT range.
• Shorten the signal range.
• Specify a lower value for the Number of Top Matches.
• Specify a Simple Search instead of an Exhaustive Search.
• Specify Top Peaks instead of All Peaks.
• Limit the number of search types.
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Editing the Peak Settings

Use the Peak Settings page to define how the method detects and identifies peaks.

Follow these procedures:

• To open the Peak Settings page

• To calculate default peak detection values from a raw data file

• To specify the peak detection settings

• To specify the search options

 To open the Peak Settings page

Click Processing in the Method View navigation pane.

By default, the Peak Settings Page opens.

 To calculate default peak detection values from a raw data file

For the Autocalc Defaults from Rawfiles box, browse to and select a raw data file.

The application populates the parameters in the Peak Detection Settings area with the 
values from the raw data file. (To reset the default values in the method, click .)

 To specify the peak detection settings

1. Do the following:

a. In the Minimum MS Signal Threshold box, type the minimum number of counts for 
the application to detect an ion.

b. In the Maximum MS Signal Threshold box, type the maximum number of counts 
for the application to detect an ion.

The application calculates the MS signal threshold (noise level) from the raw data file and 
sets this value to reflect a signal-to-noise level of 20.

Valid range: These values depends on the instrument. The minimum value is 0, and the 
maximum value is never larger than the maximum intensity component in the sample.

2. In the Min Peak Width box, type a value for the minimum acceptable peak width for the 
chromatographic peak.

3. In the Max Peak Width box, type a value for the maximum acceptable peak width for the 
chromatographic peak. 

4. In the RT Shift box, type a value for the maximum allowable peak alignment correction 
for the chromatographic peak.

The application applies this value only when you enable batch processing. 

5. In the RT Window box, type a value for the maximum viewable window around the 
identified chromatographic peak.
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6. To create one peak list for the batch regardless of threshold settings, select the Alignment 
and Gap Filling check box.

The application processes the batch as a group instead of as individual samples. When the 
application finds a peak in one sample but not in another, this option adds the missing 
peak to all sample lists and displays N/A or the found peak information in the results. 
This option is similar to the Show All Compounds option in a quantitation or a target 
screening method. The application displays the results for the batch in a color-coded heat 
map grid. Refer to Chapter 6, “Using the Analysis Mode for Unknown Screening 
Batches” in the TraceFinder User Guide.

When you clear this option, the application creates a unique peak list for each sample 
based on the method peak settings, similar to clearing the Show All Compounds option 
in a target screening method.

 To specify the search options

1. In the Search Types area, select the check box for the type of search that you want to 
perform:

• Database Search

• Library Search 

• Elemental Composition

• ChemSpider Search

You can select as many search types as you want.

2. To perform the search only on the sample that has the highest peak response in the batch, 
select the Highest Point Analysis check box.

When you select this option, the application performs the search only on the sample in 
the batch that has the highest peak response.

When you clear this option, the application uses all search criteria on a per-peak basis.

For example, in a batch with samples 1, 2, and 3 with responses of 10, 1000, and 50, 
respectively, the application performs the search only on the peak from sample 2 with the 
greatest peak response. Because the mass and retention time for the peak are the same in 
each sample, the application identifies the same chemical. When you use this option with 
the Top Peaks option, the application uses the responses across the batch to filter the 
results and treats the entire batch of sample data as it would when returning the top n 
responses for a single sample.

3. Select one of the following options:

• Simple Search: When the application identifies a peak by one of the identification 
points, it lists only that compound name in Data Review.

• Exhaustive Search: The application lists all identified peaks from each search 
criterion and displays them as hierarchical entries under the top hit in Data Review.

4. To specify the number of matching peaks to display for each search type, enter a value for 
Number of Top Matches.
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Peak Settings Page

Use the features on the Peak Settings page to define how the method detects and identifies 
peaks.

Figure 124. Peak Settings page
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Table 82.  Peak Settings page parameters  (Sheet 1 of 3)

Parameter Description

Peak Detection Settings

Autocalc Defaults 
from Rawfiles

Populates the parameters in the Peak Detection Settings area with 
the values from the selected raw data file.

Minimum/Maximum 
MS Signal Threshold

Specifies the minimum and maximum number of counts that the 
application uses to detect an ion. The application calculates the 
MS signal threshold (noise level) from the raw data file and sets 
this value to reflect a signal-to-noise level of 20.

Valid range: This value depends on the instrument. The minimum 
value is 0, and the maximum value is never larger than the 
maximum intensity component in the sample.

Default minimum: 10 000 000.00
Default maximum: 1 000 000 000.00

Min Peak Width Specifies the minimum allowable peak width for chromatographic 
peak detection.

Default: 0.50
Max Peak Width Specifies the maximum allowable peak width for chromatographic 

peak detection.

Default: 1.00
RT Shift (minutes) Specifies the maximum allowable peak alignment for 

chromatographic peak detection.

Default: 1.0
RT Window (seconds) Specifies the maximum viewable window around the identified 

chromatographic peak.

Default: 30.00
Use RT Limits Specifies a lower and upper limit for searches. 

Valid range: 0.00 through 999.99 minutes
Default: 0.00 minutes for lower limit; 999.00 minutes for upper 
limit

Mass Tolerance Specifies the number of millimass units or parts per million to use 
as the m/z ± tolerance value.

Valid range: 0 through 500 
Default: 5.00
Unit: mmu or ppm
Note  When using ion trap data, the application uses 300 mmu 
regardless of the value you enter here.
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Alignment and Gap 
Filling

Specifies that the application creates a single peak list for the whole 
batch whether or not it finds a peak in a raw data file. 

When you clear this option, each data file has its own unique peak 
list based on the unknown peak settings.

All Peaks / Top Peaks Specifies that the application displays results for the top n peaks or 
for all peaks.

(number of ) Top Peaks Specifies the maximum number of peaks to identify. Available only 
when you select the previous Top Peaks option. 

Default: 50
Search Options

Search Types Database Search: To specify the unknown database search 
parameters, see Editing the Database Settings.

Library Search: To specify the unknown library search parameters, 
see Editing the Element Settings.

Elemental Composition: To specify the unknown elemental search 
parameters, see Editing the Element Settings.

ChemSpider Search: To specify the ChemSpider search parameters, 
see Editing the ChemSpider Settings.

Highest Point Analysis Specifies that the application performs the search only on the 
sample that has the highest peak response of all samples in the 
batch, working in conjunction with the Alignment and Gap Filling 
option. 

For example, in a batch with samples 1, 2, and 3 with responses of 
10, 1000, and 50, respectively, the application performs the search 
only on the peak from sample 2 with the greatest peak response. 
Because the mass and retention time for the peak are the same in 
each sample, the application identifies the same chemical. When 
you use this option with the Top Peaks option, the application uses 
the responses across the batch to filter the results and treats the 
entire batch of sample data as it would when returning the top n 
responses for a single sample.

When you clear this option, the application uses single-sample 
logic.

Table 82.  Peak Settings page parameters  (Sheet 2 of 3)

Parameter Description
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Editing the Library Settings

Use the Library Settings page to specify the settings for library searches. The application uses 
these settings only when you select the Library Search option as a search type. See To specify 
the compound databases to use.

To find the identity of an unknown compound, the application searches the MS/MS 
spectrum against a mass spectral library using the library search parameters specified in the 
method. The application displays the results in Data Review. The application uses the 
MS/MS scan closest to the apex of the detected peak or from the associated data-dependent 
scan for the extracted mass chromatogram and submits it for a library search.

When the application finds a library match and the formula is present in the library record, 
the application reports the formula in Data Review.

When the application does not find a library match, or when the match does not have an 
associated formula, the application does the following:

• Performs a reverse search of the mass spectrum against the library.

• Returns the top n hits, where n is the value of the Number of Top Matches parameter.

• Displays each match as a separate row in Data Review.

• Shows the score for each match in Data Review (except matches with a score of zero).

Follow these procedures:

• To open the Library Settings page

• To specify the libraries to use

• To specify the general library settings

• To specify the NIST settings

• To specify the mzVault settings

Exhaustive Search / 
Simple Search

Simple Search (Default): When the application identifies a peak by 
one of the identification points, it lists only that compound name 
in Data Review.

Exhaustive Search: The application lists all identified peaks from 
each search criterion and displays them as hierarchical entries 
under the top hit entry in Data Review.

Number of Top 
Matches

Specifies the maximum number of matches returned from a library 
search that you want to display in the Cross Sample Peak List in 
Data Review and in reports.

Valid range: 1 through 99
Default: 3

Table 82.  Peak Settings page parameters  (Sheet 3 of 3)

Parameter Description
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 To open the Library Settings page

Click the Library Settings tab.

The Library Settings Page opens.

 To specify the libraries to use

In the Library Selection area, select the Enabled check box for each library that you want 
to use for unknown screening searches.

The Database Name list displays the libraries located in the following folders:

C:\Program Files (x86)\NISTMS\MSSEARCH

C:\TraceFinderData\New Libraries

 To specify the general library settings

1. To specify the source for the confirming peaks, select one of the following:

• MS: Confirming peaks come from the same scan.

• MS2: Confirming peaks are fragments from an adjacent scan.

• MS–In Source CID: Confirming peaks come from the Source CID.

2. (Optional only when you select MS2) To use the isolation width when no precursor 
match is found, select the Use Isolation Width check box.

The application uses the isolation width to determine if there is an MS/MS scan within 
the same peak RT window that includes the precursor fragments.

 To specify the NIST settings

Note  When you use the following combination of criteria, 
• An accurate mass library (such as libraries from Exactive™, Q Exactive™, or 

Orbitrap instruments)
• Search Type set to MS/MS
• Presearch set to Default

and the application does not return results, you might be using a tighter tolerance 
than the selected library supports. 

Make sure that the Precursor Tolerance parameter for NIST libraries specifies enough 
decimal precision to match the precursor in the library. Try setting the Precursor 
Tolerance to .01 amu (the minimum allowed), or try checking the decimal precision 
entered for the precursor in the specified library.
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1. To specify the type of search to perform, select one of the following:

• Normal: Uses a more extensive set of presearch screenings—a total of four different 
criteria.

When you select this option, skip to step 6.

• MS/MS: Searches for an MS/MS spectrum in a library of MS/MS spectra.

• In-source HiRes: Searches for an in-source/EI with an accurate ion m/z or an 
MS/MS spectrum in a library that contains in-source/EI accurate ion m/z or MS/MS 
spectra.

2. Specify the m/z ± tolerance value for the Precursor Tolerance and the Product Tolerance, 
and then specify the units of measure.

• For accurate mass libraries, choose amu.

• For exact mass libraries, choose ppm (default).

3. To ignore mass spectral peaks within the specified precursor tolerance range, select the 
Ignore Precursor check box.

4. To use alternate peak matching, select the Use Alt Peak Matching check box.

5. To specify that the application use the reverse search method, select the Reverse Search 
check box. 

A reverse search compares a library entry to an unknown compound (whereas a forward 
search compares the mass spectrum of an unknown compound to a mass spectral library 
entry).

6. To choose a Presearch method, use these guidelines:

• For libraries created before 2014, set Presearch to Off.

• When you set the Search Type to In-source HiRes, set Presearch to Off.

• For all other criteria, set Presearch to Default.

7. Select a threshold value for SI Threshold.

The application uses this lower threshold value for the search index method used to search 
the NIST library. The application does not return results below this value.

Note  These tolerance options are available only when you select the MS/MS or 
In-source HiRes search types.

Note  This option is available only when you select the MS/MS or In-source HiRes 
search types.

Note  This option is available only when you select the MS/MS or In-source HiRes 
search types.
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8. Select a threshold value for RSI Threshold.

The application uses this lower threshold value for the reverse search index method used 
to search the NIST library. The application does not return results below this value.

9. Select a threshold value for Probability Threshold.

The application uses this lower threshold value for the match probability.

 To specify the mzVault settings

1. From the Search Type list, select one of the following search algorithms to use for 
matching: Classic or HighChem.

2. Specify an m/z ± tolerance value for Precursor Tolerance, and then select the units of 
measure for precursor tolerance.

3. Specify an m/z ± tolerance for Fragment Tolerance, and then select the units of measure 
for fragment tolerance.

4. Select a threshold value for Score Threshold.

The application uses this lower threshold value for the Library Score in Data Review. The 
application does not return results below this value. 

5. To ignore mass spectral peaks within the specified precursor tolerance range, select the 
Ignore Precursor check box.

6. To specify that the application use the reverse search method, select the Reverse Search 
check box. 

A reverse search compares a library entry to an unknown compound (whereas a forward 
search compares the mass spectrum of an unknown compound to a mass spectral library 
entry).
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Library Settings Page

Use the Library Settings page to specify the parameters for library searches. The application 
uses these settings only when you select the Library Search option as a search type. 

Figure 125. Library Settings page

Table 83.  Library Settings page parameters  (Sheet 1 of 4)

Parameter Description

Library Selection

Enabled The databases for unknown screening searches.
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Database Name Specifies all databases that you configured in the 
Configuration Console. See Screening Libraries.

Database Type Specifies the database type as either NIST or mzVault.
General Library Settings

MS Order Specifies that the confirming peaks come from the same scan 
(MS), are fragments from an adjacent scan (MS2), or come 
from the Source CID (MS–In Source CID). 

Use Isolation Width Specifies that the application uses the isolation width to 
determine if there is an MS/MS scan within the same peak RT 
window that includes the precursor fragments. Available only 
when you set the MS Order to MS2.

NIST Settings

Search Type Specifies the type of library search algorithm to use.

Normal: Uses a more extensive set of presearch screenings—a 
total of four different criteria.

MS/MS: Searches for an MS/MS spectrum in a library of 
MS/MS spectra.

In-source HiRes: Searches for an in-source/EI with an accurate 
ion m/z or an MS/MS spectrum in a library that contains 
in-source/EI accurate ion m/z or MS/MS spectra.

Precursor Tolerance Specifies the precursor m/z ± tolerance as either amu or ppm. 
Available only when you select MS/MS or In-source HiRes 
search types.
Note  Use amu for accurate mass libraries (such as libraries 
from Exactive, Q Exactive, or Orbitrap instruments).

Valid range: 0.01 through 100 000.00
Default: 1.60 ppm

Product Tolerance Specifies the mass spectral peak m/z ± tolerance as either amu 
or ppm. Available only when you select MS/MS or In-source 
HiRes search types.
Note  Use amu for accurate mass libraries (such as libraries 
from Exactive, Q Exactive, or Orbitrap instruments).

Valid range: 0.01 through 100 000.00
Default: 1.60 ppm

Ignore Precursor Ignores mass spectral peaks within the specified precursor 
tolerance range.
Available only when you select MS/MS or In-source HiRes 
search types.

Table 83.  Library Settings page parameters  (Sheet 2 of 4)

Parameter Description



 6 Using the Method Development Mode for Unknown Screening Methods
Editing an Unknown Screening Method

Thermo Scientific TraceFinder Lab Director User Guide 335

Use Alt Peak Matching Specifies that the application uses an alternate peak matching 
method for searching the mass spectra.
Available only when you select MS/MS or In-source HiRes 
search types.

Reverse Search Specifies that the NIST library search uses the reverse search 
method. A reverse search compares a library entry to an 
unknown compound (whereas a forward search compares the 
mass spectrum of an unknown compound to a mass spectral 
library entry).

Presearch Specifies that the application uses presearch screening before 
calculating the spectrum-by-spectrum match factor.

SI Threshold Specifies the lower threshold value for the search index method 
used to search the NIST library. The application does not 
return results below this value.

Valid range: 0 through 999
Default: 250

RSI Threshold Specifies the lower threshold value for the reverse search index 
method used to search the NIST library. The application does 
not return results below this value.

Valid range: 0 through 999
Default: 250

Probability Threshold Threshold value for the match probability.
mzVault Settings

Search Type  Specifies the type of library search algorithm to use.
• Classic: Uses the standard library search algorithm.
• HighChem: Uses the HighChem library search algorithm.

Precursor Tolerance Specifies the precursor m/z ± tolerance as either amu or ppm.

Valid range: 0.1 through 1000.0
Default: 0.50 mmu

Fragment Tolerance Specifies the fragment m/z ± tolerance as either amu or ppm.

Valid range: 0.1 through 1000.0
Default: 5.00 ppm

Score Threshold Specifies that the application does not return results below this 
value.

Valid range: 0 through 100
Default: 80.00

Ignore Precursor Specifies that the application ignores mass spectral peaks 
within the specified precursor tolerance range.

Table 83.  Library Settings page parameters  (Sheet 3 of 4)

Parameter Description
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Editing the Database Settings

Use the Database Settings page to specify the compound databases and the settings for 
database searches. The application uses these settings only when you select the Database 
Search option as a search type. See To specify the compound databases to use. The application 
compares the specified compound databases with found peaks from the mass analyzer peak 
detector. 

When a found peak is within the mass range of a compound in a specified database, the 
application scores it as a match and adds the labeled peak result to the Data Review results 
grid for unknown screening analysis.

If the application finds a conflict of information, then the application uses the next level of 
identification to compare the fragments of any associated data-dependent scan. The 
application chooses the peak with the most matching fragments as the name of the identified 
peak.

If there are no fragments available, then the application labels the compound database entry 
with the mass that is closest to the mass of the extracted mass analyzer peak.

Follow these procedures:

• To open the Database Settings page

• To specify the database matching settings

• To specify the fragments settings

• To specify the isotopes settings

• To specify the compound databases to use

Reverse Search Specifies using the reverse search method for an mzVault 
search. A reverse search compares a library entry to an 
unknown compound (whereas a forward search compares the 
mass spectrum of an unknown compound to a mass spectral 
library entry).
Note   When you are using all ions fragmentation (AIF), 
data-independent (DIA), variable data-independent (vDIA), 
or source collision-induced dissociation (CID) data, the 
application automatically uses reverse search even if you do 
not select this option.

Table 83.  Library Settings page parameters  (Sheet 4 of 4)

Parameter Description
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 To open the Database Settings page

Click the Database Settings tab.

The Database Settings Page opens.

 To specify the database matching settings

1. In the CDB RT Window box, type a value (in seconds) for the database retention time 
window.

2. Specify the number of millimass units or parts per million for the Mass Tolerance.

3. Select the units of measure for the m/z ± tolerance value.

The application applies this mass tolerance range to the extracted chromatograms.

 To specify the fragments settings

1. In the Intensity Threshold box, type a value for the minimum intensity value for 
fragments. 

Fragments with intensity values less than this value are ignored.

2. Specify the number of millimass units or parts per million for the Mass Tolerance.

3. Select the units of measure for the m/z ± tolerance value.

The application applies this mass tolerance range to the fragment chromatograms.

4. To specify the source for the peaks, set the MS Order to MS, MS2, or MS–In Source 
CID.

 To specify the isotopes settings

1. In the Allowed Mass Deviation box, type a value (in parts per million) to specify the 
allowed mass deviation in the spectrum data.

The isotopic pattern algorithm considers an isotope peak as found if its measured m/z is 
less than this deviation amount away from its expected m/z. For best results, set this value 
to a number that causes up to 98 percent of all mass deviations to be smaller than the 
allowed mass deviation value. 

2. In the Allowed Intensity Deviation box, type a value to specify the allowed intensity 
deviation of the mass spectrometer relative to the monoisotopic ion, as a percentage of the 
base peak height.

The isotopic pattern algorithm considers an isotope peak as not found if its intensity 
relative to the monoisotopic ion’s intensity is more than this deviation percentage from 
the theoretical relative intensity of the isotope ion. For best results, set this value to a 
number that causes up to 98 percent of all intensity deviations to be smaller than the 
allowed intensity deviation value.
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3. To specify that isotopic pattern calculations use internal mass calibration, select the Use 
Internal Mass Calibration check box. Otherwise, to use external mass calibration, clear 
the check box.

When you select this check box, the application applies a requirement that an isotope’s 
m/z must be closer to its theoretical value to avoid a score penalty. For more information, 
see Isotopic Pattern Details.

 To specify the compound databases to use

1. Select the Selected check box for each compound database that you want to use for the 
database search.

2. (Optional) To edit a database, click open and do the following:

a. Edit the database. 

See Chapter 2, “Using Compound Databases in the Method Development Mode.” 

b. When you finish editing the database, click Processing in the Method View 
navigation pane to return to the Processing page.
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Database Settings Page

Use the Database Settings page to specify the compound databases and settings for database 
searches. The application uses these settings only when you select the Database Search option 
as a search type.

Figure 126. Database Settings page

Table 84.  Database Settings page parameters  (Sheet 1 of 2)

Parameter Description

CDB Matching

CDB RT Window 
(seconds)

Specifies the database retention time window in seconds.

Default: 30.00
Mass Tolerance Specifies the m/z ± tolerance in units of mmu or ppm.

• mmu (millimass units): mmu is a static calculation to the 
extracted mass.

• (Default) ppm (parts per million): ppm is a variable calculation 
dependent on the actual mass. The smaller the mass, the 
narrower the tolerance range. The larger the mass, the wider the 
tolerance range.

Default: 5.00
Valid range: 0.1 through 999
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Fragments

Intensity Threshold Fragments with intensity values less than this are ignored.

Default: 10 000
Mass Tolerance Specifies the m/z ± tolerance in units of mmu or ppm.

• mmu (millimass units): mmu is a static calculation to the 
extracted mass.

• ppm (parts per million): ppm is a variable calculation 
dependent on the actual mass. The smaller the mass, the 
narrower the tolerance range. The larger the mass, the wider the 
tolerance range.

Default: 5.00 ppm
Valid range: 0.1 through 999

MS Order Specifies that the confirming peaks come from the same scan (MS), 
are fragments from an adjacent scan (MS2), or come from the 
Source CID (MS–In Source CID). 

Isotopes

Allowed Mass 
Deviation

Specifies the allowed mass deviation in the spectrum data.

Valid range: 3 through 100 ppm
Default: 5 ppm

Allowed Intensity 
Deviation

Specifies the allowed intensity deviation of the mass spectrometer 
relative to the monoisotopic ion, as a percentage of the base peak 
height.

Valid range: 1 through 100%
Default: 10%

Use Internal Mass 
Calibration

Specifies that isotopic pattern calculations use internal mass 
calibration.

Database List

Selected Specifies that the application uses the compound database for a 
database search.

Database Name Specifies the name of the database.
Refresh Updates the database list.
Open Opens the compound database in the Method Development mode. 

Table 84.  Database Settings page parameters  (Sheet 2 of 2)

Parameter Description
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Editing the Element Settings

Use the Element Settings page to specify settings to use for elemental composition searches. 
The application uses these settings only when you select the Elemental Composition option as 
a search type. See To specify the compound databases to use.

Follow these procedures:

• To open the Element Settings page

• To specify the scoring settings

• To specify the elemental composition settings

• To select elements to use in the elemental formula

 To open the Element Settings page

Click the Element Settings tab.

The Element Settings Page opens.

 To specify the scoring settings

1. In the Allowed Mass Deviation box, type a value (in parts per million) to specify the 
allowed mass deviation in the spectrum data.

The isotopic pattern algorithm considers an isotope peak as found if its measured m/z is 
less than this deviation amount away from its expected m/z. For best results, set this value 
to a number that causes up to 98 percent of all mass deviations to be smaller than the 
allowed mass deviation value. 

2. In the Allowed Intensity Deviation box, type a value to specify the allowed intensity 
deviation of the mass spectrometer relative to the monoisotopic ion, as a percentage of the 
base peak height.

The isotopic pattern algorithm considers an isotope peak as not found if its intensity 
relative to the monoisotopic ion’s intensity is more than this deviation percentage from 
the theoretical relative intensity of the isotope ion. For best results, set this value to a 
number that causes up to 98 percent of all intensity deviations to be smaller than the 
allowed intensity deviation value.

3. To specify that isotopic pattern calculations use internal mass calibration, select the Use 
Internal Mass Calibration check box. 

Otherwise, to use external mass calibration, clear the check box.

When using internal mass calibration, the application applies a requirement that an 
isotope’s m/z must be closer to its theoretical value to avoid a score penalty.

For more information, see to Isotopic Pattern Details.
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 To specify the elemental composition settings 

1. From the Electron Rule list, select one of the following rules to use in the formula 
calculation: Do Not Use, Even Electrons, or Odd Electrons.

2. In the RDB Equiv Low and the RDB Equiv High boxes, type values for double bonds 
and ring equivalents—a measure of the number of unsaturated bonds in a compound—
to limit the calculated formulas to only those that make sense.

The RDB Equiv Low value must be smaller than the RDB Equiv High value. 

 To select elements to use in the elemental formula 

1. Click View Elements.

The Elements In Use dialog box opens. By default, all elements are selected for use.

Figure 127. Element in Use dialog box 

2. To activate an element in the list, select the corresponding Use check box.

3. To deactivate an element in the list, clear the corresponding Use check box.

4. To add an element to the list, do the following:

a. Click Add.

The Periodic Table of Elements opens.

Figure 128. Periodic Table of Elements
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b. Select an element and click Apply. 

The periodic table closes, and the application adds the selected element to the 
Elements In Use dialog box.

The values in the Element column and the Nominal Mass column are read-only. You 
can edit the values in the Minimum, Maximum, and Relative columns.

5. In the Relative column, do one of the following:

• To specify the maximum or minimum value as an absolute number of atoms, clear 
the check box. 

• To specify the maximum or minimum value as a relative percentage by weight, select 
the check box.

Default: Selected for H, C, and O; cleared for all other elements

6. In the Minimum and Maximum columns, specify a minimum value and a maximum 
value to define the calculated element.

You can type each of these values as either an absolute number of atoms (0 through 1000) 
or as a relative percentage by weight (0 through 100%), depending on the setting in the 
Relative column.

The value you enter for the Minimum column must be smaller than the value for the 
Maximum column.

7. To remove elements from use in the elemental formula, do the following:

a. Select the element row by clicking in the row selector area marked by the arrow icon.

b. Right-click and choose Delete Row from the shortcut menu (or press the DELETE 
key).

c. Click Yes in the confirmation dialog box to remove the selected rows from the table.

Tip  If the element you select displays several isotopes, for best results, select the 
most abundant one before you click Apply.

IMPORTANT  Add candidates only for the neutral molecule, not for adducts.

Click here to select the row, right-click, 
and choose Delete Row.
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Element Settings Page

Use the Element Settings page to specify settings to use for elemental composition searches.

Figure 129. Element Settings page

Tip  To select noncontiguous rows, hold down the CTRL key when you select them. 
To select contiguous rows, select the first row in the group, hold down the SHIFT key, 
and then select the last row in the group. Or, drag your pointer across the group of 
rows.

Tip   You can also deactivate an element from use in the elemental formula without 
removing it from the table by clearing the element’s Use check box.

Table 85.  Element Settings page parameters  (Sheet 1 of 2)

Parameter Description

Scoring Settings

Allowed Mass 
Deviation (ppm)

Specifies the allowed mass deviation in the spectrum data.

Valid range: 3 through 100 ppm
Default: 5 ppm

Allowed Intensity 
Deviation (%)

Specifies the allowed intensity deviation of the mass spectrometer 
relative to the monoisotopic ion, as a percentage of the base peak 
height.

Valid range: 1 through 100%
Default: 10%

Use Internal Mass 
Calibration

Specifies that isotopic pattern calculations use internal mass 
calibration.
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Editing the ChemSpider Settings

Use the ChemSpider Settings page to specify settings to use for ChemSpider searches. The 
application uses these settings only when you select the ChemSpider Search option as a search 
type. See To specify the compound databases to use.

ChemSpider is an online search engine that provides access to millions of chemical structures 
in databases. The ChemSpider search engine aggregates and indexes chemical structures and 
their associated information into a single, searchable repository. 

The application sends suggested elemental compositions to the ChemSpider search engine 
and retrieves compound names that match the searched elemental compositions. The 
application uses the active databases that you select and ranks the results according to the 
number of databases that return found references for each matched compound. The higher 
the number of databases with found references, the higher the ranking for that match. To 
speed processing, the application stores the results in a local cache. The cache maintains the 
age of each result from the time that the entry is saved. During a search, the application 
deletes any cached entry older than the time period specified in the Cached Entries Expire 
After list and replaces it with newer information.

Elemental Composition

Electron Rule Specifies whether to use a rule in the formula calculation.

Valid values: Do Not Use, Even Electrons, Odd Electrons
Default: Do Not Use

RDB Equiv Low Specifies the lower limit value for double bonds and ring 
equivalents—a measure of the number of unsaturated bonds in a 
compound—to limit the calculated formulas to only those that 
make sense. The RDB Equiv Low value must be smaller than the 
RDB Equiv High value.

Valid range: –1.5 through 99.9
Default: –1.5

RDB Equiv High Specifies the upper limit value for double bonds and ring 
equivalents—a measure of the number of unsaturated bonds in a 
compound—to limit the calculated formulas to only those that 
make sense.

Valid range: 0 through 100
Default: 100.00

View Elements Opens the Elements in Use dialog box where you can specify the 
elements to use in the elemental formula.

Table 85.  Element Settings page parameters  (Sheet 2 of 2)

Parameter Description

IMPORTANT  You must have an Internet connection to access the ChemSpider databases.
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Each time you update the list of active databases, the application clears the entire cache and 
starts over with new information from the next search. Unknown screening searches that use 
the ChemSpider search engine might take longer until the application populates the cache 
with results again. When you change the list of active databases, the ranking of the results 
might also change accordingly.

Follow these procedures:

• To open the ChemSpider Settings page

• To update the list of available databases

• To make databases active

• To specify an expiration time for cached entries

 To open the ChemSpider Settings page

Click the ChemSpider Settings tab.

The ChemSpider Settings Page opens.

 To update the list of available databases

Click Refresh.

The application updates the list of available databases with the most current list from the 
ChemSpider website.

 To make databases active

1. From the Available Databases list, select the ChemSpider databases that you want to 
search.

2. Click  to move the selected databases to the Active Databases list.

The application searches all active ChemSpider databases for matching compound 
formulas.

IMPORTANT  Each time you access the ChemSpider Settings page, the application 
automatically compares the list of available databases with the most current list from 
the ChemSpider website. The Refresh button becomes available only when there is a 
difference between the two lists.

Note  Use the CTRL or SHIFT keys to select multiple databases.

IMPORTANT  Whenever you change the list of active databases, the application 
deletes all previous results stored in the cache and starts over with new information 
from the next search. This might increase the time required to complete the search.

IMPORTANT  If a database in the Active Databases box is no longer available on the 
website, the application automatically removes that database name.
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 To specify an expiration time for cached entries

Select one of the following time periods from the Cached Entries Expire After list:

• ThreeMonths

• SixMonths

• OneYear

• Never

During a search, the application deletes any cached entry older than this value and 
replaces it with newer information.

ChemSpider Settings Page

Use the ChemSpider Settings page to specify settings to use for ChemSpider searches.

Figure 130. ChemSpider Settings page

Table 86. ChemSpider Settings page parameters 

Parameter Description

Available Databases Lists the most current databases from the ChemSpider website.
Refresh Updates the list of available databases with the most current list from 

the ChemSpider website.
Cached Entries 
Expire After

During a search, the application deletes any cached entry older than 
the specified value and replaces it with newer information.

Active Databases Lists the ChemSpider databases that you can search.
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Editing the Peak Detection Settings Page

Use the features on the Peak Detection page to specify any of the following peak detection 
algorithms: Genesis, ICIS, or Avalon.

 To specify peak detection parameters

1. Click Peak Detection in the Method View navigation pane. 

2. In the Peak Detection Parameters area, select one of the detection algorithms: Genesis, 
ICIS, or Avalon.

• The Genesis peak detection algorithm provides backward compatibility with 
Xcalibur 1.0 studies. For detailed descriptions of the Genesis method parameters, see 
Genesis peak detection parameters.

• The ICIS peak detection algorithm is designed for MS data and has highly efficient 
peak detection at low MS signal levels. For detailed descriptions of the ICIS method 
parameters, see ICIS peak detection parameters.

• The Avalon peak detection algorithm is designed for integrating UV/Vis and analog 
chromatograms. For detailed descriptions of the Avalon method parameters, see 
Avalon peak detection parameters.

3. Specify the parameters for the selected detection algorithm. 
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Genesis Detection Method 

The application provides the Genesis peak detection algorithm for backward compatibility 
with Xcalibur 1.0 studies. 

Figure 131. Genesis peak detection

Table 87. Genesis peak detection parameters  (Sheet 1 of 3)

Parameter Description

Detection Algorithm Specifies the Genesis peak detection algorithm.

S/N Threshold Current signal-to-noise threshold for peak integration. Peaks with 
signal-to-noise values less than this value are not integrated. Peaks 
with signal-to-noise values greater than this value are integrated. 

Valid range: 0.0 through 999.0
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Enable Valley 
Detection

Uses the valley detection approximation method to detect 
unresolved peaks. This method drops a vertical line from the apex 
of the valley between unresolved peaks to the baseline. The 
intersection of the vertical line and the baseline defines the end of 
the first peak and the beginning of the second peak. 

Expected Width (sec) The expected peak width parameter (in seconds). This parameter 
controls the minimum width that a peak is expected to have if 
valley detection is enabled. 

With valley detection enabled, any valley points nearer than the 
expected width/2 to the top of the peak are ignored. If a valley 
point is found outside the expected peak width, the application 
terminates the peak at that point. The application always 
terminates a peak when the signal reaches the baseline, 
independent of the value set for the expected peak width. 

Valid range: 0.0 through 999.0

Constrain Peak Width Constrains the peak width of a component during peak 
integration of a chromatogram. You can then set values that 
control when peak integration is turned on and off by specifying a 
threshold and a tailing factor. Selecting the Constrain Peak Width 
check box activates the Peak Height (%) and Tailing Factor 
options.

Peak Height (%) A signal must be above the baseline percentage of the total peak 
height (100%) before integration is turned on or off. This text box 
is active only when you select the Constrain Peak Width check 
box. 

Valid range: 0.0 through 100.0%

Tailing Factor A factor that controls how the application integrates the tail of a 
peak. This factor is the maximum ratio of the trailing edge to the 
leading side of a constrained peak. This text box is active only 
when you select the Constrain the Peak Width check box. 

Valid range: 0.5 through 9.0

Min Peak Height (S/N) Specifies the minimum peak height measured as a signal-to-noise 
ratio.

Valid range: 0.00 through 999.00
Default: 3.00

Table 87. Genesis peak detection parameters  (Sheet 2 of 3)

Parameter Description
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Peak S/N Cutoff The peak edge is set to values below this signal-to-noise ratio. 

This test assumes it has found an edge of a peak when the baseline 
adjusted height of the edge is less than the ratio of the baseline 
adjusted apex height and the peak S/N cutoff ratio. 

When the S/N at the apex is 500 and the peak S/N cutoff value is 
200, the application defines the right and left edges of the peak 
when the S/N reaches a value less than 200. 

Valid range: 50.0 through 10000.0

Valley Rise (%) The peak trace can rise above the baseline by this percentage after 
passing through a minimum (before or after the peak). This 
criteria is useful for integrating peaks with long tails.

This method drops a vertical line from the apex of the valley 
between unresolved peaks to the baseline. The intersection of the 
vertical line and the baseline defines the end of the first peak and 
the beginning of the second peak. 

When the trace exceeds rise percentage, the application applies 
valley detection peak integration criteria. This test is applied to 
both the left and right edges of the peak. 

Valid range: 0.1 through 500.0

Valley S/N Specifies a value to evaluate the valley bottom. Using this 
parameter ensures that the surrounding measurements are higher. 

Valid range: 1.0 through 100.0
Default: 2.0

# Background Scans Number of background scans performed by the application.

Report Noise As Determines if the noise used in calculating S/N values is calculated 
using an RMS calculation or peak-to-peak resolution threshold. 
Options are RMS or Peak To Peak.

Table 87. Genesis peak detection parameters  (Sheet 3 of 3)

Parameter Description
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ICIS Detection Method 

The ICIS peak detection algorithm is designed for MS data and has highly efficient peak 
detection at low MS signal levels. 

Figure 132. ICIS peak detection 

Table 88. ICIS peak detection parameters  (Sheet 1 of 3)

Parameter Description

Detection Algorithm Specifies the ICIS peak detection algorithm.

Area Noise Factor The noise level multiplier used to determine the peak edge after 
the location of the possible peak. The ICIS peak detection 
algorithm uses this value. 

Valid range: 1 through 500
Default: 5
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Peak Noise Factor The noise level multiplier used to determine the potential peak 
signal threshold. The ICIS peak detection algorithm uses this 
value.

Valid range: 1 through 1000
Default: 10

Baseline Window The application looks for a local minima over this number of 
scans. The ICIS peak detection algorithm uses this value.

Valid range: 1 through 500
Default: 40

Constrain Peak Width Constrains the peak width of a component during peak 
integration of a chromatogram. You can then set values that 
control when peak integration is turned on and off by specifying a 
peak height threshold and a tailing factor. Selecting the Constrain 
Peak Width check box activates the Peak Height (%) and Tailing 
Factor options.

Peak Height (%) A signal must be above the baseline percentage of the total peak 
height (100%) before integration is turned on or off. This text box 
is active only when you select the Constrain Peak Width check 
box. 

Valid range: 0.0 through 100.0%

Tailing Factor A factor that controls how the application integrates the tail of a 
peak. This factor is the maximum ratio of the trailing edge to the 
leading side of a constrained peak. This text box is active only 
when you select the Constrain the Peak Width check box. 

Valid range: 0.5 through 9.0

Min Peak Height (S/N) Specifies the minimum peak height measured as a signal-to-noise 
ratio.

Valid range: 0.00 through 999.00
Default: 3.00

Noise Method The options are INCOS or Repetitive.

INCOS: Uses a single pass algorithm to determine the noise level. 
The ICIS peak detection algorithm uses this value. 

Repetitive: Uses a multiple pass algorithm to determine the noise 
level. The ICIS peak detection algorithm uses this value. In 
general, this algorithm is more accurate in analyzing the noise than 
the INCOS Noise algorithm, but the analysis takes longer. 

Table 88. ICIS peak detection parameters  (Sheet 2 of 3)

Parameter Description
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Min Peak Width The minimum number of scans required in a peak. The ICIS peak 
detection algorithm uses this value.

Valid range: 0 through 100 scans
Default: 3

Multiplet Resolution The minimum separation in scans between the apexes of two 
potential peaks. This is a criteria to determine if two peaks are 
resolved. The ICIS peak detection algorithm uses this value.

Valid range: 1 through 500 scans
Default: 10 

Area Tail Extension The number of scans past the peak endpoint to use in averaging 
the intensity. The ICIS peak detection algorithm uses this value.

Valid range: 0 through 100 scans
Default: 5

Area Scan Window The number of allowable scans on each side of the peak apex. A 
zero value defines all scans (peak-start to peak-end) to be included 
in the area integration. 

Valid range: 0 through 100 scans
Default: 0 

RMS Specifies that the application calculates noise as RMS. By default, 
the application uses Peak To Peak for the noise calculation. RMS is 
automatically selected if you manually determine the noise region.

Table 88. ICIS peak detection parameters  (Sheet 3 of 3)

Parameter Description



 6 Using the Method Development Mode for Unknown Screening Methods
Editing an Unknown Screening Method

Thermo Scientific TraceFinder Lab Director User Guide 355

Avalon Detection Method 

The Avalon peak detection algorithm is designed for UV data. The Avalon peak detection 
algorithm also supports negative peaks. You can edit the Event values from the Avalon Event 
List.

Figure 133. Avalon peak detection 

Table 89. Avalon peak detection parameters 

Parameter Description

Detection Algorithm Specifies the Avalon peak detection algorithm.

Time/Event/Value Displays the events specified in the Avalon Event List dialog box. 
Initially displays only the default events that cannot be edited or 
deleted.

Autocalc Initial Events Automatically calculates the events in the Event list.

Edit Opens the Avalon Event List dialog box where you can edit the 
Time/Event/Value parameters.



6 Using the Method Development Mode for Unknown Screening Methods
Editing an Unknown Screening Method

356 TraceFinder Lab Director User Guide Thermo Scientific

Avalon Event List 

The event list includes both user-defined and noneditable default events. The application 
displays the default events when you choose Avalon sensitivity. You cannot delete these events 
or change their time or values. For a detailed list of events and value ranges, see Event types.

Figure 134. Avalon Event List dialog box

Table 90. Avalon Event List dialog box parameters 

Parameter Description

Time (Min) Specifies the start time of the event.

Event Specifies the type of event. For a detailed list of events and value 
ranges, see “Event types.” 

Value Specifies the value of the event.

Add Adds a new event to the list with the current Time/Event/Value 
parameters.

Delete Removes the selected Time/Event/Value parameter from the event 
list.

Change Applies the current parameter values.

Cancel Closes the dialog box without making any changes. Any additions, 
deletions, or changes revert to their original state.

Apply Closes the dialog box.
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Figure 135. Event types

Table 91. Event type descriptions  (Sheet 1 of 2)

Event type Description

Start Threshold Specifies the threshold at the start of a peak. The Start Threshold is 
directly related to the RMS noise in the chromatogram.

Valid range: 0 through 999 999 999

End Threshold Specifies the threshold at the end of a peak. The End Threshold is 
directly related to the RMS noise in the chromatogram.

Valid range: 0 through 999 999 999

Area Threshold Controls the area cutoff. Any peaks with a final area less than the area 
threshold will not be detected. This control is in units of area for the 
data. 

Valid range: 0 through 999 999 999

P-P Threshold The peak-to-peak resolution threshold controls how much peak 
overlap must be present before two or more adjacent peaks create a 
peak cluster. Peak clusters have a baseline drop instead of 
valley-to-valley baselines. Specified as a percent of peak height 
overlap. 

Valid range: 0.1 through 99.99

Negative Peaks Permits detection of a negative going peak. Automatically resets after 
finding a negative peak.

Valid values: On or Off
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Bunch Factor Specifies the number of points grouped together during peak 
detection. This event controls the bunching of chromatographic 
points during integration and does not affect the final area 
calculation of the peak. A high bunch factor groups peaks into 
clusters.

Valid range: 0 through 999

Tension Controls how closely the baseline should follow the overall shape of 
the chromatogram. A lower tension traces the baseline to more 
closely follow changes in the chromatogram. A high baseline tension 
follows the baseline less closely, over longer time intervals. 

Valid range: 0 through 999.99 minutes

Tangent Skim Using this event, you can tangent skim any peak clusters. By default, 
it chooses the tallest peak in a cluster as the parent. You can also 
identify which peak in the cluster is the parent. Tangent skim peaks 
are detected on either side (or both sides) of the parent peak. Tangent 
skim automatically resets at the end of the peak cluster.

Valid range: 0 through 1

Shoulders On Allows peak shoulders to be detected (peaks which are separated by 
an inflection rather than a valley) Sets a threshold for the derivative.

Shoulders Off Disables peak shoulder detection.

Valid range: 0 through 50

Force Cluster On Force the following peaks to be treated as a cluster (single peak).

Force Cluster Off End the forced clustering of peaks.

Disable Cluster On Prevent any peaks from being clustered.

Disable Cluster Off Permit clusters to occur again.

Table 91. Event type descriptions  (Sheet 2 of 2)

Event type Description
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Editing the Reports Page 

Use the Reports Page to specify how you want to save or print your reports. 

See the instructions for the following tasks:

• Specifying Report Formats

• Specifying Report Options

Specifying Report Formats 

For each report type, you can create a hard-copy printout, a PDF file, a CSV file, or an Excel 
file. 

 To open the Reports page

Click Reports in the Method View navigation pane.
 

The Reports page opens with a list of all configured reports.

To configure which reports are available when you create a method or which reports 
create a batch-level report, see Specifying the Reports. 

 To specify reports and output formats

1. To specify the type of report output to create for each report, select the check box in the 
appropriate column.

2. To duplicate an output type for all reports, click the cell to select it, and then right-click 
and choose Copy Down.

All check boxes in the column below the selected cell duplicate the selected or cleared 
state of the selected cell. This action applies only to reports where this output format is 
available. By default, all report type options are cleared. 
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Reports Page 

Use the features on the Reports page to specify how you want to save or print your reports. 

Figure 136. Reports page

Specifying Report Options 

Use the options on the Report Options page to choose the compounds to display in reports.

Figure 137. Reports Options page

Table 92. Reports page parameters 

Parameter Description

Report list columns

Report The name of a report. 

Print Sends reports to the default printer. 

Create PDF Saves reports as PDF files. 

Create CSV Saves reports as CSV files. 

Create Excel Saves reports as Excel files. 

Exists Indicates that the report template is identified in the 
C:\TraceFinderData\4.0\Templates\ReportTemplates folder.

Table 93. Report Options page parameters 

Parameter Description

Include All 
Compounds

Generates reports that include all compounds results, whether or 
not they are found in the samples.

Include Only Found 
Compounds

Generates reports that include only the compounds that are found 
in the samples.
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Isotopic Pattern Details

The TraceFinder application calculates an isotopic pattern score based on the settings in the 
method. The application displays this score in the Data Review view. This appendix describes 
the isotopic distribution concepts and provides calculation details with examples for the 
isotopic pattern score.

Isotopic Distribution in Exact Mass Spectra
To determine the elemental compositions, the TraceFinder application uses an isotopic 
pattern matching algorithm that considers the isotope accurate mass and intensity ratios. 
Using a single exact mass, usually the monoisotopic mass of a measured isotope pattern, the 
application calculates all possible elemental compositions that lie within a mass tolerance 
window. You can filter this list of possible elemental compositions and narrow the results by 
using the natural isotopic distribution of elements. 

Natural Isotopic Distribution

The following table lists the natural isotopic distribution of the most common elements.

Contents

• Isotopic Distribution in Exact Mass Spectra

• Isotopic Pattern Score Calculations

Table 94.  Natural isotopic distribution (Sheet 1 of 2)

Element Isotope Isotope 
order Exact mass Mass difference Abundance (%)

Hydrogen 1H A0 1.0078 99.9985
2H A1 2.014102 +1.006302 0.015

Carbon 12C A0 12.0 98.890
13C A1 13.003355 +1.003355 1.110

Nitrogen 14N A0 14.003074 99.634
15N A1 15.00109 +0.998016 0.366
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where:

• A0 represents the monoisotopic peak, which is the most abundant and usually the isotope 
with the lowest mass. 

For example: 1H, 12C, 14N, 16O, 19F, 31P, and 32S

• A1 represents the isotope where one atom in the molecule is statistically replaced by 
another atom approximately 1 amu heavier. 

For example: 2H, 13C, 15N, 17O, and 33S

• A2 represents the isotope where:

Two atoms in the molecule are statistically replaced by two other atoms, each 
approximately 1 amu heavier.

–or–

One atom is replaced by another atom approximately 2 amu heavier. 

For example: 18O and 34S

• A3 represents the isotope where:

Three atoms in the molecule are statistically replaced by three other atoms, each 
approximately 1 amu heavier.

–or–

One atom is replaced by another atom approximately 1 amu heavier and one atom is 
replaced by another atom approximately 2 amu heavier. 

–or–

One atom is replaced by another atom approximately 3 amu heavier. 

Oxygen 16O A0 15.994915 99.762
17O A1 16.999132 +1.004217 0.038
18O A2 17.999161 +2.004246 0.200

Fluorine 19F A0 18.99840 100

Phosphorus 31P A0 30.971459 100

Sulfur 32S A0 31.972071 95.020
33S A1 32.971459 +0.999388 0.750
34S A2 33.967867 +1.995796 4.210
36S A4 35.967081 +3.995010 0.020

Table 94.  Natural isotopic distribution (Sheet 2 of 2)

Element Isotope Isotope 
order Exact mass Mass difference Abundance (%)
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• A4 represents the isotope where: 

Four atoms in the molecule are statistically replaced by four other atoms, each 
approximately 1 amu heavier.

–or–

Two atoms are replaced by two other atoms, each approximately 1 amu heavier, and one 
atom is replaced by another atom approximately 2 amu heavier. 

–or–

Each atom of the two atoms is replaced by another atom approximately 2 amu heavier. 

–or–

One atom is replaced by another atom approximately 1 amu heavier, and one atom is 
replaced by another atom approximately 3 amu heavier. 

–or–

One atom is replaced by another atom approximately 4 amu heavier. 

For example: 36S

• Mass difference is the difference in mass between the A0 isotope and another isotope (A1, 
A2, A3, A4, and so on) of the same element.

• Abundance is the percentage of occurrence of each isotope normally in nature.

In the following figure, the x axis shows the mass difference of A1 relative to the monoisotopic 
peak (A0) of the 13C, 15N, and 33S isotopes. The y axis shows relative abundance in intensity.

Figure 138. Mass difference and abundance of A1 relative to A0
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In the following figure, the x axis shows the mass difference of A2 relative to the monoisotopic 
peak (A0) of the 18O, 34S, and 13C2 isotopes. The y axis shows relative abundance in 
intensity. 

Figure 139. Mass difference and abundance of A2 relative to A0

Note  For a particular isotopic spectrum, the mass difference is always the same between 
the A0 isotope and the other isotopes (A1, A2, and so on) of each specific element, but the 
intensity varies according to the composition of the molecule—that is, the number of each 
element in the molecule.
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Isotopic Pattern Score Calculations
The TraceFinder application follows the same isotopic distribution logic as described in 
Isotopic Distribution in Exact Mass Spectra, but in a different order and with numerical limits 
and scores to optimize automatic processing. After the TraceFinder application determines the 
possible elemental compositions for a particular compound of interest, it calculates a expected 
isotope pattern for each elemental composition candidate and an isotopic pattern score to 
represent the fit between the expected and measured isotope patterns. 

The following data set example describes the isotopic pattern score data and provides the score 
calculation details for one specific data set. 

Data Set Example

This example uses the Metribuzin target compound in an Apple_PosHCD__40_5_01 
sample.

For this compound, note that the Isotopic Pattern Score column shows 90% and the Num 
Isotopes Matched column shows “2 of 3” in the Compound Results pane in the Data Review. 
The compound’s formula is C8H14N4OS and its adduct is H, so the modeled isotopic 
pattern is C8H15N4OS.

Figure 140. Isotopic data for Metribuzin

In the Compound Details pane, select Isotope and zoom in to view the expected isotopic 
pattern spectrum compared to the acquired, measured spectrum. The resulting isotopic 
pattern score should correlate to a visual inspection of the difference between the expected 
isotope display and the measured display for the target compound.

Figure 141. Isotopic pattern spectra (stacked)

Expected 
spectrum

Measured 
spectrum
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For this example, the processing method used to process the data contains the following 
isotopic pattern settings for target screening:

• Fit threshold = 90%

• Allowed Mass Deviation = 5 ppm

• Allowed Intensity Deviation = 10%

• Use Internal Mass Calibration = Cleared

The data for the Metribuzin compound is as follows:

Because the measured and the expected spectra have different intensities, the spectral noise 
threshold must proportionally apply to the expected spectrum to decide which peaks are 
expected in the measured data.

Noise threshold (expected) = Noise of A0 (measured)  Intensity of A0 (expected)  
Intensity of A0 (measured)

Following the previous formula, the expected noise threshold is 
1482 8.55E5  4.75E4 = 2.6676E4.

The expected ions in the measured spectrum are those whose intensities are above the 
expected noise threshold. The following table lists the ions in the expected spectrum. A “” in 
the Above Threshold column indicates the expected ions. 

Measured Expected

A0 m/z = 215.09602 A0 m/z = 215.09611

A0 Noise = 1482 –

A0 intensity = 4.75E4 A0 intensity = 8.55E5

Table 95. Ions in expected spectrum

Isotope 
order

m/z 
(expected)

Intensity 
(expected) Above threshold Present in measured 

spectrum

A0 215.09611 8.55E5  Yes

A1 216.09945 7.50E4  Yes

A2 217.09191 3.86E4  Yes

A3 218.09521 3.39E3 No
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Calculating Mass and Intensity Deviations

The expected number of ions is 3, as shown by those ions with a “” in the Above Threshold 
column of the Ions in expected spectrum table. These are the ions you focus on for the scoring 
calculations. This number “3” shows as the value of y in the Num Isotopes Matched column 
of the Compound Results pane in the Data Review. It indicates the number of expected 
isotopic pattern peaks based on the Fourier transform (FT) noise in the spectrum. 

In this case, you expect to see the three most intense expected peaks in the measured 
spectrum. The masses of those peaks are (in order of intensity from high to low): 215.09611, 
216.09945, and 217.09191. When the measured spectrum is more intense or the noise level is 
lower, you find more peaks passing the noise threshold and expected in the measured 
spectrum, eventually including other isotopic peaks.

The following table shows the mass deviation (delta m/z) data for each of the expected ions.

where:

Delta m/z (ppm) = 1 000 000  ([m/z (measured) – m/z (expected)]  m/z (expected))

For example: 

1 000 000  ([216.09879 – 216.09945]  216.09945)] = –3.05 ppm

If the absolute value of the Delta m/z is less than 5 ppm (the Allowed Mass Deviation value set 
in the processing method), the TraceFinder application determines that this ion is found—
that is, the ion is present in the measured spectrum. For this data set example, the application 
finds only the A0 and A1 ions, so “2” shows as the value of x in the Num Isotopes Matched 
column of the Compound Results pane in the Data Review. The application does not find the 
A2 expected ion because the absolute value of its Delta m/z of 24 ppm is much higher than 5 
ppm.

Table 96. Mass deviation data for the expected ions

Isotope order m/z (expected) m/z (measured) Delta m/z (ppm)

A0 215.09611 215.09602 –0.42
A1 216.09945 216.09879 –3.05
A2 217.09191 217.09712 24

Tip   You can see the expected, measured, and delta m/z values on the Isotope page of the 
Compound Details pane. 

If you want more precision, you can see extra decimal digits for the A0 m/z values in an 
exported data file. 

Note  You can see from zooming in on the isotopic pattern spectra (see Isotopic pattern 
spectra (stacked)) that there are measured peaks in the measured spectrum closely 
corresponding to the first two expected ions, but there is not a measured peak closely 
corresponding to the 217.09191 expected ion. 
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The following table lists the intensity deviation (delta intensity) data for each of the expected 
ions, relative to the A0 ion’s expected intensity of 8.55E5 and measured intensity of 4.75E4.

where:

• Relative intensity (expected and measured) values are derived from the isotopic pattern 
spectra (see Isotopic pattern spectra (stacked)). Each value is a percentage of the isotope’s 
intensity relative to the A0 ion’s intensity.

For example: 7.50E4 8.55E5 = 8.77%

• Delta intensity = Relative intensity (measured) – Relative intensity (expected)

For example: 18.42 – 8.77 = 9.65

In this example, the absolute values of the Delta m/z for the A0 and A1 ions (see Mass 
deviation data for the expected ions) are both less than the Allowed Mass Deviation of 5 ppm; 
therefore, the application considers that these two ions are present in the measured spectrum. 
The delta intensity of the A1 isotope ion is close to the Allowed Intensity Deviation of 10% 
and the delta intensity of the A2 isotope ion is much higher (see Intensity deviation data for 
the expected ions). 

The TraceFinder application determines the isotopic pattern score value from a combination 
of the mass and intensity deviations between the expected and the measured spectra. In this 
case, the application reduces the isotopic pattern score value down to 90 from 100 to reflect 
the marginal quality of the intensities of the A1 and A2 isotopes and to penalize for not 
finding the A2 isotope.

Calculating Isotopic Pattern Score

To score the fit for an isotopic pattern, the TraceFinder application calculates each expected 
ion’s fit and then combines the individual fit scores, weighted by their expected intensities.

For each expected ion peak, the application measures the m/z and intensity differences 
between the expected and the measured patterns. It then normalizes those differences 
(normalized deviation values) to the maximum allowed mass and intensity deviation values set 
in the processing method. The application then sums the normalized differences by vector 
addition (see Zoomed area showing the vector sum of intensity (I) and mass (M) deviations).

Table 97. Intensity deviation data for the expected ions

Isotope 
order m/z (expected) Intensity 

(expected)
Relative intensity 
(expected, %)

Intensity 
(measured)

Relative intensity 
(measured, %)

Delta 
intensity 

A0 215.09611 8.55E5 100 4.75E4 100 0

A1 216.09945 7.50E4 8.77 8.75E3 18.42 9.65

A2 217.09191 3.86E4 4.51 3.47E4 73.05 68.54
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Figure 142. Measured and expected patterns

Figure 143. Zoomed area showing the vector sum of intensity (I) and mass (M) deviations

This example starts with the intensity deviations. The Allowed Intensity Deviation value set 
in the processing method is 10, so this is the normalization value. As shown in Intensity 
deviation data for the expected ions, the delta intensity value for the A1 isotope is close to 
10%, resulting in a normalized intensity deviation close to 1.0.

Normalized Intensity Deviation

The following table lists the normalized intensity deviation data for each of the expected ions.

Table 98. Normalized intensity deviation data for the expected ions

Isotope 
order m/z (expected) Delta 

intensity

Allowed 
intensity 
deviation (%)

Normalized intensity 
deviation

A0 215.09611 0 10 0  10 = 0.0 

A1 216.09945 9.65 10 9.65  10 = 0.965

A2 217.09191 68.54 10 68.54  10 = 6.854

Measured spectrum in greenExpected spectrum in blue

Vector sum

Measured spectrum in greenExpected spectrum in blue
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For mass deviations, you can control two settings in the processing method:

• The first setting is the Allowed Mass Deviation that functions as an outer limit in the 
same way that the Allowed Intensity Deviation functions as a limit for the intensity. 

• The second setting is the Use Internal Mass Calibration check box. If you do not select 
this check box in the method, then the application considers any mass value within 
2 ppm of the expected m/z as a perfect match (no deviation). If you select this check box, 
then the application considers only a mass value within 1 ppm of the expected m/z as a 
perfect match.

In this example, the Allowed Mass Deviation value set in the processing method is 5 ppm and 
the Use Internal Mass Calibration check box is cleared. The mass normalization is more 
complex than the intensity normalization because mass values < 2 ppm (Use Internal Mass 
Calibration setting) from the expected m/z are considered to have no deviation from theory; 
however, for values between 2 and 5 ppm (Allowed Mass Deviation value) from the expected 
m/z, the normalized deviation varies from 0 through 1.

The calculated normalized mass deviation value is as follows:

• 0 if absolute value (Delta m/z) < 2 ppm

where 2 ppm is the value from the Use Internal Mass Calibration setting.

• [absolute value (Delta m/z) – 2 ppm] (5 ppm – 2 ppm) if 
absolute value (Delta m/z) 2 ppm

where 2 ppm is the value from the Use Internal Mass Calibration setting and 5 ppm is the 
Allowed Mass Deviation value.

In this case, the absolute value of the mass deviation for the A0 ion is less than 2 ppm; 
therefore, its normalized mass deviation value is 0.

Normalized Mass Deviation

The following table lists the normalized mass deviation data for each of the expected ions.

For example: [(24 – 2)] (5 – 2) = 7.33

Table 99. Normalized mass deviation for each of the expected ions

Isotope 
order

m/z 
(expected)

m/z 
(measured) Delta m/z (ppm) Internal 

calibration (ppm)
Allowed mass 
deviation (ppm)

Normalized mass 
deviation

A0 215.09611 306.10356 –0.42 2 5 0

A1 216.09945 307.10691 –3.05 2 5 0.35

A2 217.09191 308.11324 24 2 5 7.33
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To calculate the combined deviations, the application uses the Pythagorean theorem to 
calculate the vector sum of the normalized deviations. The calculation for the vector sum is as 
follows:

Vector sum = Square root [(Normalized intensity deviation)2 + (Normalized mass deviation)2]. 

However, if the vector sum > 1, then set it to 1.

Calculated Vector Sum

The following table lists the vector sum data for each of the expected ions.

To calculate the final score, you must weigh the vector sum values and then express the result 
as a percentage value. Each ion’s weighting contribution to the final isotopic pattern score is 
proportional to its intensity. 

Weighting Factor Calculations

The following table lists the weighting factor of each of the three expected ions.

The weighting factor of each individual ion = Intensity of each ion  Sum of intensities of all 
expected ions

For example: 8.55E5 9.686E5 = 0.8827

Table 100. Calculated vector sum

Isotope 
order m/z (expected) Normalized intensity 

deviation
Normalized mass 
deviation Vector sum

A0 215.09611 0 0 0

A1 216.09945 0.965 0.35 1

A2 217.09191 6.854 7.33 1

Table 101. Weighting factor calculations

Isotope order m/z (expected) Intensity (expected) Weighting factor for final score

A0 215.09611 8.55E5 0.8827

A1 216.09945 7.50E4 0.0774

A2 217.09191 3.86E4 0.0399

Sum = 9.686E5 Sum = 1.000
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When not all of the expected ions are present in the measured spectrum, the application 
applies a penalty value (1, 2, or 4) to the weighted deviation of each missing ion, lowering the 
final isotopic pattern score even further. The penalty value depends on how strong the ion 
signal is expected to be in the measured spectrum. For the A2 ion that is not found, the 
application sets its penalty to a value of 1, causing its vector sum value of 1 (in Table 100 on 
page 371) to be replaced with the penalty value of 1 (in Table 102). In this case, it is the same 
number, but for other cases, the penalty value might be different from the vector sum value.

Calculated Isotopic Pattern Score

The following table lists the calculated isotopic pattern score using the weighting factors. 

where:

• Weighted deviation of each individual ion = Deviation  Weighting factor

For example: 1  0.0774 = 0.0774

• Isotopic pattern score = 100% (1.0 – Sum of all weighted deviation values)

For this example, the calculated isotopic pattern score of 100% (1.0 – 0.12) is 88, 
which is close to the 90 score displayed in the application.

Table 102. Calculated isotopic pattern score

Isotope 
order

m/z 
(expected)

Deviation (vector 
sum or penalty) Weighting factor Weighted deviation

A0 215.09611 0 (vector sum) 0.8827 0

A1 216.09945 1 (vector sum) 0.0774 0.0774

A2 217.09191 1 (penalty) 0.0399 0.0399

Sum = 0.12

Note  Use these calculations to approximate the score displayed in the application. The 
calculated score might not exactly match the score in the application because some 
internal calculation details are not listed here or because there is a discrepancy caused by 
decimal digit rounding.

In certain cases, closely matching isotopes exist because heavier isotopes contribute to the 
isotopic pattern observed in the mass spectra. For example, the isotopes 206.0941 and 
206.1006 result from the contribution of one heavier isotope of carbon and one heavier 
isotope of nitrogen, respectively, which make up the split A1 isotopic peak. When the 
application performs isotopic pattern scoring, this situation appears as a main isotopic 
peak with a smaller peak to the side whose m/z is included in the calculations.
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Finding the Noise Value

On the Isotope page of the Compound Details pane, you can view the averaged noise value 
(N) for a peak in the measured spectrum.

 To find the noise value associated with a mass spectral peak

1. Right-click the plot area and choose Display Stack Spectra.

2. Zoom in to the peak of interest.

As an example, see Isotopic pattern spectra (stacked) for the compound Metribuzin. 

3. Right-click the measured plot area and choose Show Noise Label.

In this example, the averaged noise value for the peak is 1579.

Noise

Measured spectrum in redExpected spectrum in blue
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